Administrator's Guide and Reference
Personal Communications for Windows, Version 12.0

Administrator's Guide and Reference
Note

Before using this information and the product it supports, read the information in Appendix C, “Notices,” on page 261.
Contents

Figures ........................................ vii
Tables ........................................... ix
About This Book.............................. xi
Who Should Read This Book ............. xi
How to Use This Book ...................... xi
Command Syntax Symbols .................. xi
Where to Find More Information ......... xii
Knowledge Center ......................... xii
Online Help .................................. xii
Messages and Alerts ....................... xii
Personal Communications Library ....... xiii

Part 1. General Information .............. 1

Chapter 1. Personal Communications Highlights ......................... 3

Chapter 2. Problem Analysis ............. 7
Log Viewer ..................................... 7
Trace Facility .................................. 8
Information Bundler ....................... 9
Internet Service ............................. 9
Checking for APARs and Manufacturing Refreshes ....... 10
  Fix Packs ................................ 10
  Manufacturing Refreshes (MRs) .......... 10

Part 2. Advanced Configuration, Management, and Operations ....... 11

Chapter 3. Advanced Configuration .................. 13
Configuration Files .......................... 13
  Initial Configuration Definitions ....... 13
  Using Template and Update Files ....... 14
Configuring Multiple Links ............... 17
  Configuring a Second 3270 Emulation Link .... 17
  Configuring a Second 5250 Emulation Link .... 18
  Configuring a Second Link of a Different Kind .... 18
  Configuring to Perform 3270 and 5250 Emulation to Multiple Hosts ....... 19
Automatic Device Name Generation (5250 Only) ............... 22
Substitution Characters ................... 22
Client Naming Function ................... 23
Device Name Collision Processing ........ 24
Commands for Emulator Functions ........ 24
  Start a Personal Communications Session .... 24
  Stop a Personal Communications Session .... 25
  Query Personal Communications Sessions .... 25

Chapter 4. Attachment Considerations and Adapter Setup Information .... 27
Attachment Information .................... 27
  IBM-EEDLC ................................ 27
  TCP/IP Connection ........................ 28
SDLC MPA Attachment ..................... 29
IBM Global Network - SNA over Async Attachment .................. 30
IBM Global Network Connection Attachment ....... 31
Home3270 Attachment ...................... 31
3270 Attachment via the iSeries System ....... 32
IBM PC720 Modem Initialization (Japan only) ....... 33
5250 Asynchronous Console ................ 33
Adapter Setup Information ............... 33
  Creating and Updating Devices in Windows 8, Windows 8.1, or Windows 10 ....... 33
  MPA Adapters ............................. 33
  OEM Adapters ............................. 35

Chapter 5. System Policy Support .......... 37
Configuration Policy ....................... 37
  Communication ........................... 37
  Menu .................................... 38
  Toolbar .................................. 38
  Multiple Sessions ....................... 39
  Keyboard ................................ 40
  Mouse ................................... 40
  Change Directory ....................... 41
  Import .................................. 41
Execution Policy ........................... 41
  Start Session ............................ 41
  Product Update ........................... 42
  Detect and Repair ....................... 42
  File Transfer ............................ 42
Installation Policy ....................... 42
  View Policy ............................. 42

Chapter 6. Configuring and Using Security for Personal Communications ....... 45
Certificates .................................. 45
  Certificate Migration ..................... 46
  Managing Certificates in the Microsoft Certificate Stores ....... 46
Configuring and Using Secure Sockets Layer ............... 46
  Preparation for TLS Communication ....... 47
  Establishing a Secure Session .......... 48
Configuring Personal Communications Session Safety ............... 49
  Security ................................ 49
  Pop-up Messages ......................... 52
  Changing the Password of a Client’s Key Database ............... 52
  Connecting to a Server Using a Certificate from a Well-Known CA ....... 53
  Connecting to a Server Using a Certificate from an Unknown CA .......... 54
<table>
<thead>
<tr>
<th>Chapter 7. Using Windows Terminal Services</th>
<th>71</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session IDs</td>
<td>71</td>
</tr>
<tr>
<td>SNA Node Options</td>
<td>71</td>
</tr>
<tr>
<td>Configuration Preferences</td>
<td>71</td>
</tr>
<tr>
<td>User ID (Local LU 6.2)</td>
<td>72</td>
</tr>
<tr>
<td>Trace Facility</td>
<td>73</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 8. ODBC Drivers and Database Access Utility</th>
<th>75</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Open Database Connectivity (ODBC)</td>
<td>75</td>
</tr>
<tr>
<td>Components of ODBC</td>
<td>75</td>
</tr>
<tr>
<td>Database Access</td>
<td>77</td>
</tr>
<tr>
<td>Accessing an ODBC Data Source</td>
<td>77</td>
</tr>
<tr>
<td>Database Size Limit</td>
<td>79</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9. Express Logon</th>
<th>81</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bypass Signon Using Password Substitute (5250)</td>
<td>81</td>
</tr>
<tr>
<td>Kerberos Services Ticket Auto-Signon</td>
<td>82</td>
</tr>
<tr>
<td>Certificate Express Logon</td>
<td>82</td>
</tr>
<tr>
<td>Preparing to Configure Certificate Express Logon</td>
<td>82</td>
</tr>
<tr>
<td>Configuring Certificate Express Logon</td>
<td>83</td>
</tr>
<tr>
<td>Problem Determination</td>
<td>84</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 10. Log Viewer Functions</th>
<th>85</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing Message and Trace Logs</td>
<td>85</td>
</tr>
<tr>
<td>Changing Message Log Size and Location</td>
<td>85</td>
</tr>
<tr>
<td>Merging Message and Trace Logs</td>
<td>85</td>
</tr>
<tr>
<td>Sorting Message and Trace Logs</td>
<td>86</td>
</tr>
<tr>
<td>Searching Personal Communications Logs</td>
<td>86</td>
</tr>
<tr>
<td>Filtering Personal Communications Logs</td>
<td>86</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part 3. SNA and AnyNet Topics</th>
<th>87</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 11. SNA Client/Server Concepts</td>
<td>89</td>
</tr>
<tr>
<td>Terminology</td>
<td>89</td>
</tr>
<tr>
<td>APPC Concepts</td>
<td>89</td>
</tr>
<tr>
<td>Introducing APPC and CPI-C</td>
<td>90</td>
</tr>
<tr>
<td>What Is a Transaction Program?</td>
<td>90</td>
</tr>
<tr>
<td>What Is the Difference between APPC and APPN?</td>
<td>91</td>
</tr>
<tr>
<td>Side Information Definitions</td>
<td>91</td>
</tr>
<tr>
<td>Improving Productivity Using APPC</td>
<td>92</td>
</tr>
<tr>
<td>Improving Productivity Using CPI-C</td>
<td>92</td>
</tr>
<tr>
<td>What Is a Logical Unit?</td>
<td>92</td>
</tr>
<tr>
<td>LU Types</td>
<td>93</td>
</tr>
<tr>
<td>Dependent and Independent LUs</td>
<td>93</td>
</tr>
<tr>
<td>What Is a Session?</td>
<td>93</td>
</tr>
<tr>
<td>What Is a Conversation?</td>
<td>94</td>
</tr>
<tr>
<td>A Conversation between Two TPs</td>
<td>95</td>
</tr>
<tr>
<td>Parallel Sessions between LUs</td>
<td>95</td>
</tr>
<tr>
<td>SNA Communications</td>
<td>95</td>
</tr>
<tr>
<td>SNA Node Operations</td>
<td>96</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 12. AnyNet SNA over TCP/IP</th>
<th>97</th>
</tr>
</thead>
<tbody>
<tr>
<td>What Does AnyNet SNA over TCP/IP Do?</td>
<td>97</td>
</tr>
<tr>
<td>Running APPC or CPI-C Applications over a TCP/IP Network</td>
<td>97</td>
</tr>
<tr>
<td>Using AnyNet to Connect SNA Applications on Different Platforms</td>
<td>97</td>
</tr>
<tr>
<td>Chaining Gateways to Connect Multiple SNA and IP Networks</td>
<td>98</td>
</tr>
<tr>
<td>5250 Emulation over a TCP/IP Network</td>
<td>98</td>
</tr>
<tr>
<td>APPC3270 Emulation over a TCP/IP Network</td>
<td>98</td>
</tr>
<tr>
<td>3270 Emulation via DLUR over a TCP/IP Network</td>
<td>99</td>
</tr>
<tr>
<td>3270 Emulation over a TCP/IP Network via an SNA Gateway to a VTAM Host on an SNA Network</td>
<td>99</td>
</tr>
<tr>
<td>3270 Emulation over a TCP/IP Network via an SNA Gateway to a VTAM Host on an APPN Network</td>
<td>100</td>
</tr>
<tr>
<td>3270 Emulation via an SNA Gateway over a TCP/IP Network</td>
<td>100</td>
</tr>
<tr>
<td>How Does SNA over TCP/IP Work?</td>
<td>101</td>
</tr>
<tr>
<td>Mapping SNA Resources to IP Addresses</td>
<td>102</td>
</tr>
<tr>
<td>Defining Domain Names and IP Addresses</td>
<td>102</td>
</tr>
<tr>
<td>Defining Unique CP Names and Connection Network Names</td>
<td>103</td>
</tr>
<tr>
<td>Setting and Modifying the Routing Preference Protocol</td>
<td>104</td>
</tr>
<tr>
<td>Helpful Hints</td>
<td>105</td>
</tr>
<tr>
<td>Tuning</td>
<td>105</td>
</tr>
<tr>
<td>Connecting to iSeries, eServer i5, or System i5</td>
<td>105</td>
</tr>
<tr>
<td>Dynamic IP Addresses</td>
<td>105</td>
</tr>
<tr>
<td>AnyNet Configuration Examples</td>
<td>106</td>
</tr>
<tr>
<td>Example 1. 5250 Emulation Over a TCP/IP Network</td>
<td>106</td>
</tr>
<tr>
<td>Example 2. Running APPC or CPI-C Applications over a TCP/IP Network</td>
<td>107</td>
</tr>
<tr>
<td>Example 3. APPC3270 Emulation over a TCP/IP Network</td>
<td>108</td>
</tr>
<tr>
<td>Example 4. 3270 Emulation via DLUR over a TCP/IP Network</td>
<td>109</td>
</tr>
<tr>
<td>Example 5. 3270 Emulation over a TCP/IP Network via a SNA Gateway to a VTAM Host on a SNA Network</td>
<td>110</td>
</tr>
<tr>
<td>Example 6. 3270 Emulation via an SNA Gateway to a VTAM Host on an APPN Network</td>
<td>111</td>
</tr>
<tr>
<td>Example 7. 3270 Emulation from a Windows 8, Windows 8.1, or Windows 10 Workstation on Different IP Networks</td>
<td>112</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 13. SNA Node Operations</th>
<th>115</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Node Operations</td>
<td>117</td>
</tr>
</tbody>
</table>
Chapter 14. SNA Cryptography
Support ........................................ 123
   Enabling and Using Session-Level Encryption .... 123
      Configuring Proper Key-Encrypting Keys .... 123
      Naming Labels for KEKs ....................... 124
   Enabling Cryptography in SNA Node
      Configuration .................................. 125


Chapter 15. Multiple-Language
Support .......................................... 129
   Overview: ....................................... 129
      System Locale .................................. 129
      Language Groups .............................. 129
   Personal Communications User Interface
      Languages ...................................... 130
      Multiple Sessions ............................. 131
      Other Considerations ......................... 131

Chapter 16. Country Codes and
Character Sets ................................. 133
   Keyboard Country ID and Shift Support .......... 134
   IBM Japanese Character Set (2-Byte Codes) .... 136
      Character Types ................................ 136
      Character Size ................................ 136
   IBM Kanji Codes ................................ 136
   IBM Traditional Chinese Character Set .......... 137
   IBM Simplified Chinese Character Set, GBK Code .... 138
   IBM Hangeul Character Set ........................ 138
   Thai Language Support ........................... 139

Chapter 17. Bidirectional Language
Support (Arabic and Hebrew) ............... 141
   Considerations for Printing .................... 141
      Printing in Arabic ................................ 141
      DAT File for 5250 Arabic ...................... 142
   Bidirectional Arabic Support .................... 143
      Limitations .................................... 143
      Installation Tips ................................ 143
   Bidirectional Keyboard Functions for 3270 ..... 143
   Arabic Character Shape Selection Functions .... 145
   Personal Communications iSeries ................. 146
   Bidirectional Hebrew Support ................... 147
   Bidirectional Functions for 3270 ............... 147
      Keyboard Layout ................................ 147
      Configuration .................................. 149
      Font .......................................... 149
      File Transfer with 862 Code Page .............. 150
   Bidirectional Functions for 5250 ............... 150
   Bidirectional Support for VT .................... 151
      Configuring VT Emulation for Arabic or Hebrew .... 151
      File Transfer .................................. 151
      Copy and Paste ................................ 152
      Print Screen .................................. 152
      Remapping BiDi Keys ........................... 152
   Bidirectional Functions for VT ................. 152
      Arabic Support for ASMO 449 7-bit Code Page ... 153

Chapter 18. Unicode Support ............... 155
   1390/1399 Code Pages ........................... 155
   Hindi Support ................................... 156

Part 5. Building a Printer Definition
Table (PDT) .................................... 157

Chapter 19. Building a Printer
Definition Table (PDT) for PC/3270 .......... 159
   ASCII_PASSTHRU? and EBCDIC_PASSTHRU? .... 159
   Supplemental Explanation of PDF Statements for PC/3270 ... 159
   SCS TAB Setting ................................ 161
   Printer Color Mixing ............................ 161
   Printer Session Data Stream Support ............. 161
      3270 Data Stream ................................ 161
      SCS Data Stream ............................... 163
   Delimiting Print Jobs ............................ 164
   Structured Fields ................................ 165
      Begin/End of File Query Reply ............... 165
      Begin/End of File Structured Fields ........... 165

Chapter 20. Building a Printer
Definition Table (PDT) for PC400 ........... 169
   Using the Printer Definition Table (PDT) File .......... 169
   Printer Definition File (PDF File) Format .......... 169
      Macro Definitions ............................. 169
      Formatting Controls ............................ 171
   Printing More than One Screen on a Page .......... 173
   Transparent Print Capability ..................... 174
   ASCII_PASSTHRU? Keyword Support ................ 174
   EBCDIC_PASSTHRU? Keyword Support ................ 174
   EBCDIC_xx Keyword Support ..................... 175
   Printer Definition Tables ........................ 175
   Example Printer Definition Files ................ 175
      IBM4019.PDF File Contents .................... 176
      IBM5577.PDF File Contents .................... 184
   Field Names of Printer Definition Files .......... 186
   Symbols of Printer Definition Files ............ 191
   Using Printer Control Codes ..................... 196
   Printer Control Code Format ..................... 196
   Parameter Definition of Printer Control Codes .... 197
   Supported Control Codes ........................ 197
   Supported SCS Commands ........................ 197
   Programming Notes .............................. 200
   Restrictions and Notes for iSeries, eServer i5, or System i5 Commands and Printer Setup .... 200
   PFT Migration Utility ............................ 206
<table>
<thead>
<tr>
<th>Chapter 21. Troubleshooting</th>
<th>231</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Personal Communications Database Access error when starting Microsoft Excel</td>
<td>231</td>
</tr>
<tr>
<td>2. Personal Communications Database Access utility limitations with Microsoft Office 2007</td>
<td>231</td>
</tr>
<tr>
<td>3. Windows Firewall, provided as part of Windows XP Service Pack 2, blocks EEDLC packets</td>
<td>232</td>
</tr>
<tr>
<td>4. Disable firewall/filtering when using Personal Communications IPv6 functionality on Windows</td>
<td>232</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part 6. Appendixes</th>
<th>235</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix A. iSeries, eServer i5, or System i5 Configuration Examples</td>
<td>237</td>
</tr>
<tr>
<td>iSeries Device Description</td>
<td>237</td>
</tr>
<tr>
<td>5250 Sessions through One Link</td>
<td>238</td>
</tr>
<tr>
<td>System i5, iSeries, eServer i5, or System Mode Description</td>
<td>238</td>
</tr>
<tr>
<td>iSeries, eServer i5, or System i5 Device Description for Twinaxial Attachments (APPC) Example</td>
<td>239</td>
</tr>
<tr>
<td>iSeries, eServer i5, or System i5 Device Description for Asynchronous Attachment Example</td>
<td>241</td>
</tr>
<tr>
<td>iSeries, eServer i5, or System i5 VT Asynchronous Attachment Example</td>
<td>244</td>
</tr>
<tr>
<td>iSeries, eServer i5, or System i5 Configuration for SDLC Example</td>
<td>246</td>
</tr>
<tr>
<td>Network Attributes</td>
<td>246</td>
</tr>
<tr>
<td>SDLC Leased Configuration</td>
<td>247</td>
</tr>
<tr>
<td>Creating an SDLC Line Description</td>
<td>247</td>
</tr>
<tr>
<td>SDLC Controller Description</td>
<td>249</td>
</tr>
<tr>
<td>SDLC Switched Configuration</td>
<td>250</td>
</tr>
<tr>
<td>SDLC Line Description</td>
<td>250</td>
</tr>
<tr>
<td>SDLC Controller Description</td>
<td>252</td>
</tr>
<tr>
<td>LAN Configuration Example</td>
<td>253</td>
</tr>
<tr>
<td>LAN Controller Description</td>
<td>254</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix B. Alerts</th>
<th>257</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Appendix C. Notices</th>
<th>261</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trademarks</td>
<td>262</td>
</tr>
</tbody>
</table>

| Index | 265 |
Figures

1. Database Access Overview 75
2. ODBC Components 76
3. A Session between Two LUs 94
4. A Conversation between Two TPs 95
5. Parallel Sessions between LUs 95
6. Running APPC or CPI-C Applications over a TCP/IP Network 97
7. Using AnyNet to Connect SNA Applications on Different Platforms 98
8. Chaining Multiple Gateways to Connect Multiple IP Networks 98
9. 5250 Emulation over a TCP/IP Network 98
10. APPC3270 Emulation over a TCP/IP Network 99
11. 3270 Emulation via DLUR over a TCP/IP Network 99
12. 3270 Emulation over a TCP/IP Network via an SNA Gateway to a VTAM Host on an SNA Network 100
13. 3270 Emulation over a TCP/IP Network via an SNA Gateway to a VTAM Host on an APPN Network 100
14. 3270 Emulation via an SNA Gateway over a TCP/IP Network 101
15. Structure of SNA over TCP/IP for Personal Communications 101
16. Formats of the Domain Names That SNA over TCP/IP Builds 102
17. Defining a CP Name and a Connection Network Name 104
18. 5250 Emulation Over a TCP/IP Network 106
19. Running APPC or CPI-C Applications over a TCP/IP Network 107
20. APPC3270 Emulation over a TCP/IP Network 108
21. 3270 Emulation via DLUR over a TCP/IP Network 109
22. 3270 Emulation over a TCP/IP Network via a SNA Gateway to a VTAM Host on an SNA Network 110
23. 3270 Emulation via an SNA Gateway over a TCP/IP Network 111
24. 3270 Emulation over a TCP/IP Network via an AnyNet SNA/IP Gateway to a VTAM Host on an APPN Network 112
25. 3270 Emulation on Different IP Networks 113
26. LAN Attachment via IEEE 802.2 237
### Tables

1. Supported Netscape PKCS#11-compatible Smart Card Drivers .................................. 57
2. Object–Action Pairs for IKEYCMD ...................................................................... 59
3. Supported Keyboard Types ................................................................................. 133
4. Keyboard Country ID and Shift Support ............................................................... 134
5. IBM Japanese Character Set and IBM Kanji Codes ............................................. 136
6. IBM Japanese Character Set and IBM Kanji Codes (Extended for Unicode Subset) . . 137
7. IBM Traditional Chinese Host Code ..................................................................... 137
8. IBM Simplified Chinese Character Set, GBK Code ................................................ 138
9. IBM Hangeul Host Code (833) ........................................................................... 138
10. IBM Hangeul Host Code (1364) ........................................................................ 139
11. Bidirectional Key-Combinations for 3270 .......................................................... 147
12. Bidirectional Key-Combinations for 5250 .......................................................... 150
13. Bidirectional Key-Combinations for VT ............................................................. 152
14. Control Sequences for Arabic VT Support ......................................................... 153
15. Color Mixes ....................................................................................................... 161
16. 3270 Data Stream Commands ............................................................................ 162
17. 3270 Data Stream Orders .................................................................................... 162
18. 3270 Data Stream Format Control Codes ........................................................... 163
19. Supported SCS Control Codes ............................................................................ 163
20. Begin/End of File Query Reply Format .............................................................. 165
22. Field Names of PDF Files .................................................................................. 186
23. Effective Values for PDF File Field Names ...................................................... 190
24. Printer Symbol Definitions ................................................................................ 191
25. Printer Control Code Parameter Types ............................................................. 197
26. Supported SCS Commands .............................................................................. 197
27. Printer Control Codes ........................................................................................ 201
28. SCD Parameter Values ..................................................................................... 201
29. Commonly Used SFG GFID Values .................................................................... 202
30. iSeries, eServer i5, or System i5 Font Parameters ............................................. 202
31. PDF File Name .................................................................................................. 206
32. Migration from the Printer Function Table to the Printer Definition File .......... 207
About This Book

IBM® Personal Communications for Windows reference books are comprised of this Administrator's Guide and Reference and an Emulator User's Reference. These volumes provide information for using IBM Personal Communications iSeries for Windows operating systems (hereafter called PC400) and IBM Personal Communications for Windows operating systems.

Notes:
1. **PC/3270** refers to the 3270 portion of the combined package.
2. **Workstation** refers to all supported personal computers.
3. **Windows** refers to Windows 8, Windows 8.1, Windows 10, and Windows Server 2008. When information is applies only to a specific operating systems, this is indicated in the text.

Who Should Read This Book

This book is intended for administrators of Personal Communications.

How to Use This Book

This book contains reference information that you might need to refer to when installing or operating Personal Communications.

Personal Communications is designed to use various communication adapters and to work with other workstation and host system software. Refer to the appropriate documentation for the products you use.

Command Syntax Symbols

Parentheses, brackets, ellipses, and slashes have the following meanings or uses:

( ) Parentheses enclose operands that govern the action of certain command options.

[ ] Brackets indicate an optional command argument. If you do not use the optional item, the program selects a default.

... Ellipsis after an argument indicates that you can repeat the preceding item any number of times.

/ For 3270, a slash must precede the Time Sharing Option Extensions (TSO/E) password. A slash must also precede parameters of DOS commands entered from the command line. For 5250, a slash must precede parameters of IBM DOS commands entered from the command line.

\ A backslash is included as part of any directory name. An initial backslash indicates the first-level directory, and an additional backslash is inserted in the directory name to indicate another level.

All directives, operands, and other syntax can be typed in either uppercase or lowercase, unless otherwise indicated.
Where to Find More Information

The following sections discuss getting help when you are installing, configuring, or using Personal Communications.

Knowledge Center

You can find documentation and links to other resources at the Personal Communications Knowledge Center, at the following address:

http://www.ibm.com/support/knowledgecenter/SEQ5Y

The Knowledge Center contains reference material that is not found in this book, such as keyboard layouts and host code page tables. The Japanese Knowledge Center also contains FAQs and troubleshooting tips.

The Personal Communications Knowledge Center provides information in English and Japanese.

Online Help

The help facility describes how to install, configure, and use Personal Communications. Online help is very extensive and includes information about every aspect of configuring and using Personal Communications.

Use help to obtain the following information:

- Menu choices
- Operation procedures
- Operations in windows
- Meanings of the terms displayed in windows
- Causes of errors and the corresponding actions to take
- Mouse-based operations
- Operation without a mouse
- Detailed explanations of specific terms
- Further technical information about Personal Communications
- Detailed explanations of operator information area (OIA) messages

To display online help, select choices from the Help menu or press F1.

You can use Personal Communications online help just as you use the online help for Windows.

Messages and Alerts

Online messages are displayed by Personal Communications, but a message does not always mean an error occurred. For example, a message might tell you that an operation is in progress or has been completed. A message can also prompt you to wait for the completion of an operation.

Messages That Appear in Pop-Up Windows

While using Personal Communications, you may see messages appear in popup windows, but not necessarily as a direct result of your actions. These messages can appear for a number of reasons, outlined in the following sections.

System-Fault Messages: If a message does appear in a pop-up window, you can paste its contents into the Windows clipboard. To do this:
1. Click Details on the pop-up window.
2. Mark the text that you want to copy.
3. Click the marked text with the right mouse button and then click **Copy**.
4. Start an editor, such as Notepad, and click **Paste** from the **Edit** menu.
5. Save the file in case an IBM Service Representative needs this information to diagnose your problem.

**Security-Related Messages:** Personal Communications optionally utilizes Secure Sockets Layer (SSL) or Transport Layer Security (TLS) to establish sessions with servers; this may require input from you (for example, a password). See Chapter 6, “Configuring and Using Security for Personal Communications,” on page 45 for details.

**System-Policy-Related Messages:** Your Personal Communications workstation configuration can be controlled centrally using facilities for managing system policies. See Chapter 5, “System Policy Support,” on page 37 for details.

**OIA Messages**

Personal Communications displays messages in the operator information area (OIA) or in a pop-up window. Messages from Personal Communications are displayed in the message window; messages from the host system regarding the condition of the session are displayed in the OIA of the session window.

The OIA is the bottom line of the session window. An OIA message indicates the status of Personal Communications as well as information about the workstation, host system, and attachment method.

All of the OIA indicators, reminders, and messages are described in the online help. To view this information:

1. Click **Index** from the **Help** menu.
2. Select **The operator information area messages**.
   
   To look up a specific OIA message, select **Search**. When the Search window appears, type the letters that appear in the OIA. For example, MACH or PROG. If a lightning bolt appears, type COMM.
3. Double-click the index entry that matches your search.
4. Scroll through the window until you find the number that appears in your OIA.

**Alerts**

Alerts may be generated which correspond to specific Personal Communications messages. See Appendix B, “Alerts,” on page 257 for more information.

**Personal Communications Library**

The Personal Communications library includes the following publications:

- CD-ROM Guide to Installation
- Quick Beginnings
- Emulator User’s Reference
- Administrator’s Guide and Reference
- Emulator Programming
- Client/Server Communications Programming
- System Management Programming
- Host Access Class Library
- Configuration File Reference
These books are also available (except in DBCS versions) in PDF format and are optionally installed or viewed from the Installation Image.

In addition to the printed books, there are HTML documents provided with Personal Communications:

*Host Access Class Library for Java*
This HTML document describes how to write an ActiveX/OLE 2.0-compliant application to use Personal Communications as an embedded object.
Part 1. General Information
Chapter 1. Personal Communications Highlights

Personal Communications brings the power of personal networking to your workstation by providing a variety of connectivity options supporting local area network (LAN) and wide area network (WAN) environments. Whether you need host terminal emulation, client/server applications, or connectivity, Personal Communications offers a robust set of communications, networking, and administrative features.

Personal Communications is a full-function emulator package with an easy-to-use graphical interface, which includes many useful features such as file transfer and dynamic configuration, and emulator APIs including the IBM Host Access Class Library.

Personal Communications also provides a variety of SNA-based client application programming interfaces (APIs). You can create applications that use the peer-to-peer client APIs, which are based on LU 6.2 (and provided by Personal Communications). Using these APIs you can simultaneously access and process information on peer workstations.

With Personal Communications, you can participate in Advanced Peer-to-Peer Networking (APPN) as an end node, and use the advanced network features, high-performance routing (HPR), and dependent LU requester (DLUR).

Personal Communications provides the following functions:

• **zSeries Connections**
  - **LAN**
    - LAN via IEEE 802.2
    - Communications Server for Windows
    - Telnet3270
    - 3270 via iSeries®
    - APPC 3270 via LAN
    - Microsoft SNA client over FMI
    - Dependent Logical Unit Requester (DLUR)
    - VT-over-Telnet (TCP/IP)
    - 3174 Peer Communication
  - **SNA/IP**
    - LU 0, 1, 2, 3
    - APPC 3270
    - LU 0, 1, 2, 3 via DLUR
  - **IBM-EEDLC**
    - LU (0, 1, 2, 3) via DLUR
    - APPC 3270
  - **OEM**
    - LU (0, 1, 2, 3)
    - 3270 via iSeries (passthru)
    - APPC 3270
    - Dependent LU Requester (DLUR)

• **iSeries Connections**
  - **LAN**
    - LAN via IEEE 802.2
    - Telnet5250 over TCP/IP
    - VT over Telnet
    - Telnet5250 over IPX/SPX
COM port
- SNA-over-Async
- Hayes AutoSync
- SNA-over-Async (Console)
- VT over Async
- VT over Telnet
- Telnet 5250
- X.25 Hayes AutoSync

SDLC  Synchronous Data Link Control

SNA/IP
- 5250

IBM ISA/MCA WAC
- Synchronous Data Link Control (WAC)
- X.25 Qualified Logical Link Control

IBM-EEDLC
- 5250

OEM  APPC 5250

• ASCII Emulator Connections
- LAN  VT over Telnet
- COM port  VT-over-Async
- VT over Telnet

• Client/Server Connections
- LAN  LAN via IEEE 802.2
- COM port  SNA-over-Async
- Hayes AutoSync
- X.25

SDLC  Synchronous Data Link Control

AnyNet® SNA over TCP/IP
- APPC

Enterprise Extender
- HPR over IP

• Configuration of SNA Node (APPN) Sessions
  - Emulator
  - Client/server applications

• SNA Node Operations
  - Starting and stopping resources
  - Deleting resources
  - Displaying resource information
  - Changing session limits
  - Initiation of path switches

• Log Viewer
  - View Message Log, Trace Log, and Merged Log files
  - Summary and Detail views
  - Set default Message Log size and location
  - Filter and search Log files
  - Message Log entries Help

• Trace Capability
  - 3270/5250 emulator data
  - APPN and APPC API data
  - Connectivity data, such as LAN or SDLC
  - User services data, such as node initialization

• APPC Applets
- Display SNA sense data (GETSENSE)
- Check connection (APING)

**Sample Programs**
- Located in \Personal Communications\samples subdirectory

**Installation and Configuration**
- Partial installation option
- Program sharing on a network server
- Automatic detection of installed communication adapters
- Dynamic change of communication configurations
- Automatic Dial Facility (Async (IGN), SDLC, Home3270, SNA-A)
- Silent Installation
- ASCII SNA-node configuration
- Verification of ASCII configuration

**OEM Adaptor Cards**
An open API enables vendors and other equipment manufacturers (OEMs) to provide adapter cards that allow for additional connectivity options, for example, additional X.25, ISDN, or SDLC support.

**Host Session Function**
- Up to 52 sessions
- Variable screen size and automatic font scaling
- Function settings (of the host code page, for example) for each session

**Host Graphics Support**
- Built-in vector graphics support for GDDM and other graphics applications

**File Transfer Function**
- Easy operation through graphical user interface (GUI) windows
- Batch transfer of multiple files
- Concurrent file transfer through multiple sessions
- Background file transfer
- File transfer invocation by macro
- OfficeVision/MVS Import/Export functions
- VT File Transfer (XModem and YModem)

**Edit (Cut and Paste) Function**
You can use the clipboard to cut, copy, and paste a selected area. In addition, you can paste data in other applications, such as spreadsheet programs, that support the PasteLink function.
- Support of spreadsheet data format (Sylk, Biff3, Wk3 formats)
- Copy Append
- Paste Next
- Paste to Trim Rectangle
- Paste Stop at Protected Line

**Graphical User Interface (GUI)**
- Customizable 3D iconic tool bar
- 3D-button hotspots
- Pop-up keypad
- Macro function, including record and play
- VBScripts, including record and play
- Keyboard-function setup and remapping
- Mouse-button-function setup and remapping
- Display setup (cursor type, graphics, sound, colors, for example)
- Automatic font size adjustment or fixed font size
- Window-appearance setup
- Menu-bar customization
- 3270 Light Pen emulation by using a mouse
- Status bar with history
- Page Setup
- Revised Configuration Dialog
- Online help

**Print Function**
- Printer session (for PC/3270: SCS, LU 3, or non-SNA)
- Graphics local print
- Printing with the Windows printer drivers
- Print function by printer definition table (PDT)
- Multiple host-print functions in multiple sessions
- Print-job control by SNA bracket timeout
- PDF-to-PDT conversion tool
- PC400 print function by OS/400® and i5/OS Host Print Transform (HPT)
- PC400 printing supported by the iSeries, eServer™ i5, and System i5
  - Advanced Print Support Utility
- ZipPrint

**Programming Interfaces**
- 16/32-bit Emulator High-Level Language Application Programming Interface (EHLLAPI)
- 16/32-bit Dynamic Data Exchange (DDE)
- 32-bit Node Operations Facility (NOF)
- 16/32-bit Personal Communications API (PCSAPI)
- 32-bit Advanced Program-to-Program Communication (APPC)
- 32-bit Common Programming Interface for Communications (CPI-C)
- 32-bit Automation Object API
- 32-bit ActiveX/OLE 2.0
- ActiveX Controls

**PC400 Client Function**
- Data transfer
- PC Organizer
- Text Assist
- Enhanced Programmable Terminal User Interface (ENPTUI)
Chapter 2. Problem Analysis

This chapter describes the information that will help you analyze problems with Personal Communications, and ways to report a problem to IBM. For detailed information about contacting IBM, refer to *Quick Beginnings*.

For information about Personal Communications and support, refer to the following Web sites:

- The Personal Communications home page provides access to general product information, and download services. To view this page, go to the following Internet address:
  

- The Personal Communications support page provides links to code fixes, tips, newsgroups, support options, and services. To view this page or to submit a software defect report, go to the following Internet address:
  
  http://www.ibm.com/software/network/pcomm/support

Personal Communications provides several utilities to help you with problem analysis. They can be invoked by selecting their icons from the Programs → IBM Personal Communications → Administrative and PD Aids subfolder on the Windows Start menu.

The following sections describe these utilities and how to use them.

Log Viewer

The Personal Communications log viewer utility enables you to view, merge, sort, search, and filter information contained in message and trace logs. Use the log viewer during problem analysis to work with message and trace log entries. The default name of the message log output file is PCSMSG.MLG; its file extension must be .mlg. The file extension for trace logs must be .tlg.

To view message or trace logs:

1. From the Administrative and PD Aids subfolder, click Log Viewer; or, from an active session, click Launch → Log Viewer from the Actions menu.
2. From the list of logged messages, double-click a message to display the message text.

*Note:* Only one message log is created per machine. In simultaneous user environments such as WTS, all user messages are logged into that single instance of the log file. See Chapter 7, “Using Windows Terminal Services,” on page 71 for more information about terminal services.

For more information about log viewer functions, see Chapter 10, “Log Viewer Functions,” on page 85.
Trace Facility

The Personal Communications trace facility enables you to log trace information for certain Personal Communications functions.

To start a trace, perform the following steps:

1. From the Administrative and PD Aids folder, click Trace Facility; or, from an active session, select Launch → Trace Facility from the Actions menu. The trace status on the title bar displays the current state:
   - **Active**: Trace data is being collected by the trace facility.
   - **Inactive**: No trace data is being collected.

2. From the main dialog box, click **Set Up** to set the desired trace system parameters.
3. Click **OK** to return to the main trace dialog box.
4. From the main trace dialog box, select the type of data you want to trace from the **Function Name**, **Component Name**, and **Trace Option** list boxes.

   - **Function Name**: A specific set of Personal Communications features, such as 3270/5250 Emulator or User Services.

   - **Component Name**: The name of a specific part of a function, such as API data (for the 3270/5250 Emulator function) or Node Initialization (for the User Services function).

   - **Trace Options**: The options associated with a particular component, such as EHLLAPI (for the API component) or API trace (for the Node Initialization component).

5. Start tracing data by clicking **Start**, or apply changes to the trace options by clicking **Apply**.
6. Run the operation that you want to trace.
7. Optionally, stop the trace by clicking **Stop**.
8. Save the trace data to your hard disk by clicking **Save**.
9. Click **Format** to specify a formatted trace file name and to format the trace data. The Information Bundler utility should be used immediately after the trace is complete to ensure that the correct information is gathered.

   **Note**: If you have changed the default path setting for the formatted trace file, the Information Bundler will not find the trace information. Copy the trace files to the system-class application data directory.

10. Click **OK**.
11. Click **Clear** to clear the trace buffer where you saved a trace.
12. Use the log viewer to view the formatted trace log.

   **Note**: Trace facility can capture only the application level (Ring 3) tracing, when logged on WTS environment, where the conso session ID is non-zero. If you want to trace the kernel level tracing (Ring 0), use the command line tracing options.
**Information Bundler**

The Personal Communications Information Bundler utility gathers system files, trace and log files, and registry information into a .ZIP file. This file can be sent to support personnel, using the Internet Service utility. The Information Bundler should be executed immediately after the trace is complete to ensure that the correct information is gathered.

Start Information Bundler using one of the following methods:

- Click **Administrative and PD Aids → Information Bundler** from the Personal Communications program menu.
- In an active emulator session, click **Actions → Launch → Information Bundler** from the menu bar.

The X12345.ZIP file is created in the Personal Communications system-class application data directory. This file contains system and Personal Communications information. Refer to the installation documentation for the location of the system-class application data directory for each Windows operating system.

**Internet Service**

The Internet Service utility enables you to send the diagnostic data output file generated by the Information Bundler to an FTP server. This utility will not work unless TCP/IP is configured and you have a direct connection to the internet. To use Internet Service, do the following:

1. Double-click the **Internet Service** icon located in the Personal Communications program group; or, from an active session, click **Actions → Launch → Internet Service**.
   
   The Internet Service window contains four data fields that must have valid values before you can submit your problem report.

2. If IBM Service directs you to add an FTP address, type it in the **FTP Address** field. The default server is indicated by the *(Default)* prefix.

3. Type your e-mail address in the field provided.

4. In the **Problem Determination Filename** field, type the file name and path of the Information Bundler output file. This file is usually located in the Personal Communications application data directory specified during installation. You can also browse to the file by clicking the ... button.

5. In the **PMR Number** field, type the data file name, including the PMR number that you received from IBM Service. The format of the data file name is *xxxx.xbb.ccc.yyy.yyy*, where the variables are as follows:
   - *xxxx* is the PMR number
   - *bbb* is the Branch Office (if known)
   - *ccc* is the IBM Country Code
   - *yyy.yyy* is a short description for the file type, such as *exe, exe.Z, zip, tar.Z, or restore.Z*
   
   Refer to the following file name examples:
   
   99999.999.000.exe
   88888.777.764.zip
   11111.222.760.tar.Z

6. Click **Transmit** to submit your problem determination information.
Checking for APARs and Manufacturing Refreshes

Service updates (Manufacturing Refreshes and Fix Packs) can be found for Personal Communications on Fixcentral at http://www.ibm.com/support/fixcentral/.

Fix Packs

A fix pack is a cumulative APAR package containing all currently available APAR fixes. Fix packs are tested to ensure that the included APARs function well together. You can obtain fix packs using the APAR commit option in the Product Update Tool or by downloading the .msp file.

When you check for APARs, any available fix packs are also displayed. The corresponding .msp file is located in the same application data directory as APARs, with the specific fix pack name. You might be prompted to reboot the system.

To download fix pack files, go to the manufacturing refresh site—you will find a link to the latest fix pack, a list of included APARs, and installation instructions.

Refer to CD-ROM Guide to Installation for information about applying fix packs to administrative installation images and local client installations.

Manufacturing Refreshes (MRs)

Manufacturing refreshes are packages containing a bundle of APARs and possibly new product options and improvements. For Personal Communications, new manufacturing refreshes are cumulative. To check for manufacturing refreshes, click Check for MRs in the Product Update Tool.

Installing a manufacturing refresh is similar to a reinstallation of the product (removing old product files and installing new files); therefore, there is no test and commit process available for manufacturing refreshes. To remove a manufacturing refresh, your only option is to uninstall the current Personal Communications product level, then reinstall the prior level.

You can obtain manufacturing refreshes only if you have purchased a full version of the product. This is validated by entering a service key, which is included in the original package of Personal Communications. When you check for manufacturing refreshes, your Internet browser opens to the manufacturing refresh site, where you are prompted to enter your registration data and service key. When registration is complete and the service key is entered, you can select the product, version, and language for which you need the manufacturing refresh update.

Note: A manufacturing refresh file is usually larger than 100 MB.
Part 2. Advanced Configuration, Management, and Operations
Chapter 3. Advanced Configuration

This chapter describes facilities useful for deploying Personal Communications in large networks. Some of these facilities are handled by features of Personal Communications itself, while others are provided by external products, augmented with facilities provided by Personal Communications.

Configuration Files

The following sections describe the advanced configurations that you can make with the built-in files of Personal Communications. Advanced configurations enable you to easily configure and distribute common keywords and parameters to your client base, and include the following:

- Initial Configuration Definitions
- Configuration with Template and Update Files

Initial Configuration Definitions

Personal Communications enables network administrators to create an initial configuration definitions file that contains common configuration definitions for their clients. By using an initial configurations file, the administrator can distribute preconfigured definitions and have them automatically preloaded whenever a new configuration is created on a client.

The first step is to create a configuration using SNA node configuration, Start or Configure Sessions, or an ASCII editor. For detailed information on configuring sessions, refer to Quick Beginnings.

After you create the configurations file, rename the file to the appropriate reserved name. For SNA node configuration files (*.ACG), the file name is PCSINIT.AC$. For workstation profiles (*.WS), the file name is PCSINIT.WS$. For emulator configurations using SNA communication, you should use both a PCSINIT.WS$ and a PCSINIT.AC$ file.

After you rename the files, they can be distributed to client workstations. Put the files in the configuration files directory. The definitions in the files will be preloaded whenever a user creates a new configuration.

Note: The initial configuration file does not override parameter defaults for new definitions in new configurations, but preloads complete definitions into new configurations. Users can modify these definitions to get custom parameter values; however, the original initial configuration file remains unchanged.

Configuration File and Emulator Profile Directories

The default directory for configuration files is specified during installation. Configuration files can be used for all users or a specific user. Refer to CD-ROM Guide to Installation for details on specifying the initial default directory.

By default, Personal Communications searches for emulator profiles in the configuration files directory. You can use the User Preference Manager utility to indicate a different location for profiles.
Using Template and Update Files

When creating configurations for a large number of clients to implement, you can create a template configuration file that represents the common configuration elements for all clients. Using an update file with only those changes necessary for each client, you can distribute the template and update file and merge the two to create the target configuration.

The Personal Communications Server template and update files enable you to create or modify a configuration using an ASCII editor. You can configure all of the Personal Communications configuration keywords and parameters with update files. Both the template and update files have the same format as Personal Communications configuration (.ACG) files.

Template files can ease the mass distribution of configurations to remote clients. A template file can specify the keywords which are common to several clients. For example, if you have multiple clients to configure as SNA clients, many of the keywords will be identical. You can create a template configuration file that reflects those common keywords.

You can use update files to add, modify, or delete keywords in a template file. The original template configuration file is left unchanged. An update file is merged into a template file by specifying the INCLUDE keyword at the end of the template file. For example, if an update file is named myconfig.chg, the last line of the template file that will use the update file is INCLUDE=myconfig.chg. When the template file and the update file are merged, you can give the resulting configuration file a name with the .ACG extension that distinguishes it from other .ACG files.

When you create configurations using template and update files, the verification utility searches directories in the following order:
1. The local directory where the verification utility is being invoked
2. The system-class application data directory

To ensure that the verification utility can locate the template and update files, you should store them in the system-class application data directory, which is also where the configuration (.ACG) files are stored.

Key Fields

The key field is the parameter in a keyword that names the keyword and uniquely identifies it from other keywords of the same type.

Some keywords do not have key fields because they can only be specified once in a configuration file. An example of a keyword that can only be specified once is the NODE keyword.

Adding Keywords to a Template File

When using an update file to add a new keyword definition, you must provide the entire keyword. The key field must be provided along with a unique value. If any subfields are omitted from the keyword, the defaults for those fields are used. For example, to add a MODE keyword to the configuration, the update file might contain the following keyword:

```
MODE=(
  NODE_NAME=MYMODE
  COS_NAME=#INTER
  CRYPTOGRAPHY=NONE
  DEFAULT_RU_SIZE=1
)```

Administrator's Guide and Reference
MAX_NEGOTIABLE_SESSION_LIMIT=128
MAX_RU_SIZE_UPPER_BOUND=4096
MIN_CONWINNERS_SOURCE=15
)

The content of the update file assumes that a MODE keyword with the parameter
of MODE_NAME=MYMODE does not exist in the template. If it does, the
parameters will be updated with the values provided in the update file.

If the MODE_NAME parameter is omitted from the update file, an error will occur
during the configuration verification because the MODE_NAME parameter cannot
be uniquely identified. Not all parameters available for the MODE keyword are
specified in the update file. The remaining parameters use the defaults as specified
in Configuration File Reference. The resulting addition to the configuration will look
like this:

MODE=(

    MODE_NAME=MYMODE
    AUTO_ACT=0
    COMPRESSION=PROHIBITED
    COS_NAME=#INTER
    CRYPTOGRAPHY=NONE
    DEFAULT_RU_SIZE=1
    MAX_NEGOTIABLE_SESSION_LIMIT=128
    MAX_RU_SIZE_UPPER_BOUND=4096
    MIN_CONWINNERS_SOURCE=15
    PLU_MODE_SESSION_LIMIT=32
    RECEIVE_PACING_WINDOW=1

)

Modifying a Keyword in a Template File
When using the update file to modify an existing keyword definition, the original
keyword should exist in the template file. If it does not exist in the template file,
the update file adds an entry to the new configuration. You must specify the key
parameter in the update file to identify the target keyword. Only those parameters
specified in the update file keyword are updated in the template file's keyword.
Parameters not specified in the update file are left unchanged. For example, if the
following MODE keyword is in the template file:

MODE=(

    MODE_NAME=#INTER
    AUTO_ACT=0
    COMPRESSION=PROHIBITED
    COS_NAME=#INTER
    CRYPTOGRAPHY=NONE
    DEFAULT_RU_SIZE=1
    MAX_NEGOTIABLE_SESSION_LIMIT=256
    MAX_RU_SIZE_UPPER_BOUND=4096
    MIN_CONWINNERS_SOURCE=128
    PLU_MODE_SESSION_LIMIT=256
    RECEIVE_PACING_WINDOW=20

)

and the following keyword is specified in the update file:

MODE=(

    MODE_NAME=#INTER
    AUTO_ACT=10

)

the resulting configuration would have the following MODE keyword definition:

MODE=(

    MODE_NAME=#INTER
    AUTO_ACT=10

)
Deleting a Keyword from a Template File

When using the update file to delete a keyword from the template, you must specify the key parameter and value that identify the keyword, along with the keyword DELETE. For example, if the template file specifies the following keyword:

```plaintext
MODE=(
  MODE_NAME=#INTER
  AUTO_ACT=0
  COMPRESSION=PROHIBITED
  COS_NAME=#INTER
  CRYPTOGRAPHY=NONE
  DEFAULT_RU_SIZE=1
  MAX_NEGOTIABLE_SESSION_LIMIT=256
  MAX_RU_SIZE_UPPER_BOUND=4096
  MIN_CONWINNERS_SOURCE=128
  PLU_MODE_SESSION_LIMIT=256
  RECEIVE_PACING_WINDOW=20
)
```

and the response file contains the following keyword:

```plaintext
MODE=(
  MODE_NAME=#INTER
  DELETE
)
```

the resulting configuration does not contain the #INTER mode definition.

The DELETE keyword can appear after a `parameter=value` specification or on a line by itself, either preceding or following the parameter. For example, the following uses of the DELETE keyword are valid:

```plaintext
MODE=(
  MODE_NAME=#INTER
  DELETE
)

MODE=(
  DELETE
  MODE_NAME=#INTER
)
```

The DELETE keyword cannot appear in front of a `parameter=value` specification on the same line. For example, the following uses of the DELETE keyword are not valid:

```plaintext
MODE=(
  DELETE MODE_NAME=#INTER
)

MODE=(
  MODE_NAME=#INTER DELETE
)
To delete all keywords of a particular type, or to delete one keyword that does not have a key field, only the keyword and the DELETE keyword are necessary. For example,

\[
\text{MODE}=(\text{DELETE})
\]

**Note:** Not all keywords can be deleted; only those which are not listed as required can be deleted—refer to *Configuration File Reference* for details.

**Applying Updates to Configuration Files**

To update or change an existing SNA configuration file using an update file, do the following:

1. Using a text editor, create an update file that contains keywords to be added, deleted, or changed in an existing SNA node configuration file.
2. Add an include statement at the bottom of the existing SNA node configuration or template indicating the name of the update file.
3. Invoke the SNA Configuration Verification utility by typing the following on the command line:
   
   ```
   vacgcon config.acg newconfig.chg
   ```
   
   - `config.acg`: The existing configuration file
   - `newconfig.chg`: The new configuration file

   You must remove the include statement to reuse your template as a configuration file.

   **Note:** When an update file does not contain a complete, usable configuration, it is recommended that you use an extension other than `.ACG`.

**Configuring Multiple Links**

Many customers must attach to multiple iSeries, eServer i5, System i5®, or zSeries mainframe systems. Personal Communications allows this type of configuration. The following sections explain how to do this.

**Note:** You do not need to read this section if you want to create multiple sessions on the same host.

**Configuring a Second 3270 Emulation Link**

**Recommendation**

If you want a second SNA connection (link) to run concurrently, we strongly recommend that you configure it in the same `.ACG` file as the first one; this will avoid any possible conflict of settings.

Perform the following steps to configure a second 3270 emulation link. You can make the configuration even if the first link is active.

1. Double-click the **Start or Configure Sessions** icon to start a new session; or click **Configure** from the **Communication** menu.
2. Choose the host, interface, and attachment type, as usual.
3. Configure the session parameters, then click **Configure Link**.

4. In the Configure Local System panel, check that the default .ACG file is the one in which you saved the configuration for the first link. If not, click **Existing** and choose the correct file from the list.

5. Check that the settings for the PC Location Name are correct. Click **Next**.

6. The LAN Device Connection panel appears. Under Device Selection, be sure that the device used for the first link is displayed. Under Connection Selection, select **New Connection**. Notice that the connection name has changed to show a new link name. Click **Next**.

7. The Configure LAN Connection panel is displayed. The Destination Address field will show 400000000000. Enter the Destination Address for the second link, and change the additional parameters if needed.

8. Click **Advanced**.

9. The Advanced dialog panel shows the default values for block ID and PU ID. Change them as necessary to the values for the second link. Click **OK**.

10. Click **Next**, then **Finish**, and save the .ACG file (replace the existing file). Then click **OK** until you return to the session window. If you have done everything correctly, and if the gateway or controller is running, you should get a connection.

You can add further 3270 links in the same way.

### Configuring a Second 5250 Emulation Link

The steps you should follow to configure a second 5250 emulation link are almost the same as for 3270. You can make the configuration even if the first link is active.

1. Double-click the **Start or Configure Sessions** icon to start a new session; or click **Configure** from the **Communication** menu.

2. Choose the host, interface, and attachment type, as usual.

3. Configure the session parameters, then click **Configure Link**.

4. In the Configure Local System panel, check that the default .ACG file is the one in which you saved the configuration for the first link. If not, click **Existing** and choose the correct file from the list.

5. Check that the settings for the first link are correct. Click **Next**.

6. The Configure Logical Connection panel appears, showing the settings for the first link. If you are going to connect to a different iSeries, eServer i5, or System i5, change the System Location Name. Click **Next**.

7. The Configure LAN Connection panel appears. If the Link Station Name has not changed, change it.

8. Change the Destination Address (and the other parameters if necessary). If you want to change the Local SAP number or the Receive Buffer Count, (which is unlikely), click **Advanced**. If not, click **Next**, then **Finish**, and save the .ACG file (replace the existing file), then click **OK** until you return to the session window.

You can add further 5250 links in the same way.

### Configuring a Second Link of a Different Kind

The procedure for configuring other links is similar to those for the configurations for 3270 and 5250 link configurations. This procedure applies whether you are going to configure two (or more) links that use the same connection type, or links that use different connection types. In this example, assume that you have already
configured a 3270 connection and now want to add a 5250 connection. As before, you can make the configuration even if the first link is active.

1. Double-click the **Start or Configure Sessions** icon to start a new session; or click **Configure** from the **Communication** menu.

2. Choose iSeries, the LAN interface and the IEEE 802.2 attachment type.

3. Configure the session parameters, then click **Configure Link**.

4. In the Configure Local System panel, check that the default .ACG file is the one in which you saved the configuration for the 3270 link. If not, click **Existing** and choose the correct file from the list. Notice that the PC Location Name is already there. Click **Next**.

5. The Configure Logical Connection panel appears. Enter the System Location Name and click **Next**.

6. Notice that the Link Station Name has changed. Enter the Destination Address of the iSeries, eServer i5, or System i5. Click **Next**, then **Finish**, and save the .ACG file (replace the existing file); then click **OK** until you return to the session window.

### Configuring to Perform 3270 and 5250 Emulation to Multiple Hosts

To configure Personal Communications to perform 3270 and 5250 emulation to multiple hosts, use the following procedure:

1. Click **Actions → Launch → SNA Node Configuration** of your active session; or click **SNA Node Configuration** from the **Program → IBM Personal Communications** folder on the Windows **Start** menu.

2. Configure the node information, as follows:
   a. Click **Configure Node** from the list of **Configuration** options.
   b. Click **New**.
   c. In the **Fully qualified CP name** field, enter the Network ID and CP name that is defined for you on the iSeries, eServer i5, or System i5 (APPN.TEST, for example).

      **Note:** If the iSeries, eServer i5, or System i5 is performing automatic configuration, the value you enter here is ignored. However, it is still necessary to enter a value in the field to close the panel.

   d. Click **OK**.

3. Configure the device information, as follows:
   a. Click **Configure Devices** from the list of **Configuration** options.

      **Note:** The dialog displays the device adapters that are installed and indicates whether each adapter is enabled or disabled.
   b. Click **LAN** from the list of available DLCs.

      **Note:** These instructions are based on the LAN DLC; the field names and tabs might be slightly different if you are configuring another type of DLC.
   c. Click **New**.
   d. Specify the adapter number for the connection.
   e. Click **OK**.

4. Configure the connection information, as follows:
   a. Click **Configure Connections** from the list of **Configuration** options.
b. Click LAN from the list of available DLCs.
c. Click New.
d. Enter the Link station name (default is LINK0000) and click the LAN device (for example, LANX_04) that you selected from the list of available DLCs. This link will be defined for the 5250 session to the iSeries, eServer i5, or System i5.
e. Enter the LAN destination address of the iSeries, eServer i5, or System i5.
f. Click the Advanced tab.
g. Verify that Activate at startup is selected
h. Verify that APPN support is selected.
i. If you plan to use 3270 passthrough on this connection, click Solicit SSCP sessions.
j. Click OK to save the information.

5. Configure the second link for the 3270 session, using the following procedure:
a. Click New.
b. Enter the Link station name (default is LINK0001) and select the same device you used to define the 5250 session (for example, LANX_04). This link will be defined for the 3270 session to the host.
c. Enter the LAN destination address of the host.
d. Click the Advanced tab.
e. Verify that Activate at startup is selected.
f. Verify that APPN support is selected.
g. Click Solicit SSCP sessions.
h. In the Local Node ID field, enter the Block ID and Physical Unit ID that identifies the device.
i. Click the Adjacent Node tab.
j. Click HOST-XID3 from the list of Adjacent CP types.
k. Click OK.

6. Configure the Partner LU 6.2 information, as follows:
a. Click New.
b. Enter the Partner LU name, such as APPN.S101010. This is the name of the iSeries, eServer i5, or System i5; this information can be obtained by running a DSPNETA on the iSeries, eServer i5, or System i5.
c. Click OK.

7. Save the configuration information, as follows:
a. On the SNA Node Configuration window, click Save As from the File menu.
b. Enter a file name with a .ACG file extension, such as TEST.ACG. Click Yes to make this configuration the default.
c. Click Exit on the File menu.

8. Start the 5250 emulator session, using the following procedure:
a. Click Program → IBM Personal Communications → Start or Configure Sessions from the Windows Start menu.
b. Click the iSeries host, the LAN interface, and the IEEE 802.2 attachment.
c. Click Configure.
d. Click Configure Link.
e. Click Existing.
f. Click the configuration you saved in step 7 from the list and click **Open**.
g. Click **Next**.
h. Verify that the System location name matches the name you specified in step 6. Click **Next**.
i. In the **Device name** field, select the device name you defined in step 3. Click **Next**.
j. In the **Link station name** field, select the name you defined in step 4, such as LINK0000. Click **Next**.
k. Click **Finish**.
l. Click **Save** and then click **Yes** to overwrite the existing file.
m. Click **OK** to close the Customize Communication - 5250 Host window and then click **OK** to close the Customize Communication window and start the 5250 session.

9. Save the workstation profile for the 5250 session, as follows:
a. Click **Save As** from the **File** menu on the emulator window.
b. Enter a file name with a .WS extension and click **OK**.
c. If you want the ability to start this session separately, click **Yes** to create an icon; otherwise, click **No**.
d. Click **OK**.

10. Start the 3270 emulator session, using the following procedure:
a. Click **Program** → **IBM Personal Communications** → **Start or Configure Sessions** from the Windows **Start** menu.
b. Click the **zSeries** host, the **LAN interface**, and the **IEEE 802.2 attachment**.
c. Click **Configure**.
d. Click **Configure Link**.
e. Click **Existing**.
f. Select the configuration you saved in step 7 from the list and click **Open**.
g. Click **Next**.
h. In the **Device name** field, select the device name you defined in step 3. Click **Next**.
i. In the **Link station name** field, select the name you defined in step 5, such as LINK0001.
j. Click **Advanced**.
k. Clear **APPN support** and click **OK**.
l. Click **Next**.
m. Click **Finish**.

11. Save the workstation profile for the 3270 session, as follows:
a. Click **Save As** from the **File** menu on the emulator window.
b. Enter a file name with a .WS extension and click **OK**.
c. If you want to start this session separately, click **Yes** to create an icon; otherwise, click **No**.
d. Click **OK**.
12. Create a batch file to start both the 5250 session and the 3270 session at the same time, using the following procedure:
   a. Close both running emulator sessions.
   b. Click **Utilities → Multiple Sessions** from the Personal Communications program menu.
   c. From the list of workstation profile files, select the .WS file for the 5250 session (step 9). Click Add.
   d. From the list of workstation profile files, select the .WS file for the 3270 session (step 11). Click Add.
   e. Click **Save As** from the **File** menu and enter a file name with a .BCH extension to save the batch file. Click OK.
   f. Click Yes. Verify that the folder is the DESKTOP and select both check boxes. Click OK.
   g. Click Exit from the **File** menu.
13. To start the 5250 and 3270 emulator sessions together, double-click the **Batch File** icon on your Desktop.

**Automatic Device Name Generation (5250 Only)**

The Telnet 5250 client function can generate a new and non-arbitrary DEVice NAME (DEVNAME) for a session without requiring per-session profile (.WS) customization or a user exit.

You can use keywords and special characters in the WorkStationID (WID) field (in the [5250] stanza of the Workstation profile) to cause some or all of the following information to be substituted into the DEVice NAME value that is sent to the TN5250 server:

- Computer name or user name
- Short session ID
- Session type ID
- Collision avoidance ID

When specified, the Collision Avoidance ID enables the generation of a new DEVice NAME if the Telnet server rejects a submitted name (which can occur when the old name is already in use on the iSeries, eServer i5, or System i5). The ability to have a variety of names generated allows multiple sessions to the same iSeries, eServer i5, or System i5 from one or more clients using just one WorkStation Profile (.WS) file. The definition of the existing .WS file parameter WorkStationID in the [5250] stanza is extended to accomplish this.

**Substitution Characters**

You can use special substitution characters in the WID field to control the placement of the generated information into the DEVNAME field. One substitution character is used in the WID for each generated character. This reserves space in the DEVNAME for each generated character and indicates where each generated character is to be placed. The three special substitution characters are:

**Short Session ID**
(value range: A-Z or a-z) The special character signifying this in the WID is the asterisk (*).
Example:
If the WorkstationID is configured as 123* and the short ID of the first session is A, then the device names generated for the first three sessions will be 123A, 123B, and 123C.

Session Type ID
(possible values: S for display or P for Printer) The special character signifying this in the WID is the percent sign (%).

Example: If the Workstation ID is configured as %123* and the session type is Printer, then the first three device names generated would be P123A, P123B, and P123C.

Collision Avoidance ID
(value range: 1-9, A-Z or a-z) The Collision Avoidance ID (CAID) is used by the device name collision (DNC) function (see “Device Name Collision Processing” on page 24) to generate a new DEVICE NAME when the old name is rejected by the Telnet server as already being in use. The special character signifying this in the WID is the equals sign (=).

Example: If the Workstation ID is configured as %ABC=, the session type is Display, and the device name SABC1 is already in use on the iSeries, eServer i5, or System i5, then the first generated device name (SABC1) will be rejected by the server, but the second name (SABC2) will be accepted.

Client Naming Function
If you specify a Client Naming (CN) substitution keyword in the Workstation ID (WID) field, then an external name is retrieved and used when generating the DEVICE NAME.

The CN keywords are prefixed with the ampersand character (&), followed by a five character identifier. Two keywords are supported:

&COMPN
Windows COMPuter Name for the client

&USERN
USER Name specified during logon to the Windows computer where the emulator executes

A name whose length exceeds the space remaining in the 10 character long DEVICE NAME field will have that excess trimmed from the left side by default. Excess characters can alternatively be trimmed from the right side by prefixing the CN keyword with a plus sign (+) character (for example, +&COMPN).

Notes:
1. If the specified name cannot be obtained, then the message Unable to get the local "x" name (where "x" is COMPN or USERN) is displayed in the status bar.
2. If a client naming keyword is specified in the WID, then characters other than those defined for this feature are ignored.
3. A numeric character in the first position of a DEVICE NAME is invalid, and may be converted by the iSeries, eServer i5, or System i5 to the pound (or number) character (#).
Example A: If the Workstation ID is &COMPN* and the name of the local computer is clientaccess1, then the device names generated for the first three sessions would be ntaccess1A, ntaccess1B, and ntaccess1C.

Example B: If the Workstation ID is +&COMPN% and the name of the USER logon for the local computer is clientaccess1, then the device names generated for the first three sessions would be clientaccA, clientaccB, and clientaccC.

Device Name Collision Processing
Device name collision occurs when a Telnet client sends the Telnet server a virtual device name, but that device name is already in use on the server. When this occurs, the Telnet server sends a request to the client asking it to send a different DEVNAME.

Device name collision (DNC) processing handles requests from the server for a different DEVNAME. If the collision avoidance ID (CAID) substitution character is present in the WID, the CAID is incremented and sent as part of the new DEVNAME to the server.

If the server requests a different DEVNAME and the CAID is not present in the WID, then the error message Device Name "x" is invalid or already in use on the server is displayed on the status bar and the session is disconnected.

Commands for Emulator Functions
Personal Communications provides the following commands for managing Personal Communications sessions:

PCOMSTRT
Start a Personal Communications session

PCOMSTOP
Stop a Personal Communications session

PCOMQRY
Query Personal Communications sessions

Start a Personal Communications Session
The command PCOMSTRT has the following parameters:

/p Name of workstation profile to start (required). The syntax is /p=workstation-profile. You can specify the workstation profile as either the path (drive, directory, and file name) or just the file name, in which case the location of the workstation profile file is the user-class application data directory.

Note: If multiple /p parameters are given, PCOMSTRT only uses the last one to start a profile (.WS file).

/s Session letter of the session to start. The syntax is /s=session-letter. This is optional. If omitted, the first available session letter is used.

/w Session window startup state. The syntax is /w={0|1|2|3}.
0 Hidden
1 Normal (default)
Minimized
Maximized
/q Quiet mode. In quiet mode, PCOMSTRT does not write any messages to stdout.

/nowait Do not wait for session to start. The /nowait option tells PCOMSTRT to complete execution without waiting until the emulator session is started. There is no /wait option; the default is to wait until the session is started.

/? Displays help information.

Returns: DOS Error level is set for use when this command is invoked by a program. When the command is directly entered, a message indicating the session is starting is displayed.

Stop a Personal Communications Session
The command PCOMSTOP has the following parameters:

/s Session letter of session to stop. The syntax is /s=session-letter. This is optional. If omitted, the first available session letter is used.

/all Stops all sessions
/NCE Stops all or specific session without confirmation, even if the confirmation on exit or exit all option are set.

/q Quiet mode. In quiet mode, PCOMSTOP does not write any messages to stdout.

/? Displays help information.

Returns: DOS Error level is set for use when this command is invoked by a program. When the command is directly entered, a message is displayed indicating the session is stopping.

Query Personal Communications Sessions
The command PCOMQRY has the following parameters:

/s Session letter of session to query, The syntax is /s=session-letter. This is optional. If omitted, the first available session letter is used.

/all Queries all sessions.

/q Quiet mode. In quiet mode, PCOMQRY does not write any messages to stdout.

/nowait
Do not wait for session to query. The /nowait option tells PCOMQRY to complete execution without waiting until the emulator session is queried. There is no /wait option; the default is to wait until the session is queried.

/? Displays help information.
Chapter 4. Attachment Considerations and Adapter Setup

This chapter describes factors you should consider when configuring Personal Communications for the following attachment types:

- "IBM-EEDLC"
- "TCP/IP Connection" on page 28
- "SDLC MPA Attachment" on page 29
- "IBM Global Network - SNA over Async Attachment" on page 30
- "IBM Global Network Connection Attachment" on page 31
- "Home3270 Attachment" on page 31
- "3270 Attachment via the iSeries System" on page 32
- "IBM PC720 Modem Initialization (Japan only)" on page 33
- "5250 Asynchronous Console" on page 33

This chapter also contains information about setting up communications adapters (for example, MPA, SDLC). See the following topics:

- "Creating and Updating Devices in Windows 8, Windows 8.1, or Windows 10" on page 33
- "MPA Adapters" on page 33
- "OEM Adapters" on page 35

Attachment Information

IBM-EEDLC

This section provides information, considerations, and restrictions for the Personal Communications IBM-EEDLC attachment.

TCP/IP Protocol Driver

You must set up your Windows environment for the TCP/IP network. To verify that the TCP/IP protocol is installed on your workstation, view the properties for your network connection. Confirm that TCP/IP appears in the list of components for the connection. You can modify the TCP/IP properties, such as the IP address.

Concurrent IPv4 and IPv6 connections

For EEDLC, you can configure the link either by IP address or host name and run IPv4 and IPv6 connections concurrently.

1. For Enterprise Extender (HPR/IP), the ports at both ends of a link must use the same addressing format (IPv4 or IPv6).
2. If Communications Server for Windows uses IPv4, it can connect only to remote systems that are configured to support IPv4.
3. If Communications Server for Windows uses IPv6, you can configure it to use either IPv4 or IPv6, provided you have configured the respective Enterprise Extender port on the server. The option you choose must match the configuration at the remote system.
4. All links on the same Enterprise Extender port must use the same addressing format (IPv4 or IPv6).
5. If you need to support links with different addressing formats, you must use separate ports. Similarly, all Enterprise Extender ports on the same connection network must use the same addressing format.

**TCP/IP Connection**

This section provides information, considerations, and restrictions for Personal Communications TCP/IP connections.

**TCP/IP Protocol Driver**

You must set up your Windows environment for the TCP/IP network. To verify that the TCP/IP protocol is installed on your workstation, double-click *Network* in your Control Panel and see if TCP/IP appears in the list of network components. Double-click *TCP/IP* to specify your IP address and other TCP/IP properties. You have to install IPv6 protocol to make use of IBM-EEDLC (IPv6) feature.

**Screen Size**

The following four screen sizes are supported for TN3270:

- 24x80
- 32x80
- 43x80
- 27x132

The following two screen sizes are supported for TN5250:

- 24x80
- 27x132

Screen sizes 48x80, 62x160, and 24x132 are supported if your server/host supports the TN3270E protocol.

**Terminal Type to Be Negotiated with TN3270**

The terminal type to be negotiated is set to IBM-3278-2-E, IBM-3278-3-E, IBM-3278-4-E, or IBM3278-5-E according to the screen size that is specified on the Customize Communication 3270 Host panel. If you need to specify IBM-3279-2-E or IBM-3279-3-E (for graphics), add the following line to the [Telnet3270] section in the workstation profile (.WS):

```
TerminalType=3279
```

**Note:** The following error message might be logged by z/OS console when the IBM Personal Communications version 6.0.2 with a 62x160 screen size is used:

```
"1EE9361 CONSOLE HHSP0141 INITIALIZATION ERROR - RC:01 - 3277-2 IS ASSUMED"
```

z/OS console connection is made through the OSA-ICC telnet server. This server does not support the Terminal Type of IBM-DYNAMIC. To resolve the problem, take the following steps:

1. Edit the WS session profile.
2. Add the following statements under the Telnet3270 stanza to force IBM Personal Communications to use the original default string:

```
[Telnet3270]
TerminalTypeString=IBM-3278-2-E
```

**TN3287 and TN3270E Connection**

TN3287 (defined in RFC 1646) and TN3270E (defined in RFC 1647) were tested with following Telnet servers:

- Communications Server for Windows
Other TCP/IP Functions

Backup Server/Host with LU Name and Port Number: Personal Communications enables you to specify up to two backup host or server names to connect to. This provides easier connections when the primary host or server cannot be reached. You can also specify a specific LU name or port number unique to that server or host.

Service Location Protocol: Personal Communications enables connection to SLP servers that are RFC 2165 compliant. This function eliminates the need for users to know the name of a network host supporting a specific service. SLP implementation for a Personal Communications client allows load balancing and dynamic location of a specific LU or LU pool across a group of servers. IBM Communications Server for Windows V6.1.x and V6.4 currently supports SLP. This support can be used in conjunction with SSL support.

SDLC MPA Attachment

This section describes factors you should consider when configuring Personal Communications with an SDLC attachment.

Line Speed
For the SDLC attachment, a line speed up to 28.8 Kbps is supported. However, actual line speed will vary depending on the carrier speed the modem supports.

V.25bis Autodial
Personal Communications only supports the bit-oriented protocol for V.25bis call control messages. Modems must support an ASCII-coded character set consisting of 7-bit coded ASCII characters with odd parity.

Personal Communications supports the following adapters:
- Multiprotocol (MPA) interface compatible adapters, for example:
  - IBM Multiprotocol Communications Adapter (73G7099)
  - IBM Multiprotocol Adapter/A (645114 or later)
  - IBM SDLC/Async Communications Adapter (ASCA) (42H4332)
- IBM SDLC PCMCIA adapter (Japan only)
- IBM SDLC PCMCIA modem (Japan only)
- IBM PCI Multiprotocol Adapter (12J2981)

Performance Considerations
If you use multiple sessions in a high-speed and high-load configuration with an SDLC attachment, the connection to the host might fail. In this case, set the host's timeout value to be greater than that of Personal Communications.
- To change the host timeout value, modify the following NCP parameters:

Communications Server for OS/2
- TN3270E Brixton PU2.1 V3.0
  - SNA Client Access for AIX® Version 1 Release 2
  - IBM Communications Server for OS/2 Warp
- Microsoft SNA Server
REPLYTO
The maximum duration in seconds that the host waits for a reply from the terminal. The default is 1 second.

RETRIES=(m,t,n)
The number of recovery attempts for errors occurring during transmission over the link. Repetitive retries are called a retry sequence. The maximum number of retries is specified as m, which can be from 0 to 128. NCP pause (the time between the retry sequences) is specified as t and can be from 1 to 255 seconds. The maximum number of retry sequences is specified by n and can be from 1 to 127. For example:

REPLYTO=1, RETRIES=(3,4,5)

\((1\text{ (seconds)} \times 3\text{ (times)} + 4\text{ (seconds)}) \times 5\text{ (times)}\)

= 35 \text{ (seconds)}

Note: In this example, the host waits 35 seconds for the terminal to reply.

For more details, ask your system personnel.

- To change the Personal Communications timeout value, type a new value in the Inactivity timer field on the Performance page of the Connections property sheet in SNA Node Configuration.

  The value is in seconds and can be from 40 to 160. The default is 80.

PIU Size: This value is negotiated between your workstation and the host system, unless XID=None is defined on the PU, or the Adjacent CP type has been changed to Host - XID0 in SNA Node Configuration. If this value is not negotiated, the Maximum PIU Size must match the MAXDATA value defined on the host system.

Receive Window Count: This value is negotiated between your workstation and the host system, unless XID=None is defined on the PU, or the Adjacent CP type has been changed to Host - XID0 in SNA Node Configuration. If this value is not negotiated, the Receive Window Count must match the MAXOUT value defined on the host system.

IBM Global Network - SNA over Async Attachment
IBM Global Network - SNA over Async is supported using 8-bit no parity; SNA session-level compression and decompression is not supported.

Line Speed
Line speeds up to 115.2 Kbps are supported. However, the maximum usable line speed depends on the speed of the processor or communication port. If communication stops or becomes exceedingly slow, reduce the line speed.

Updating Phone List
To update the phone number list for IBM Global Network SNA over Async, do the following:

1. Click the Use Phone Book button on the Define a Com Port Connection panel.
2. Click the Download Phone Numbers button.

   Personal Communications FTPs to the IGN server and downloads the phone number file and converts it to the correct format.

Note: A Proxy must be configured in order for this procedure to work.
IBM Global Network Connection Attachment

Note: This attachment type is not available in Japan.

IBM Global Network Connection supports only a single communication port.

Line Speed
IBM Global Network Connection supports up to 115.2 kbps as the line speed. However, the maximum usable line speed depends on the speed of the processor or communication port. If communication stops or becomes exceedingly slow, reduce the line speed.

Updating Phone List
To update the phone number list for IBM Global Network SNA over Async, click the Download Phone Numbers button from the Configuration panel. When this button is selected, Personal Communications FTPs to the IGN server and downloads the phone number file and converts it to the correct format.

Note: A Proxy must be configured in order for this procedure to work.

Restrictions
You cannot use the following functions:
- Import/Export
- Host graphics
- Host print
- Server-Requester Programming Interface (SRPI)
- Concurrent multiple file transfers

Home3270 Attachment
Because Home3270 supports only a single COM port, only one session is available for use at a time.

Setting the Screen Colors in a Home3270 Session
Because protocol converters translate the 3270 (EBCDIC) data stream into an ASCII data stream, the original information about the 3270 fields is lost, and all the field attributes of the 3270 screen are treated as extended attributes. Because of this, you must select the Extended Color category in order to change the colors of characters on the screen. Changing base colors will have no effect.

For example, if you want to change the color of characters that appear in green on a black background, select Extended Color - Green, then click or drag-and-drop the color you want for the characters (and for the background if you wish). Do not change the appropriate Base Color because the change will have no effect.

Line Speed: Line speeds up to 115,200 bps are supported. However, characters might be lost on high-speed lines, depending on the processor speed. If communication stops or becomes exceedingly slow, reduce the line speed.

Unsupported Character Sequences: The following character sequences are valid for the Home3270 attachment. However, they perform no function.
- ESC P 1 (Block cursor command)
- ESC P 0 (Underline cursor command)
- DLE DC2 (Printer start command)
- DLE DC4 (Printer end command)
Conditions for Communication Check 50x: Home3270 requires both Data Set Ready (DSR) and Carrier Detect (CD) to determine the state of the attachment with the host system. If DSR is not recognized, communication check 501 appears in the operator information area. When DSR is recognized and CD is not recognized, communication check 504 appears in the operator information area.

When you select ROLMphone with DCM in the Home3270 configuration, communication check 504 does not appear.

Home3270 and OIA message COMM 504: If you run Home3270 sessions at a speed of 28.8 kbps or higher and the session disconnects with a COMM504 in the OIA, try lowering the port speed to equal the line speed of the Protocol Converter you are connecting to.

Note: DBCS is not available with this attachment.

Restrictions: The following functions are not available with this attachment:
• Host graphics
• Host print
• Server Requester Programming Interface

3270 Attachment via the iSeries System
This section provides information, considerations, and restrictions for PC/3270 connections through an iSeries, eServer i5, or System i5 system.

iSeries, eServer i5, or System i5 Setup
PC/3270 can connect to a host computer through one or more iSeries, eServer i5, or System i5 systems by using the passthrough function (usable with OS/400 Version 2.2.0 or later, or with i5/OS™).

To use this function, set the following communication configuration descriptions in the iSeries, eServer i5, or System i5 system to on (Vary On):
• Line description
• Controller description
• Printer description

Error Messages from the iSeries, eServer i5, or System i5
When the system is connected to a zSeries host system through an iSeries, eServer i5, or System i5, the following message might appear on the screen.

AS/400 CPI5xxx

The message might appear for the following reasons:
• Line error between the iSeries, eServer i5, or System i5 system and the host system
• Communication configuration description error in the iSeries, eServer i5, or System i5 system
• The communication configuration description in the iSeries, eServer i5, or System i5 system is set to off (Vary Off)

When this message appears, detailed error information is saved in the iSeries, eServer i5, or System i5 system operator message queue. Refer to the error message that corresponds to the number displayed on the screen and then correct the cause of the error.
IBM PC720 Modem Initialization (Japan only)

In the Japanese version of Personal Communications, if you use an IBM PC720 and connect it via a dial connection, the error message “COMDIA15 Unable to initialize modem” may appear at startup. To correct this condition, increase the value of Retries in Initialization to more than 1 by using the Modem Information panel.

5250 Asynchronous Console

For the asynchronous console attachment, you must have a 2609 or 2612 adapter for the Multiple Function I/O Processor (MFIOP) on the iSeries, eServer i5, or System i5 system. This connection also requires a special cable. The part numbers for the cables are 46G0450 (6m) and 46G0479 (2.5m).

Note: The iSeries Advanced Portable Model P02 does not support the asynchronous console attachment.

An asynchronous console has the following restrictions:

- Multiple console sessions cannot be used.
- APIs are not supported.
- The session type cannot be set to the Printer.
- The file transfer functions is not supported.
- The PC Organizer cannot be used.

Adapter Setup Information

Creating and Updating Devices in Windows 8, Windows 8.1, or Windows 10

In Windows 8, Windows 8.1, or Windows 10 and later operating system, Personal Communications does not install drivers for communications adapters (MPA and SDLC). You have to install the drivers and create devices using the Windows Hardware wizard or the Device Manager. You must use that process for both Plug-and-Play and non-Plug-and-Play adapters. The drivers and .INF files are located on the Personal Communications installation image in the \admin\drivers subdirectory.

If you are installing Personal Communications Version 12.0 on Windows 8, Windows 8.1, or Windows 10 or later operating system over a previous release of Personal Communications, and you are using a communications adapter, you should update the existing driver using the Windows Device Manager.

Not all communications adapters listed here are supported for Windows 8, Windows 8.1, or Windows 10 and later operating system.

Note: For more information about driver installation, updating drivers, and adapter setup, refer to the CD-ROM Guide to Installation.

MPA Adapters

Preventing Conflicts with Non-PCI MPA Adapters

The multiprotocol adapters use system resources that, in some cases, cannot be shared. Therefore, you must make sure there are no conflicts with the following resources:
The IBM Multiprotocol interface adapters use the following system resources:

- DMA level
- I/O addresses (MPA0 uses X'380'–X'38F' and MPA1 uses X'3A0'–X'3AF')
- IRQ level (ISA bus only)

Note: When the MPA is configured for mode 4, the device is not allowed to use the other IRQ even though only one interrupt is claimed.

Personal Communications supports the MPA0 or MPA1 communication ports. Some sound cards use an I/O address within the range X'380'–X'38F'. MPA1 should be used to avoid a conflict.

- The MPA/A for a microchannel-bus workstation uses IRQ3, and the DMA level can be configured. Both the MPA0 and MPA1 communication ports can be active at the same time and the interrupt is claimed as sharable.

**IBM SDLC PCMCIA Adapter and Modem (Japan Only)**

Only one SDLC PCMCIA card can be used at a time. Because a common driver supports both SDLC PCMCIA and MPA interface cards, an MPA cannot be used concurrently with SDLC PCMCIA.

See “Creating and Updating Devices in Windows 8, Windows 8.1, or Windows 10” on page 33.

**IBM SDLC PCMCIA Adapter:** The IBM SDLC PCMCIA adapter supports:

- Leased and switched connections
- Speeds up to 19.2 Kbps
- Switched and Constant Request To Send (RTS)
- NRZ and NRZI encoding schemes

The IRQ number on the device page's adapter property sheet is ignored.

**IBM SDLC PCMCIA Modem:** The IBM SDLC PCMCIA modem supports:

- Switched V.26bis connections only
- Speeds up to 2400 baud
- Switched RTS only

The configured value on the constant RTS and IRQ level send/receive device page's adapter property sheet are ignored.

**IBM PCI Multiprotocol Adapter**

Two IBM PCI Multiprotocol Adapters can operate concurrently. The configuration specifies one adapter with Communication Port MPA0 and the second adapter with Communication Port MPA1. When the link is activated, MPA0 is the first PCI Multiprotocol Adapter that the operating system finds and MPA1 is the second adapter found. If more than one PCI Multiprotocol adapter is installed on a machine and you are unsure which adapter the operating system will find first,
you may want to perform an isolated test to determine which adapter is connected to which Communication Port. One suggestion is to disconnect the modems connected to the adapter from the telephone line and then try to start each link individually. By watching the modems, you should be able to determine which modem is connected to which Communication Port. Then the modems can be attached to the proper network. If a single PCI Multiprotocol Adapter is used, the configuration file must specify MPA0 as the Communication Port.

**Note:** If a Personal Communications configuration is using this adapter, and a PCI MPA adapter is added or removed from the system, Personal Communications may have to be reconfigured.

An ISA-bus MPA and IBM PCI Multiprotocol Adapter can be used concurrently, as long as the ISA-bus MPA adapter is configured as MPA1.

The IBM PCI Multiprotocol Adapter supports:
- Leased and switched connections
- Speeds up to 56 kbps
- Switched and Constant Request To Send (RTS)
- NRZ and NRZI encoding schemes

The IRQ number on the device page adapter property sheet is ignored.

The following sections provide additional information about configuring adapters, including PCMCIA and PCI cards.

**OEM Adapters**

Personal Communications has an open API that enables vendors and other equipment manufacturers (OEMs) to provide adapter cards that allow for additional connectivity options, for example, additional X.25, ISDN, or SDLC support. After installing the OEM adapter, you can begin to configure it in the usual manner described in *Quick Beginnings*. However, at some point in the configuration process you may need to provide information required by the manufacturer of the OEM adapter card.
Chapter 5. System Policy Support

System policies allow you to control the actions that a user is permitted to perform.

A policy can be defined by any application or component. The policy appears in the administrator user interface; information that you set about the policy migrates to the local computer's registry. The application or component that defines a policy must check the registry to enforce its own policy.

Policy information is typically added to a local registry in the following sequence:

1. Categories, policies, and parts are described in a policy template (*.ADM) file. The *Microsoft Resource Kit* includes three policy template files: WINNT.ADM, COMMON.ADM, and WINDOWS.ADM. Applications or components can also provide their own policy template files.

   Note: Personal Communications supplies a policy template for each language currently supported. The templates are on the installation image in the admin directory. For example, the policy template for the US English language is named ENUPOL.ADM and the policy template for the French language is named FRAPOL.ADM.

2. You run the policy editor, which reads one or more policy templates and lists the available categories and policies. You set up the desired policies, and the policy editor uses registry functions to save the work to a policy (*.POL) file. A group policy editor is provided with Windows. Documentation about the use of Microsoft policy editors can be found at http://www.microsoft.com.

3. After the user logs on (and user profiles are reconciled if they are enabled), the policy downloader determines where to find the file on the network, opens the policy file, and merges the appropriate computer, user, and user group policies into the local registry.

   Note: When using the group policy editor provided with Windows operating system, the Not Configured setting allows the same permission or access to features as the Enabled setting.

Configuration Policy

This category contains policy information related to configuration.

Communication

This policy category controls the user's ability to change configuration information pertaining to communication. This includes both emulator configuration (modified by selecting the Communication → Configure menu) and the SNA node configuration utility (PCSCFG.EXE).

The Communication Configuration drop-down list contains the following options.

No Access

The user has no access to communication information. However, this does not prevent the user from changing the communication configuration information by manually editing the .WS file, the .ACG file, or both. This is the most restrictive level of control.
**Write**  The user can read preconfigured communication information, and can make temporary and permanent changes to the communication configuration information. This is the least restrictive, and is equivalent to the level of control in which users operate without policy support.

**Menu**

This policy controls the user's ability to read and change configuration information pertaining to the menu.

When the Menu Configuration policy is enabled, the drop-down list contains the following options.

**No Access**

The user has no access to menu configuration information; that is, the user cannot read preconfigured menu configuration information or change menu configuration information. This means that any menu configuration information contained in the .WS file (specifically, in the [Menu] stanza) or the PCSWIN.INI file (modified by selecting the View → Show → Menu menu) is ignored, and the user cannot execute the menu bar customization utility (PCSMENU.EXE).

The difference between this item and the Read item is that this item ignores updates to the menu configuration information that the user may have made while manually editing the .WS file or PCSWIN.INI file. This means that the user can use only the product default menu configuration, and that you cannot set up modified menu configurations to be used by users who have No Access. This is the most restrictive level of control.

**Read**

The user can only read preconfigured menu information. This means that menu configuration information contained in the .WS file (specifically, in the [Menu] stanza) and the PCSWIN.INI file (modified by selecting the View → Show → Menu menu) is not ignored, but the user cannot update the menu by selecting View → Show → Menu or the menu bar customization utility (PCSMENU.EXE). The difference between this item and the No Access item is that this item does not prevent the user from updating the menu configuration information by hand editing the .WS file or the PCSWIN.INI file. However, unlike the No Access item, this item allows an administrator to set up modified menu configurations to be used by users who have Read access. This is less restrictive than No Access.

**Write**

The user can read preconfigured menu information, and can make permanent changes to the menu configuration information. This is the least restrictive item, and is equivalent to the level of control in which users operate without policy support.

**Toolbar**

This policy controls the user's ability to read and change configuration information pertaining to the toolbar.

When the Toolbar Configuration policy is enabled, the drop-down list contains the following options.

**No Access**

The user has no access to toolbar configuration information; that is, the user cannot read preconfigured toolbar configuration information or change (temporarily or permanently) toolbar configuration information. This means that any toolbar configuration information contained in the
.WS file (specifically, in the [Toolbar] stanza) or the PCSWIN.INI file (modified by selecting the View → Show → Tool Bar menu) is ignored. The difference between this item and the Read item (described later) is that this item ignores updates to the toolbar configuration information that the user may have made while manually editing the .WS file or the PCSWIN.INI file. This means that the user can use only the product default toolbar configuration, and that you cannot set up modified toolbar configurations to be used by users who have No Access. This is the most restrictive level of control.

Read  The user can only read preconfigured toolbar information. This means that toolbar configuration information contained in the .WS file (specifically, in the [Toolbar] stanza) and the PCSWIN.INI file (the results of manipulating the View → Show → Tool Bar menu) is not ignored, but the user cannot change (temporarily or permanently) the toolbar configuration information. The difference between this item and the No Access item is that this item does not prevent the user from updating the toolbar configuration information by hand editing the .WS file or the PCSWIN.INI file. However, unlike the No Access item, this item allows an administrator to set up modified toolbar configurations to be used by users who have Read access. This is less restrictive than No Access.

Write  The user can read preconfigured toolbar information, and can make temporary or permanent changes to the toolbar configuration information. This is the least restrictive item, and is equivalent to the level of control in which users operate without policy support.

Multiple Sessions

This policy controls the user's ability to read, execute, and change configuration information pertaining to multiple sessions with the multiple sessions utility (PCSBAT.EXE).

When the Multiple Sessions policy is enabled, the drop-down list contains the following options.

No Access  The user has no access to multiple session configuration information; that is, the user cannot read or execute preconfigured multiple session configuration information or change multiple session configuration information. This means that the user cannot execute the multiple sessions utility (PCSBAT.EXE). This is the most restrictive level of control.

Read  The user can only read and execute preconfigured multiple session information. This means that the user can execute the multiple sessions utility (PCSBAT.EXE) to read multiple session configuration information, or execute the multiple sessions utility (PCSBAT.EXE) to execute preconfigured multiple session information. However, the user cannot save any changes made to the multiple session configuration information. This is less restrictive than No Access.

Write  The user can read and execute preconfigured multiple session information, and can make permanent changes to multiple session configuration information. This is the least restrictive item, and is equivalent to the level of control in which users operate without policy support. This setting allows the user access to the Modify function in the Session Manager window.
Keyboard

This policy controls the user's ability to read and change configuration information pertaining to the keyboard.

When the Keyboard Configuration policy is enabled, the drop-down list contains the following options.

No Access
The user has no access to keyboard configuration information; that is, the user cannot read preconfigured keyboard configuration information or change (temporarily or permanently) keyboard configuration information. This means that any keyboard configuration information contained in the .WS file (specifically, in the [Keyboard] stanza) is ignored. The difference between this item and the Read item is that this item ignores updates to the keyboard configuration information that the user may have made while manually editing the .WS file or the PCSWIN.INI file. This means that the user can only use the product default keyboard configuration, and that you cannot set up modified keyboard configurations to be used by users who have No Access. This is the most restrictive level of control.

Read
The user can only read preconfigured keyboard information. This means that keyboard configuration information contained in the .WS file (specifically, in the [Keyboard] stanza) and the PCSWIN.INI file is not ignored, but the user cannot change (temporarily or permanently) the keyboard configuration information. The difference between this item and the No Access item is that this item does not prevent the user from updating the keyboard configuration information by manually editing the .WS file or the PCSWIN.INI file. However, unlike the No Access item, this item allows an administrator to set up modified keyboard configurations to be used by users who have Read access. This is less restrictive than No Access.

Write
The user can read preconfigured keyboard information, and can make temporary or permanent changes to the keyboard configuration information. This is the least restrictive item, and is equivalent to the level of control in which users operate without policy support.

Mouse

This policy controls the user's ability to read and change configuration information pertaining to the mouse.

When the Mouse Configuration policy is enabled, the drop-down list contains the following options:

No Access
The user has no access to mouse configuration information; that is, the user cannot read preconfigured mouse configuration information or change (temporarily or permanently) mouse configuration information. This means that any mouse configuration information contained in the .WS file (specifically, in the [Mouse] stanza) is ignored. The difference between this item and the Read item is that this item ignores updates to the mouse configuration information that the user may have made while manually editing the .WS file or the PCSWIN.INI file. This means that the user can use only the product default mouse configuration, and that you cannot set up modified mouse configurations to be used by users who have No Access. This is the most restrictive level of control.
Read  The user can only read preconfigured mouse information. This means that mouse configuration information contained in the .WS file (specifically, in the [Mouse] stanza) and the PCSWIN.INI file is not ignored, but the user cannot change (temporarily or permanently) the mouse configuration information. The difference between this item and the No Access item is that this item does not prevent the user from updating the mouse configuration information by hand editing the .WS file or the PCSWIN.INI file. However, unlike the No Access item, this item allows an administrator to set up modified mouse configurations to be used by users who have Read access. This is less restrictive than No Access.

Write  The user can read preconfigured mouse information, and can make temporary or permanent changes to the mouse configuration information. This is the least restrictive item, and is equivalent to the level of control in which users operate without policy support.

Change Directory  This policy controls the user's ability to select sessions and batch files in directories other than the application data location, from the Session Manager window.

Import  This policy controls the user's ability to import .WS files from the Session Manager.

Execution Policy  This category contains policy information related to execution.

Dynamic Menu Modification  This policy controls whether or not DDE applications executed by the user are permitted to dynamically add themselves to the menu of an active session.

Java™ Applet  This policy controls the user's ability to execute Java applets from the Actions → Run Java Applet menu.

Macro Play/Record  This policy controls the user's ability to play and record macros.

The Macro Play/Record drop-down list has the following options:

No Access  The user has no access to macros; that is, the user cannot play or record macros. This is the most restrictive level of control.

Play  The user can play macros.

Record  The user can play and record macros.

Start Session  This policy controls the user's ability to minimize an emulator session window.

Minimize Session  This policy controls the user's ability to minimize an emulator session window.
Maximize Session
This policy controls the user’s ability to maximize an emulator session window.

Close Session
This policy controls the user’s ability to close an emulator session window.

Delete Session
This policy controls the user’s ability to delete an emulator session from the Session Manager window.

Product Update
This policy controls the user’s ability to start the Product Update Tool.

Detect and Repair
This policy controls the user’s ability to utilize the Help Detect and Repair function.

File Transfer
This policy controls the user’s ability to send or receive files from the host.

Installation Policy
This category contains policy information related to installing or removing Personal Communications.

Uninstall
This policy controls the user’s ability to uninstall IBM Personal Communications.

View Policy
This category contains policy information related to changing the session window.

Menu Bar
This policy controls whether the user can view the menu bar.
Select Disable to hide the menu bar. The Not Configured or Enabled settings retain the menu bar in the session window.

Tool Bar
This policy controls whether the user can view the tool bar.
Select Disable to hide the tool bar. The Not Configured or Enabled settings retain the tool bar in the session window.

Status Bar
This policy controls whether the user can view the status bar.
Select Disable to hide the status bar. The Not Configured or Enabled settings retain the status bar in the session window.

Expanded OIA
This policy controls whether the user can view the expanded OIA.
Select Disable to hide the status bar. The Not Configured or Enabled settings retain the expanded OIA in the session window.

Quick Connect Bar
This policy controls whether the user can view the Quick Connect Bar.
Select Disable to hide the Quick Connect Bar. The Not Configured or Enabled settings retain the Quick Connect Bar in the session window.
Personal Communications provides session security using IBM Global Security Kit (GSKit) and Microsoft CryptoAPI (MSCAPI). These packages enable use of the Transport Layer Security (TLS) security protocols.

The configuration information in this chapter usually applies to TLS. See “Using Transport Layer Security” on page 68 for more information.

You can display information about the security aspects of your session by clicking Communication → Security Information from the session menu bar. This provides details about the certificates exchanged during TLS negotiations between client and server.

A TLS session is established in the following sequence:

1. The client and the server exchange hello messages to negotiate the encryption algorithm and hashing function (for message integrity) to be used for the session.

2. The client requests an X.509 certificate from the server to verify the identity of the server. Optionally, the server can request a certificate from the client (known as Client Authentication).

The digital signature of the certificate authority (CA) is authenticated using a published root certificate of the issuing CA. The client automatically decrypts certain information on the presented certificate using a public key on the CA's root certificate. This step is successful only when the presented certificate was encrypted using a well-guarded, unique, and corresponding private key, known only to the CA. This process can detect (and reject) intentional alterations (forgeries) and the rare garbling that can occur over data circuits. Personal Communications also allows users to use self-signed certificates for this purpose.

3. Once the certificate-issuer authentication step succeeds, the client and server negotiate for an encryption key to be used during the ensuing data exchange session. The client randomly generates a set of keys to be used for encryption. The keys are encrypted with the server's public key and are securely communicated to the server.

When a secure connection is established, a padlock icon is displayed in the Personal Communications status bar. Depending on the level of encryption, the icon is accompanied by a number (0, 40, 56, 128, 168, 256). If the session is not TLS-based, the icon shows as unlocked.

Certificates

Security is controlled by digital certificates that act as electronic ID cards. The purpose of a certificate is to assure a program or a user that it is safe to allow the proposed connection and (if encryption is involved) to provide the necessary encryption/decryption keys. They are usually issued by Certificate Authorities (CAs), which are organizations that are trusted by the industry as a whole and
who are in the business of issuing of Internet certificates. A CA’s certificate, which is also known as a root certificate, includes the CA’s signature and a validity period, among other things.

Encryption and authentication are performed by means of a pair of keys, one public and one private. The public key is embedded in a certificate, known as a site or server certificate. The certificate contains several items of information, including the name of the Certificate Authority (CA) that issued the certificate, the name and public key of the server or client, the CA’s signature, and the date and serial number of the certificate. The private key is created when you create a self-signed certificate or a CA certificate request and is used to decrypt messages from clients.

**Certificate Migration**

Personal Communications provides a utility for migrating personal or signer certificates from GSKit to MSCAPI. Click the **Certificate Migration** icon in the IBM Personal Communications → Administrative and PD Aids menu to start the utility. You will be required to enter the key database password.

The utility can be used to automatically migrate the selected certificate in the following paths:

- From GSKit Personal store to Windows Personal store
- From GSKit Signer store to Windows Trusted Root Certificate Authority store

You can also manually place certificates in each of the stores.

**Managing Certificates in the Microsoft Certificate Stores**

In order to connect secure sessions using the Microsoft CryptoAPI (MSCAPI) security package, the appropriate certificates must exist in the Microsoft Certificate Stores. To connect to a secure host, the root certificate of the host certificate’s verification chain must be in the Trusted Root Certification Authorities store. To connect a secure client authentication session, the client certificate must be in the Personal store.

To add, remove, and view certificates in the Microsoft Certificate Stores, select **Internet Options** in the Windows Control Panel. On the **Content** tab, click **Certificates**. The tabs represent the different Microsoft Certificates Stores. Each tab shows the certificates that exist within each store.

To add a certificate to a store, click **Import**; the **Certificate Import** wizard helps you import certificates from a file. The Import wizard can import certificates from several types of certificate files, including the ARM, DER, and P12 formats that can be extracted or exported from the Certificate Management utility.

---

### Configuring and Using Secure Sockets Layer

The purpose of basing communications on TLS is to provide privacy and integrity during communication over an unsecured TCP/IP connection between a client and a target server. This section briefly describes how to configure the Personal Communications client to use this mode.

Personal Communications provides two ways to manage certificates for use with the GSKit security package:

- "Using Certificate Management" on page 52
Preparation for TLS Communication

There is a division of labor for TLS configuration tasks. The configurations of the client and the server are coordinated to achieve the required compatibility. The following sections describe the preparation tasks required for client configuration and server configuration.

Server and Related Client Configuration

The administrator of a target server must have completed at least one of the following:

- **Equip the server with an appropriate class X.509 certificate from a well-known Certificate Authority (CA).** The administrator will have created a public/private key pair, submitted a request to the CA for a certificate, and received and activated that server certificate. By definition a *well-known CA* is one whose root certificates are already stored in the Personal Communications PCommClientKeyDb.kdb database file or Microsoft Certificate Store—see “Connecting to a Server Using a Certificate from a Well-Known CA” on page 53 for a list of these.

  **Note:** You must also equip the client with an X.509 personal certificate from the same certificate authority (CA) to enable client authentication.

- **Equip the server with an appropriate class X.509 certificate from an unknown CA.** The procedure is the same as the step above with the added necessity of obtaining the root certificate from the *unknown* CA. Usually the administrator of the target server will distribute the appropriate root certificate which must then be added to the PCommClientKeyDb.kdb database file.

  **Note:** You must also equip the client with an X.509 personal certificate from the same certificate authority (CA) to enable client authentication.

- **Equip the server with a self-signed X.509 certificate.** The administrator of the target server can do this as an interim measure while waiting for a CA's certificate. A copy of that certificate must be added to the client PCommClientKeyDb.kdb database file. The distribution must be done in a secure manner to guard the privacy and integrity offered by SSL.

  **Notes:**
  1. You must also equip the client with an X.509 personal certificate from the same certificate authority (CA) to enable client authentication.
  2. You must also add a copy of this certificate to the server's key database.

Client Configuration

The following elements must be configured on the client side to enable TLS using the GSKit security package:

- **PCommClientKeyDb.kdb** is a certificate management database that is automatically created in the user-class application data directory when Personal Communications is installed. It is password protected. The default password is pcomm and is generated when PCommClientKeyDb.kdb is initially created by Personal Communications. To assure the continued integrity of PCommClientKeyDb.kdb, change the default password to a password or passphrase that is not easily guessed. See “Changing the Password of a Client’s Key Database” on page 52 for instructions on changing the password. As installed, this database contains a list of well-known CAs and their root certificates that will be sufficient for the majority of TLS client users for server-side authentication. If the target server uses a certificate from one of those
well-known CAs, the client user does not need to modify the
PCommClientKeyDb.kdb other than to change the default password for
server-side authentication. See the notes in “Server and Related Client
Configuration” on page 47.

- PCommClientKeyDb.sth is a password stash file that is automatically created
when Personal Communications is installed. By default, Personal
Communications clients try to use the password stash file at runtime. The
password or passphrase used to protect PCommClientKeyDb.kdb is encrypted
and stored in this stash file for use by Personal Communications. Every time the
password is changed on PCommClientKeyDb.kdb, this stash file must be
regenerated. Otherwise, TLS mode will not operate. See “Changing the
Password of a Client’s Key Database” on page 52 for instructions on changing
the password.

Note: The use of a password stash file is strongly discouraged; the protection
for these files is not strong.

Personal Communications allows the option to not use the
PCommClientKeyDb.sth password stash file. In order to operate without the
stash file, erase the PCommClientKeyDb.sth file from the user-class application
data directory; then, during TLS session configuration, select the Prompt for
Password Once radio button in the Security Setup → Advanced dialog. This
option is available only for GSKit security.

- Security must be enabled in order to operate in TLS mode. A client operating in
TLS mode cannot establish a connection with a server that is operating in
ordinary Telnet mode. Likewise, a client operating in ordinary Telnet mode
cannot establish a connection with a server operating in TLS mode. See
“Configuring Personal Communications Session Security” on page 49 for
information about enabling security.

- Select Send Personal Certificate to Server if Requested on the Security Setup
property page for client authentication. If this option is not selected, only
server-side authentication is performed. If the server requests a client certificate
and this option is not selected, there will be no active connection. See “Opening
a Key Database and Adding a Root Certificate” on page 52 for details.

To add, remove, and view certificates in the Microsoft Certificate Stores, select
Internet Options in the Windows Control Panel. On the Content tab, click
Certificates. The tabs represent the different Microsoft Certificates Stores. Each tab
shows the certificates that exist within each store.

Establishing a Secure Session

Upon establishing a preliminary connection with a target server, the Personal
Communications client is presented a certificate by that server; if you have enabled
client certificate authentication, your certificate is likewise presented to the server.
The digital signature of the CA is authenticated using a published root certificate of
the issuing CA. The client automatically decrypts certain information on the
presented certificate using a public key on the CA's root certificate. This step is
successful only when the presented certificate was encrypted using a well-guarded,
unique, and corresponding private key, known only to the CA. This process can
detect (and reject) intentional alterations (forgeries) and the rare garbling that can
occur over data circuits.

Personal Communications also allows users to use self-signed certificates for this
purpose.
Note:

Once this certificate-issuer authentication step succeeds, the client and server negotiate to agree on an encryption key to be used during the ensuing data exchange session.

Configuring Personal Communications Session Security

Whether you are configuring a TN3270, TN5250, or VT session, the underlying protocol must be TCP/IP. Use the following procedure to enable security:

1. Start a workstation profile from the Session Manager; or, from an active session, click Configure from the Communication menu. When the dialog box opens, click Configure.
2. In the Customize Communication panel, choose the appropriate Type of Host, Interface, and Attachment values for the desired Telnet host.
3. Click Link Parameters.
4. On the Host Definition property page, do the following:
   a. Specify the normal host name and LU parameters under Primary.
   b. Specify the Port Number under Primary. It is likely that it will not be the default port value for Telnet. The administrator of the destination server might have set up a specific port number to handle TLS/SSL service.
   For server authentication only, no additional setup is required. For client authentication, proceed to the next step.
6. For 3270 sessions, select the Telnet-negotiated option to have Personal Communications negotiate security with the Telnet 3270 server. See “Negotiated Telnet Security” on page 69 for details. If Enable Security is unchecked, the Telnet-negotiated option cannot be selected.
7. On the Security Setup property page, select the IBM Global Security Kit (GSKit) or Microsoft CryptoAPI (MSCAPI) security package.

   Note: To avoid the need of manually adding host certificate into the Microsoft Certificate Store, refer to Pass Through Certificate Validation.
8. For GSKit, you can click Advanced to control key ring access password options and Smart Card setup.
   In the Key Ring Access group box, you can choose whether or not to use the key database password stash file. Select Use Password Stash (STH) File to use key database stash file and not be prompted for the key database file password. You can use this option with or without the Client Authentication function.
   Select Cryptographic Support to enable Smart Card use. Click Setup to enter module and token information. See “Smart Card Support in GSKit” on page 57 for more information.
9. Use the Security Protocol drop-down list to choose TLS protocol for negotiation of the secure session. The supported TLS protocols are TLS 1.2, TLS 1.1, and TLS 1.0.
   If the host does not support the selected TLS security protocol, Personal Communications will drop down to the next lower level of security protocol, and continue negotiations to establish a secure session. For example, if TLS1.2 is chosen from the Security Protocol drop-down box, and the host supports only up to TLS1.0, then the negotiation is carried out at TLS1.0.
To protect against security vulnerability in RC4 stream cipher, the FIPS (Federal Information Processing Standard) mode has been made mandatory. For GSKit, the following FIPS-approved cipher suites are available:

- **FIPS Allowed TLSv10 CipherSpecs:**
  - TLS_RSA_WITH_AES_128_CBC_SHA
  - TLS_RSA_WITH_AES_256_CBC_SHA
  - TLS_RSA_WITH_3DES_EDE_CBC_SHA

- **FIPS Allowed TLSv11 CipherSpecs:**
  - TLS_RSA_WITH_AES_128_CBC_SHA
  - TLS_RSA_WITH_AES_256_CBC_SHA
  - TLS_RSA_WITH_3DES_EDE_CBC_SHA

- **FIPS Allowed TLSv12 CipherSpecs:**
  - TLS_RSA_WITH_AES_128_CBC_SHA
  - TLS_RSA_WITH_AES_256_CBC_SHA
  - TLS_RSA_WITH_3DES_EDE_CBC_SHA
  - TLS_RSA_WITH_AES_128_GCM_SHA256
  - TLS_RSA_WITH_AES_256_GCM_SHA384
  - TLS_RSA_WITH_AES_128_CBC_SHA256
  - TLS_RSA_WITH_AES_256_CBC_SHA256
  - TLS_ECDHE_RSA_WITH_3DES_EDE_CBC_SHA
  - TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA
  - TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA
  - TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256
  - TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA256
  - TLS_ECDHE_RSA_WITH_3DES_EDE_CBC_SHA

For more details, you are suggested contacting IBM Technical Support.

For MSCAPI, refer to the vendor documentation for the latest information.

**Note:** Follow the below steps to enable AES support with MSCAPI on Windows 8, Windows 8.1, Windows 10, Windows Server 2008, and Windows Server 2012.

a. From an administrator account, open **Group Policy Editor** (gpedit.msc).

b. Choose **Computer Configuration->Administrative Templates->Network->SSL Configuration Settings**.

c. Open **SSL Cipher Suite Order** and select **Enabled**.

d. Alter the cipher order as per your organization’s needs, save the changes, and REBOOT the system for the above changes to apply.
It is important to note that the client can only present the server a prioritized cipher list. The host has the final say on what gets selected as the cipher for the session. When choosing an algorithm with a specific bit length, one important consideration is to remember that encryption and decryption are CPU intensive operations which take time depending upon the key size. In almost all cases, a 128-bit key is more than sufficient to protect the information you are exchanging over your telnet connections.

11. Enable **Check for Server Name and Certificate Name Match** to have the session authenticate the server by matching the server name to the host or server certificate name. The server and certificate names must match exactly. For MSCAPI sessions, if the certificate name and server name do not match, an error is returned. For GSKit sessions, if the host certificate name does not match the name of the host to which are connecting, the session is terminated.

12. In the **Client Authentication** group box, you determine when and how the client certificate will be chosen for sending to the server.

If you want to enable client authentication and have the personal client certificate from the key database file sent to the server when requested, check **Send Personal Certificate to Server if Requested**.

**Send Personal Certificate Trusted by Server**

Select this option if you do not want to be prompted to select a personal client certificate from a key database file. Personal Communications will send the personal client certificate trusted by the server.

**Send Personal Certificate based on Key Usage**

Use this option to select one or more key usages. Click **Key Usage** to select the defined Object ID (OID) key usages. Go to the **Extended Key Usage** panel to add a new OID and description to the list.

At authentication time, Personal Communications chooses certificates for client authentication, based on the key usage that you select. If a certificate's Enhanced Key Usage attribute contains one or more of the OIDs that you specify, the certificate is eligible for use.

If no eligible certificates are found, the authentication fails. If one eligible certificate is found, it is automatically used. If two or more eligible certificates are found, you will be prompted to select a personal client certificate.

**Select or Prompt for Personal Client Certificate**

Use this option if you want to choose the personal client certificate. You will be prompted to select a personal client certificate during session establishment, when the server requests the client certificate.

To preselect a personal client certificate during configuration, click **Select now** and choose the **Personal Certificate Label**.

**Pass Through Host Certificate Validation**

Use this option to disable the default certificate validation process during TLS handshake. Applicable only for Microsoft schannel provider.

**Note:** By default, schannel (MSCAPI) is responsible for validating the host certificate chain received during TLS handshake. Schannel runs several checks on the received certificate chain one of which is verifying that the signature affixed to the certificate valid, that is, the hash value computed on the certificate...
Pop-up Messages

During session establishment, your workstation may display pop-up messages in order to solicit from you:

- The password for accessing the PCommClientKeyDb.kdb database
- The location of the PCommClientKeyDb.kdb

If you chose to be prompted for personal client certificate information, the Select Client Personal Certificate Label Name screen is displayed at connection time, when the server requests the client personal certificate. The Server Certificate Information list box displays the information about the certificate issued to the server, as well as the issuer. Information includes common name, organization, locality and e-mail. This is provided for information purpose only; none of the information can be selected. The Server Trusted Root List list box displays the information about the trusted root supported by the server. This is also provided for information purpose only; none of the information can be selected. Click the Select Personal Certificate Label Name drop-down list and select the personal certificate to be sent to the server for client authentication. Click OK after selection.

If you chose to be prompted once for the key database password, the Enter Key Database Password screen is displayed at connection time, when the server requests the client personal certificate. Enter the key database password and click OK.

Changing the Password of a Client's Key Database

The key database file created when Personal Communications is installed has a default set of root certificates that will handle a majority of server certificates without modification to the file. This initial file is accessible using certificate management. The default password pcomm.

Certificates can be managed using Certificate Manager or the IKEYCMD command-line interface.

Using Certificate Management

To change the password using Certificate Management, do the following:

1. From the Start ➔ Programs ➔ IBM Personal Communications ➔ Utilities menu, select Certificate Management.
2. From the Key Database File menu, select Open.
3. Select the PCommClientKeyDb.kdb file from the user-class application data directory.
4. Click Open.
5. Type the current password for the file in the Password entry field.
6. From the **Key Database File** menu, select **Change Password**. Follow the guidelines issued by your network manager for selecting a password or passphrase that is not easily guessed.

7. Type the new password in the New Password entry field.

8. Type the new password again in the Confirm New Password entry field.

9. To set a password expiration time, click **Set expiration time** and enter the number of days until expiration.

10. Click **Stash the password** to stash the password of the current database encrypted.

   **Note**: Personal Communications cannot access the certificates in your file if this checkbox is not selected.

11. Click **OK**.

**Connecting to a Server Using a Certificate from a Well-Known CA**

The following CA signed root certificates are already stored in Personal Communication's key database and marked as trusted certificates:

   **Note**: The updated list of CA certificates can be viewed by opening the default PCommClientKeyDb.kdb file.

   - Entrust.net Certification Authority (2048)
   - Entrust.net Client Certification Authority
   - Entrust.net Global Client Certification Authority
   - Entrust.net Global Secure Server Certification Authority
   - Entrust.net Secure Server Certification Authority
   - Thawte Personal Basic CA
   - Thawte Personal Freemail CA
   - Thawte Personal Premium CA
   - Thawte Premium Server CA
   - Thawte Server CA
   - VeriSign Class 1 Public Primary Certification Authority
   - VeriSign Class 1 Public Primary Certification Authority - G2
   - VeriSign Class 1 Public Primary Certification Authority - G3
   - VeriSign Class 2 Public Primary Certification Authority
   - VeriSign Class 2 Public Primary Certification Authority - G2
   - VeriSign Class 2 Public Primary Certification Authority - G3
   - VeriSign Class 3 Public Primary Certification Authority
   - VeriSign Class 3 Public Primary Certification Authority - G2
   - VeriSign Class 3 Public Primary Certification Authority - G3
   - VeriSign Class 3 Public Primary Certification Authority - G5
   - VeriSign Class 4 Public Primary Certification Authority - G2
   - VeriSign Class 4 Public Primary Certification Authority - G3

Following is a summary of the steps required for connecting to a server using a certificate issued by a well-known CA:

1. Confirm that the server you want to connect to has a certificate from a well-known CA.
2. Configure Personal Communications for TLS/SSL support. See "Configuring Personal Communications Session Security" on page 49 for details.

Connecting to a Server Using a Certificate from an Unknown CA

The procedures in this section explain how to configure security for connecting to a server using a certificate issued by an unknown CA; that is, a CA that is not already defined in the PCommClientKeyDb.kdb file.

Following is a summary of the steps required:
1. Confirm that the server you want to connect with has a certificate from an unknown CA.
2. Request the root certificate for the unknown CA from your server administrator.
3. Open the PCommClientKeyDb.kdb file and add the root certificate to it.
4. For client authentication, obtain a personal certificate from this unknown CA and add it to the PCommClientKeyDb.kdb file.

Opening a Key Database and Adding a Root Certificate

When you get the root certificate file from your server administrator, make sure that it is in one of the following formats, based on the normal file extensions:

- **.ARM** Base64-encoded ASCII data (armored 64 format)
- **.DER** Binary DER data

Only a certificate in one of these formats can be added to the keyring database.

**Note:** In many cases, instead of providing a root certificate file, the server administrator may create the key database file and password stash file at the server. After adding the root certificate, the server administrator can copy the files to each client. If you do this, it is important that the names and location match as follows:

- Key database file: PCommClientKeyDb.kdb
- Password stash file: PCommClientKeyDb.sth

These files are located in the user-class application data directory.

If the server administrator provided only a root certificate file, use the Certificate Management utility to open the key database file and add the root certificate.

**Using Certificate Management:** To use Certificate Management to open a key database and add a root certificate, do the following:

1. From the Start → Programs → IBM Personal Communications → Utilities menu, select Certificate Management.
2. From the Key Database File menu, click Open.
3. Select the PCommClientKeyDb.kdb file.
4. Click Open.
5. Type the password in the Password entry field and click OK.
6. Select Signer Certificates from the drop-down listbox.
7. Click Add to receive the certificate.

   The Add CA’s Certificate from a File panel appears.
8. Select the format dictated by your server administrator from the Data Type listbox.
9. Type the full path to the root certificate file in the Certificate file name entry field.
10. Click Browse, open the certificate file, and click OK.
11. Enter a label for the certificate and click OK.
12. Click View/Edit.
13. Activate the Set the certificate as a trusted root, and click OK.

**Opening a Key Database and Adding a Personal Certificate**

When you get the personal certificate file from your server administrator or a CA, make sure that it is in one of the following formats:

- PKCS#12 file
- CMS key database file
- Keyring file
- Base64-encoded ASCII data (armored 64 format)
- Binary DER data

A personal certificate can also be in a cryptographic device (such as a Smart Card or Fingerprint) or in a browser’s keyring.

**Using Certificate Management:** To use Certificate Management to open a key database and add a personal certificate, do the following:

1. From the Start → Programs → IBM Personal Communications → Utilities menu, select Certificate Management.
2. From the Key Database File menu, click Open.
3. Select the PCommClientKeyDb.kdb file.
4. Click Open.
5. Type the password in the Password entry field and click OK.
6. Select Personal Certificates from the drop-down listbox.
7. Click Import for KDB, DYR and PK12 format files to import the certificate. The Import Key panel appears.
8. Select the format dictated by your server administrator from the Key file Type listbox.
9. Type the full path to the root certificate file in the Certificate file name entry field.
10. Click Browse, open the certificate file, and click OK.
11. Enter the Key Label, or accept the default, and click OK.
12. Click Receive for ARM and DER format files. The Add CA’s Certificate from a File panel appears.
13. Select the format dictated by your server administrator from the Data Type listbox.
14. Type the full path to the root certificate file in the Certificate file name entry field.
15. Click Browse, open the certificate file, and click OK.
16. Enter a label for the certificate and click OK.
Obtaining a Personal ID Certificate from a Known Certificate Authority (CA)

A personal ID certificate uniquely identifies you, and can be obtained from known certificate authorities. One such certificate authority is Symantec. To obtain a Personal ID certificate from Symantec:

2. Follow the instructions to install a Digital ID (either full-service or trial) in your Web browser or on a cryptographic device, if the device has such capability.

After the certificate has been installed in your browser, you must store it in the key database. On Windows, you can use the Certificate Management utility to open the Microsoft Certificate Store. For other supported Windows operating systems, use the following procedure.

1. From the browser, export the certificate into a new key file.
2. Open the Personal Communications client key database file.
3. Click Export/Import to import the certificate. The Export/Import Key dialog appears.
4. Click the Key button.

Note: The key file type must be PKCS#12.
5. Enter the name of the file in the first field, the path to the file in the second field; click OK.
6. At the password prompt, enter your password and click OK.

Connecting to a Server Using a Self-Signed Certificate

Although using self-signed certificates is not recommended, a server administrator can use them while waiting for a purchased CA certificate. Once the CA certificate is available, the server and all clients should be reconfigured to switch from the self-signed certificate to the purchased one.

Following is a summary of the steps required:
1. Confirm that the server you want to connect with has a self-signed certificate.
2. Request from your server administrator the root certificate for the self-signed certificate.
3. Open the PCommClientKeyDb.kdb file and add the root certificate to it.

The steps required by a client in this scenario are the same as those for the Unknown CA scenario. See "Opening a Key Database and Adding a Root Certificate" on page 54 for the steps involved.

Problem Determination

Following is some information to help you avoid problems that might be related to TLS configuration.

- With server-side authentication, the common name in the sever's certificate is always compared to the name you type in the Host Name field on the client. These names must match exactly. You cannot:
  - Type the IP address in one place and the host name in the other
  - Type wrt05306 in one place and WTR5306 in the other
  - Type wrt05036 in one place and wrt05036.raleigh.ibm.com in the other

Note: This information is available only from the target server administrator.
Make sure that TLS is enabled on both the Personal Communications client and the TLS server.

- Makes sure that the port number in the Advanced configuration panel on the client matches the port number defined in the server.
- For each different server using a self-signed certificate, you must add a copy of each of the server certificates to your keyring.
- Be sure there is a root certificate of the proper class to correspond with the class and issuer of the certificate on the server.
- Make sure that the password to your key database has not expired.

**Note:** Notify your server administrator of any problems prior to contacting IBM Service.

### Smart Card Support in GSKit

The GSKit security package includes Smart Card support. A Smart Card is a small electronic device that contains electronic memory and can be used to store a certificate. You can keep the certificate in a local or network accessed file, in Netscape PKCS#11 format. You can specify the location of the certificate in the session preferences, or prompt for the personal client certificate. You can control the timing of prompts for client certificates.

You need a Smart Card reader installed when working with certificates for Smart Card. Supported Smart Card Drivers displays the supported Smart Card drivers and their filenames.

**Note:** Drivers other than the ones listed below can be used by manually keying in the driver name and pressing TAB key to move to the next field.

Table 1 displays the supported Smart Card drivers and their filenames.

<table>
<thead>
<tr>
<th>Smart Card Drivers</th>
<th>File names</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM SecureWay Smartcard</td>
<td>w32pk2ig.dll</td>
</tr>
<tr>
<td>GemPlus/GemSoft Smartcard</td>
<td>w32pk2ig.dll</td>
</tr>
<tr>
<td>IBM Netfinity® PSG Chip1</td>
<td>ibmpkcss.dll</td>
</tr>
<tr>
<td>Rainbow Ikey 1000</td>
<td>Cryptoki22.dll</td>
</tr>
<tr>
<td>Schlumberger Cryptoflex</td>
<td>acpks.dll or slbck.dll</td>
</tr>
<tr>
<td>SCW PKCS 3GI 3-G Internal</td>
<td>3gp11csp.dll</td>
</tr>
<tr>
<td>Data Key</td>
<td>Dckck232.dll</td>
</tr>
<tr>
<td>Fortezza Module</td>
<td>fort32.dll</td>
</tr>
</tbody>
</table>

1The system boards in some IBM systems are preconfigured with a Promise of Value (POV) card, a 256-bit encrypted security chip daughtercard attached to the motherboard. If an attempt is made to remove the POV card from the board and install it into another system, the cryptographic key material will be erased, rendering it unusable. This security feature is by design and prevents the cryptographic key migration from one system to another. Therefore, moving this security chip from one board to another is not a supported option. If an attempt is made to move the POV card from one system to another, it may hang on boot and display an error message referring to an invalid machine type and serial number.

### Enabling Smart Card Support in GSKit

Smart Card is only used for the personal certificate—it can only hold one personal certificate and does not hold the signer certificates. The signer certificate or the root
and any intermediate certificate of the personal certificate on the Smart Card should be added in the PCommClientKeyDb.kdb file.

To enable Smart Card security using the Certificate Management utility, do the following:
1. From the Select Key Database File menu, select Open.
2. From the Key database type drop-down menu, select Cryptographic Token.
3. Locate the appropriate file or enter the file name and location.

To enable Smart Card support when configuring a session, do the following:
2. Select Send Personal Certificate to Server if Requested.
3. Select Cryptographic Support (PKCS#11).
4. In the Cryptographic Support Setup panel, choose the Netscape Compatible PKCS#11 driver name from the drop-down list. If a driver software provider was not found by Personal Communications, you must enter a Smart Card driver name.
5. If the driver loaded successfully, the Cryptographic Token Label list is displayed. There may be a delay while the certificate labels are loaded.
6. Enter the Cryptographic Token Password for the selected Cryptographic Token Label; this provides access to the PKCS#11 Cryptographic device. You can then access the PKCS#11 Certificate Label Names from the drop-down list. If there is only one Certificate, it will automatically be used.

If PKCS#11 Cryptographic support is enabled and a password for the PKCS#11 cryptographic module is not defined during configuration, you will be prompted for the password.

**Using the IKEYCMD Command-Line Interface**
IKEYCMD is a command-line tool that can be used to manage keys, certificates, and certificate requests. It is functionally similar to Certificate Management (IKEYMAN) and is intended to be run from the command line without a graphical interface.

Use IKEYCMD for configuration tasks related to public/private key creation and management. You can use IKEYCMD to create key database files for the same key database types that IKEYMAN currently supports. You can also create certificate requests, import CA signed certificates, and manage self-signed certificates.

You cannot use IKEYCMD for configuration options that update the server configuration file httpd.conf. To update the server configuration file, you must use the IBM Administration Server.

**Environment Setup for IKEYCMD Command-Line Interface**
Use the following procedure to set the environment variables to use the IKEYCMD command-line interface.

1. Set or modify the PATH variable to include the location of the Java executables. This can be done by using the UI, modifying autoexec.bat, or typing the following in a command window:

   ```
   set PATH=c:\Program Files\IBM\Personal Communications\java\jre\bin;%PATH%;
   ```

   where C:\Program Files\IBM\Personal Communications is the directory where is Personal Communications installed.
2. Once completed, run IKEYCMD from any directory.

To run an IKEYCMD command, use the following syntax:

ikeycmd

**IKEYCMD Syntax**

The syntax of the IKEYCMD CLI is

\[ ikeycmd \ <object> \ <action> \ [options] \]

where object is one of the following:

- **-keydb**
  - Actions taken on the key database (either a CMS key database file, a WebDB keyring file, or SSlight class).

- **-cert**
  - Indicates that the operation applies to a certificate.

- **-certreq**
  - Actions taken on a certificate request.

- **-help**
  - Display help for the IKEYCMD invocations.

- **-seckey**
  - Actions taken on a secret key.

- **-version**
  - Display version information for IKEYCMD.

*Action* is the specific action to be taken on the object, and *options* are the options (either required or optional) specified for the object and action pair. Some options may be required for certain object and action pairs.

**Note:** The object and action keywords are position-sensitive and must be in the order indicated in the example. However, options are not position-sensitive and can be typed in any order, provided that they are entered as an option and operand pair.

**Object–Action Pairs:** The following table describes each action that can be performed on a specified object.

<table>
<thead>
<tr>
<th>Object</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-keydb</td>
<td>-changepw</td>
<td>Change the password for a key database.</td>
</tr>
<tr>
<td></td>
<td>-convert</td>
<td>Convert the key database from one format to another.</td>
</tr>
<tr>
<td></td>
<td>-create</td>
<td>Create a key database.</td>
</tr>
<tr>
<td></td>
<td>-delete</td>
<td>Delete the key database.</td>
</tr>
<tr>
<td></td>
<td>-expiry</td>
<td>Display password expiry</td>
</tr>
<tr>
<td></td>
<td>-list</td>
<td>Currently supported types of key database.</td>
</tr>
<tr>
<td></td>
<td>-stashpw</td>
<td>Stash the password of a key database into a file.</td>
</tr>
<tr>
<td>-cert</td>
<td>-add</td>
<td>Add a CA certificate from a file into a key database.</td>
</tr>
<tr>
<td></td>
<td>-create</td>
<td>Create a self-signed certificate.</td>
</tr>
<tr>
<td></td>
<td>-delete</td>
<td>Delete a CA certificate.</td>
</tr>
<tr>
<td></td>
<td>-details</td>
<td>List the detailed information for a specific certificate.</td>
</tr>
</tbody>
</table>
### Table 2. Object–Action Pairs for IKEYCMD (continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-export</td>
<td>Export a personal certificate and its associated private key from a key database into a PKCS#12 file, or to another key database.</td>
</tr>
<tr>
<td>-extract</td>
<td>Extract a certificate from a key database.</td>
</tr>
<tr>
<td>-getdefault</td>
<td>Get the default personal certificate.</td>
</tr>
<tr>
<td>-import</td>
<td>Import a certificate from a key database or PKCS#12 file.</td>
</tr>
<tr>
<td>-list</td>
<td>List all certificates.</td>
</tr>
<tr>
<td>-listsigners</td>
<td>List signer certificates delivered with ikeyman.</td>
</tr>
<tr>
<td>-modify</td>
<td>Modify a certificate. <strong>Note:</strong> Currently, the only field that can be modified is the Certificate Trust field.</td>
</tr>
<tr>
<td>-populate</td>
<td>Populate with included CA Certificates.</td>
</tr>
<tr>
<td>-receive</td>
<td>Receive a certificate from a file into a key database.</td>
</tr>
<tr>
<td>-rename</td>
<td>Rename a certificate.</td>
</tr>
<tr>
<td>-setdefault</td>
<td>Set the default personal certificate.</td>
</tr>
<tr>
<td>-sign</td>
<td>Sign a certificate stored in a file with a certificate stored in a key database and store the resulting signed certificate in a file.</td>
</tr>
<tr>
<td>-certreg</td>
<td>-create</td>
</tr>
<tr>
<td>-delete</td>
<td>Delete a certificate request from a certificate request database.</td>
</tr>
<tr>
<td>-details</td>
<td>List the detailed information of a specific certificate request.</td>
</tr>
<tr>
<td>-extract</td>
<td>Extract a certificate request from a certificate request database into a file.</td>
</tr>
<tr>
<td>-list</td>
<td>List all certificate requests in the certificate request database.</td>
</tr>
<tr>
<td>-recreate</td>
<td>Recreate a certificate request.</td>
</tr>
<tr>
<td>-seckey</td>
<td>-create</td>
</tr>
<tr>
<td>-delete</td>
<td>Delete a secret key.</td>
</tr>
<tr>
<td>-details</td>
<td>Show the details of a specific secret key.</td>
</tr>
<tr>
<td>-export</td>
<td>Export secret keys to a file.</td>
</tr>
<tr>
<td>-import</td>
<td>Import secret keys from a file.</td>
</tr>
<tr>
<td>-list</td>
<td>List all secret keys in a key database.</td>
</tr>
<tr>
<td>-rename</td>
<td>Rename a secret key.</td>
</tr>
<tr>
<td>-help</td>
<td>Display this help text.</td>
</tr>
<tr>
<td>-version</td>
<td>Display iKeyman version information.</td>
</tr>
</tbody>
</table>

### IKEYCMD Tasks for Personal Communications

IKEYCMD command-line interface tasks required for Personal Communications are summarized in the following sections.

- "Creating a New Key Database" on page 61
- "Storing the Encrypted Database Password in a Stash File" on page 62
- "Creating a New Key Pair and Certificate Request" on page 62
- "Creating a Self-Signed Certificate" on page 63
Creating a New Key Database

A key database is a file that the Personal Communications client uses to store one or more key pairs and certificates—this is required to enable secure connections between the Personal Communications client and the Telnet server. Before configuring TLS communication, you need to have the PCommClientKeyDb.kdb key database file in the Personal Communications application data directory. By default, this file is installed on your machine with Personal Communications and it has a default password of \textit{pcomm}. It is recommended that you change this initial password the very first time you use Personal Communications. See “Changing the Database Password” on page 62 for instructions on how to change the key database password.

To create a new key database using the IKEYCMD command-line interface, type the following command:

\begin{verbatim}
ikeycmd -keydb -create -db PCommClientKeyDb.kdb -pw <password> -type cms -expire <days> -stash
\end{verbatim}

where:

\begin{itemize}
\item \textbf{<password>}: Password is required for each key database operation. The initial password for PCommClientKeyDb.kdb is \textit{pcomm}.
\item \textbf{-type}: The PCommClientKeyDb.kdb used by the Personal Communications client is a CMS database type.
\item \textbf{-expire}: Number of days before password expires.
\item \textbf{-stash}: Stashes password for key database.
\end{itemize}

When the \texttt{-stash} option is specified during the key database creation, the password is stashed in the PCommClientKeyDb.sth file.

The PCommClientKeyDb.kdb key database file holds all the security information needed by the Personal Communications client. Any additions or changes are made to the existing PCommClientKeyDb.kdb key database file.

**Setting the Database Password:** When you create a new key database, specify a key database password. This password protects the private key. The private key is the only key that can sign documents or decrypt messages encrypted with the public key. Change the key database password frequently.

Use the following guidelines when specifying the password:
\begin{itemize}
\item The password must be from the U.S. English character set.
\end{itemize}
The password should be at least six characters and contain at least two nonconsecutive numbers. Make sure the password does not consist of publicly obtainable information about you, such as the initials and birth date for you, your spouse, or children.

Stash the password.

**Note:** Keep track of expiration dates for the password. If the password expires, a message is written to the error log. The server will start, but there will not be a secure network connection if the password has expired.

**Changing the Database Password:** To change the database password, type the following command:

```
ikeycmd -keydb -changepw -db PCommClientKeyDb.kdb
-pw <password> -new_pw<new_password> -expire <days> -stash
```

where:

- **-new_pw**
  
  New key database password. This password must be different than the old password and cannot be a NULL string.

- **-expire**
  
  Number of days before the password expires.

- **-stash**
  
  Stashes password for key database.

**Storing the Encrypted Database Password in a Stash File:** For a secure network connection, store the encrypted database password in a stash file.

To store the password while a database is created, type the following command:

```
java com.ibm.gsk.ikeyman.ikeycmd -keydb -create -db <path_to_db>/<db_name>.kdb
-pw <password> -type cms -expire <days> -stash
```

To store the password after a database has been created, type the following command:

```
java com.ibm.gsk.ikeyman.ikeycmd -keydb -stashpw -db <db_name>.kdb -pw <password>
```

**Registering a Key Database with the Server:** The initial configuration setting for the default key database name is key.kdb. If you use key.kdb as your default key database name, you do not need to register the database with the server. The server uses the initial setting on the KeyFile directive in the configuration file. If you do not use key.kdb as your default key database name, or if you create additional key databases, you must register those databases.

**Creating a New Key Pair and Certificate Request**

To create a public-private key pair and certificate request, do the following:

1. Type the following command:

   ```
   java com.ibm.gsk.ikeyman.ikeycmd -certreq -create -db PCommClientKeyDb.kdb
   -pw <password> -size <1024 | 512>
   -dn<distnguished_name>-file <filename> -label <label>
   ```

   where:

   - **-size**
     
     Key size of 512 or 1024.

   - **-label**
     
     Label attached to certificate or certificate request.

   - **-dn**
     
     Enter an X.500 distinguished name.

   - **-file**
     
     Name of file where the certificate request will be stored. By default,
Personal Communications uses the name certreq.arm and it should be stored in the application data directory, where the PCommClientKeyDb.kdb key database is located.

2. Verify that the certificate was successfully created.
   a. View the contents of the certificate request file you created.
   b. Make sure the key database recorded the certificate request by typing the following command:
      ```java
      java com.ibm.gsk.ikeyman.ikeycmd -certreq -list -db PCommClientKeyDb.kdb
      -pw <password>
      ```
      You should see the label that you just created in the list of certificates. Send the newly created file to a certificate authority.

3. Send the newly created file to a certificate authority.

Creating a Self-Signed Certificate

It usually takes two to three weeks to get a certificate from a well-known certificate authority (CA). While waiting for an issued certificate, use IKEYCMD to create a self-signed server certificate to enable TLS/SSL sessions between clients and the server. Use this procedure if you are acting as your own CA for a private Web network.

To create a self-signed certificate, type the following command:
```java
java com.ibm.gsk.ikeyman.ikeycmd -cert -create -db PCommClientKeyDb.kdb
-pw <password> -size <1024 | 512> -dn <distinguished name>
-label <label> -default_cert <yes or no>
```
where:
- `size` Key size 512 or 1024.
- `label` Enter a descriptive comment used to identify the key and certificate in the database.
- `dn` Enter an X.500 distinguished name.
- `default_cert` Type `yes` if you want this certificate to be the default certificate in the key database. Otherwise, type `no`.

Exporting Keys

To export keys to another key database or to export keys to a PKCS#12 file, type the following command:
```java
java com.ibm.gsk.ikeyman.ikeycmd -cert -export -db PCommClientKeyDb.kdb
-pw <password> -label <label>-type <cms | ssllight> -target <filename>
-target_pw <password> -target_type <cms | ssllight | pkcs12>
-encryption <strong | weak>
```
where:
- `label` Label attached to the certificate.
- `target` Destination file or database.
- `target_pw` Password for the target key database.
- `target_type` Type of the database specified by `target` operand.
**Importing Keys**

To import keys from another key database, type the following command:

```
java com.ibm.gsk.ikeyman.ikeycmd -cert -import -db <filename> -pw <password> -label <label> -type <cms | sslight> -target <filename> -target_pw <password> -target_type <cms | sslight>
```

To import keys from a PKCS#12 file, type the following command:

```
java com.ibm.gsk.ikeyman.ikeycmd -cert -import -file <filename> -pw <password> -type pkcs12 -target <filename> -target_pw <password> -target_type <cms | sslight>
```

where:

- **-label**  
  Label attached to the certificate.

- **-target**  
  Destination database.

- **-target_pw**  
  Password for the key database if -target specifies a key database.

- **-target_type**  
  Type of database specified by -target operand.

**Listing CAs**

To display a list of trusted CAs in the PCommClientKeyDb.kdb key database, type the following command:

```
java com.ibm.gsk.ikeyman.ikeycmd -cert -list CA -db PCommClientKeyDb.kdb -pw <password> -type cms
```

**Storing the CA Certificate**

**Receiving a CA-Signed Certificate:** Use this procedure to receive an electronically mailed certificate from a certificate authority (CA), designated as a trusted CA on your server. By default, the following CA certificates are stored in the PCommClientKeyDb.kdb key database and marked as trusted CA certificates:

- IBM World Registry CA
- Integrion CA Root (from IBM World Registry)
- VeriSign Class 1 Public Primary CA
- VeriSign Class 2 Public Primary CA
- VeriSign Class 3 Public Primary CA
- VeriSign Class 4 Public Primary C
- VeriSign Test CA
- RSA Secure Server CA (from VeriSign)
- Thawte Personal Basic CA
- Thawte Personal Freemail CA
- Thawte Personal Premium CA
- Thawte Premium Server CA
- Thawte Server CA

The CA may send more than one certificate. In addition to the certificate for your server, the CA may also send additional Signing certificates or Intermediate CA Certificates. For example, Verisign includes an Intermediate CA Certificate when sending a Global Server ID certificate. Before receiving the server certificate, you
must receive any additional Intermediate CA certificates. See “Storing a CA Certificate” for instructions on receiving Intermediate CA Certificates.

**Note:** If the CA who issues your CA-signed certificate is not a trusted CA in the key database, you must first store the CA certificate and designate the CA as a trusted CA. Then you can receive your CA-signed certificate into the database. You cannot receive a CA-signed certificate from a CA who is not a trusted CA. For instructions, see “Storing a CA Certificate.”

To receive the CA-signed certificate into a key database, type the following command:

```java
java com.ibm.gsk.ikeyman.ikeycmd -cert -receive -file <filename>
-db PCommClientKeyDb.kdb -pw <password> -format <ascii | binary> -default_cert <yes | no>
```

where:

- **-format**
  Certificate Authority might provide CA Certificate in either ASCII or binary format.

- **-label**
  Label attached to CA certificate.

- **-trust**
  Indicates whether this CA can be trusted. Use enable options when receiving a CA certificate.

- **-file**
  File containing the CA certificate.

- **-default_cert**
  Type yes if you want to make this key your default key.

**Storing a CA Certificate:** To store a certificate from a CA who is not a trusted CA, type the following command:

```java
java com.ibm.gsk.ikeyman.ikeycmd -cert -add -db PCommClientKeyDb.kdb 
-pw <password> -label <label> -format <ascii> -trust <enable> -file <file>
```

where:

- **-label**
  Label attached to certificate or certificate request.

- **-format**
  Certificate Authorities might supply a binary ASCII file.

- **-trust**
  Indicate whether this CA can be trusted (should be yes).

**Opening a Key Database**

Explicit opening of a key database is not supported. For each command, database and password options are given—these options are sufficient to operate in a key database.

**Showing the Default Key in a Key Database**

To display the default key entry, type the following command:

```java
java com.ibm.gsk.ikeyman.ikeycmd -cert -getdefault -db PCommClientKeyDb.kdb 
-pw <password>
```

**Managing a Digital Certificate on a Smart Card**

You can manage digital certificates on a Smart Card (or, more generically, on a PKCS#11 cryptographic device). To do so, you must first use the following procedure to inform the IKEYMAN CLI of the name of the module for managing your Smart Card.
1. Edit the java.security file in your JDK environment with one of the following settings stored in the (JAVA_HOME)\jre\lib\security\ directory:
   - security.provider.1=sun.security.provider.Sun
   - security.provider.2=com.ibm.spi.IBMCMSProvider
   - security.provider.3=com.ibm.crypto.provider.IBMJCE

2. Edit the ikmcmd.properties file to set the DEFAULT_CRYPTOGRAPHIC_MODULE property to the name of the module for managing your smart card. For example,
   DEFAULT_CRYPTOGRAPHIC_MODULE=C:\Winnt\System32\W32pk2ig.dll
   The module is normally installed on your system when you install the software for your Smart Card.

3. Save the ikmcmd.properties file.

Use the following command syntax for PKCS#11 operations:
-crypto <module_name> -tokenlabel <token_label> -pw <password>

For example, to display the certificate contained on your PKCS#11 cryptographic device, type the following:
java -Dikeycmd.properties=<properties_file> com.ibm.gsk.ikeyman.ikeycmd
-cert -list all -crypto <module_name> -tokenlabel <token_label> -pw <password>

where:
-cert Indicates that the operation applies to a certificate.
-list all Displays the certificate.
-crypto <module_name> Specifies PKCS#11 cryptographic device usage, where <module_name> is the name of the module to manage your smart card. This parameter is optional if the module name is specified in the ikmcmd.properties file.
-tokenlabel <token_label> The PKCS#11 cryptographic device token label.
-pw <password> The password for the PKCS#11 cryptographic device.

Using Microsoft CryptoAPI: If you want to open a cryptographic hardware device using MS CryptoAPI, use the following procedure.

1. Edit the ikmcmd.properties file. Set the cryptographic service provider (CSP) name to the DEFAULT_CRYPTOGRAPHIC_MODULE property. For example,
   DEFAULT_CRYPTOGRAPHIC_MODULE=Schlumberger Cryptographic Service Provider
   The CSP is normally installed on your system when you install the software for your Smart Card.

2. Save the ikmcmd.properties file.

Use the following command syntax to display the certificate contained on your cryptographic device:
java -Dikeycmd.properties=<propertiesfile> com.ibm.gsk.ikeyman.ikeycmd -cert
-list all -crypto <CSP_module_name>

where:
-cert Indicates that the operation applies to a certificate.
-list all
  Displays the certificate.
-crypto <CSP_module_name>
  Specifies the CSP name.

Managing the Microsoft Certificate Store
You can use the following command to manage the Microsoft Certificate Store:
-db MSCertificateStore

For example, to view the details of a certificate stored in Microsoft Certificate Store, use the following command syntax:
java com.ibm.gsk.ikeyman.ikeycmd -cert -details -db MSCertificateStore
-label <label>

where:
-cert Indicates that the operation applies to a certificate.
-details Specifies verbose mode when displaying information.
-db MSCertificateStore Specifies Microsoft Certificate Store.
-label <label> The label of the certificate used in the operation.

The password parameter is not needed in -db MSCertificateStore operations.

Using GSK6CMD Batch File
The batch file gsk6cmd provides the same function as the java com.ibm.gsk.ikeyman command. For example, to store the password after a database has been created, you can also type the following command:
gsk6cmd -keydb -stashpw -db <db_name>.kdb -pw <password>

Summary of Command-Line Invocations
The following is a list of each of the command-line invocations, with the optional parameters specified in italics.

Note: The actual Java invocation java com.ibm.gsk.ikeyman,iKeycmd must precede each of the command examples.
-keydb -changepw -db <filename> -pw <password> -newpw <new_password> -stash -expire <days>
-keydb -convert -db <filename> -pw <password> -old_format <cms | webdb> -new_format <cms>
-keydb -create -db <filename> -pw <password> -type <cms | sslight> -expire <days> -stash
-keydb -delete -db <filename> -pw <password>
-keydb -stashpw -db <filename> -pw <password>
-cert -add -db <filename> -pw <password> -label <label> -file <filename> -format ascii |binary> -trust <enable | disable>
-cert -create -db <filename> -pw <password> -label <label> -dn <distinguished_name> -size 1024 | 512> -x509version <3 | 1 | 2>
-default_cert <no |yes>
-cert -delete -db <filename> -pw <password> -label <label>
-cert -details -db <filename> -pw <password> -label <label>
Using Transport Layer Security

Personal Communications allows you to negotiate the Transport Layer Security 1.0 protocol. The TLS protocol is based on the SSL protocol. TLS differs from SSL mainly in the initial handshake protocol for establishing client/server authentication and encryption. TLS also allows you to use FIPS (Federal Information Processing Standard) mode. Although TLS and SSL do not operate with each other, TLS provides a mechanism by which a TLS 1.0 implementation can revert to SSLv3.

The TLS protocol uses public-key and symmetric-key cryptographic technology. Public-key cryptography uses a pair of keys, one public and one private. Information encrypted with one key can only be decrypted with the other key. For example, information encrypted with the public key can be decrypted only with the private key. Each server's public key is published, while the private key is confidential. To send a secure message to the server, the client encrypts the message by using the server's public key. When the server receives the message, it decrypts the message with its private key.
Symmetric-key cryptography uses the same key to encrypt and decrypt messages. The client randomly generates a symmetric key to be used for encrypting all session data. The key is then encrypted with the server’s public key and sent to the server.

TLS provides three basic security services:

**Message privacy**
Achieved through a combination of public-key and symmetric-key encryption. All traffic between a client and a server is encrypted using a key and an encryption algorithm negotiated during session setup.

**Message integrity**
Ensures that session traffic does not change while in route to its final destination. TLS and SSL use a combination of public/private keys and hash functions to ensure message integrity.

**Mutual authentication**
Exchange of identification through public-key certificates. The client and server identities are encoded in public-key certificates, which contain the following components:
- Subject’s distinguished name
- Issuer’s distinguished name
- Subject’s public key
- Issuer’s signature
- Validity period
- Serial number

### Configuring for TLS
When configuring a Telnet session, you can choose **TLS** or **SSL only** as your Security Protocol. If the configured host does not support TLS, the host does one of the following:
- Sends SSLv3 hello to Personal Communications
  In this case, Personal Communications will revert to SSLv3 and continue SSLv3 negotiations.
- Sends a fatal error
  In this case, Personal Communications does not continue negotiations with the host.

If you know that the host does not support TLS, you can select the **SSL only** option. In this case, Personal Communications starts with SSL negotiations to establish a secure connection, and does not attempt TLS negotiations. This option also enables SSLv2.

### Negotiated Telnet Security
Typically, a secure channel is established before the Telnet 3270 server and client negotiate for a session. For Personal Communications 3270 sessions, you can use negotiated Telnet security. This option enables Personal Communications to establish security with the Telnet 3270 server during the Telnet negotiation. The security protocol used is TLS 1.0, TLS 1.1, and TLS 1.2.

If you select the **Telnet-negotiated** option on the Security Setup panel, the Telnet connection is established. Personal Communications then uses the **TLS-based Telnet**
Security protocol (as defined by IETF) to negotiate the TLS security. If the connection is successful, a status message is returned.

This support is only applicable with a Telnet server which supports the TLS-based Telnet Security protocol. By default, this option is not enabled.
Chapter 7. Using Windows Terminal Services

Windows Terminal Services (WTS) is a feature that allows more than one user to log onto a Windows machine. This functionality is also referred to as simultaneous user environments or terminal services.

Users can logon to the Windows machine from the console (the screen attached to the Windows machine) or from a remote desktop client.

On Windows 8, Windows 8.1, and Windows 10, more than one user can logon at the console, although only one of the logged-on users will be able to see his desktop at any time. This terminal services function is called fast user switching.

Citrix MetaFrame allows administrators to configure their WTS servers to run individual applications, and to configure each user to run different applications on different servers. Thus, instead logging on to a WTS server, a user launches preconfigured applications from his Citrix environment running on their client machine. Citrix then logs onto the appropriate WTS server and runs the application. When the user closes the application, Citrix shuts down the application, waits for all processes that were started by the application to terminate, and then logs off from the WTS server.

Notes:
1. A message file log is not maintained for each WTS logon session. Only one message log file is maintained for the WTS server.
2. When Personal Communications is used in a WTS environment, the maximum of 52 sessions (A-Z or a-z) applies to each WTS logon session. There is not a limit of 52 sessions per WTS server.

Session IDs

In simultaneous user environments such as WTS, each time a user logs on, that specific logon session is assigned a session ID. When a user logs on at the console, that session is assigned the session ID 0 (zero)—this is also called the server console session. When a user logs on from a remote desktop, the assigned session IDs begin with session 1.

SNA Node Options

Personal Communications has a number of features that allow it to fully function in simultaneous user environments. In addition, you can use specific features to control the behavior of SNA nodes in such environments.

Note: You can only have one SNA node configuration file running for each WTS server. This means that each user cannot start an independent SNA node.

The following features are available in the SNA Node Configuration utility. Refer to the online help for specific information about option settings.

Configuration Preferences

The SNA Node Configuration Edit → Preferences dialog displays the following node options:
Auto Start
This option controls whether and when an SNA node is automatically started. The settings are as follows:

- **None**
  The SNA node is never automatically started.
- **On Boot**
  The SNA node is started when the workstation is booted up.
- **User**
  The SNA node is started when any user logs onto the workstation.

Auto Stop
This option controls whether and when an SNA node is automatically stopped. The settings are as follows:

- **None**
  The SNA node is automatically stopped only when the workstation is shut down or restarted.
- **TP User**
  The SNA node is stopped when the TP user logs off the workstation.
- **User**
  The SNA node is stopped when any user logs off the workstation.
- **Last User**
  The SNA node is stopped when the last logged-on user logs off the workstation.

TP Context
An SNA Node is responsible for starting Transaction Programs (TPs). This option controls whether a TP is allowed to access a user’s desktop. The settings are as follows:

- **System**
  An SNA Node is responsible for starting Transaction Programs (TPs). The TP Context **System** value causes TPs to run with SYSTEM authority and the only workstation that can be accessed is the system console.
- **User**
  The TP Context **User** value allows a TP to access the TP User’s desktop.

The **TP User** is defined as the user who starts the SNA node. If that user logs off the workstation, the TP User becomes the user who has been logged onto the system the longest. If the SNA node was started on boot then the TP User becomes the first user who logs on.

**Note:** The TP context is ignored when a user ID is specified in the Local LU definition in the active node configuration.

Default SNA Node Configuration
You can specify a default node configuration (.acg) file.

User ID (Local LU 6.2)
When you configure a Local LU 6.2, you can specify a user ID for this Local LU. When a Transaction Program is started on a Local LU that has this user ID defined, the SNA Node attempts to give the TP access to that user’s desktop. If the user is logged on at the time, the TP context is the user ID entered in this Local LU 6.2 configuration panel.
This user ID field can also be the value **SYSTEM** (as in the TP Context configuration option). In that case, the TP is always started with a TP context value of **SYSTEM**.

---

**Trace Facility**

For simultaneous user environments such as WTS, the **APPN and APPC and Connectivity** functions are only available for users logged in as session 0.

Each user can run his own trace facility, which gives information from that user’s specific WTS logon session. However, there are trace options that enable tracing from device drivers, which are not associated with any specific WTS logon session. Thus, those options only appear on the trace facility that is started in the WTS console session (session 0).
Chapter 8. ODBC Drivers and Database Access Utility

This chapter contains information about ODBC drivers and the Database Access utility.

You can find additional information in the online help.

Overview of Open Database Connectivity (ODBC)

ODBC is an industry standard application program interface (API) that provides a solution to a common problem—how to write programs that access a Database Management System (DBMS) without making them dependent on specific DBMS designs. ODBC provides API access to SQL-accessible databases, allowing application programs to use SQL to access data from many kinds of sources. The independence of the access method from the original design of the database means that developers can design and produce a single version of an application that can work with, for example, Oracle or Sybase data, without requiring a separate version for each DBMS. Users simply add database drivers to link the application to their choice of DBMS.

ODBC is a component of the Windows Open Services Architecture (WOSA).


An ODBC driver provides an application program with standard and uniform SQL access to a DBMS database. An ODBC driver allows the designers and users of the application program to ignore the SQL differences between various DBMS systems. Figure 1 shows an overview of the Personal Communications Database Access utility and the ODBC DB2® drivers.

Figure 1. Database Access Overview

Components of ODBC

There are four components in the ODBC architecture:

• The application component defines and performs the work to be accomplished. It calls the ODBC API functions that submit SQL statements and retrieve results.

• The driver manager component loads drivers on behalf of an application.
The **driver** component processes ODBC function calls, submits SQL requests to a specific data source, and passes results to the application. The driver transforms the application's SQL syntax into the syntax expected by the driver's associated DBMS.

The **data source** component is the data to be accessed and the means for doing so, including the associated operating system, DBMS and network platform.

From the application program's perspective, the driver manager and the driver appear to be a single unit for processing ODBC function calls. Figure 2 shows the relationship between the four components:

![Diagram of ODBC Components](image)

**Figure 2. ODBC Components**

**Application Component**
An application using ODBC performs the following tasks:
- Requests a session (connection) with a data source.
- Sends SQL requests to the data source.
- Defines storage areas and data formats for the results of the SQL requests.
- Requests the results of the defined query.
- Processes errors.
- Requests commit or rollback operations for transaction control.
- Terminates the session with the data source.

Any program that accesses a DBMS, such as a spreadsheet, a mail server, or a report generator, can be designed to use ODBC.

**Driver Manager**
The driver manager is a dynamic link library (DLL), the purpose of which is to load drivers. It also performs the following functions:
- Maps a data source name to a specific driver DLL.
- Processes ODBC initialization calls.
- Provides the entry points to the ODBC functions for each driver.
- Provides parameter and sequence validation for ODBC calls.

**Driver**
A driver is a DLL that implements ODBC function calls and interacts with a data source.
The driver manager loads a driver when the application calls the SQLBrowseConnect, SQLConnect, or SQLODriverConnect function.

A driver performs the following tasks in response to ODBC function calls from an application:
- Establishes a connection to a data source.
- Submits requests to the data source.
- Translates data to or from other formats, if requested by the application.
- Returns results to the application.
- Formats errors into standard error codes and returns them to the application.
- Declares and manipulates cursors if necessary. This operation is invisible to the application unless there is a request for access to a cursor name.
- Initiates transactions of the data source. This operation is invisible to the application.

Data Source
A data source is an instance of a DBMS product and any remote operating system and the protocol required to access it.

Database Access
Database Access lets you access host or PC databases and retrieve data, using ODBC drivers. If you specify the conditions for accessing data in each window, the desired query can be created automatically. See the online help for extensive information on using the Database Access utility with the Personal Communications ODBC drivers.

From Database Access, you can perform any of the following actions:
- You can see and modify the SQL statements that are created automatically.
- You can see available database table lists.
- You can copy spreadsheet data to the clipboard.
- You can show data in the grid in the main window spreadsheet, send data to other applications (for example Lotus® 1-2-3® or Microsoft Excel), or send data to a printer.
- If you want to know the meaning of items in the windows, you can see an explanation when you click on the item and then click help.

Accessing an ODBC Data Source
To access an ODBC data source, do one of the following:
- Click on the Data Source button on the toolbar.
- Select Data Source from the query pull-down menu.

The SQL Data Source window appears.
Select the data source you want to access; then click OK.

Note: Before using Database Access, you must install the 32-bit ODBC administrator and set up the ODBC data source you wish to use.
Selecting Database Tables
To select database tables, do one of the following:
• Click on the Tables button on the toolbar.
• Select Tables from the Query pull-down.
The Tables window appears.

Joining Conditions for Multiple Tables
To join conditions for multiple tables, do one of the following:
• Click on the Join Conditions button on the toolbar.
• Select Join from the Query pull-down menu.
The Join By window appears.

Selecting Database Columns
To select database columns, do one of the following:
• Click on the Columns button on the toolbar.
• Select Columns from the Query pull-down menu.
The Columns window appears.

Selecting Query Conditions
To select query conditions for the data, do one of the following:
• Click on the Query Conditions button on the toolbar.
• Select Query Conditions from the Query pull-down menu.
The Query Conditions window appears.

Selecting Sort Conditions
To select sort conditions for each column, do one of the following:
• Click on the Order button on the toolbar.
• Select Order from the Query pull-down menu.
The Order By window appears.

Viewing the Current SQL Statement
To view the current SQL statement, do one of the following:
• Click on the SQL Statement button on the toolbar.
• Select **SQL Statement** from the Query pull-down menu.
• Click the SQL button in any window selected from the Query pull-down menu.

The SQL Statement window appears.

**Database Size Limit**

When you use Database Access, the maximum number of each value that can be displayed in the spreadsheet is as follows:

- Number of columns: 400
- Number of rows: 16350
- Column length: 2048 bytes
- Row length: 2048 bytes
- SQL statement's length: 32766 bytes

**Note:** The values shown are standard, but your PC's available resources (such as memory) can result in other limits.

When you use another application (for example Lotus 1-2-3), refer to the manual for that application because the limit might be different.
Bypass Signon Using Password Substitute (5250)

This option enables the user to bypass iSeries login screen by sending a SHA1 password substitute.

**Note:** This option works only when the QPWDLVL system value at the iSeries is either 2 or 3. A change to this system value takes effect at the next IPL. To see the current and pending password level values, use the **Display Security Attributes** (DSPSECA) command. The QRMTSIGN system value, which specifies how the system handles remote sign-on requests, also needs to be set to "*VERIFY".

The credentials are encrypted and saved in the current user's registry hive on the local computer. User will be prompted for a password in case the password stored in the registry is no longer valid. The newly entered password shall be stored in the registry and used for subsequent bypass logins.

Users can update the existing password in the registry or add a new password by using **Update registry with bypass login credentials...** menu item present in the Actions menu. This option can be used whenever an user changes the password on the host; for example, at the time of password expiry.

Starting from PCOMM V12.0, if bypass login is enabled, PCOMM prompts the user for a password in case the password stored in the registry is incorrect. The newly entered password is to be stored in the registry and used for subsequent bypass logins.

Also, there is a new menu option added to Actions menu called **Update registry with bypass login credentials...**, which allows users to update the existing password in the registry or add a new password corresponding to a particular hostname or IP address.

In case the password stored in the registry is expired and bypass login is enabled and the user logs in, the password change screen displays so that the user can set a new password.

When the user change the password successfully (registry still contains the old or expired password), log out, disconnect, and try bypass login again, the old or expired password is still taken from the registry and used for the bypass login. Due to the invalidity of the old password from the registry, the login fails for the first time and PCOMM prompts the user for new password. When the user enter the new password that has been created before reglogin, the correct password is to be stored in the registry and PCOMM reconnects using the new password.
Kerberos Services Ticket Auto-Signon

For 5250 emulator sessions, the **Bypass signon using Kerberos principal** option enables Kerberos authentication. A ticket is generated and passed to the iSeries, eServer i5, or System i5 host during TN5250 negotiation.

If the ticket is valid, authentication is completed and you will be logged onto the host. If authentication fails, a host login screen will be displayed.

**Note:** You must log into a Windows domain in order to use Kerberos authentication. Refer to the relevant Microsoft documentation for specific details.

For the Data Transfer utility, you can set the **Use Kerberos principal, no prompting** option (from **Setup → Signon Options**). This function enables Kerberos authentication, using the ticket generated by the Windows user credentials.

Certificate Express Logon

Certificate Express Logon (formerly known as Express Logon Feature or ELF) enables a Personal Communications Telnet 3270 user to securely logon to a host application without sending the User ID and password. One advantage of using this function is that it reduces the time you spend maintaining host user IDs and passwords. It also reduces the number of user IDs and passwords that the users have to remember.

To use Certificate Express Logon, the host session must be configured for SSL and client authentication. This means the client must have a valid client certificate. The SSL connection must be made to one of the supported Telnet 3270 servers.

Using Certificate Express Logon

When starting a session using Certificate Express Logon, Personal Communications establishes an SSL client authentication session with the Telnet 3270 server. During the logon process, a macro with the Certificate Express Logon information is played. Once the session is established, Personal Communications sends the application ID for the application that the user is accessing to the Telnet 3270 server. This information is contained in the logon macro. The Telnet 3270 server uses certificate information from the SSL connection and the application ID received from Personal Communications, and requests the user ID and passticket (a temporary password) from the host access control program (such as RACF®).

Personal Communications uses the macro function to put predefined substitute strings in the user ID and password fields. The Telnet 3270 server substitutes the user ID and passticket in the appropriate place in the 3270 datastream. The logon is completed.

After a Certificate Express Logon macro is recorded, it can be distributed to multiple users for playback without further modification.

Preparing to Configure Certificate Express Logon

Before you configure an Certificate Express Logon macro, you need to have the following information.

- Host application name

  Name of the host application the user is logging onto. For example, the name entered on the USSMSG10 screen.
Host access application ID
This name must match the RACF PTKTDATA (Passticket Data Profile) application name that is configured on the OS/390® (V2R10 or later) or z/OS® host. This name could be the same as the application name that the user is logging onto (for example, the name on USSMSG10). When creating PTKTDATA profiles for applications such as TSO, the application name portion of the profile will most likely not be the same. For example, RACF requires that the application ID portion of the profile name be TSO+SID. Refer to OS/390 V2R10.0 SecureWay Security Server RACF Security Administrator’s Guide or z/OS V1R1.0 SecureWay Security Server RACF Security Administrator’s Guide to determine the correct profile naming.

User ID and password for the application that you are logging on to.
During macro recording, the actual user ID and password are used. They are not recorded in the macro; only the predefined substitute strings are recorded in the macro. The Telnet 3270 server replaces the predefined substitute strings with the actual user ID and password during the logon process.

Client Security Certificate
The security certificate for the client must be stored in RACF using the RACF RACDCERT command.

- For information about using digital certificates with RACF, refer to the following books:

- For information about configuring DCAS to use RACF certificates, refer to the following books:
  - For OS/390, refer to OS/390 V2R10.0 IBM Communication Server IP Migration.
  - For z/OS, refer to z/OS V1R1.0 IBM Communication Server IP Migration.

Configuring Certificate Express Logon

Recording the Macro
You must record a macro for each host application that you want to access. You cannot log on to multiple applications with one macro. You do not have to configure SSL, and client authentication is not required on the telnet servers and OS/390 or z/OS before recording the logon macro, but you must do this before you can play the macro.

Manual Configuration of a Certificate Express Logon Macro
You can manually configure an existing Macro format file for Certificate Express Logon use. The procedure is as follows:

1. From the Action Bar, open the macro file containing the recorded keystrokes by selecting Edit → Preferences → Macro/Script.
2. Select the macro file you just recorded and then select Customize.
3. Replace the UserID recorded in the macro with two tags: the Certificate Express Logon Application ID and the UserID placeholder. The Application ID tag
consists of three words, each separated by a blank character: elf, applid, and the identifier of the host application that will be logged onto. The UserID placeholder is )USR.ID().
For example, replace "myUserID with )USR.ID().
4. Replace the Password recorded in the macro with the Certificate Express Logon Password placeholder tag )PSS.WD().
For example, replace "myPassword with )PSS.WD().

Limitations of the Logon Macro
• Automatic insertion of the user ID and password placeholders into the recorded macro requires that the password be typed into the first non-display input field. The user ID is assumed to have been entered just prior to the password. The Modified Data Tag attribute of each formatted input field is assumed to be ON only when the field has been modified by the operator.
• There is a short delay while the Telnet 3270 server acquires the passticket from the host access control facility. The amount of time is probably less than the usual delay incurred when the user enters a user ID and password. However, the user can see the macro proceed through the screens during the logon process.
• Logon Express recording requires that the host program uses 3270 field attributes to define the password field on the screen.

Problem Determination
If the client logon fails and displays the messages )USR.ID( NOT IN CP DIRECTORY, INVALID USERID, )USR.ID( PASSWORD NOT AUTHORIZED or any similar messages, check the Telnet 3270 server log for details.

Possible reasons for failures are:
• The application ID defined in the macro is not valid.
• The Telnet 3270 server could not connect to DCAS. The host might be down.
• The client certificate is not defined in RACF or it is not valid.
• The passticket has expired and could not be used to log on.
• The Telnet 3270 server completed scanning of data stream without replacing the user ID or password.
• The Telnet 3270 server or the host does not support Certificate Express Logon.
Chapter 10. Log Viewer Functions

The Personal Communications log viewer utility enables you to view, merge, sort, search, and filter information contained in message and trace logs. You can use the viewer during problem determination to work with message and trace log entries. The default name of the message log output file is PCSMSG.MLG; its file extension must be .MLG. The file extension for trace logs must be .TLG. Note that the Help per Message Log Item functionality is available only for message logs.

Viewing Message and Trace Logs

To view message or trace logs:
1. From the Administrative and PD Aids folder, click Log Viewer; or, from an active session window, click Actions → Launch → Log Viewer.
2. From the list of logged messages, click on one of the details on the log entry in the bottom pane.

Note: If the logger device driver determines that the product kernel driver-generated log is full and cannot log a message, it will create an entry in the Windows log. The information logged may include which log failed, as well as the location and reason for the failure.

Changing Message Log Size and Location

The Personal Communications log viewer utility allows you to modify the size and location of message log files, and change the name of the default message log file. The size of a log file is counted in kilobytes and can range from a minimum of 4Kb to a maximum limited only by available hard disk space.

To modify the location and size of the log:
1. From the Log Viewer main menu, click Options and then click Configure Message Log Settings... A Windows common dialog box is displayed.
2. From the dialog box, browse the directory structure and choose the destination directory and file name for the message log.
3. Using the spin control counter field, use the up and down arrows to increase or decrease the log file size (in kilobytes).
4. Select OK to save settings and exit the window.

Merging Message and Trace Logs

The Personal Communications log viewer utility allows you to open and merge message and trace log entries in the same log viewer window. You can merge any combination of message and trace log files.

- .MLG into .TLG
- .TLG into .TLG
- .TLG into .MLG
- .MLG into .MLG

To merge message and trace log files:
1. From the Log Viewer window, select the message or trace log file window where the files will be merged.
2. Click the File menu, then click Merge and choose a file to be merged.
Sorting Message and Trace Logs

The Personal Communications log viewer utility allows you to sort message and log files in ascending and descending order. To sort files in ascending order, click the column header one time, or right mouse click the data. Click the column header, or right mouse click the data a second time to sort in descending order.

Message and logs can also be sorted by selecting the data to be sorted, and right mouse clicking to display the pop-up menu. Click Sort.

Searching Personal Communications Logs

To search the log files, click Edit → Find on the Main menu.

Type your search string in the provided box. You can refine your search by checking the Match case check box if your search is to be case-specific. If you want to limit your search to only complete words, select the Match whole word only check box.

Clicking Find Next takes you to the next instance where your search string appears highlighted in the log.

Clicking Cancel will stop the search.

Filtering Personal Communications Logs

Messages can be filtered by component only. Traces can be filtered by component, by process ID, and by thread ID.

To filter the message or trace record list, do the following:
1. Decide what you want to filter by. For example, in the message log, you may want to filter your view so that it contains only messages issued by a particular component. (Filtering by component is the default.)
2. Click the left mouse button to highlight the item that has the value that you want to filter by.
3. Right click in the appropriate column list area.
4. Click Filter In, Filter Out or Sort.

Filter In allows only those items selected to be in the resulting view. Filter Out removes the selected items from the resulting view. Sort allows you to sort entries in ascending or descending order based upon the entry selected. This function works much like sorting by column header. Filters are cumulative, so you can filter the results of your first filter.

To restore your original view, click View and then Refresh, or you can press F5.
Part 3. SNA and AnyNet Topics
Chapter 11. SNA Client/Server Concepts

Terminology

**Advanced Program-to-Program Communication (APPC)**
An implementation of the SNA LU 6.2 protocol that allows interconnected systems to communicate and share the processing of programs.

**Advanced Peer-to-Peer Networking (APPN)**
An enhancement for Systems Network Architecture (SNA) networks featuring:
- Dynamic exchange of network topology information that simplifies connections, route selection, network definition, and reconfiguration
- Automated resource registration and directory lookup
- Greater distributed network control that helps to isolate the effects of single points of failure

**Common Programming Interface for Communications (CPI-C)**
Personal Communications provides support for the Common Programming Interface for Communications (CPI-C) 2.0 industry standard interface from X/Open. The CPI-C interface enables greater application portability across different platforms. By using CPI-C 2.0, APPC programming is simplified, resulting in reduced cycle time, and enhanced client/server computing capability. This support provides the capability for distributed parts of an application to converse with one another. The implementation is consistent with the Conversational function described in the IBM Open Blueprint.

**Logical Unit Address (LUA)**
System software and interfaces that supply input/output (I/O) service routines to support communications that use LU types 0, 1, 2, and 3 SNA protocols. These protocols support user defined data streams, SNA character streams, and SNA 3270 data streams. LUA services include only those services that support data communications. LUA does not supply any device emulation facilities.

**Node**
An endpoint of a link, or a junction, common to two or more links in a network. Nodes can be linked to host processors, communication controllers, cluster controllers, terminals, or workstations.

**End Node**
Provides directory and routing services for a workstation on an APPN network.

If the workstation will not be connecting from an end node to a network node server, you need to define an SNA connection.

**APPC Concepts**

Personal Communications provides Advanced Peer-to-Peer Networking (APPN) end node support for workstations, allowing them to communicate more flexibly with other systems in the network.

Personal Communications provides advanced program-to-program communications (APPC) to support communications between distributed
processing programs, called transaction programs (TPs). APPN extends this capability to a networking environment. The TPs can be located at any node in the network that provides APPC.

**Introducing APPC and CPI-C**

Advanced Program-to-Program Communication (APPC), also known as LU 6.2, is software that enables high-speed communications between programs on different computers, from portables and workstations to midrange and host computers. APPC software is available for many different IBM and non-IBM operating systems, either as part of the operating system or as a separate software package.

APPC serves as an interface between application programs and the network. When the communications application on your workstation passes information to the APPC software, APPC takes the information and sends it on to a network interface, such as a token ring adapter card. The information travels across the network to another computer, where the APPC software receives the information from the network interface. APPC puts the information back into its original format and passes it to the corresponding communications application.

APPC provides a consistent set of functions for program-to-program communications across different platforms. But, the architecture did not specify a common application programming interface (API) for implementing these functions. As a result, each operating system that supports APPC developed its own API, a set of verbs that closely resemble the operating system itself. These differences do not pose a problem if you are writing programs for two computers that use the same operating system. Most client/server applications run on different types of computers, however, to take advantage of the strengths of each computer. So, if you are designing programs for different operating systems, you must learn how to use two or more different sets of verbs.

The Common Programming Interface for Communications (CPI-C) eliminates this problem. CPI-C provides one standard set of verbs, known as CPI-C calls, for all systems that support CPI-C. As a result, you learn only one set of calls to write client/server applications for different systems.

**What Is a Transaction Program?**

The part of the communications application that initiates or responds to APPC communications is called a transaction program. A transaction program is not an entire, stand-alone program. Instead, it is the part of the program that handles transactions (exchanges of data) with another program.

When people talk with each other, we say that they are having a conversation. Likewise, the communication between two transaction programs is called a conversation.

A conversation between two programs is similar to a conversation between two people. When you have a conversation with another person, you follow unwritten rules that govern how you begin and end the conversation, take turns speaking, and exchange information. Similarly, APPC is called a protocol because it provides the rules that govern how conversations between transaction programs start and stop, which program “speaks” first, and how data is exchanged. Computers need complete and rigid rules for conversations between programs. For that reason, APPC consists of a set of well-defined and thorough rules to cover all possible communications situations.
An APPC program may have several conversations active at one time, with the same transaction program or with different transaction programs.

Every transaction program needs a partner to communicate with. Thus, transaction programs are developed in pairs called partner transaction programs.

People use different parts of speech to communicate with each other. Transaction programs are more limited in their communications; they use only verbs to communicate with each other. The verbs are the programming language you use to start, stop, and control conversations.

A transaction program consists of APPC and CPI-C verbs such as:

**ALLOCATE (CMALLC in CPI-C)**
Starts a conversation with another transaction program

**SEND_DATA (CMSEND in CPI-C)**
Sends data to the partner transaction program

**RECEIVE (CMRCV in CPI-C)**
Receives data from the partner transaction program

**DEALLOCATE (CMDEAL in CPI-C)**
Ends a conversation with another transaction program.

The APPC verbs make up the application programming interface (API) for APPC and CPI-C. In other words, these verbs represent the interface between the transaction program and the APPC software.

**What Is the Difference between APPC and APPN?**

APPC is a communications protocol that enables programs on different computers to “talk to” each other. APPC provides the interface between the programs and the networking hardware and software and defines the rules that programs use to exchange information.

Advanced Peer-to-Peer Networking (APPN) is the underlying networking protocol that routes APPC traffic through intermediate nodes in the network. For instance, when Program A uses APPC to talk to Program B, APPN finds the node where Program B is located and directs the APPC traffic through the network.

APPN includes several features that help reduce the amount of configuration required to set up and maintain a network. These features automate many tasks that are time-consuming, complicated, and error-prone. For example, if you’re installing a new workstation that uses APPN, you don’t have to set up configuration information for every workstation you want to communicate with. You simply provide the name of the computer and the address of the intermediate node that handles your traffic. APPN takes care of the rest of the information needed to route APPC traffic to and from your workstation.

If you connect to an APPN network, you simplify your own configuration and make it easier for other computers in the network to find you.

**Side Information Definitions**

Before starting a conversation with a partner program, a CPI-C program requires the following information:

- The name of the partner program
- The name of the LU on the remote computer
• The type of session used by the program
• Security information

If the CPI-C partner program uses a blank symbolic destination name, a side information definition is not necessary.

**Improving Productivity Using APPC**

The advanced features of APPC help speed the development of robust client/server applications and keep development costs low.

Client/server applications often prove to be especially challenging to the programmer. It is not enough to understand the details about the computer and operating system that your application uses. If you’re designing client/server applications, you have to deal with computers used by both sides of the application, as well as the intervening network. For instance, implementing effective security measures is more important and more complicated, since you must ensure security throughout the network. In addition, synchronization and error reporting are often problematic in a distributed environment, because both sides of the application must coordinate their work.

One reason that APPC has become so widely used in client/server applications is that it furnishes a complete set of useful functions like security, synchronization, and error reporting. If you use other protocols, you must build these functions in every application you write. For example, if you use NetBIOS, you must design and implement a strategy for security for each application. Not only does this approach require additional work, it may result in a number of incompatible security systems in your network. By contrast, APPC includes a common set of security services that are consistent across all APPC platforms.

Similarly, most protocols do not include synchronization functions. Synchronization is required by any program that cannot continue processing data until the data sent to the partner program has been received and processed. Rather than writing your own synchronization routine, APPC provides a Confirm call that you can use to handle synchronization between two programs.

**Improving Productivity Using CPI-C**

Because many client/server applications are distributed between mainframe systems and workstations, host programmers and workstation programmers must work together to develop partner applications. CPI-C bridges the gap between these programmers by providing a common language for designing the communications part of the applications. CPI-C also enables you to write the communications portion of an application without knowing the details of the operating system. After you write a CPI-C application, you can easily move the programs from one operating system to another with few changes. So, by using the CPI-C interface, you can port both your applications and your programming skills from one system to another, quickly and cost-effectively.

**What Is a Logical Unit?**

Every TP gains access to an SNA network through a logical unit (LU). An LU is SNA software that accepts verbs from your programs and acts on those verbs. A TP issues APPC verbs to its LU. These verbs cause commands and data to flow across the network to a partner LU. An LU also acts as an intermediary between
the TPs and the network to manage the exchange of data between TPs. A single LU can provide services for multiple TPs. Multiple LUs can be active in the node simultaneously.

**LU Types**

Personal Communications supports LU types 0, 1, 2, 3, and 6.2. LU types 0, 1, 2, and 3 support communication between host application programs and different kinds of devices, such as terminals and printers.

LU 6.2 supports communications between two programs located at type 5 subarea nodes, type 2.1 peripheral nodes, or both, and between programs and devices. APPC is an implementation of the LU 6.2 architecture.

Communication occurs only between LUs of the same LU type. For example, an LU 2 communicates with another LU 2; it does not communicate with an LU 3.

When Personal Communications is configured, your local and partner LUs are defined once for each machine. When you design programs, you must understand the capabilities supported by the LU in the particular machines you plan to use.

**Dependent and Independent LUs**

A dependent LU depends on a system services control point (SSCP) to activate a session. A dependent LU needs an active SSCP-LU session, which the dependent LU uses to start an LU-LU session with an LU in a subarea node. A dependent LU can have only one session at a time with the subarea LU. For communications with a TP at a subarea node, each dependent LU can have only one conversation at a time, and each dependent LU can support communications for only one TP at a time.

An independent LU does not depend on an SSCP to activate a session. An independent LU supports multiple concurrent sessions with other LUs in a subarea node, so you can have multiple conversations and support multiple TPs for communications with subarea TPs. LUs between peripheral nodes also use this support.

The distinction between a dependent LU and an independent LU is meaningful only when discussing a session between an LU in a peripheral node and an LU in a subarea node. Otherwise, dependent and independent LUs both support multiple concurrent sessions and conversations when communicating between type 2.1 peripheral nodes, for example, between two Windows workstations. A Personal Communications LU can support a single session with a dependent LU or multiple sessions with an independent LU.

**What Is a Session?**

Before TPs can communicate with each other their LUs must be connected in a mutual relationship called a session. A session connects two LUs, so it is called an LU-LU session. Figure 3 on page 94 illustrates this communication relationship. Multiple, concurrent sessions between the same two LUs are called parallel LU-LU sessions.
Sessions act as conduits that manage the movement of data between a pair of LUs in an SNA network. Specifically, sessions deal with things such as the quantity of data transmitted, data security, network routing, and traffic congestion.

Sessions are maintained by their LUs. Normally, your TPs do not deal with session characteristics. You define session characteristics when you:

- Configure your system
- Use the Session Services function in the Subsystem Management windows
- Use the management verbs

**What Is a Conversation?**

The communication between TPs is called a *conversation*. Conversations occur across LU-LU sessions. A conversation starts when a TP issues an APPC verb or CPI-C call that allocates a conversation. The conversation style associated with the conversation indicates the style of data transfer to be used, two-way alternate or two-way simultaneous. A conversation that specifies a two-way alternate style of data transfer is also known as a *half-duplex* conversation. A conversation that specifies a two-way simultaneous style of data transfer is referred to as a *full-duplex* conversation.

When a half-duplex conversation is allocated to a session, a send-receive relationship is established between the TPs connected to the conversation, and a two-way alternate data transfer occurs where information is transferred in both directions, one direction at a time. Like a telephone conversation, one TP calls the other, and they “converse”, one TP talking at a time, until a TP ends the conversation. One TP issues verbs to send data, and the other TP issues verbs to receive data. When it finishes sending data, the sending TP can transfer send control of the conversation to the receiving TP. One TP decides when to end the conversation and informs the other when it has ended.

When a full-duplex conversation is allocated to a session, both TPs connected to the conversation are started in send-and-receive state, and a two-way simultaneous data transfer occurs where information is transferred in both directions at the same time. Both TPs may issue verbs to send and receive data simultaneously with no transfer of send control required. The conversation ends when both TPs indicate they are ready to stop sending data, and each TP has received the data sent by the partner. If an error condition occurs, one TP may decide to end both sides of the conversation abruptly.

Conversations can exchange control information and data. The TP should select the conversation style best suited for its application.
A Conversation between Two TPs

Figure 4 shows a conversation between two TPs as it occurs over a session.

Figure 4. A Conversation between Two TPs

A session can support only one conversation at a time, but one session can support many conversations in sequence. Because multiple conversations can reuse sessions, a session is a long-lived connection compared to a conversation. When a program allocates a conversation and all applicable sessions are in use, the LU puts the incoming Attach (allocation request) on a queue. It completes the allocation when a session becomes available.

Two LUs can also establish parallel sessions with each other to support multiple concurrent conversations. A parallel session occurs when either TP allocates a conversation, and a session exists but is being used by a conversation. The LU can request a new session to satisfy the allocation.

Parallel Sessions between LUs

Figure 5 shows three parallel sessions between two LUs; each session carries a conversation.

Figure 5. Parallel Sessions between LUs

SNA Communications

Personal Communications supports Systems Network Architecture (SNA) type 2.1 nodes (including SNA type 2.0 and SNA type 2.1 support for LUs other than SNA LU 6.2). This support lets you write programs to communicate with many other IBM SNA products.

You can write programs without knowing the details of the underlying network. All you need to know is the name of the partner LU; you do not need to know its location. SNA determines the partner LU location and the best path for routing data. A change to the underlying network, such as a physical address change, the
addition of a new adapter, or the relocation of a machine, does not affect APPC programs. A program might, however, need to establish link connections over switched SDLC connections.

When Personal Communications starts, it establishes local LU and logical link definitions, which are stored in a configuration file. The system management application programming interface (API) provides functions that control configuration definition and adapter and link activation.

**SNA Node Operations**

With SNA Node Operations, either a user or system administrator can display information or take action on node resources that are known to the active node.

The following tasks are supported:
- Starting and stopping resources
- Deleting resources
- Displaying resource information
- Changing session limits
- Initiating path switches

For more information about SNA node operations, see Chapter 13, “SNA Node Operations,” on page 115 or refer to the online help.
Chapter 12. AnyNet SNA over TCP/IP

This chapter describes the AnyNet SNA over TCP/IP function of Personal Communications.

What Does AnyNet SNA over TCP/IP Do?

SNA over TCP/IP is one of the IBM AnyNet software offerings. AnyNet software enables application programs to communicate over different transport networks and across interconnected networks. Using AnyNet, you can reduce the number of transport networks and therefore reduce operational complexity. These benefits are gained without modification to your existing application programs or hardware.

The AnyNet function in Personal Communications enables SNA applications to communicate over an IP network. This includes the Personal Communications emulators, both 3270 and 5250, as well as APPC and CPI-C applications.

The following network configurations illustrate how SNA over TCP/IP access nodes and gateways can be used.

Running APPC or CPI-C Applications over a TCP/IP Network

Figure 6 illustrates how you can use the AnyNet SNA over TCP/IP function of Personal Communications to enable communication between SNA applications over an IP network. Configuration information for a similar configuration is provided in Quick Beginnings.

Using AnyNet to Connect SNA Applications on Different Platforms

Figure 7 on page 98 illustrates some of the many products with AnyNet SNA over TCP/IP function. AnyNet gateways (Node F) allow SNA applications to communicate across a combination of TCP/IP and SNA networks.
Chaining Gateways to Connect Multiple SNA and IP Networks

Chained gateways enable the SNA network to connect multiple IP networks.

**Note:** While Figure 8 shows three networks connected, the number of networks that can be concatenated is unlimited.

![Figure 8. Chaining Multiple Gateways to Connect Multiple IP Networks](image)

5250 Emulation over a TCP/IP Network

Figure 9 illustrates how AnyNet enables 5250 emulation over a TCP/IP network. Configuration instructions for this example are provided in *Quick Beginnings*.

![Figure 9. 5250 Emulation over a TCP/IP Network](image)

APPC3270 Emulation over a TCP/IP Network

AnyNet also enables APPC3270 emulation over a TCP/IP network. See Figure 10 on page 99. Configuration instructions for this example are given in *Quick*.
Beginnings.

Figure 10. APPC3270 Emulation over a TCP/IP Network

3270 Emulation via DLUR over a TCP/IP Network

Figure 11 illustrates how you can use the AnyNet SNA over TCP/IP function of Personal Communications to enable 3270 emulation over a TCP/IP network. Node B, an access node, is defined as a dependent LU requester (DLUR). Configuration instructions for this example are provided in Quick Beginnings.

Node A: VTAM

VTAM

• AnyNet SNA over TCP/IP
• DLUS

Node B: Windows NT

Personal Communications

• DLUR
• AnyNet SNA over TCP/IP

Figure 11. 3270 Emulation via DLUR over a TCP/IP Network

3270 Emulation over a TCP/IP Network via an SNA Gateway to a VTAM Host on an SNA Network

Figure 12 on page 100 illustrates a configuration that supports dependent LU communications for downstream workstations to a subarea host. In this example, Node B is configured for dependent LU communication over AnyNet to a zSeries host. Configuration instructions for this example are provided in Quick Beginnings.
3270 Emulation over a TCP/IP Network via an SNA Gateway to a VTAM Host on an APPN Network

Figure 13 illustrates a configuration that supports dependent LU communication for downstream workstations to an APPN host. The configuration of Node C is the same as that of Node B in the previous example, but the VTAM® host and the OS/2 gateway are connected to an APPN network.

3270 Emulation via an SNA Gateway over a TCP/IP Network

Figure 14 on page 101 illustrates a configuration that supports dependent LU communication for downstream workstations over a single IP network. All three machines are running AnyNet SNA over TCP/IP. As in the previous example, Node A is a dependent LU server (DLUS), and Node B is a dependent LU requester (DLUR). Configuration instructions for this example are given in *Quick Beginnings*.
How Does SNA over TCP/IP Work?

SNA over TCP/IP uses protocols that bypass the lower transport layers of the SNA architecture. This process is transparent to the SNA application program. Using a supported API, an application program passes data to the presentation services of Personal Communications. This data, in turn, is passed through the SNA architectural layers and presented to SNA over TCP/IP at the data link control level. When Personal Communications initiates a session for an application program, SNA over TCP/IP translates the SNA routing information (network-qualified name) into IP routing information (IP address) and uses the IP address to create a TCP connection to the appropriate system.

Figure 15 illustrates how an SNA over TCP/IP access node enables SNA application programs to communicate over IP networks.

The configuration information you define enables SNA over TCP/IP to determine:
- Whether to route the data using SNA or to route the data using IP
- The IP address associated with the network-qualified LU name
SNA over TCP/IP uses both stream (TCP) and datagram (UDP) sockets that are bound to the well-known port (397). Any information received over this port is routed to AnyNet.

Mapping SNA Resources to IP Addresses

SNA over TCP/IP access nodes must determine the IP address of the partner before an SNA session can be established. The SNA identifier of the partner is mapped to an IP address using the following steps:

1. SNA over TCP/IP receives the SNA identifier from Personal Communications in one of the following formats:
   - For LU names, netid.luname
   - For CP names, netid.cpname
2. SNA over TCP/IP takes the identifier and generates a domain name:
   - For LU names, luname.netid.snasuffix
   - For CP names, cpname.netid.snasuffix

Note: The default value for snasuffix is SNA.IBM.COM. For additional information on the SNA domain name suffix, refer to the online help.

Figure 16 shows examples of domain names generated by SNA over TCP/IP.

Defining Domain Names and IP Addresses

This section describes the TCP/IP name resolution function, used by AnyNet to map SNA resources to IP addresses. This function queries both the local HOSTS file and any domain name servers to convert a domain name (for example, lu1.netal.sna.ibm.com) into an IP address (for example, 10.1.1.1).

HOSTS File

You can use TCP/IP HOSTS files to define domain names and IP addresses for your network. However, as your network becomes larger and maintaining the HOSTS file on each user workstation becomes too time-consuming, it is recommended that you use a domain name server.

The HOSTS file lists:
- IP address
- Domain name
- Other aliases for the domain name
For example, if your IP address is 10.1.1.1, network ID is NETA1, SNA resource name is LUA1, and SNA domain name suffix is the default (sna.ibm.com), enter the following in your HOSTS file:

```
10.1.1.1 lua1.neta1.sna.ibm.com
```

**Domain Name Server**
Domain names and IP addresses can also be defined in the domain name server database.

Each SNA identifier is mapped to a corresponding IP address by a domain name server. The location of these servers is configured in the Network section of the Control Panel.

For more information on HOSTS files and domain name servers, refer to your TCP/IP documentation. If your workstation is using the TCP/IP support in Windows 8, Windows 8.1, Windows 10, and Windows Server 2008, refer to the online TCP/IP documentation that is included with the Windows products.

---

### Defining Unique CP Names and Connection Network Names

For configurations that have two or more SNA over TCP/IP gateways connecting an SNA network with two or more IP networks, you must define a unique SNA control point (CP) name and a unique SNA connection network name for each IP network.

All LUs that reside on access nodes in the IP network appear to reside on a node with this CP name.

Use the reverse data file of the domain name server or the HOSTS file to define the CP name and the connection network name for a given IP network. Map the IP address 127.0.0.3 to the CP name and map the IP address 127.0.0.4 to the connection network name.

The following example shows entries in the reverse data file. For an IP network with SNA network ID NETA, CP name MYCPNAME, and connection network name MYCNET, you would define the following entries:

```
127.0.0.3 NETA.MYCPNAME.
127.0.0.4 NETA.MYCNET.
```

**Notes:**
1. A period is required at the end of the name only if the definition is in the DNS reverse data file. No period is used in HOSTS file definitions.
2. Do not include the SNA domain name suffix.

The AnyNet SNA over TCP/IP function of Personal Communications provides a default CP name ($ANYNET.$GWCP) and a default connection network name ($ANYNET.$GWCNET). In configurations with one IP network, you can use the default by not defining a CP name or a connection network name. In configurations with multiple gateways connecting multiple IP networks, one IP network can use the default. You must, however, define a unique CP name and connection network name for all other IP networks.

[Figure 17 on page 104](#) shows how to define the CP name and the connection network name for a configuration with two IP networks. An example is provided in *Quick Beginnings*. 

---

Chapter 12. AnyNet SNA over TCP/IP 103
Setting and Modifying the Routing Preference Protocol

When an SNA application initiates a session, Personal Communications must first determine which transport to use, either SNA, IP, or a combination of the two.

Personal Communications uses the default routing preference for the session unless there is a specific routing preference set for the partner LU. Personal Communications then sets up a session for the partner LU using the preferred transport.

If the partner is not available through the preferred transport, Personal Communications can reroute the session request over the other available transport, depending on the setting in the routing preference table. For example, if the setting in the routing preference table for the destination LU is nonnative first, Personal Communications will attempt to set up the session over TCP/IP. If the partner is not available through TCP/IP, Personal Communications will route the session over SNA. However, if the setting in the routing preference table for the destination LU is nonnative only, Personal Communications will attempt to set up the session over TCP/IP. If TCP/IP is not available, Personal Communications will not route the session over SNA, because the setting allows only Personal Communications to use nonnative transport.

The routing preference table is used only for new sessions. Previously existing sessions use the same transport; they are not brought down and rerouted if the routing preference table is changed.

You can set or modify the default routing preference to one of the following:

Native first
Requests are routed over SNA. If no SNA route is available, requests are routed over TCP/IP.

Nonnative first
Requests are routed over TCP/IP. If no TCP/IP route is available, requests are routed over SNA.
Native only
Requests are routed only over SNA. If no SNA route is available, the connection will fail.

Nonnative only
Requests are routed only over TCP/IP. If no TCP/IP route is available, the connection will fail.

Helpful Hints
This section contains helpful hints on tuning, TCP/IP connectivity via SLIP or PPP, and dynamic IP addresses.

Tuning
If you can access an LU through multiple SNA over TCP/IP gateways, and you have mapped that LU name to multiple IP addresses, increase the Connection retry duration and Connection wait time limit when configuring the AnyNet base parameters. This ensures that TCP attempts to connect to all possible adapters and gateways. It can take as long as 90 seconds for a TCP connection to fail to an inactive IP address.

Connecting to iSeries, eServer i5, or System i5
If you are unable to connect to iSeries, eServer i5, or System i5 using SNA over TCP/IP, use the following procedure:
1. Make sure that the ANYNET support on the iSeries, eServer i5, or System i5 is activated. Issue the command DSPNETA on the iSeries, eServer i5, or System i5 and make sure the ANYNET status is yes.
2. Edit the HOSTS file on the PC, mapping the IP address to the CP name of the iSeries, eServer i5, or System i5.
3. Reboot the PC; the SNA over TCP/IP connection is then activated.

Dynamic IP Addresses
Generally, AnyNet SNA over TCP/IP depends on SNA resources (for example, LU names, CP names, or idblk/num) being statically mapped to IP addresses. However, depending on your configuration and how your connections are initiated, you might be able to use AnyNet SNA over TCP/IP in environments where IP addresses are dynamically assigned (for example, DHCP).

APPC or CPI-C Applications
An SNA over TCP/IP access node with a dynamically assigned IP address may always initiate sessions to another SNA over TCP/IP access node or gateway with a static IP address.

The only way an SNA over TCP/IP access node or gateway with a static IP address (node A) can initiate a session to a partner with a dynamic IP address (node B) is:
• Node B initiated a session to or through node A first.
• The session initiated in Step 1 is still active.

Dependent LU Applications
Note: The information in this section applies to LU 0, 1, 2, 3, or dependent 6.2 applications.
SNA over TCP/IP access nodes with dynamically assigned IP addresses can support dependent LU communications if the following criteria are met.

- Dependent LU communication is occurring through an SNA gateway either through:
  - Communications Manager/2: V5 or later
  - Communications Server for Windows: 5.0 or later
- The SNA over TCP/IP access node with a dynamically assigned IP address initiates connections to an SNA gateway with a static IP address.

Dependent LU communication through DLUS/DLUR over AnyNet SNA over TCP/IP is not supported if the DLUR node has a dynamically assigned IP address.

**AnyNet Configuration Examples**

This section includes examples of AnyNet running SNA over IP connections. In all examples, the SNA domain name suffix is SNA.IBM.COM.

**Example 1. 5250 Emulation Over a TCP/IP Network**

Follow these steps to establish communication between the Windows 2008 workstation (Node A) and the iSeries host (Node B).

For Windows 2008 Node A, do as follows:

1. Add the following entries to the local HOSTS file:
   10.1.1.1 CPNAME1.NETA.SNA.IBM.COM
2. Create a workstation profile using the Personal Communications configuration tool:
   a. Click the Start/Configure Session icon; or click Configure from the Communication menu. The Customize Communication window is displayed.
   b. Select the following options:
      - Host: iSeries
      - Interface: AnyNet
      - Attachment: TCP/IP 5250
   c. Click Configure.
   d. Click Configure Link.
   e. On the Configure Local System window, enter:
      PC Location Name: NETA.CPNAME2
On the Configure Logical Connection Windows, enter:

- **System Location Name:** NETA.CPNAME1
- f. Save your workstation profile.

For iSeries Node B, add the following entry to the local HOSTS file:

```
10.2.1.1 CPNAME2.NETA.SNA.IBM.COM
```

### Example 2. Running APPC or CPI-C Applications over a TCP/IP Network

Follow these steps to establish communication between two Windows nodes. Note that in this example, the CP names are used as LU names.

For Windows Node A, do as follows:
1. Add the following entry to the local HOSTS file:
   ```
   172.25.11.2 CP2.NETA.SNA.IBM.COM
   ```
2. Create a configuration using the Personal Communications configuration tool:
   a. Click the **SNA Node Configuration** icon; or click **Actions → Launch → SNA Node Configuration**. The Personal Communications SNA Node Configuration window is displayed.
   b. In the Configuration Options list, choose **Configure Node** and click **New**.
   c. On the Define the Node window on the Basic tab, enter:
      - **Fully qualified CP name:** NETA.CP1
      - Click **OK** to complete node configuration.
   d. Choose **Configure Devices**. In the **DLCs** list, choose **AnyNet SNA/IP** and click **New**.
   e. On the Define an AnyNet SNA over TCP/IP Device window on the Basic tab, enter:
      - **SNA domain name suffix:** SNA.IBM.COM
   f. Click the **Routing Preferences** tab:
      - **Default Routing Preference:** Nonnative only
      - Click **OK** to complete configuration of the AnyNet device.
   g. From the Personal Communications SNA Node Configuration window, click **File. Click Save as...** and enter the desired file name to save.

For Windows Node B, do as follows:
1. Add the following entry to the local HOSTS file:
2. Create a configuration using the Personal Communications configuration tool:
   a. Click the SNA Node Configuration icon; or click Actions → Launch → SNA Node Configuration. The Personal Communications SNA Node Configuration window is displayed.
   b. In the Configuration Options list, choose Configure Node and click New.
   c. On the Define the Node window on the Basic tab, enter:
      
      Fully qualified CP name: NETA.CP2
      
      Click OK to complete node configuration.
   d. Choose Configure Devices. In the DLCs list, choose AnyNet SNA/IP and click New.
   e. On the Define an AnyNet SNA over TCP/IP Device window on the Basic tab, enter:
      
      SNA domain name suffix: SNA.IBM.COM
      
   f. Click the Routing Preferences tab:
      
      Default Routing Preference: Nonnative only
      
      Click OK to complete configuration of the AnyNet device.
   g. From the Personal Communications SNA Node Configuration window, click File. Click Save as... and enter the desired file name to save.

3. Start Personal Communications on each machine.
4. Start your applications (for example APING).

Example 3. APPC3270 Emulation over a TCP/IP Network

Figure 20. APPC3270 Emulation over a TCP/IP Network

Follow these steps to establish communication between the VTAM host (Node A) and the Windows 2008 workstation (Node B).

For VTAM Node A, add the following entry to the local HOSTS file:

10.2.1.2 LUNAME2.NETA.SNA.IBM.COM

For Windows 2003 Node B, do as follows:
1. Add the following entry to the local HOSTS file:
   
   10.1.1.1 LUNAME1.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration tool:
Example 4. 3270 Emulation via DLUR over a TCP/IP Network

Follow these steps to establish communication between the VTAM Host (Node A) and the Windows 2008 workstation (Node B).

For VTAM Node A, add the following entry to the HOSTS file:

192.168.7.10  CP2.NETA.SNA.IBM.COM
192.168.7.10  DEPLU1.NETA.SNA.IBM.COM

For Windows 2008 Node B, do as follows:

1. Add the following entry to the local HOSTS file:
   192.168.7.8  CP1.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration tool:
   a. Click on the Start/Configure Session icon; or click Configure from the Communication menu. The Customize Communication window is displayed.
   b. Select the following options:
      • Host: zSeries
      • Interface: AnyNet
      • Attachment: APPC3270
   c. Click Configure.
   d. Click Configure Link.
   e. On the Configure Local System window, enter:
      PC Location Name: NETA.LUNAME2
   f. On the Configure Logical Connection window, enter:
      • System location name: NETA.LUNAME1
      • Routing Preference: Nonnative only
   g. On the Configure AnyNet Connection window, enter:
      SNA domain name suffix: SNA.IBM.COM
   h. Save your workstation profile.
Routing Preference: Nonnative only

g. On the Configure AnyNet Connection window, enter:
   SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.

Example 5. 3270 Emulation over a TCP/IP Network via a SNA Gateway to a VTAM Host on a SNA Network

For Windows Server 2008 Node A, add the following entry to the HOSTS file:

172.16.5.6 CP1.NETA.SNA.IBM.COM

Follow these steps to establish communication between the Windows 8, Windows 8.1, or Windows 10 workstation (Node B) and the VTAM host.

For Windows 8, Windows 8.1, or Windows 10 Node B, do as follows:

1. Add the following entry to the local HOSTS file:

   172.16.3.4 CP2.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration tool:
   
a. Click on the Start/Configure Session icon; or click Configure from the Communication menu. The Customize Communication window is displayed.
   
b. Select the following options:
      • Host: zSeries
      • Interface: AnyNet
      • Attachment: TCP/IP LU 0,1,2,3
   
c. Click Configure.
   
d. Click Configure Link.
   
e. On the Configure Local System window, enter:
      PC Location Name: NETA.CP1
   
f. On the Configure AnyNet Connection window, enter:
      • SNA domain name suffix: SNA.IBM.COM
      • Fully qualified CP name: NETA.CP2
   
g. Save your workstation profile.

Example 6. 3270 Emulation via an SNA Gateway over a TCP/IP Network
Follow these steps to establish communication between the Windows 8, Windows 8.1, or Windows 10 Workstation (Node C) and the VTAM host (Node A).

For VTAM Node A, add the following entry to the HOSTS file:

- 10.1.1.2 CP2.NETA.SNA.IBM.COM
- 10.1.1.2 DEPLU1.NETA.SNA.IBM.COM

For Windows Server 2008 Node B, add the following entry to the HOSTS file:

- 10.1.1.3 CP1.NETA.SNA.IBM.COM
- 10.1.1.1 CP3.NETA.SNA.IBM.COM

For Windows 8, Windows 8.1, or Windows 10 Node C, do as follows:

1. Add the following entry to the local HOSTS file:

- 10.1.1.2 CP2.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration tool:
   a. Click the Start/Configure Session icon; or click Configure from the Communication menu. The Customize Communication window is displayed.
   b. Select the following options:
      - Host: zSeries
      - Interface: AnyNet
      - Attachment: TCP/IP LU 0,1,2,3
   c. Click Configure.
   d. Click Configure Link.
   e. On the Configure Local System window, enter:
      PC Location Name: NETA.CP1
   f. On the Configure AnyNet Connection window, enter:
      - SNA domain name suffix: SNA.IBM.COM
      - Fully qualified CP name: NETA.CP2
   g. Save your workstation profile.

Example 7. 3270 Emulation over a TCP/IP Network via an AnyNet SNA/IP Gateway to a VTAM Host on an APPN Network

Figure 23. 3270 Emulation via an SNA Gateway over a TCP/IP Network
Follow these steps to establish communication between the Windows Server 2008 workstation (Node B) and the Windows 2000 workstation (Node C).

For Windows Server 2008 Node B, add the following entries to the HOSTS file:

- `192.168.1.2  CP2.NETA.SNA.IBM.COM`
- `127.0.0.2  DEPLU1.NETA.SNA.IBM.COM`
- `192.168.1.2  DEPLU1.NETA.SNA.IBM.COM`

For Windows 8, Windows 8.1, or Windows 10 Node C, do as follows:

1. Add the following entry to the local HOSTS file:

   - `192.168.1.1  CP1.NETA.SNA.IBM.COM`

2. Create a workstation profile using the Personal Communications configuration tool:
   a. Click the Start/Configure Session icon; or click Configure from the Communication menu. The Customize Communication window is displayed.
   b. Select the following options:
      - Host: zSeries
      - Interface: AnyNet
      - Attachment: TCP/IP LU 0,1,2,3 via DLUR
   c. Click Configure.
   d. Click Configure Link.
   e. On the Configure Local System window, enter:
      - PC Location Name: NETA.CP2
   f. On the Configure DLUR window, enter:
      - DLUS name: NETA.CP1
      - Routing Preference: Nonnative only
   g. On the Configure AnyNet Connection window, enter:
      - SNA domain name suffix: SNA.IBM.COM
   h. Save your workstation profile.

Example 8. 3270 Emulation from a Windows 8, Windows 8.1, or Windows 10 Workstation on Different IP Networks
Follow these steps to establish communication from the Windows 8, Windows 8.1, or Windows 10 workstation (Node A), and from Windows 8, Windows 8.1, or Windows 10 (Node D), to the VTAM Host (Node E).

For Windows 8, Windows 8.1, or Windows 10 Node A, do as follows:

1. Add the following entries to the local HOSTS file:
   
<table>
<thead>
<tr>
<th>IP Address</th>
<th>Host Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.2.4.8</td>
<td>CP5.NETB.SNA.IBM.COM</td>
</tr>
<tr>
<td>127.0.0.4</td>
<td>IPNET1.GWCNET</td>
</tr>
<tr>
<td>127.0.0.3</td>
<td>IPNET1.CP1</td>
</tr>
</tbody>
</table>

2. Create a workstation profile using the Personal Communications configuration tool:
   
   a. Click on the **Start/Configure Session** icon; or click **Configure** from the **Communication** menu. The Customize Communication window is displayed.
   b. Select the following options:
      - **Host**: zSeries
      - **Interface**: AnyNet
      - **Attachment**: TCP/IP LU 0,1,2,3 via DLUR
   c. Click on **Configure**.
   d. Click on **Configure Link**.
   e. On the Configure Local System window, enter:
      - **PC Location Name**: NETA.CP1
   f. On the Configure DLUR window, enter:
      - **DLUS name**: NETB.CP5
      - **Routing Preference**: Non-native only
   g. On the Configure AnyNet Connection window, enter:
      - **SNA domain name suffix**: SNA.IBM.COM
   h. Save your workstation profile.

For Windows Server 2008 Node B, add the following entries to the HOSTS file:

<table>
<thead>
<tr>
<th>IP Address</th>
<th>Host Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.2.4.6</td>
<td>CP1.NETA.SNA.IBM.COM</td>
</tr>
<tr>
<td>127.0.0.2</td>
<td>DEPLU1.NETA.SNA.IBM.COM</td>
</tr>
<tr>
<td>10.2.4.6</td>
<td>DEPLU1.NETA.SNA.IBM.COM</td>
</tr>
<tr>
<td>127.0.0.4</td>
<td>IPNET1.GWCNET</td>
</tr>
<tr>
<td>127.0.0.3</td>
<td>IPNET1.CP1</td>
</tr>
</tbody>
</table>

Figure 25. 3270 Emulation on Different IP Networks
For Windows Server 2008 Node C, add the following entries to the HOSTS file:

172.20.1.2 CP4.NETC.SNA.IBM.COM
127.0.0.2 DEPLU2.NETC.SNA.IBM.COM
172.20.1.2 DEPLU2.NETC.SNA.IBM.COM
127.0.0.4 IPNET2.GWCNET
127.0.0.3 IPNET2.CP2

For Windows 8, Windows 8.1, or Windows 10 Node D, do as follows:

1. Add the following entry to the local HOSTS file:

172.20.1.1 CP5.NETB.SNA.IBM.COM
127.0.0.4 IPNET2.GWCNET
127.0.0.3 IPNET2.CP2

2. Create a workstation profile using the Personal Communications configuration tool:

   a. Click the **Start/Configure Session** icon; or click **Configure** from the **Communication** menu. The Customize Communication window is displayed.

   b. Select the following options:
      * **Host**: zSeries
      * **Interface**: AnyNet
      * **Attachment**: TCP/IP LU 0,1,2,3 via DLUR

   c. Click **Configure**.

   d. Click **Configure Link**.

   e. On the Configure Local System window, enter:
      
      PC Location Name: NETC.CP4

   f. On the Configure DLUR window, enter:
      
      DLUS name: NETB.CP5
      * **Routing Preference**: Nonnative only

   g. On the Configure AnyNet Connection window, enter:
      
      SNA domain name suffix: SNA.IBM.COM

   h. Save your workstation profile.
Chapter 13. SNA Node Operations

SNA Node Operations enable you to display information and manage the node for certain Personal Communications resources, which can be useful when operating the SNA node. The following tasks are supported:

- Starting and stopping resources
- Deleting resources
- Displaying resource information
- Changing session limits
- Initiating path switches

The configuration information for an SNA Node is stored in an ASCII file, with the extension .ACG. You can edit the file by launching SNA Node Configuration. To ensure that your new configuration is correct, use the Verification tool.

You can display information or take action on resources if you start 3270, 5250, or any client/server sessions with one of the following attachment types:

**zSeries Connections**
- LAN 3270 via iSeries
- LAN via IEEE 802.2
- APPC 3270 via LAN
- Dependent Logical Unit Requester (DLUR)
- 3174 Peer Communication

**COM port**
- SNA-over-Async
- IBM Global network — SNA-over-Async
- Dependent Logical Unit Requester (DLUR) via:
  - SNA-over-Async
  - Hayes AutoSync
- APPC 3270 via:
  - SNA-over-Async
  - Hayes AutoSync
  - X.25 Hayes AutoSync
  - X.25 DLUR via Hayes AutoSync
  - X.25 APPC 3270 via Hayes AutoSync

**SDLC**
- Synchronous Data Link Control
- 3270 via iSeries (passthru)
- APPC 3270 via SDLC
- Dependent Logical Unit Requester (DLUR)

**SNA/IP**
- LU 0, 1, 2, 3
- APPC 3270
- LU 0, 1, 2, 3 via DLUR

**IBM-EEDLC**
- LU (0, 1, 2, 3) via DLUR
- APPC 3270

**OEM**
- LU (0, 1, 2, 3)
- 3270 via iSeries (passthru)
- APPC 3270
- Dependent Logical Unit Requester (DLUR)
iSeries Connections
LAN LAN via IEEE 802.2
COM port
SNA-over-Async
Hayes AutoSync
X.25 Hayes AutoSync
SDLC Synchronous Data Link Control
SNA/IP
5250
IBM-EEDLC
5250
OEM APPC 5250

Client/Server Connections
LAN LAN via IEEE 802.2
COM port
SNA-over-Async
Hayes AutoSync
X.25
SDLC Synchronous Data Link Control
AnyNet SNA over TCP/IP
APPC
Enterprise Extender
HPR over IP

SNA resources that can be displayed or managed include the following:

Connection Networks
Allows APPN nodes in a LAN to have direct links with each other without requiring logical link definitions at each node.

Connections
Link stations to the adjacent nodes.

CPI-C Side Information
Associate a set of parameters with a specified symbolic destination name.

Data Link Controls
How data is formatted for transmission on the physical connection.

Devices
Parts of the workstation hardware, such as adapters, that are used to transmit and receive data.

DLUR PUs
A dependent logical unit requester (DLUR) physical unit (PU) is a PU in an APPN end node that owns dependent LUs, but requests that a dependent LU server provide the SSCP services for those dependent LUs.

Focal Points
A system that provides centralized network management services.

Local LU 0 to 3
A local logical unit (LU) type 0, 1, 2, or 3 is a dependent LU on the workstation that provides services for 3270 terminal and printer emulation applications.

Local LU 6.2
A local logical unit (LU) type 6.2 is an independent or dependent LU that provides APPC services.
**LU 6.2 Sessions**  
Transports data between two partner LU 6.2s. Conversations between transaction programs use LU 6.2 sessions.

**Mode**  
The name used by the initiator of a session to designate the characteristics desired for the session, such as traffic pacing values, message-length limits, sync point and cryptography options, and the class of service (COS) within the transport network.

**Node**  
The control point that manages the node and its associated resources. The local node provides APPN services.

**Partner LU 6.2**  
A remote computer that communicates through an APPC session with local LU 6.2s.

**RTP Connections**  
In high-performance routing (HPR), a rapid transport protocol (RTP) connection is the connection established between the endpoints of the route to transport session traffic.

**Transaction Programs**  
A transaction program (TP) is a program that processes transactions in an SNA network. There are two kinds of TPs: application transaction programs and service transaction programs.

---

**Starting Node Operations**

To start Node Operations, click the **SNA Node Operations** icon in the Personal Communications folder; or, from an active session window, click **Actions** → **Launch** → **SNA Node Operations**.

---

**Using the Menu Bar**

From the menu bar of the SNA Node Operations utility, click one of the following:

**Operations**
To start or stop a SNA node.

To start a node, select the configuration file you want to use.

To change session limits (CNOS).

To apply a new configuration file, select the configuration file you want to use.

**Launch**
To launch to other Personal Communications programs, such as Log Viewer, Trace Facility, or SNA Node Configuration.

**View**
To modify the layout of your Personal Communications window (Tool bar or Status bar).

To select resource attributes, which allows you to customize the display of SNA resource attributes.

To view frequently used resources, such as:

- Node
- Connections
- Local LU 0 to 3
- Partner LUs
- LU 6.2 sessions
Window
To modify the layout of your Personal Communications window.

Help
To view the Personal Communications online help.

---

**Displaying a Resource**

To display a resource, select a resource from the pull-down list on the toolbar.

---

**Starting a Resource**

To start a resource:

1. Select a resource from the pull-down list on the toolbar.
2. Select the first column of the item, and right mouse click to display the pop-up menu.
3. Click Start to start the resource. A started (active) resource can be stopped, but not deleted.

---

**Stopping a Resource**

There are two ways of stopping a resource:

**Normal Stop**
Perform clean up and then stops the resource.

**Abnormal Stop**
Immediately stops the resource.

To stop a resource:

1. Select a resource from the pull-down list on the tool bar.
2. Select the first column of the item, and right mouse click to display the pop-up.
3. Select **Normal Stop** or **Abnormal Stop** to suspend the resource. If a resource is stopped (inactive), it can be deleted or redefined.

---

**Deleting a Resource**

To delete a resource:

1. Select a resource from the pull-down list on the tool bar.
2. Select the first column of the item, and right mouse click to display the pop-up.
3. Select **Delete** to delete the resource.

You should stop a resource (make it inactive) before redefining it. You do not need to delete the resource before redefining it.

---

**Changing an HPR Path Switch**

To perform a high performance routing (HPR) path switch:

1. Select **RTP connections** from the pull-down list on the tool bar.
2. Select the first column of the item, and right mouse click to display the pop-up.
3. Select **HPR path switch** to change the path for the data on this RTP connection.
Updating SNA Resources Dynamically

It is not necessary to delete an SNA resource before redefining it. A resource must be inactive, however, when you redefine it.

If a redefinition is rejected for a reason other than that the resource is active, a STATE_CHECK return code is returned as well as a specific secondary return code, as listed in the NOF specification. Most rejections are due to inconsistencies in the configuration, such as one of the following:

• Attempting to define an LS with the adjacent CP name set to the local CP name.
• Attempting to define two link stations on a non-switched port with the same destination address.

Such rejections occur regardless of whether you are defining a resource for the first time or redefining it.

Keep in mind the following when redefining resources:

• You cannot change the ls_role of a port that has link stations defined on it. The link stations must be deleted before the port role can be changed (because an LS may default to the port ls_role).
• You cannot change the type of a named DLC. The DLC definition must be deleted before the same name can be reused for a DLC of a different type.

Command-Line Utilities

Another way to perform SNA Node operations is to use the command line. Five command line programs are available to perform basic operations for the SNA Node.

CSSTART [ -p | -q | -c | -a ] [ -m | -d ] [ cfgfile ]
Use the CSSTART command to start the SNA Node with a specified configuration. The -a flag enables automatic start up after rebooting the machine. The -d flag sets the default SNA node configuration file. The -m flag stands for manual start which disables automatic start up after rebooting the machine. If the -p flag is used, all messages are shown in a message box pop-up. Messages are written to stdout by default. The -q flag suppresses all output. The -h flag summons the help data for this command. The cfgfile parameter is the name of the configuration file you want to use to start the product. If no cfgfile parameter is specified, the default configuration file is used. If no default configuration file has been set, an error is reported. If the node is successfully started, CSSTART returns zero, otherwise a nonzero value is returned.

CSSTOP [ -p | -q | -c ] [-h ]
Use the CSSTOP command to stop the SNA Node. The flags have the same meaning as for CSSTART. If the node is successfully stopped then CSSTOP returns zero, otherwise a nonzero value is returned. The -c flag convert output to Windows code page. This option is intended to use with the Tivoli-integration support for Personal Communications.

CSQUERY [ -p | -q | -c ] [-h ]
Use the CSQUERY command to query the status of the SNA Node. The flags have the same meaning as for CSSTART. Along with the status, the default and active configuration file names are shown. If the node is running, then CSQUERY returns zero; otherwise a nonzero value is
returned. The -c flag convert output to Windows code page. This option is intended to use with the Tivoli-integration support for Personal Communications.

**CSDSPY** {resource [resource_id] [/D#] [/[C] [ -h ]}

Displays information about SNA node resources, where:

**resource**
One of the following:
- **AIL** AnyNet IP to LU mapping
- **CNT** Connection networks
- **CON** Connections
- **CPS** CPI-C side information
- **DLC** Data link controls
- **DEV** Devices
- **DPU** DLUR PUs
- **FPT** Focal Points
- **LU0** Local LU 0 to 3
- **L62** Local LU 6.2
- **L6S** LU 6.2 sessions
- **MOD** Modes
- **NOD** Nodes
- **PLU** Partner LU 6.2
- **RTP** RTP connections
- **TRP** Transaction programs

**object_id**
Specifies a case-sensitive value (for example, LU001 or LINK001) to search for. Only objects whose first attribute matches this value are displayed. The object_id must be spelled correctly, including case (upper and lower). An incorrect object_id will result in nothing being displayed.

**/D#** Specifies the level of detail to display. # has the value 1, 2, or 3, where 1 displays the least level of detail and 3 shows all information. 2 is the default.

The -c flag convert output to Windows code page. This option is intended to use with the Tivoli-integration support for Personal Communications.

**CSMODIFY** {resource resource_id action} [/[C] [ -h ]}

Enables you to control SNA node resources, where:

**resource**
Is one of the following:
- **CON** Connections. You can start, stop, or delete this resource.
- **CPS** CPI-C side information. You can delete this resource.
- **DLC** Data link controls. You can start, stop, or delete this resource.
DEV Devices. You can start, stop, or delete this resource.
DPU DLUR DPUs. You can start or stop this resource.
LU0 Local LU 0 to 3. You can delete this resource unless the LU is in use.
L62 Local LU 6.2. You can delete this resource.
RTP RTP connections. You can switch the path of this resource.

object_id
Specifies a case-sensitive value (for example, LU001 or LINK001) to search for. Only objects whose first attribute matches this value are displayed. The object id must be spelled correctly, including case (upper and lower). An incorrect object id will result in an error being displayed.

action One of the following:
SN Normal stop
SI Immediate stop
ST Start
DL Delete
PS Path switch

[-h] This switch is used to summon help data for this command.
The -c flag convert output to Windows code page. This option is intended to use with the Tivoli-integration support for Personal Communications.
Chapter 14. SNA Cryptography Support

SNA session-level encryption (SLE) enables secure data transfer between nodes running SNA applications. The request units (RUs) for all the SNA traffic across the selected session are encrypted. Software encryption/decryption is implemented with the Application Manager for Data Security (AMDSEC) utility. AMDSEC is a software implementation of the Common Cryptographic Architecture verbs used by SNA Session Level Encryption (SLE). A subset of these verbs are implemented and they are the ones required to allow data confidentiality.

Because this is a complete software implementation, it will be slower than the conventional hardware-based encryption. SNA SLE is only supported for Windows Server 2008 and Windows 8, Windows 8.1, or Windows 10 platforms. Some of the supported environments are as follows:

- 3270 emulation
- APPC/CPI-C client-server applications
- APPC over TCP/IP

The key-encrypting keys can be added or accessed using the command-line utility amdsec.exe, which is available in the Personal Communications installation directory.

Enabling and Using Session-Level Encryption

Configuring Proper Key-Encrypting Keys

Enter the key-encrypting keys before performing any operation. KEKs are shared between the LUs that are going to be involved. KEKs reside in key storage (.kek file) and are used to protect data (session) keys when they are sent to the partner node or Logical Unit (LU).

The following commands are available to add or modify these keys:

**amdsec clear**

This command clears the AMDSEC key storage. All key-encrypting keys are discarded.

**amdsec pass <new passphrase>**

This command sets the AMDSEC passphrase. Using this passphrase, the key-encrypting keys are secured before they go to the storage file (by encryption). The default passphrase is **amdsec security**

**amdsec addkey <label> <key value> <key form> <option>**

amdsec adds a key-encrypted key to key storage.

- **<label>** is the key label for this KEK (up to 5 key label tokens of 8 bytes each). See "Naming Labels for KEKs" on page 124 for further details.
- **<key value>** is the KEK value. It must be 16 bytes in hexadecimal (32 hex digits), optionally separated by the - (hyphen) character.
- **<key form>** is the value importer or exporter.
- **<option>** is the value translate. Specify this option to have the translate attribute for this key.
This parameter is optional. Data key translate is required only when you are running APPN encryption.

Example:
```
amdsec addkey cm@lu@im.netid.cpnam1.netid.lunam2
   8182-d4e7-836a-4d6f-8182-d4e7-830a-4d6f importer

amdsec addkey cm@lu@ex.netid.cpnam2.netid.lunam1
   8182-d4e7-836a-4d6f-8182-d4e7-830a-4d6f exporter
```

When entering KEKs, it is often easier to edit the commands in a batch (.bat) file and then execute the command to enter your keys in key storage.

```
amdsec repkey <label> <key value> <key form> <option>
```

```
amdsec repkey cm@lu@im.netid.cpnam1.netid.lunam2
   8182-d4e7-836a-4d6f-8182-d4e7-830a-4d6f importer

amdsec repkey cm@lu@ex.netid.cpnam2.netid.lunam1
   8182-d4e7-836a-4d6f-8182-d4e7-830a-4d6f exporter
```

```
amdsec list
```

```
amdsec list
```

**Naming Labels for KEKs**

**Key Labels for Dependent LU Encryption**
The key label when implementing session level encryption for dependent LU sessions uses the following naming convention:
```
CM@LU@IM.mynet1.cpnamea.puname.locaddr
```
- **CM** is a constant prefix
- **@** is a constant delimiter
- **LU** identifies an LU key-encrypting key
- **IM** identifies an importer key-encrypting key
- **netid1 cpname1** is the fully qualified name of the local node where the key-encrypting key will be used
- **puname** is the PU name of the subarea or DLUR PU, as configured in Communications Server
- **locaddr** is the network addressable unit address or local address of the dependent LU. It has to be of the form nnn with possible values from 1 to 255 (for example, 001, 002, 003, . . . , 255)
Note: For encryption of dependent LU sessions you only need importer KEKs in the Communications Server node, because LUA sessions are always secondary.

**Key Labels for APPC Encryption**
The following key labels are used for the key-encrypting keys:

- **CM@LU@IM.netid1.cpname1.netid.luname**
- **CM@LU@EX.netid1.cpname1.netid.luname**

<table>
<thead>
<tr>
<th>Key Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM</td>
<td>a constant prefix</td>
</tr>
<tr>
<td>@</td>
<td>a constant delimiter</td>
</tr>
<tr>
<td>LU</td>
<td>identifies an LU key-encrypting key</td>
</tr>
<tr>
<td>IM</td>
<td>identifies an importer key-encrypting key</td>
</tr>
<tr>
<td>EX</td>
<td>identifies an exporter key-encrypting key</td>
</tr>
<tr>
<td>netid1.cpname1</td>
<td>the fully qualified name of the local node where the key-encrypting key will be used</td>
</tr>
<tr>
<td>netid.luname</td>
<td>the fully qualified name of the partner LU</td>
</tr>
</tbody>
</table>

Note: In APPC, an independent LU can initiate a session (primary LU) or it can be secondary when the partner LU initiates the LU 6.2 session. If the LU initiates a session, an exporter KEK is required in key storage. Otherwise, an importer KEK will be used.

**Enabling Cryptography in SNA Node Configuration**

Open the SNA Node Configuration utility (pcscfg.exe). In the Connection Configuration section of the LU you are planning to use, select the Use Cryptography option.

Note: For LU 6.2, a mode has to be defined with Use Cryptography enabled in the Configure Modes → Advanced panel. That mode has to be used while connecting to the peer LU.
Chapter 15. Multiple-Language Support

Personal Communications multiple-language support provides the capability to allow users to interact with more than a single language on their workstations. Prior versions allowed for different languages to be displayed in emulator sessions; now, the Windows graphical user interface elements of the Personal Communications user interface can be tailored to the languages of users, allowing more flexibility in configuring and using Personal Communications.

This chapter provides a basic description of these facilities. Refer to Quick Beginnings for a description of the procedures for changing your configured user interface language. The particulars of installing the support are described in Installation Guide.

Overview

There are two system-related factors which govern the usage of multiple languages by Personal Communications users:

System Locale
This is set in the Windows Regional and Language Options under the control panel applet; it determines what system user interface languages can be viewed.

Language Groups
Each system locale is associated with a language group; some groups have only one language; others support several, allowing for simultaneous viewing of applications in more than one language.

System Locale
When you choose a language on the Regional Settings (or Options) screen, a system locale is established as the basis for interacting with the system; Windows interactions of certain applications (such as Personal Communications) are governed by this setting.

Personal Communications uses the settings specified in Regional and Language Options → Advanced → Language for non-Unicode programs.

Notes:
1. Windows common dialogs, such as file open and print, may not change to match the system locale; they will be displayed in the language chosen when Windows was installed.
2. The actions needed to switch system locales depend on the languages installed and the version of Windows. Refer to your Windows documentation for details.

Language Groups
The system locale set when Windows is started determines which Windows/ANSI code page is used by applications; in turn, this code page determines which language group an application can use. The language groups and languages supported for Personal Communications user interface are:

Cyrillic
   Russian
Japanese
Japanese

Latin 1
- Brazilian-Portuguese
- Danish
- Dutch
- English
- Finnish
- French
- German
- Italian
- Norwegian
- Portuguese
- Spanish
- Swedish

Latin 2
- Czech
- Hungarian
- Polish
- Slovenian

Turkish
Turkish

Notes:
1. For Windows 8, Windows 8.1, or Windows 10, most language groups are installed by default. You can specify supplemental language support.
2. English text can be displayed for any system locale without significant corruption. Therefore, English is an implicit member of each language group.
3. There are additional languages supported for host emulation sessions; these groups only concern user interface language.

---

**Personal Communications User Interface Languages**

It is important to understand how Personal Communications uses the capability for supporting multiple languages. Like other applications, Personal Communications can use any language within the language group for which the current system locale is set. As an administrator, you have the ability to change that locale, using the Windows Regional Settings control panel applet.

There are several considerations to keep in mind:
- There is a default Personal Communications user interface language; this is set at installation, and applies to every user of the Windows system.

**Note:** This default is set to match the Windows user default locale.

- The Personal Communications user interface language is a preference that is stored per user; thus, a shared workstation can support users of different languages.
• If a user does not have a user interface language preference defined, Personal Communications uses the Personal Communications default language for that machine.
• If the user's language preference cannot be displayed (because of a language group mismatch) the user interface is in the Personal Communications default language; a warning is displayed.
• If the Personal Communications default language is incompatible with the system language, English is used as the default.
• Each user in a client/server or Windows Terminal Server (WTS) environments can have his own Personal Communications user interface language.

Multiple Sessions

It is possible to open multiple Personal Communications emulation sessions simultaneously; in previous versions of Personal Communications these sessions could interact with hosts of different languages.

It is also possible to have simultaneous sessions with different user interface languages; this is only possible for languages within a language group. In order to do this, you start a session in one language, then change the Personal Communications configuration to another language; when you then start a new session, it will use the newly selected language.

Other Considerations

To prevent the generation of log files in several languages the Personal Communications log file is recorded in the default Personal Communications user interface language.

Some of the Personal Communications components (such as LLC2 drivers) do not require multiple-language support; they only use the default Personal Communications language.

Some Personal Communications components (the keyboard customizer, keypad, play/record, copy/paste and macro components, for example) record, store, and insert language-sensitive text into Personal Communications sessions. It should be noted that text created in one language group may be corrupted and meaningless when inserted in a session running under another language group. For instance, keyboard customizer text created on a Japanese Personal Communications configuration will not be readable on a French configuration.
Chapter 16. Country Codes and Character Sets

This chapter contains information useful in providing national language support for a network station or a gateway.

Table 3. Supported Keyboard Types

<table>
<thead>
<tr>
<th>Keyboard Type</th>
<th>Figure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Saving (single row of function keys; no numeric keypad)</td>
<td><img src="image" alt="Figure" /></td>
</tr>
<tr>
<td>Enhanced and Microsoft Natural (single row of function keys; numeric keyboard)</td>
<td><img src="image" alt="Figure" /></td>
</tr>
<tr>
<td>5576-001 (Japanese keyboard with double row of function keys; numeric keypad)</td>
<td><img src="image" alt="Figure" /></td>
</tr>
<tr>
<td>5576-002 (Japanese keyboard with single row of function keys; numeric keypad)</td>
<td><img src="image" alt="Figure" /></td>
</tr>
<tr>
<td>5576-003 (Japanese keyboard with single row of function keys; no numeric keypad)</td>
<td><img src="image" alt="Figure" /></td>
</tr>
<tr>
<td>5576-A01 (Japanese keyboard with single row of function keys; numeric keypad)</td>
<td><img src="image" alt="Figure" /></td>
</tr>
</tbody>
</table>
Keyboard Country ID and Shift Support

Table 4 shows the keyboard country ID and shift support for each country.

Table 4. Keyboard Country ID and Shift Support

<table>
<thead>
<tr>
<th>Keyboard Country</th>
<th>Enhanced Keyboard ID</th>
<th>Enhanced Keyboard-Lock Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arabic-speaking</td>
<td>238, 239, 240, 253, 254</td>
<td>C</td>
</tr>
<tr>
<td>Austria</td>
<td>129</td>
<td>S</td>
</tr>
<tr>
<td>Baltic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Estonia</td>
<td>442</td>
<td>C</td>
</tr>
<tr>
<td>Latvia</td>
<td>463</td>
<td>C</td>
</tr>
<tr>
<td>Lithuania</td>
<td>449</td>
<td>C</td>
</tr>
<tr>
<td>Belgium</td>
<td>120</td>
<td>S</td>
</tr>
<tr>
<td>Brazil</td>
<td>275</td>
<td>C</td>
</tr>
<tr>
<td>Canada (Bilingual)</td>
<td>058</td>
<td>C</td>
</tr>
<tr>
<td>Canada (445)</td>
<td>445</td>
<td>C</td>
</tr>
<tr>
<td>Cyrillic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bulgaria</td>
<td>442</td>
<td>C</td>
</tr>
<tr>
<td>Belarus</td>
<td>463</td>
<td>C</td>
</tr>
<tr>
<td>FYR Macedonia</td>
<td>449</td>
<td>C</td>
</tr>
<tr>
<td>Russia (441)</td>
<td>441</td>
<td>C</td>
</tr>
<tr>
<td>Russia (443)</td>
<td>443</td>
<td>C</td>
</tr>
<tr>
<td>Serbia / Montenegro</td>
<td>450</td>
<td>C</td>
</tr>
<tr>
<td>Ukraine</td>
<td>465</td>
<td>C</td>
</tr>
<tr>
<td>Denmark</td>
<td>159</td>
<td>C</td>
</tr>
<tr>
<td>Finland</td>
<td>153</td>
<td>C</td>
</tr>
<tr>
<td>France (120)</td>
<td>120</td>
<td>C</td>
</tr>
<tr>
<td>France (189)</td>
<td>189</td>
<td>S</td>
</tr>
<tr>
<td>Germany</td>
<td>129</td>
<td>S</td>
</tr>
<tr>
<td>Greece</td>
<td>319</td>
<td>C</td>
</tr>
<tr>
<td>Iceland</td>
<td>197</td>
<td>C</td>
</tr>
<tr>
<td>Israel</td>
<td>115</td>
<td>C</td>
</tr>
<tr>
<td>Italy (141)</td>
<td>141</td>
<td>C</td>
</tr>
<tr>
<td>Italy (142/293)</td>
<td>142</td>
<td>C</td>
</tr>
<tr>
<td>Japan</td>
<td>–</td>
<td>C</td>
</tr>
<tr>
<td>Laos</td>
<td>466</td>
<td>C</td>
</tr>
<tr>
<td>Latin America (Spanish)</td>
<td>171</td>
<td>C</td>
</tr>
<tr>
<td>Latin 1 (Open Systems)</td>
<td>1047</td>
<td>697</td>
</tr>
<tr>
<td>Latin 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bosnia / Herzegovina (Latin)</td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Croatia</td>
<td>234</td>
<td>C</td>
</tr>
<tr>
<td>Czech Republic</td>
<td>234</td>
<td>C</td>
</tr>
<tr>
<td>Hungary</td>
<td>243</td>
<td>C</td>
</tr>
<tr>
<td>Poland</td>
<td>208</td>
<td>C</td>
</tr>
<tr>
<td>Romania (Moldavia)</td>
<td>457, 214</td>
<td>C</td>
</tr>
<tr>
<td>Slovakia</td>
<td>446</td>
<td>C</td>
</tr>
<tr>
<td>Slovenia</td>
<td>245</td>
<td>C</td>
</tr>
<tr>
<td></td>
<td>234</td>
<td>C</td>
</tr>
</tbody>
</table>
Table 4. Keyboard Country ID and Shift Support (continued)

<table>
<thead>
<tr>
<th>Keyboard Country</th>
<th>Enhanced Keyboard ID</th>
<th>Enhanced Keyboard-Lock Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Netherlands</td>
<td>143</td>
<td>C</td>
</tr>
<tr>
<td>Norway</td>
<td>155</td>
<td>C</td>
</tr>
<tr>
<td>Portugal</td>
<td>163</td>
<td>C</td>
</tr>
<tr>
<td>Spain</td>
<td>173</td>
<td>C</td>
</tr>
<tr>
<td>Sweden</td>
<td>153</td>
<td>C</td>
</tr>
<tr>
<td>Switzerland (French)</td>
<td>150F</td>
<td>C</td>
</tr>
<tr>
<td>Switzerland (German)</td>
<td>150G</td>
<td>C</td>
</tr>
<tr>
<td>Turkey (179/402)</td>
<td>179</td>
<td>C</td>
</tr>
<tr>
<td>Turkey (440)</td>
<td>440</td>
<td>C</td>
</tr>
<tr>
<td>U.K. (166)</td>
<td>166</td>
<td>C</td>
</tr>
<tr>
<td>U.K. (168)</td>
<td>168</td>
<td>C</td>
</tr>
<tr>
<td>U.S. (English)</td>
<td>101G</td>
<td>C</td>
</tr>
<tr>
<td>Vietnam</td>
<td>461</td>
<td>C</td>
</tr>
</tbody>
</table>

Note:
- Not selectable
S Shift lock on key 30
C Caps lock on key 30
IBM Japanese Character Set (2-Byte Codes)

The IBM Japanese character set defines characters that consist of 2-byte codes.

**Character Types**

The following characters are included in this character set:

- Basic kanji set
- Basic non-kanji set: alphabet, numerals, Katakana, Hiragana, symbols, and space
- Extended kanji set
- New extended kanji set
- New extended non-kanji set
- Extended non-kanji set: Roman numerals, Greek alphabet, and Russian alphabet

In addition to these characters, you can define up to 1880 (6205 for extended Unicode subset) user-defined characters.

**Character Size**

A kanji character is displayed on the screen using the area of two SBCS characters; it is usually enclosed with the shift characters hex 0E and hex 0F. Similarly, when a kanji character is printed, it uses the area of two SBCS printed characters. This size is equivalent to double the area used by alphabetic, numeric, and Katakana characters when they are displayed or printed.

**IBM Kanji Codes**

The following tables show the relationship between kanji and IBM kanji codes.

*Table 5. IBM Japanese Character Set and IBM Kanji Codes*

<table>
<thead>
<tr>
<th>1st byte (hex)</th>
<th>2nd byte (hex)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td>41... FE</td>
<td>Reserved area</td>
</tr>
<tr>
<td>40</td>
<td>space</td>
<td>Reserved area</td>
</tr>
<tr>
<td>41</td>
<td>Extended non-kanji set</td>
<td>134 characters</td>
</tr>
<tr>
<td>42</td>
<td>Basic kanji set (includes space)</td>
<td>416 characters</td>
</tr>
<tr>
<td>44</td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Basic kanji set</td>
<td>3226 characters</td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>Extended kanji set</td>
<td>3487 characters</td>
</tr>
<tr>
<td>68</td>
<td>User-defined characters</td>
<td>1880 characters</td>
</tr>
<tr>
<td>7F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td>Reserved area</td>
<td></td>
</tr>
<tr>
<td>FE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Table 6. IBM Japanese Character Set and IBM Kanji Codes (Extended for Unicode Subset)**

<table>
<thead>
<tr>
<th>1st byte (hex)</th>
<th>2nd byte (hex)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td>41...</td>
<td>...FE</td>
</tr>
<tr>
<td>40</td>
<td>space</td>
<td>Reserved area</td>
</tr>
<tr>
<td>41</td>
<td></td>
<td>Extended non-kanji set</td>
</tr>
<tr>
<td>42...</td>
<td></td>
<td>Basic kanji set</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(includes space)</td>
</tr>
<tr>
<td>44</td>
<td></td>
<td>416 characters</td>
</tr>
<tr>
<td>45...</td>
<td></td>
<td>Basic kanji set</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3226 characters</td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
</tr>
<tr>
<td>56...</td>
<td></td>
<td>Extended kanji set</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3478 characters</td>
</tr>
<tr>
<td>68</td>
<td></td>
<td></td>
</tr>
<tr>
<td>69...</td>
<td></td>
<td>User-defined characters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6205 characters</td>
</tr>
<tr>
<td>87</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B7</td>
<td></td>
<td>New extended kanji set</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5522 characters</td>
</tr>
<tr>
<td>88</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5</td>
<td></td>
<td>New extended non-kanji set</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2035 characters</td>
</tr>
<tr>
<td>EA</td>
<td></td>
<td>Reserved area</td>
</tr>
<tr>
<td>FE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** These tables do not show that all characters have a kanji code assigned. Each kanji character has a kanji number in addition to the IBM kanji code A kanji number is a decimal number up to five digits in length, which is used for entering a kanji-like symbol from keyboards that do not have “YOMI”.

Following is the relationship between IBM kanji codes and kanji numbers:

kanji number = converted value of ((IBM kanji code) - x'4000')

All kanji characters can be entered using kanji numbers.

**IBM Traditional Chinese Character Set**

**Table 7. IBM Traditional Chinese Host Code**

<table>
<thead>
<tr>
<th>Number of Characters</th>
<th>Code Range</th>
<th>Low-Byte Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBCS Space</td>
<td>X'4040'</td>
<td></td>
</tr>
<tr>
<td>DBCS Symbols</td>
<td>X'4141' - X'4959'</td>
<td>X'41' - X'FD', skipping X'7F'</td>
</tr>
<tr>
<td>Primary Chinese</td>
<td>X'4C41' - X'68CB'</td>
<td>X'41' - X'FD', skipping X'7F'</td>
</tr>
</tbody>
</table>
Table 7. IBM Traditional Chinese Host Code (continued)

<table>
<thead>
<tr>
<th>Number of Characters</th>
<th>Code Range</th>
<th>Low-Byte Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Chinese</td>
<td>X'6941' - X'91C7'</td>
<td>X'41' - X'FD', skipping X'7F'</td>
</tr>
<tr>
<td>User-Defined Area</td>
<td>X'C241' - X'E2FD'</td>
<td>X'41' - X'FD', skipping X'7F'</td>
</tr>
</tbody>
</table>

**IBM Simplified Chinese Character Set, GBK Code**

Table 8. IBM Simplified Chinese Character Set, GBK Code

<table>
<thead>
<tr>
<th>Number of Characters</th>
<th>Host Code Range</th>
<th>PC Code Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBCS Space</td>
<td>X'4040'</td>
<td>X'A1A1'</td>
</tr>
<tr>
<td>GB 2312-80 Non-Chinese Character Set (GBK/1)</td>
<td>X'4141'-'X'47FE' (737)</td>
<td>X'A1A1'-'X'9FE' (846)</td>
</tr>
<tr>
<td>GB 2312-80 Chinese Character Set (GBK/2)</td>
<td>X'4841'-'X'6CFE' (6763)</td>
<td>X'B0A1'-'X'F7FE' (6768)</td>
</tr>
<tr>
<td>ISO 10646-1 CJK unified ideographs (GBK/3)</td>
<td>6080</td>
<td>X'8141'-'X'A0FE', X'A1A1'-'X'A181'</td>
</tr>
<tr>
<td>ISO 10646-1 CJK unified ideographs ISO 10646-1 CJK compatibility (GBK/4)</td>
<td>8160</td>
<td>X'A182'-'X'A1FE', X'A241'-'X'CCFE', X'CE41'-'X'CEFE'</td>
</tr>
<tr>
<td>Big-5 Symbol Compatibility Ideographic Structure Symbols (GBK/5)</td>
<td>1894</td>
<td>X'CD41'-'X'CDFE' (148)</td>
</tr>
<tr>
<td>User Definable Characters Area (UDC 1 to 3)</td>
<td>X'7641'-'X'80FE'</td>
<td>X'AA40'-'X'A9A0' (192)</td>
</tr>
</tbody>
</table>

Note 1: X'7F' of second byte is excluded.

**IBM Hangeul Character Set**

Table 9. IBM Hangeul Host Code (833)

<table>
<thead>
<tr>
<th>Number of Characters</th>
<th>Code Range</th>
<th>Low-Byte Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBCS Space</td>
<td>X'4040'</td>
<td></td>
</tr>
</tbody>
</table>
Table 9. IBM Hangeul Host Code (833) (continued)

<table>
<thead>
<tr>
<th>Number of Characters</th>
<th>Code Range</th>
<th>Low-Byte Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBCS Symbols</td>
<td>X'4141' - X'4BFD'</td>
<td>X'41' - X'FD', skipping X'7F'</td>
</tr>
<tr>
<td>Hanja Set</td>
<td>X'5041' - X'6C45'</td>
<td>X'41' - X'FD', skipping X'7F'</td>
</tr>
<tr>
<td>Hangeul and Jamo Set</td>
<td>X'8441' - X'D3B7'</td>
<td>X'41' - X'FD', skipping X'7F'</td>
</tr>
<tr>
<td>User-Defined Area</td>
<td>X'D441' - X'DDFD'</td>
<td>X'41' - X'FD', skipping X'7F'</td>
</tr>
</tbody>
</table>

Table 10. IBM Hangeul Host Code (1364)

<table>
<thead>
<tr>
<th>Number of Characters</th>
<th>Code Range</th>
<th>Low-Byte Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBCS Space</td>
<td>X'4040'</td>
<td></td>
</tr>
<tr>
<td>Non-Hangeul/Hanja Set</td>
<td>X'4141' - X'4E92'</td>
<td>X'41' - X'FE'</td>
</tr>
<tr>
<td>Hanja Set</td>
<td>X'5041' - X'6C45'</td>
<td>X'41' - X'FE'</td>
</tr>
<tr>
<td>Hangeul and Jamo Set</td>
<td>X'8441' - X'D3BD'</td>
<td>X'41' - X'FE'</td>
</tr>
<tr>
<td>User-Defined Area</td>
<td>X'D441' - X'DDFD'</td>
<td>X'41' - X'FE'</td>
</tr>
</tbody>
</table>

**Thai Language Support**

**Thai Display Mode Selection**
Select Appearance → Thai Compose Mode on emulator session.

**Switching Keyboard between Thai and Latin**
Press either Alt+left Shift or Alt+right Shift to toggle the keyboard between Thai and Latin.

**Language Shift Status**
The status line of each emulator session shows a language shift indicator. If keyboard is in Thai language shift, an indicator TH will appear in the status line.

**Thai Display Composed Mode**

**Mode 1: Non-compose mode**
No character composition occurs in this mode.

**Mode 2: Composed mode**
Thai characters are auto-composed in this mode. No column realignment is performed.

**Mode 3: Composed with space alignment**
In this mode of composing, three consecutive spaces cause column realignment. The realignment occurs whenever composing routine finds three consecutive spaces. Thus if all fields have at least three trailing spaces, then all fields of all records will be properly aligned.

**Mode 4: Composed with EOF alignment**
In this mode of composing, the EOF character (Hexadecimal 'EA') also causes column realignment. Whenever the composing routine finds a single
EOF, it deletes the EOF and performs column realignment. If two consecutive EOFs are found, no realignment occurs, one EOF is deleted, and one EOF is treated as data.

**Mode 5: Composed with space and EOF alignment**
This mode of composing performs the column realignment function of both mode 3 and mode 4.

**Printer Space Adjustment**
If your printer needs space adjustment for Thai printing, add the following statement to PCSWIN.INI, which resides in the user-class application data directory:

```
[Thai]
PrintAdjust=x
```

The value of x can be:

- **0** no adjustment (same as no PrintAdjust statement)
- **1** Perform adjustment when found three consecutive spaces
- **2** Perform adjustment when found EOF character
- **3** Perform adjustment when found three consecutive spaces or EOF character (combine 1 and 2)

**Thai Scalable (Truetype) Font Support on Printers**
Personal Communications provides a Thai Truetype font, ThaiPhuket. To print Thai characters, you can install a Thai scalable (Truetype) font as follows:

1. Open the **Control Panel** Folder.
   a. Click **Start** on the task bar.
   b. Move pointer to **Settings** and click **Control Panel**.
2. Open the **Fonts** Folder (Double-click the Fonts icon).
3. On the file menu, select **Install New Font**.
4. Click the drive and folder where Personal Communications is installed.
5. Double-click on **ThaiPhuket**.
Chapter 17. Bidirectional Language Support (Arabic and Hebrew)

Considerations for Printing

PDT printing mode requires the IBM 864 code page font to be installed for Arabic printing, and the IBM Hebrew 862 code page font for Hebrew printing.

Printing in Arabic

Using the Windows Printer Driver
To set up your printer to use a Windows printer driver, do the following:

1. In the session window, click **File → Printer Setup**. The Printer Setup dialog lists the supported printers.
2. Select the desired printer driver from the **Printer** list. The default value is the Windows default printer.
3. Confirm that the **Use PDT** option is clear and click **OK**.

**Page Setup:** For 5250 printer sessions, click the **Advanced Options** tab in the **Page Setup** dialog. Set the **Printer Font Code Page** to 1008.

For 3270 sessions, click the **Text** tab in the **Page Setup** dialog. Set the **Font** to **Typing Arabic**.

Using Printer Definition Table (PDT) Files
To set up your printer to use a PDT file, do the following:

1. In the session window, click **File → Printer Setup**. The Printer Setup dialog lists the supported printers.
2. Select the desired port from the **Printer** list.
3. Select the **Use PDT** box and click **Select PDT**.
4. Select a PDT file to be used and click **OK**.

**Page Setup:** For 5250 printer sessions, click the **Advanced Options** tab in the **Page Setup** dialog. Set the **Printer Font Code Page** to 864.

Creating an Arabic PDT file for an Arabic printer: If none of the predefined PDTs are acceptable, you can create a new one. To create a PDT, you must create a printer definition file (PDF) and then compile it to create a PDT.

You should understand a PDF’s structure and the types of statements. See **Chapter 20, “Building a Printer Definition Table (PDT) for PC400,” on page 169** for information about building a PDT.

To customize an existing PDF file for Arabic, do the following:

1. In the macro definition dialog, define a macro containing a printer command that selects the Arabic printer font.
2. Define the escape sequences of the fonts that you want to use. For example,

```c
/* Naseem ( 1 0 v ( s 0 p 1 5 h 9 v 0 s 0 b 3 T */
NSM EQU 1B 28 31 30 56 18 28 73 30 70 31 35 68 39 76 30 73 30 62 33 54
```

© Copyright IBM Corp. 1989, 2016
Note: You can get the font escape sequences by printing out the font names from the printer menus.

2. Add this macro to the START_JOB escape sequence in the Control Code section of the PDF. For example,
   
   ```
   START_JOB=CUL CBP NSM /* Switch to Arabic Font */
   ```

3. Save your new PDF file and copy it to the pdfpdt directory in the Personal Communications program directory.

4. In the Printer Setup → Select PDT file dialog, click Convert PDF.

5. Select the PDF file that you modified, and click Convert.

6. In the Select PDT file dialog, select the converted PDT file

**Using Host Print Transform (5250 only)**
When configuring an Arabic 5250 printer session, the Host Print Transform (HPT) mode can be selected. This mode requires that the 864 font be installed on the printer.

To use HPT, do the following:

1. Select Printer session type in the Session Parameters – 5250 Host panel. Click the Advanced tab.

2. Select the Host Print Transform=Yes option.

   In the iSeries, eServer i5, or System i5 screen, do the following:
   
   1. Specify that Host Print Transform will be used in the device description of a printer:

   ```
   Host print transform........... TRANSFORM (*YES)
   ```

   2. Specify your printer type and model:

   ```
   Manufacturer type and model........ MFRTYPMDL (*__________)
   ```

   3. Ensure that the character identifier parameter is capable of handling Arabic:

   ```
   Character identifier: CHRID
   Graphic character set........ 235
   Code page...................... 420
   ```

   **Page Setup:** Click the Advanced Options tab in the Page Setup dialog. Set the Printer Font Code Page to 864.

**DAT File for 5250 Arabic**
For Arabic 5250 print sessions, selecting the 420 host code page prompts Personal Communications to load the PCSPDA.DAT file. This file ensures that the host-specified fonts map properly to the Typing Arabic print font.

If the 037 (U.S.) host code page is selected in a Win32 OS session, the PCSPD.SAM file is loaded automatically. This file replaces the Courier font with Courier New. For 5250 sessions in OS/2, Personal Communications uses the original PCSPD.DAT file, since Euro support is implemented in Courier in OS/2, not in Courier New (as in Windows).

The user can specify the DAT file using the .ws parameter

```DATFILE=xxxx```

where xxxx is the name of the preferred DAT file.
Bidirectional Arabic Support

Limitations

The Bidirectional Text Assist Function is not supported in the Personal Communications iSeries component. As a result, the user cannot run Bidirectional OfficeVision/400.

Installation Tips

To set up an Arabic workstation, do the following:

1. Select 420 Arabic Speaking as the host code page in the Customize Communication panel.
2. Select Arabic Speaking as the keyboard layout.
3. In the Select Display Font panel, choose ARB3270 at the Automatic Sizing list box or at the Fixed size font selection.
4. In the API Settings panel, select 1256 as the DDE/EHLLAPI PC code page.
5. Choose Typing Arabic as the font in the Page Setup panel.

To set up for Numeric Swapping or Symmetric Swapping:

1. Select Display Setup from the Edit → Preferences → Appearance pull-down list.
2. Select Swapping from the list box at the left, where the settings for numerics and symmetric characters is displayed. Changes are immediately reflected on the active session.

   Note: Numeric Swapping is a 3270-only feature. This function will not be selectable if the session is an iSeries session.

The supported Arabic fonts are:

• ARB3270, which is found in the PCSANSIA.FON, or MFIANSIA.FON. To use the MFIANSIA.FON:
  1. Rename the file PCSANSIA.FON to PCSANSIA.ORG.
  2. Copy MFIANSIA.FON to PCSANSIA.FON.
• Typing Arabic, which is found in the file TYPEARB.TTF.

The Arabic font files are located on the installation image in the FONT subdirectory.

Bidirectional Keyboard Functions for 3270

The keys unique to Bidirectional 3270 are:

• Language selection: This function is activated by the key combination Alt+Shift and allows you to change the language layer. If the language layer is Latin, pressing the Alt+RightShift key combination changes the language layer to Arabic. If the language layer is Arabic, pressing the Alt+LeftShift key combination changes the language layer to Latin.

• Screen Reverse: This function is activated by the key combination Alt+NewLine and reverses the screen image. If the screen orientation is left-to-right, pressing this key combination reverses the screen image right-to-left. If the screen orientation is right-to-left, pressing this key combination reverses the screen image to left-to-right.

   Note that the operator information area is not reversed by this operation.

   When the screen orientation is changed, the language layer is changed to the default language of the new screen orientation. If the screen is reversed to
If the cursor is in the first logical position of a field or line, when you select the field reverse function, the cursor skips to the other side of that field or line, which becomes the first logical position. If the cursor was not in the first position of the field or line, when selecting the field reverse function, the cursor remains in its position and allows natural and correct editing of existing text.

**Auto Field Reverse:** This function is activated by the key combination Alt+NumPad5, which toggles the auto field reverse mode for the current screen orientation. Auto field reverse affects the automatic selection of the field orientation of unprotected fields:
- When auto field reverse is disabled, upon initial entry to a field (whether numeric or alphanumeric), the field orientation is always set equal to the screen orientation.
- When auto field reverse is enabled, upon initial entry to an alphanumeric field, the field orientation will be set to right-to-left (for both left-to-right and right-to-left screen orientations).
- When auto field reverse is enabled, upon initial entry to a numeric field, the field orientation will be set to left-to-right (for both left-to-right and right-to-left screen orientations).

**Push/End Push:** This function is activated by the key combination Shift+NumLock and allows the entering and editing of text whose direction is opposite from the field direction. When this function is activated, the cursor orientation is reversed, the language layer is changed accordingly, and a push segment is created.

The PUSH function has two secondary modes:
- Boundary mode: This mode is activated upon entering push mode. In this mode, the cursor remains in its position, and the typing of additional characters pushes the text in the direction opposite from the field direction. To indicate this boundary mode, the cursor has a block shape.
- Edit mode: This mode is activated when the cursor is moved from its boundary position into the PUSH SEGMENT area. In this mode, you can edit the text within the PUSH segment, while typing in the field’s natural direction.

END PUSH, activated by the Shift+NumLock key sequence, terminates the push mode.

**Note:** In Windows mode, END PUSH is activated by the Shift+Numpad/ key sequence.
The cursor jumps to the end of the PUSH segment, and its direction changes to the original direction. You can also perform END PUSH by pressing any field exit keys (for example, Cursor Up or Cursor Down) or an AID key (for example, Enter)

- **AutoPush**: This function is activated by the key combination Alt+NumPad/ and assists the terminal operator in typing mixed left-to-right and right-to-left text. When enabled, reversed segments are automatically initiated and terminated, according to the entered character or the selected language layer. This mode relieves the operator from manually pressing Push, as it is automatically invoked.
  - In right-to-left fields, typing a digit or a Latin letter causes the automatic initiation of Push, without language change. Further Latin letters or digits will continue the push mode; any other character automatically terminates push mode. This feature allows you to type Arabic text with imbedded numbers or Latin words without using Push/End Push.
  - In left-to-right fields, typing an Arabic character or special character causes the automatic initiation of Push, without language change. Typing any digit or Latin character causes the automatic termination of the mode. This allows the user to type Latin text with imbedded Arabic words using language layer selection rather than Push/End Push.

### Arabic Character Shape Selection Functions

There are five shape selection keys: one for Contextual Shape Determination (CSD), and 4 for Specific Shaping modes (Base/Isolated, Initial, Middle, Final). The default Shaping Mode is CSD.

The keys unique to Bidirectional 3270 are:

- **Contextual Shape Determination (CSD) key**: Pressing this key sets the shaping mode to Contextual Shape Determination (CSD), which is the default. Note that contextual shape determination is performed only for right-to-left text entered or modified by the operator. This key toggles between CSD and Base mode.

Pressing any of the Specific shape selection keys disables CSD.

The character Alef-Madda

\[ \text{أ} \]

in the operator information area indicates that CSD is selected. This function is initiated by the key combination Alt+NumPad4.

- **Specific Shape Selection keys**:
  - Base/Isolated: initiated by the key combination Alt+NumPad2
  - Initial: initiated by the key combination Alt+NumPad1
  - Final: initiated by the key combination Alt+NumPad7
  - Middle: initiated by the key combination Alt+NumPad8

Pressing one of the above keys disables CSD, and sets shaping mode to the selected value. Arabic letters typed from then on will have the selected shape.

**Note**: Some Arabic characters do not have middle, initial, or final shapes. In this case, if the user enters one of those characters where the requested shape does not exist, then the closest shape is selected according to the following rules:

- Instead of initial, isolated is selected.
- Instead of final, isolated is selected.
– Instead of middle, final (if it exists) or isolated is selected.
The selected Shaping Mode is shown in the operator information area:
– Isolated GHEIN

\[ \] 
indicates Base/Isolated Shaping Mode
– Initial GHEIN

\[ \] 
indicates Initial Shaping Mode
– Middle GHEIN

\[ \] 
indicates Middle Shaping Mode
– Final GHEIN

\[ \] 
indicates Final Shaping Mode

• **Field Shape key**: Pressing the key combination Alt+NumPad+ causes the shaping of the Arabic data present in the current field or line. The cursor position remains unchanged.

• **Field De-Shape key**: The key combination Alt+NumPad Enter de-shapes the Arabic data present in the current field or line. All Arabic letters are converted to their Base/Isolated shapes.

**Personal Communications iSeries**
The keys unique to Bidirectional PC400 are:

• **Language selection**: This function is activated by the key combination Alt+Shift and allows the changing of the language layer. If the language layer is Latin, by pressing the Alt+RightShift key combination, the language layer will change to Arabic. If the language layer is Arabic, by pressing the Alt+LeftShift key combination, the language layer will change to Latin.

• **Screen Reverse**: This function is activated by the key combination Alt+NewLine and reverses the screen image. If the screen orientation is left-to-right, by pressing this key combination the screen image will be reversed to right-to-left. If the screen orientation is right-to-left, pressing this key combination reverses the screen image to left-to-right.

Note that the operator information area is not reversed by this operation.

When the screen orientation is changed, the language layer is changed to the default language of the new screen orientation. If the screen is reversed to right-to-left, the language is changed to Arabic. If the screen is reversed to left-to-right, the language is changed to one using Latin characters.

The inversion of the screen causes directional characters to be replaced by their counterparts.

• **Field Reverse**: This function is activated by the key NumLock and toggles the field orientation to either left-to-right or right-to-left. The text in the field is not inverted. The cursor orientation is set equal to the new field orientation and the language layer is selected accordingly.
If the cursor is in the first logical position of a field or line, when selecting field reverse function, the cursor skips to the other side of that field or line, which now becomes the first logical position. If the cursor was not in the first position of the field or line, when selecting field reverse function, the cursor remains in its position and allows natural and correct editing of existing text.

- **Close**: This function is activated by the key combination NumPad/ and is provided so that the data entered in one keying direction can be concatenated with the data that was previously entered in the opposite direction. It operates as follows:
  - All embedded nulls are removed from the current line.
  - Concatenated text is moved to the right boundary of the field (if the field direction is right-to-left) or to the left boundary (if the field direction is left-to-right).
  - The cursor direction is set to the field direction.
  - The language layer is set to the default for the field direction.
  - If the screen orientation is now left-to-right, the cursor is positioned at the first null to the right of the concatenated text.
  - If the screen orientation is now right-to-left, the cursor is positioned at the first null to the left of the concatenated text.

- **Base**: This function is activated by the key combination Ctrl+Home; it is a toggle key that activates or deactivates the Automatic Shape determination function for Arabic RTL text. It is valid only when processing RTL Arabic text. If it is pressed in an LTR field, an operator error 0027 results.

---

**Bidirectional Hebrew Support**

The Bidirectional Hebrew support in 3270 enables the program to emulate an English/Hebrew 3270 display terminal. Special Language and Bidirectional functions are added to the list of standard functions supported by the emulation program.

**Bidirectional Functions for 3270**

*Table 11. Bidirectional Key-Combinations for 3270*

<table>
<thead>
<tr>
<th>Function</th>
<th>Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hebrew Language</td>
<td>Alt+RightShift</td>
</tr>
<tr>
<td>English Language</td>
<td>Alt+LeftShift</td>
</tr>
<tr>
<td>Screen Reverse</td>
<td>Alt+Enter</td>
</tr>
<tr>
<td>Field Reverse</td>
<td>Alt+NumLock</td>
</tr>
<tr>
<td>Auto Field Reverse</td>
<td>Alt+NumPad5</td>
</tr>
<tr>
<td>Push</td>
<td>Shift+NumLock</td>
</tr>
<tr>
<td>End Push</td>
<td>Shift+NumPad/</td>
</tr>
<tr>
<td>Autopush</td>
<td>Alt+NumPad/</td>
</tr>
</tbody>
</table>

The 3270 host system can run as a native Windows application. The layout and user interface functions in the Windows-based product conform to the IBM user interface standard (SAA/CUA); they are similar to the layout and functions implemented in other IBM products (for example, OS/2).

- **Language Selection**: The key combination Alt+Shift allows you to change the language layer. If the language layer is Latin, pressing Alt+RightShift changes
the language layer to Hebrew. If the language layer is Hebrew, pressing Alt+LeftShift changes the language layer to Latin.

- **Screen Reverse**: This function, activated by the Alt+Enter key sequence, reverses the screen image. If the screen direction is left-to-right, the screen image is inverted and displayed from right-to-left. Pressing this hotkey again returns the screen to its original direction, left-to-right. When the screen orientation is changed, the language layer is changed to the default language of the new screen orientation. If the screen is changed to right-to-left, the language changes to Hebrew. If the screen is changed to left-to-right, the language changes to Latin.

Note that the status line (OIA) never reverses. It always displays from left to right.

- **Field Reverse**: In most cases, the field direction is the same as the general screen direction. However, sometimes it is necessary to have a field whose direction is the opposite of the screen direction. The Field Reverse function, activated by the Alt+NumLock key sequence, allows such transitions. When this function is activated, the typing direction is reversed, but the existing text in the field and the screen image does not change. This function creates a temporary change which stays in effect as long as the cursor remains within the field, or until Field Reverse is activated again.

If the function is activated while the cursor is at the beginning of a line or field, the cursor jumps to the end of the line or field, so that the reversed field begins logically from that position. Otherwise, the cursor remains in its position and allows natural and correct editing of existing texts whose direction is the opposite of the screen direction.

- **Auto Field Reverse**: This function sets the field orientation for you, when you are entering data for mixed applications (Hebrew and English). This is done by automatically activating the Field Reverse function. The Auto Field Reverse mode is activated by the Alt+NumPad5 key sequence, and can be applied independently for each screen orientation, left-to-right or right-to-left.

  - If the Auto Field Reverse option is activated on a right-to-left screen, the Field Reverse function is automatically activated every time the cursor moves to a numeric field. The cursor then jumps to the leftmost position of the numeric field, to allow left-to-right typing of numbers.

  - If the Auto Field Reverse option is activated on a left-to-right screen, the Field Reverse function is automatically activated only when the cursor moves to an alphanumeric field. The cursor then jumps to the rightmost position of the field, to allow right-to-left typing of Hebrew.

Initially, the Auto Field Reverse option is enabled when the screen direction is right-to-left, and is not enabled when the screen direction is left-to-right. To terminate the Auto Field Reverse mode, press Alt+NumPad5 again.

- **Push** and **End Push**: These functions allow you to type or edit text whose direction is the opposite of the field direction. When this function is activated the cursor orientation is reversed, the language layer is changed accordingly, and a push segment is created.

The Push function is activated by the Shift+NumLock key sequence. The Push function has two secondary modes:

  - **Boundary Mode**: This mode is activated upon entering the Push mode. In this mode, the cursor remains in its position, and the typing of additional characters pushes the text in the direction opposite to the field direction. To indicate this boundary mode, the cursor shape is changed.
Edit Mode: This mode is activated when the cursor is moved from its boundary position into the Push Segment area. In this mode, you can change the text within the Push segment, while typing in the text's natural direction. End Push, activated by the Shift+NumPad/ key sequence, terminates the temporary mode. The cursor jumps to the end of the Push segment, and its direction reverts to that of the field.

- **Autopush:** The Autopush mode makes work easier and more efficient when typing Hebrew and English mixed text. When this mode is enabled, reverse segments initiate and terminate automatically, according to the entered character or the selected language layer. It relieves the operator from manually selecting Push and End Push. Autopush is especially useful for typing digits in Hebrew fields (right-to-left fields). The Autopush mode is activated by the Alt+NumPad/ key sequence; it can be applied independently to fields whose direction is left-to-right or right-to-left. In this mode, the Push and End Push functions are automatically activated according to the language of the text being typed. There is no need to worry about activating and terminating the Push mode manually.

- In right-to-left fields, typing a digit or a Latin letter causes the automatic initiation of Push, without language change. Additional Latin letters or digits will continue the push mode; any other character automatically terminates push mode. This feature allows you to type Hebrew text with imbedded numbers or Latin words without using Push/End Push.

- In left-to-right fields, typing a Hebrew character causes the automatic initiation of Push. Typing any digit or Latin character causes the automatic termination of the mode. This allows the user to type Latin text with imbedded Hebrew words by using language layer selection rather than Push/End Push.

**Keyboard Layout**

Two Hebrew keyboard templates (Bulletin and Old Code) are supplied with the product. The Old-Code template is similar to the Bulletin template, with the following exceptions:

- Shift of "6" (s-6) produces the Greek Delta symbol (ASCII 235, hex EB), representing the old Israeli Lira, instead of the regular Cent symbol.
- Shift of "7" (s-7) does not produce anything (the Ampersand symbol is not available in Old Code).
- In English language mode, unshifted English letters produce uppercase letters (A-Z or a-z), rather than lower case letters (A-Z or a-z), whether Caps Lock is ON or OFF.

**Configuration**

To set up a Hebrew workstation, do the following:

1. Select **424 Hebrew (Bulletin Code)** or **803 Hebrew (Old Code)** as the host code page in the Customize Communication panel.
2. Select Hebrew (Bulletin Code) or Hebrew (Old Code) as the keyboard layout.
3. Select Transfer from the Edit → Preferences pull-down menu.
4. From the General tab, select 862, 916, or 1255 from the PC Code-Page list.
5. In the API Settings panel, select 862, 916, or 1255 as the DDE/EHLLAPI PC code page.
6. In the Select Display Font panel, choose HEB3270 at the Automatic Sizing list box or at the Fixed size font selection.
7. Select Page Setup from the File pull-down menu.
8. In the Text tab, choose (Courier Heb) printer font.

Font

If you are accustomed to a traditional Display Station such as IBM InfoWindow 3472, you may not prefer the Personal Communications font. You can try an alternative font by changing the font files as follows:

1. Rename PCSANSIH.FON file to BASANSIH.FON
2. Copy ALTANSIH.FON to PCSANSIH.FON

In order to use the ALTANSIH.FON file, you must order the needed diskette separately.

File Transfer with 862 Code Page

PC code page 862 is the IBM number for the Hebrew code page. Microsoft Windows (Hebrew) uses a code page based on (but not identical to) the ISO code page, and quite different from code page 862.

Apart from the differences in code points, Microsoft Windows for Hebrew works with logical text. This means that Windows applications are expected to store text in logical order (that is, the same order as typed but not as displayed). Accordingly, the text that is displayed on the screen is different from the text that is processed by the application.

Therefore, when transferring files with translation to and from code page 862, there may be unexpected results (such as a different order of Hebrew text), in some cases. To overcome such problems, it is recommended after conversion of EBCDIC text to code page 862 to consider using the CONVERT program, provided as part of Microsoft Windows, which is capable of converting between logical text and visual text.

Bidirectional Functions for 5250

Table 12. Bidirectional Key-Combinations for 5250

<table>
<thead>
<tr>
<th>Function</th>
<th>Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hebrew Language</td>
<td>Alt+RightShift</td>
</tr>
<tr>
<td>English Language</td>
<td>Alt+LeftShift</td>
</tr>
<tr>
<td>Reverse</td>
<td>NumLock</td>
</tr>
<tr>
<td>Close</td>
<td>NumPad/</td>
</tr>
<tr>
<td>Screen Reverse</td>
<td>Alt+Enter</td>
</tr>
</tbody>
</table>

- **Hebrew Language**: same meaning as in “Bidirectional Functions for 3270” on page 147
- **English Language**: same meaning as in “Bidirectional Functions for 3270” on page 147
- **Reverse**: Pressing this key allows the operator to reverse the current cursor direction. It functions as follows:
  - The cursor is repositioned according to the current cursor direction. When right-to-left, the cursor is placed at the current left boundary location. When left-to-right, the cursor is placed at the current right boundary location.
  - The cursor direction is then reversed; the Keyboard Layer you get depends on the new cursor direction.
  - Insert mode is reset.
• **Close**: By pressing this key, data entered in one key direction is joined with data that was previously entered in the opposite direction:
  - All embedded null characters are removed from the current line (or field, if the field is contained on one line).
  - Joined text is moved to the right boundary of the field if the field direction is right-to-left, or to the left boundary if the field direction is left-to-right.
  - The remainder of the line (or the field, if contained on one line) is padded with null characters.
  - The cursor direction is set to the field direction.
  - If the cursor direction is now left-to-right, the cursor is positioned at the first null character to the right of the joined text. If the cursor direction is now right-to-left, the cursor is positioned at the first null character to the left of the joined text.
  - Insert mode is reset.

• **Screen Reverse**: same meaning as in “Bidirectional Functions for 3270” on page 147

---

**Bidirectional Support for VT**

The bidirectional support in VT enables the program to emulate English/Arabic or English/Hebrew VT 340 7-bit, VT 340 8-bit, VT 100, VT 52, and VT ANSI display terminals. Special language and bidirectional functions are added to the list of standard functions supported by the emulation program.

**Configuring VT Emulation for Arabic or Hebrew**

To set up an Arabic or Hebrew workstation for VT emulation, do the following:

1. Click **Configure** from the **Communication** pull-down menu.
2. Select **ASCII** for the host type.
3. Click the **Session Parameters** button.
4. Select the **National** host code page type.
5. Select the host code page
   - If configuring for Arabic, choose Arabic ASMO 708 for 8-bit code page or Arabic ASMO 449 for 7-bit code page.
   - If configuring for Hebrew, choose Hebrew ISO or Hebrew NRCS.
6. Select the font by going to the **Edit** pull-down menu and selecting **Preferences** → **Appearance** → **Font**.
7. Select **Face Name**.
   - If configuring for Hebrew, select **HEB3270**.
   - If configuring for Arabic, select **AVT3270**.

**File Transfer**

Automatic code page conversion occurs during file transfer. However, this is only valid for 8-bit code pages.

For Arabic workstations, the conversion is from Arabic ASMO 708 to 1256 when sending. The code page conversion is reversed when receiving.

For Hebrew workstations, the conversion is from Hebrew ISO to 1255 when sending. The code page conversion is reversed when receiving.
Copy and Paste
Automatic code page conversion occurs during copy and paste operations. For Arabic, the conversion is from the current host code page to 1256, and vice versa. For Hebrew, the conversion is from the current host code page to 1255, and vice versa.

Print Screen
To print a screen in an Arabic or Hebrew session, do the following:
1. Click Page Setup from the File menu.
2. For an Arabic session, select the Typing Arabic VT font. For a Hebrew session, select the Courier Heb font.

Remapping BiDi Keys
You can customize the keyboard to map BiDi functions. The following functions are available for a VT BiDi session:
- Screen Reverse (for Logical sessions only)
- National Keyboard Layer
- Latin Keyboard Layer
- Set/reset right-to-left cursor direction (for Hebrew session and visual text type only)
- Toggle between 7-bit and 8-bit character set modes (for Hebrew session only)
- Adjust the column heading (for Arabic session only)

Bidirectional Functions for VT

<table>
<thead>
<tr>
<th>Function</th>
<th>Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language Selection (Hebrew or Arabic)</td>
<td>Alt+RightShift</td>
</tr>
<tr>
<td>English Language</td>
<td>Alt+LeftShift</td>
</tr>
<tr>
<td>Screen Reverse (Hebrew Logical Text Mode and Arabic only)</td>
<td>Alt+NewLine</td>
</tr>
<tr>
<td>Adjust Column Heading (Arabic only)</td>
<td>Alt+K</td>
</tr>
<tr>
<td>Toggle Cursor Direction (Visual Hebrew only)</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Toggle 7-bit and 8-bit Character Set Modes (Hebrew only)</td>
<td>Alt+B</td>
</tr>
</tbody>
</table>

- **Language Selection**: Same meaning as in “Bidirectional Functions for 3270” on page 147
- **English Language**: Same meaning as in “Bidirectional Functions for 3270” on page 147
- **Screen Reverse**: Same meaning as in “Bidirectional Functions for 3270” on page 147
- **Adjust Column Heading**: Column Heading mode causes blanks between columns of text to break insertions. Thus, the English titles for columns of data maintain their correct position.
- **Toggle Cursor Direction**: If current cursor direction is left-to-right, pressing Alt+D changes it to right-to-left, and back again. When the cursor direction is set
to right-to-left, this does not affect cursor addressing, moving, inserting, and deleting characters, erasing in line or erasing in display.

The following functions are affected by the right-to-left cursor direction setting:

- Backspace (the cursor moves one position to the right)
- Carriage return (the cursor moves to the rightmost position on the current line)
- Line feed (the cursor moves to the rightmost position of the next line)
- Typing in the auto wrap mode (current line is continued from rightmost position of the next line)

• **Toggle 7-bit and 8-bit Character Set Modes**: This function allows switching between 7-bit and 8-bit character sets. If the current character set is ISO Hebrew (8-bit), pressing Alt+B changes the character set to Hebrew NRCS (7-bit).

### Arabic Support for ASMO 449 7-bit Code Page

The following Control Sequences are supported for ASMO 449 7-bit code page.

*Table 14. Control Sequences for Arabic VT Support*

<table>
<thead>
<tr>
<th>Control Sequence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arabic Mode and State Controls</strong></td>
<td></td>
</tr>
<tr>
<td>DECSABM</td>
<td>• Arabization disabled</td>
</tr>
<tr>
<td></td>
<td>• BiDi with Text Controls</td>
</tr>
<tr>
<td></td>
<td>• BiDi without Text Controls</td>
</tr>
<tr>
<td>DDECSNL</td>
<td>Start new Arabic/Latin language</td>
</tr>
<tr>
<td>DECVTCM</td>
<td>• Invisible Text Controls</td>
</tr>
<tr>
<td></td>
<td>• Visible Text Controls</td>
</tr>
<tr>
<td>DECSAPV</td>
<td>Numerals displayed in Arabic/Hindi, according to context</td>
</tr>
<tr>
<td><strong>Arabic Imaging Controls</strong></td>
<td></td>
</tr>
<tr>
<td>DECBDOCPD</td>
<td>Set the direction of the screen (Document Presentation Direction)</td>
</tr>
<tr>
<td><strong>Arabic Text Controls</strong></td>
<td></td>
</tr>
<tr>
<td>SLR</td>
<td>Start LTR direction</td>
</tr>
<tr>
<td>SRL</td>
<td>Start RTL direction</td>
</tr>
<tr>
<td>SDD</td>
<td>SDD start default direction</td>
</tr>
</tbody>
</table>
Chapter 18. Unicode Support

Personal Communications supports Unicode for Hindi and 1390/1399 Japanese code pages.

For a description of the procedure for configuring Personal Communications Hindi support, refer to Quick Beginnings. Installation information is described in CD-ROM Guide to Installation.

1390/1399 Code Pages

The following features are supported in Unicode for 1390/1399 Japanese character processing:

- Print Screen
- Record and play macros
- Data and file transfer
- Copy, Cut, and Paste
- EHLLAPI. Refer to Emulator Programming for information about 1390/1399 transfer APIs.
- Keyboard Customization

See the following list for more information about specific 1390/1399 support issues.

DBCS Translation Table

Personal Communications maps 1390/1399 code pages as follows:

- 1390→UCS2
- UCS2→1390
- 1399→UCS2
- UCS2→1399
- 1399→943
- 943→1390

Personal Communications loads a different translation table for display.

Data and File Transfer

File transfer uses the EBCDIC<-->UNICODE (or EBCDIC<-->ASCII ) translation for Host to PC. The user can save as an ASCII file or as a Unicode file.

User Defined Area (UDA) Support

Personal Communications handles EBCDIC<-->UNICODE (UDC), which is different from EBCDIC <--> ASCII. The DBCS UDA mapping table editor handles UNICODE<--> EBCDIC UDA.

JIS2004 Support

JIS2004 support can be enabled by selecting host code page "1390 Japan Katakana Extended(JIS2004)" and "1399 Japan Latin Extended(JIS2004)". The 1390/1399 JIS2004 code pages support all features as described above except for the following two features, that will not support surrogate characters:
Hindi Support

The following features are supported in Unicode for Hindi.

- Print Screen
- Data transfer. File transfer is not supported.
- Copy, Copy Append, Cut, and Paste. Copy Link is not supported.
- EHLLAPI. Refer to *Emulator Programming* for information about Hindi data transfer APIs.
- Trace

See the following list for more information about specific Hindi support issues.

**Code Page**
The host code page for Hindi is 1137. The Unicode PC code page is 1200.
Personal Communications uses a predefined translation table to map these code pages.

**Record and Play Macros**
Hindi enablement is limited to macro scripts only. Customization of the macro file is disabled in Hindi sessions. VB scripts are not supported.

**Fonts**
Only True Type Fonts are used for Hindi for display and printing. The TTF file is enumerated by Personal Communications and is displayed in the *Page Setup* pull-down menu. This font file has to be selected for printing the characters in Hindi. The Hindi font file is installed along with other font files.

**Keyboard**
The English keyboard layout is mapped to the Hindi layout. This is accomplished by loading the two key mapping tables corresponding to Hindi from the PCSKBD.DLL file. The first table maps the Windows virtual key number to the IBM key number. The second key mapping table maps the IBM key number to the Unicode value of the corresponding character.

**Keyboard Customization**
When a key is selected in the *Keyboard Customization* dialog, the edit control window displays the corresponding Hindi character. The user can change the mapping by selecting a new character from the list box. If the user attempts to directly edit the edit control window, the characters from the current input character set appear.

**Copy/Move/Swap and Find keys**
The function of these keys is similar to that of the existing SBCS languages. The only difference is that the Hindi characters are stored as Unicode characters instead of single-byte characters.

**Switching from Hindi to English**
Hindi language support also includes toggling between Hindi and English using the ALT+left Shift key.

**OIA Display**
HI is displayed in the OIA when working in Hindi mode. There is no display when the user shifts from Hindi mode.
Part 5. Building a Printer Definition Table (PDT)
Chapter 19. Building a Printer Definition Table (PDT) for PC/3270

This chapter, in combination with Chapter 20, “Building a Printer Definition Table (PDT) for PC400,” on page 169, explains how to customize a printer definition table (PDT file) for PC/3270. Chapter 20 contains basic information about creating and changing PDTs; this chapter contains specific information about creating PC/3270 PDTs. PDTs for PC/3270 and PC400 differ only slightly; if you use a common PDT (used for both PC/3270 and PC400), the additional statements for PC400 are ignored for PC/3270 processing. Similarly, statements unique to PC/3270 are ignored for PC400 processing.

ASCII_PASSTHRU? and EBCDIC_PASSTHRU?

The ASCII_PASSTHRU? and EBCDIC_PASSTHRU? PDF statements are new options available for PC/3270. See “Transparent Print Capability” on page 174 for details.

Supplemental Explanation of PDF Statements for PC/3270

The following PDF statements have functions that differ from those for PC400. All statements are listed in “Field Names of Printer Definition Files” on page 186.

MAXIMUM_PAGE_LENGTH
Printed lines per page. If you change this value, you must change the value in the SET_PAGE_LENGTH=SFL value statement (see “Session parameters” on page 171) to be the same.

MAXIMUM_PRINT_POSITION
Printed characters per line.

COMPRESS_LINE_SPACING?
Whether blank or null lines are to be printed if all characters on that line are nulls (for LU 3 only).

FORM_FEED_ANY_POSITION?
Whether a form feed is to be valid in any position. If NO, a form feed will be valid only in the following positions:
• First print-position of the buffer
• After a valid new line operation
• First print-position of a line

OVERRIDE_FORMATTED_PRINT?
Whether nulls are to be printed as blanks.

INTERV_REQ_TIMER
This statement is ignored.

INTERV_TIMER_ON_PE_ONLY?
This statement is ignored.

RESELECT_TIME_EXCPT_5204
This statement is ignored.

ESC/P_LINE_FEED?
If YES, the line feed (LF) function is emulated when the line feed
command is received. This is useful when you do not want a line feed accompanied by a carriage return (CR) on a printer using the ESC/P printer language. If NO, the value defined in the LINE_FEED statement is sent to the printer.

**IGNORE_FORM_FEED_AT_FIRST_POS?**
If YES, the form feed (FF) function is ignored at the first position (for LU 2, LU 3, and non-SNA sessions) or at the beginning of the print job (for LU 1 sessions). Using this option eliminates extra blank pages at the beginning of each print job.

**FORM_FEED_TAKES_POSITION?**
If YES, the form feed (FF) function is effective if followed by data (LU 2, LU 3, and non-SNA sessions only).

**KANJI_CODE?**
If YES, kanji codes (JIS or SHIFT_JIS) have been used. This value cannot be changed.

**ZENKAKU_SPACE**
The size (adjustment unit) of a user-defined character and a HANKAKU character. This value cannot be changed.

**SBCS_FONT_LOAD**
Registration of a HANKAKU GAIJI. This value cannot be changed.

**DBCS_FONT_LOAD**
Registration of a ZENKAKU GAIJI. This value cannot be changed.

**SET_LOCAL_FONT**
Set a font set of user-defined characters. Remove it when user-defined characters are not loaded to a printer.

**RESET_LOCAL_FONT**
Reset a font set of user-defined characters. Remove it when user-defined characters are not loaded to a printer.

**KANJI_ON**
Set kanji mode.

**KANJI_OFF**
Reset kanji mode.

**ATTRIBUTE_GRID_LINE**
Set to grid-line print. This value cannot be changed.

**START_DOUBLE_WIDTH_CHARACTER**
Set a double-width character.

**END_DOUBLE_WIDTH_CHARACTER**
Reset a double-width character.

**Notes:**
1. When using IBM5577.PDF, change FORM_FEED=EJC to FORM_FEED in the file when a continuous form job does not feed correctly.
2. When using ESC_P.PDF, DBCS (2-byte) characters are placed to the left of the character box, not in the center. To place DBCS characters in the center of the character box, change the IBM-supplied values in ESC_P.PDF:
   ```
   P10 EQU 1B 50 1B 20 00 1C 53 00 0C 1C 54 00 00
   P12 EQU 1B 4D 1B 20 00 1C 53 00 06 1C 54 00 00
   P13 EQU 1B 67 1B 20 01 1C 53 00 03 1C 54 00 01
   P15 EQU 1B 67 1B 20 00 1C 53 00 00 1C 54 00 00
   ```
   to the following:
**SCS TAB Setting**

A PC/3270 printer session LU type 1 can accept any number of tab positions, and the host printer session can send any number of tabs to the printer session. However, the workstation printer you are using might support fewer tab positions than the host application sets; for example, the IBM Proprinter supports 27 tab positions.

If the number of tab positions that the host application sets exceeds the maximum number of positions that the printer supports, your printed output will not look as you expect it to. You can avoid this situation by modifying the PDF file and reconfiguring PC/3270 as follows:

1. Modify the SET_HORIZONTAL_TABS statement as follows:
   ```
   SET_HORIZONTAL_TABS = number
   ```
2. Save the file under a new name.
3. Convert the PDF file (with the procedure described in Chapter 20, “Building a Printer Definition Table (PDT) for PC400,” on page 169).
4. Select the new PDT file created in Step 2.

**Printer Color Mixing**

Some printers, such as the IBM 5182, compose certain colors by mixing colors. Colors are mixed by printing the text in one color and then printing over the same text in another color on a second pass.

PC/3270 will compose a color if the color is not defined in the printer definition table of a color printer that is capable of mixing colors. Therefore, if you are using a printer that composes some colors by mixing two colors, leave the definition of the composed colors blank in the printer definition file. Only the composite colors defined in Table 15 are created by double-printing the primary colors.

**Table 15. Color Mixes**

<table>
<thead>
<tr>
<th>Composite Color</th>
<th>Primary Colors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>yellow, magenta, cyan</td>
</tr>
<tr>
<td>Green</td>
<td>yellow, cyan</td>
</tr>
<tr>
<td>Blue</td>
<td>magenta, cyan</td>
</tr>
</tbody>
</table>

For example, to create red, you must define yellow and magenta. The primary colors must be defined in the printer definition table.

**Printer Session Data Stream Support**

There are two types of host-directed print data streams supported by PC/3270: the 3270 data stream and the SNA character string (SCS) data stream.

**3270 Data Stream**

The 3270 data stream is a buffer-oriented data stream. The print data is formatted as if it were going to be displayed on a screen. The host system sends commands
to format the presentation space. These commands can change the presentation space in any location at any time. Once the host system completes formatting the presentation space, it issues a START PRINT command and the presentation space is printed as accurately as the printer hardware allows. The 3270 data stream can be sent to PC/3270 workstations over an SNA LU 3 session or a non-SNA DFT printer session.

Table 16 lists the commands that can be sent in the 3270 data stream.

Table 16. 3270 Data Stream Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Write</td>
</tr>
<tr>
<td>EW</td>
<td>Erase/Write</td>
</tr>
<tr>
<td>EWA</td>
<td>Erase/Write Alternate</td>
</tr>
<tr>
<td>RB</td>
<td>Read Buffer</td>
</tr>
<tr>
<td>RM</td>
<td>Read Modified</td>
</tr>
<tr>
<td>RMA</td>
<td>Read Modified All</td>
</tr>
<tr>
<td>EAU</td>
<td>Erase All Unprotected</td>
</tr>
<tr>
<td>WSF</td>
<td>Write Structured Field</td>
</tr>
</tbody>
</table>

The RB, RM, and RMA commands cannot be used with an SNA attachment.

Table 17 lists the orders that can be sent in the 3270 data stream.

Table 17. 3270 Data Stream Orders

<table>
<thead>
<tr>
<th>Order</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>SBA</td>
<td>Start Buffer Address</td>
</tr>
<tr>
<td>SF</td>
<td>Start Field</td>
</tr>
<tr>
<td>IC</td>
<td>Insert Cursor</td>
</tr>
<tr>
<td>PT</td>
<td>Program Tab</td>
</tr>
<tr>
<td>RA</td>
<td>Repeat to Address</td>
</tr>
<tr>
<td>EUA</td>
<td>Erase Unprotected to Address</td>
</tr>
<tr>
<td>SFE</td>
<td>Start Field Extended</td>
</tr>
<tr>
<td>SA</td>
<td>Set Attribute</td>
</tr>
<tr>
<td>MF</td>
<td>Modify Field</td>
</tr>
</tbody>
</table>

The last three orders in the preceding table manage the color, extended highlighting, and programmed symbols attributes for fields and individual characters. The programmed symbols attribute is not supported by PC/3270.

In addition to the commands and orders in the two preceding tables, there are special printer formatting control codes that can be included in the 3270 data stream.

The following table lists the control codes that can be sent in the 3270 data stream.
Table 18. 3270 Data Stream Format Control Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NL</td>
<td>New Line control code moves the print position to the left margin and down one line.</td>
</tr>
<tr>
<td>CR</td>
<td>Carriage Return control code moves the print position to the left margin.</td>
</tr>
<tr>
<td>EM</td>
<td>End of Message control code ends the print operation.</td>
</tr>
<tr>
<td>FF</td>
<td>Form Feed control code moves the print position to the left margin at the top of the next page.</td>
</tr>
</tbody>
</table>

Note: NL, CR, and EM are valid only if a line-length format specified by the WCC is not used. The FF code is valid in any buffer position.

PC/3270 printer support interprets each 3270 attribute and printer control code and translates them into a sequence of one or more workstation printer control codes. For more information about the 3270 data stream, refer to IBM 3270 Information Display Data Stream Programmer's Reference.

SCS Data Stream

The SCS data stream is a sequential data stream that is oriented toward line printers. The characters are translated according to the host system code page and printed according to the attributes and formatting specified by the control commands. The way in which SCS characters are printed depends only on the control codes that precede them. Therefore, it is not necessary to buffer the characters before they are printed. The SCS data stream flows across the SNA LU 1 session only.

The valid SCS control codes supported by PC/3270 are listed in Table 19.

Table 19. Supported SCS Control Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Value</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>NL</td>
<td>X'15'</td>
<td>New Line</td>
</tr>
<tr>
<td>LF</td>
<td>X'25'</td>
<td>Linefeed (Index)</td>
</tr>
<tr>
<td>CR</td>
<td>X'0D'</td>
<td>Carriage Return</td>
</tr>
<tr>
<td>FF</td>
<td>X'0C'</td>
<td>Form Feed</td>
</tr>
<tr>
<td>BS</td>
<td>X'16'</td>
<td>Backspace</td>
</tr>
<tr>
<td>BEL</td>
<td>X'2F'</td>
<td>Bell Function</td>
</tr>
<tr>
<td>IRS</td>
<td>X'1E'</td>
<td>Interchange-Record Separator</td>
</tr>
<tr>
<td>SA</td>
<td>X'28'</td>
<td>Set Attribute</td>
</tr>
<tr>
<td>TRN</td>
<td>X'35'</td>
<td>Transparent</td>
</tr>
<tr>
<td>NUL</td>
<td>X'00'</td>
<td>Null</td>
</tr>
<tr>
<td>HT</td>
<td>X'05'</td>
<td>Horizontal Tab</td>
</tr>
<tr>
<td>VT</td>
<td>X'0B'</td>
<td>Vertical Tab</td>
</tr>
<tr>
<td>SHF</td>
<td>X'2B C1'</td>
<td>Set Horizontal Format</td>
</tr>
<tr>
<td>SVF</td>
<td>X'2B C2'</td>
<td>Set Vertical Format</td>
</tr>
<tr>
<td>SLD</td>
<td>X'2BC 6'</td>
<td>Set Line Density</td>
</tr>
<tr>
<td>SPD</td>
<td>X'2BD2 xx29'</td>
<td>Set Print Density</td>
</tr>
<tr>
<td>VCS</td>
<td>X'04 xx'</td>
<td>Vertical Channel Select</td>
</tr>
<tr>
<td>ENP</td>
<td>X'14'</td>
<td>Enable Presentation</td>
</tr>
</tbody>
</table>
Table 19. Supported SCS Control Codes (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Value</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>INP</td>
<td>X'24'</td>
<td>Inhibit Presentation</td>
</tr>
<tr>
<td>GE</td>
<td>X'08'</td>
<td>Graphic Escape</td>
</tr>
<tr>
<td>PPM</td>
<td>X'2BD2 xx48'</td>
<td>Page Presentation Media</td>
</tr>
<tr>
<td>SO</td>
<td>X'0E'</td>
<td>Shift Out</td>
</tr>
<tr>
<td>SI</td>
<td>X'0F'</td>
<td>Shift In</td>
</tr>
<tr>
<td>RNL</td>
<td>X'06'</td>
<td>Required New Line</td>
</tr>
<tr>
<td>RCR</td>
<td>X'06'</td>
<td>Required Carriage Return</td>
</tr>
<tr>
<td>SPS</td>
<td>X'09'</td>
<td>Superscript</td>
</tr>
<tr>
<td>WUS</td>
<td>X'23'</td>
<td>Word Underscore</td>
</tr>
<tr>
<td>IR</td>
<td>X'33'</td>
<td>Index Return</td>
</tr>
<tr>
<td>PP</td>
<td>X'34'</td>
<td>Presentation Position</td>
</tr>
<tr>
<td>EBS</td>
<td>X'36'</td>
<td>Expanded Backspace</td>
</tr>
<tr>
<td>NBS</td>
<td>X'36'</td>
<td>Numeric Backspace</td>
</tr>
<tr>
<td>SBS</td>
<td>X'38'</td>
<td>Subscript</td>
</tr>
<tr>
<td>IT</td>
<td>X'39'</td>
<td>Indent Tab</td>
</tr>
<tr>
<td>RFF</td>
<td>X'3A'</td>
<td>Required Form Feed</td>
</tr>
<tr>
<td>RPE</td>
<td>X'3A'</td>
<td>Required Page End</td>
</tr>
<tr>
<td>RSP</td>
<td>X'41'</td>
<td>Required Space</td>
</tr>
<tr>
<td>NSP</td>
<td>X'E1'</td>
<td>Numeric Space</td>
</tr>
<tr>
<td>ESP</td>
<td>X'E1'</td>
<td>Expandable Space</td>
</tr>
<tr>
<td>SH</td>
<td>X'CA'</td>
<td>Syllable Hyphen</td>
</tr>
</tbody>
</table>

Note: The ENP and INP commands are accepted, but are ignored, in an LU 1 session.

For more information about the SCS printer data stream, refer to IBM Systems Network Architecture - Sessions Between Logical Units.

**Delimiting Print Jobs**

Many print jobs can be sent over a single PC/3270 printer session. PC/3270 allows multiple sessions and applications to share a single workstation printer on a between-jobs basis. PC/3270 needs to know when each print job starts and ends so that printers can be shared properly and begin and end job strings can be sent at the appropriate times. The emulator recognizes a number of different methods of delimiting print jobs:

**By Session**

PC/3270 printer support assumes, by default, that all print jobs are delimited by sessions. That is, in the absence of all other indicators, PC/3270 assumes that a print job begins when a printer session is started and ends when it is reset.

**Time-Out Interval**

On non-SNA DFT sessions, print jobs can be delimited by a user-specified timeout interval. A print job on a non-SNA DFT printer session begins when the first host-outbound data for that job is received, and ends when
no host-outbound data is received for a period of time exceeding the
user-specified non-SNA DFT timeout interval. For PC/3270, this interval is
specified during configuration.

By Brackets
On an SNA session with an LU 1 or LU 3 host application, PC/3270 can
use bracket indicators to delimit print jobs. The emulator opens the printer
when it receives the begin bracket, then it processes and prints data. The
emulator closes the printer after it receives an end bracket.

When the emulator receives another begin bracket, it again opens a printer
and begins processing a print job.

Structured Fields
The host can use structured fields to indicate to the device that a new file
is beginning or that the current file is completed. PC/3270 delimits print
jobs with Begin of File and End of File structured fields (SF) to perform
host-directed printing. Structured fields are described in "Structured
Fields."

Structured Fields
The host uses Begin of File and End of File structured fields to indicate to a device
that a file is beginning or ending.

Begin/End of File Query Reply
The Begin/End of File query reply indicates that a device supports Begin of File
and End of File to delineate print jobs. The PC/3270 sends a query reply, as shown
in Table 20 to the host in response to a Read Partition General query.

<table>
<thead>
<tr>
<th>Byte</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>0–1</td>
<td>X'0005'</td>
</tr>
<tr>
<td>2</td>
<td>X'81'</td>
</tr>
<tr>
<td>3</td>
<td>QCODE X'9F'</td>
</tr>
<tr>
<td>4</td>
<td>FLAGS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Byte</th>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0–1</td>
<td>X'0007'</td>
<td>The length of this structure</td>
</tr>
<tr>
<td>2–3</td>
<td>X'0F85'</td>
<td>Begin/End of File</td>
</tr>
<tr>
<td>4</td>
<td>PID</td>
<td>Partition ID</td>
</tr>
<tr>
<td>5</td>
<td>FLAG1</td>
<td>Reserved</td>
</tr>
<tr>
<td></td>
<td>B'00'</td>
<td>End of File is being sent</td>
</tr>
<tr>
<td></td>
<td>B'01'</td>
<td>Begin of File is being sent</td>
</tr>
<tr>
<td>2–7</td>
<td>B'10'</td>
<td>Reserved</td>
</tr>
<tr>
<td></td>
<td>B'11'</td>
<td>Reserved</td>
</tr>
<tr>
<td>6</td>
<td>FLAG2</td>
<td>Reserved; must be set to 0's.</td>
</tr>
</tbody>
</table>

Begin/End of File Structured Fields
Begin/End of File structured fields are accepted on either LU 1 or LU 3 sessions.
Table 21 shows the format of the Begin/End of File structured fields.

Table 21. Begin/End of File Structured Field Format

<table>
<thead>
<tr>
<th>Byte</th>
<th>Bit</th>
<th>Contents</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0–1</td>
<td></td>
<td>X'0007'</td>
<td>The length of this structure</td>
</tr>
<tr>
<td>2–3</td>
<td></td>
<td>X'0F85'</td>
<td>Begin/End of File</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>PID</td>
<td>Partition ID</td>
</tr>
<tr>
<td>5</td>
<td>0–1</td>
<td>FLAG1 B'00' B'01' B'10' B'11'</td>
<td>Reserved; End of File is being sent</td>
</tr>
<tr>
<td></td>
<td>2–7</td>
<td>Reserved</td>
<td>Begin of File is being sent</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>FLAG2</td>
<td>Reserved; must be set to 0's.</td>
</tr>
</tbody>
</table>
### Processing Begin or End of File Structured Fields

When the Begin or End of File structured fields are used with brackets or non-SNA timeout intervals, the Begin or End of File SFs take precedence over the brackets or timeout intervals in determining when a print job begins or ends. See the following examples:

- **Begin or End of File structured fields overriding brackets:**
  
  Begin Bracket, Begin of File Structured Field, ...Data...,  
  End Bracket  
  
  The device will wait indefinitely until the End of File structured field is received before ending the print job.

- **Begin or End of File structured fields overriding non-SNA timeout intervals:**
  
  Begin of File structured fields, ...Data..., pause > timeout value  
  
  The device will wait indefinitely until the End of File structured fields is received before ending the print job.

- **Inconsistent use of Begin or End of File structured fields and brackets:**
  
  Begin Bracket, ...Data1...,  
  Begin of File Structured Fields,...Data2...,  
  End of File Structured Fields, ...Data3...,  
  End Bracket  
  
  When you use the Begin of File and End of File structured fields inconsistently with brackets, the results are unpredictable. In the preceding example, the device might process Data1, Data2, and Data3 as separate jobs or combine two or more of them into one file.

For predictable results, each data block must be enclosed by a Begin of File structured field and an End of File structured field. The following example shows three print jobs all delimited by Begin or End of File structured fields:

Begin Bracket, Begin of File Structured Field, ...Data1...,  
End of File Structured Field,(job1)  
Begin of File Structured Field, ...Data2..., End of File Structured Field, (job2)  
Begin of File Structured Field, ...Data3..., End of File Structured Field,  
End Bracket(job3)  

PC/3270 always keeps track of brackets and timeout intervals. After the emulator receives a Begin of File structured field, it takes no action on Begin Brackets, End Brackets, or timeout until it receives an End of File structured field. After a valid End of File SF is processed, the emulator defaults to delimiting jobs by brackets or timeout intervals until it receives the next Begin of File structured field.

### Begin or End of File Structured Field Error Conditions

PC/3270 does not accept transmission of data belonging to two separate print jobs in the same chain. To be accepted by the emulator, Begin of File structured fields must be the first structured field of a chain and End of File structured fields must be the last structured field of a chain.

PC/3270 rejects transmission in the following instances:
• The emulator receives an End of File structured field without first receiving a Begin of File structured field.
• The emulator receives a second Begin of File structured field without receiving an intervening End of File structured field.
• The emulator receives a Begin of File structured field that is not the first structured field following a write structured field command (LU 2, LU 3, and non-SNA sessions) or a Function Management Header 1 (LU 1 sessions).
• The emulator receives an End of File structured field that is not the last structured field following a write structured field command (LU 2, LU 3, and non-SNA sessions) or a Function Management Header 1 (LU 1 sessions).

Processing SCS Data Streams
When processing an SCS data stream, PC/3270 treats Begin or End of File structured fields as follows:
• A Begin of File structured field indicates that all SCS data in the same transmission until an End of File structured field is received is part of a new print job.
• An End of File structured field indicates that any SCS data received in the same chain as the End of File structured field is the last data of the current print job.

Processing 3270 Data Streams
When processing a 3270 data stream, PC/3270 treats Begin or End of File structured fields as follows:
• A Begin of File structured field indicates that the next presentation space print (initiated by a write type command with the start print bit turned on in the write control character) is the first in a print job.
• An End of File structured field indicates that the last presentation space print was the last of the current print job. The emulator immediately sends a terminate string to the printer to close the printer session.

If PC/3270 receives a Begin of File structured field and an End of File structured field without at least one presentation space separating them, it ignores the structured fields.
Chapter 20. Building a Printer Definition Table (PDT) for PC400

This chapter explains how to create and change the printer definition table (PDT file) used for PC400. Chapter 19, “Building a Printer Definition Table (PDT) for PC/3270,” contains specific information about creating PC/3270 PDTs. PDTs for PC/3270 and PC400 differ only slightly; if you use a common PDT (used for both PC/3270 and PC400), the additional statements for PC400 are ignored for PC/3270 processing. Similarly, statements unique to PC/3270 are ignored for PC400 processing.

The PDT file is created by converting the printer definition file (PDF file). The PDF and PDT define the transmission of characters and control codes to the printer and the format of printer output. To change an existing PDF (the recommended method) or create a new one, use a text editor that can produce or update an ASCII file.

Using the Printer Definition Table (PDT) File

To use the PDT file:

1. Select File from the menu bar of the workstation window.
2. Select Printer Setup from the File menu.
   The Printer Setup window appears.
3. Select the Use PDT file check box and Select PDT.
   The Select PDT file window appears.

To build the PDT file (required only if the PDF has been changed or created):

1. Select Convert PDF. Select the PDF file to be converted from the list in the Convert PDF to PDT window; then select Convert. The PDF File Converter window appears. After the file has been converted, click on Close, then click Close in the Convert PDF to PDT window.
2. Click OK in the Select PDT file window.
3. Click OK on the Printer Setup window.
   After printer setup is complete, the Printer Setup window is closed.

Printer Definition File (PDF File) Format

A PDF contains 3 main sections:

- Macro definitions
- Formatting controls
- Character definitions using EBCDIC_xx keywords

Macro Definitions

This section of a PDF contains user-defined macros. A macro is a single mnemonic that stands for a control code or a sequence of control codes. A mnemonic simplifies defining control sequences for PC printers and makes it easier to read the information in the PDF.
The following table shows the structure of a macro definition statement. A macro definition is composed of four parts:

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>EQU</td>
<td>PC Printer Control Codes</td>
<td>Comments</td>
</tr>
</tbody>
</table>

For example:

```
FFF EQU 0C /* Form Feed */
```

The first part is the user-defined mnemonic or macro name. This name must be exactly three characters long and must not begin with a number. It is helpful to define a meaningful mnemonic, such as P17 for 17.1 pitch.

The second part, EQU, stands for equate and must be coded as EQU.

The third part is the hexadecimal control code, which is specific to a PC printer. Each PC printer manufacturer can define different control codes for the same printer function. For example, the IBM 4019 LaserPrinter uses control codes defined by the IBM Personal Printer Data Stream (PPDS). Hewlett-Packard printers use control codes defined by the Hewlett-Packard Printer Control Language (PCL). These control codes are usually defined in the manual that comes with the printer.

Some PC printer manuals describe control sequences as a string of ASCII symbols, such as ESC J 1 K; others use hexadecimal numbers, such as 1B 57 01; while others use decimal values, such as 27 28 1. The printer definition table compiler accepts any of these formats.

The control codes in the macro definitions section can be any of the following:

- Single characters that are interpreted as their ASCII value
- Two-digit numbers that are interpreted as hexadecimal values
- Three-digit numbers that are interpreted as decimal values

If you leave the control code section blank or if you delete it, the character or control code is interpreted as a null string. If a character or control code is defined more than once in the file, the last definition is used.

The fourth part is the comment section. The symbols /* indicate the beginning of a comment and the symbols */ indicate the end of a comment. Comments can be coded at any point in the printer definition file and are ignored by the printer definition table compiler.

The following is an example macro definition statements that are specific to the IBM 4019 LaserPrinter.

```
LFF EQU 0A /* Line Feed */
VTB EQU 0B /* Vertical Tab */
FFF EQU 0C /* Form Feed */
CRR EQU 0D /* Carriage Return */
P05 EQU 1B 57 01 /* 5 Pitch-Characters/inch */
P10 EQU 12 /* 10 Pitch-Characters/inch */
CDW EQU 1B 57 00 /* Cancel Double Wide contin. */
P17 EQU 12 0F /* 17.1 Pitch-Character/inch */
LL8 EQU 1B 41 09 1B 32 /* Set line length 8 lines/inch */
P12 EQU 1B 3A /* 12 Pitch-characters/inch */
RES EQU 1B 58 48 07 00 05 31 01 A4 00 00 90 /* The above macro resets the */
/ * printer using the factory */
```
To illustrate how macros are coded, consider this example. To have the host print job printed in double-wide characters, you must know what control code turns on double-wide printing on your PC printer. On the IBM 4019 LaserPrinter, the control code to turn on double-wide printing is X'1B5701'. This would be coded as:

```
BDW EQU 1B 57 01
```

where BDW stands for Begin Double Wide.

This alone would not cause 3270 host print to send this control to the printer. The mnemonic would have to be included in a control code statement, such as START_JOB which is described in the control codes section of the file.

**Note:** The IBM 4019 LaserPrinter printer definition file that comes with IBM Personal Communications already has this control code defined as the P05 macro. See line 9 of the sample IBM 4019 LaserPrinter Macro Definition Statements (IBM4019.PDF File Contents” on page 176).

### Macro Name Examples

The following are example mnemonics or macros. The control codes are for the IBM 4019 LaserPrinter:

- **LND** EQU 1B 26 6C 31 4F /* LANDSCAPE */
- **POR** EQU 1B 26 6C 30 4F /* PORTRAIT */
- **P12** EQU 1B 28 73 31 32 2E 30 30 48 /* PITCH_12.00 */
- **T10** EQU 1B 28 73 31 30 2E 30 56 /* POINT_10.0 */
- **LTR** EQU 1B 26 6C 32 41 /* LETT_PAPER */
- **G66** EQU 1B 26 6C 36 36 50 /* PG_LENGTH_66 */

### Formatting Controls

The controls section of a PDF contains the following:

- Session parameters
- Control codes
- Color specifications
- Highlight specifications

### Session parameters

**MAXIMUM_PAGE_LENGTH, MAXIMUM_PRINT_POSITION, and SET_PAGE_LENGTH**

The parameter to the left of the equal sign is a keyword and must be coded exactly as shown. The keyword is used to define a statement. The values to the right of the equal sign are macros or control codes. Because the values to the right of the equal sign can be both macros and control codes, they will sometimes be referred to as parameters.

The MAXIMUM_PAGE_LENGTH, MAXIMUM_PRINT_POSITION, and SET_PAGE_LENGTH parameters specify the dimensions of the output job. The number specified in the MAXIMUM_PAGE_LENGTH parameter is used in the SET_PAGE_LENGTH parameter and is substituted for the value keyword. In other words, if SET_PAGE_LENGTH and MAXIMUM_PAGE_LENGTH are coded as follows:

```
MAXIMUM_PAGE_LENGTH=066 /* Printed lines per page */
SET_PAGE_LENGTH=SFL 066
```

Chapter 20. Building a Printer Definition Table (PDT) for PC400  171
The results would be:

```
SET_PAGE_LENGTH=SFL 066
```

Because SFL is coded as X'1B 43' in the macro section, the actual control code that would be sent to the printer to set the maximum page length is:

```
X'1B 43 42'
```

where X'42' is decimal 66.

Note: Setting MPL=255 causes suppression of form feeds (FFs).

**Control Codes**

The control codes section of a PDF is used by the PDT function to determine what specific PC printer control code is to be sent to the PC printer when an SCS control code is received. Some of the statements used by Communications Manager are shown in the following example.

```
START_JOB=SEL CDW CDL CUL CDS CP8 CS2
END_JOB=CAT CDW CDL CUL CDS CP4 FFF
SET_PAGE_LENGTH=SFL value
SET_VARIABLE_LINE_DENSITY=ESC A value ESC 2
SET_10_CHARACTERS_PER_INCH=P10
```

Note: The above example lines come from the IBM 4019 LaserPrinter PDF.

**START_JOB and END_JOB**

The control codes associated with START_JOB are sent at the start of each host print job. It is best to set all printer options to a known or desired state at the beginning of each host print job. The PC printer changes its state or changes the options selected only when instructed to do so by control codes. Therefore, the previous PC application could have left the printer in portrait mode with a Courier font selected, and unless your job changed them, these would be the printer options used.

Even though the START_JOB and END_JOB control codes are the ones shipped with the IBM4019.PDF, many users change them to be more like the ones below:

```
START_JOB=RES P12 LL8
END_JOB=RES
```

In this example, the RES, P12 and LL8 macros are used on the START_JOB statement (these macros are defined in IBM4019.PDF File Contents” on page 176). This translates into the following control codes being sent to the printer at the beginning of your print job:

```
X'1B 5B 4B 07 00 05 31 01 A4 00 00 90 1B 3A 1B 41 09 1B 32'
```

This sequence of control codes:

- Resets the printer to the IBM PPDS factory default settings (RES)
- Begins printing in 12 pitch (P12)
- Begins printing at 8 lines per inch (LL8)

The END-JOB statement sends the following control code to the printer at the end of your job:
This control code resets the printer to IBM PPDS factory default settings (RES).

**SET_VARIABLE_LINE_DENSITY**

The SET_VARIABLE_LINE_DENSITY statement is used in combination with the panel where you can select the number of lines per inch (LPI), which can be either 6 or 8.

The PDT process uses whatever is selected in the lines per inch field, and substitutes this number for the value keyword in the SET_VARIABLE_LINE_DENSITY parameter. In other words, if lines per inch is set to 8, the SET_VARIABLE_LINE_DENSITY parameter is

```
SET_VARIABLE_LINE_DENSITY=ESC A 09 ESC 2
```

where the 09 comes from 72/8. The number of typographic points in 1 inch is 42; thus a value of 12 points would indicate six lines to an inch.

The control code that is sent to the printer to set the line density is:

```
X'1B 41 09 1B 32'
```

**SET_10_CHARACTERS_PER_INCH**

On most printers, the default pitch is 10 characters per inch. In most PDTs, Personal Communications uses this same convention and sends the control code found on the SET_10_CHARACTERS_PER_INCH statement. This is usually coded in the PDF as:

```
SET_10_CHARACTERS_PER_INCH=P10
```

where P10 is coded in the macro definition section as:

```
P10 EQU 12
```

---

**Printing More than One Screen on a Page**

If you want to print two or more screens per page, use the BEL command in the PDF to specify the number of blank lines to insert (instead of a Form Feed between two successive screens). You must coordinate this modification with the usage of the LPI and MPL parameters in the PDF (see “Field Names of Printer Definition Files” on page 186).

**Note:** This specific use of the BEL command is applicable only for printing screens using the Print Screen Collection function.

Setting the value `BEL=FF` will send a Form Feed, while the value `BEL=00` does not insert a Form Feed or a Line Feed.

Values between 00 and FF send that number of blank lines between successive screens. For example, `BEL=02` inserts two blank lines between two successive screens. Thus, more than one screen can be printed on a single page.
Transparent Print Capability

ASCII_PASSTHRU? Keyword Support
If you add the following line to your PDF, Personal Communications will send host data without any translation:

ASCII_PASSTHRU? = YES

This option is for special host applications that generate PC printer control codes directly.

Even if ASCII_PASSTHRU? is set, control codes defined START_JOB and END_JOB are sent to the printer at the start and the end of a print job respectively. To remove those commands, you need to rebuild the PDT file after removing the PDF keyword definitions for START_JOB and END_JOB.

If ASCII_PASSTHRU? is set, all character definition lines, for example, EBCDIC_xx, are ignored.

If both ASCII_PASSTHRU? and EBCDIC_PASSTHRU? are set, ASCII_PASSTHRU? has priority.

EBCDIC_PASSTHRU? Keyword Support
If you add the following line to your PDF, Personal Communications will ignore all SCS commands and send data to the printer after EBCDIC-to-ASCII translation:

EBCDIC_PASSTHRU? = YES

For example, the default EBCDIC-ASCII translation table used for U.S. English host code page 037 is as follows:

<table>
<thead>
<tr>
<th>Hex</th>
<th>0 1 2 3 4 5 6 7 8 9 A B C D E F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>2020 2020 2020 2020 2020 2020</td>
</tr>
<tr>
<td>40</td>
<td>20FF 8384 85A0 C686 87A4 BD2E</td>
</tr>
<tr>
<td>50</td>
<td>2682 8889 8AA1 8C8B 8DE1 2124</td>
</tr>
<tr>
<td>60</td>
<td>202F B6B5 202F 202F 202F 202F</td>
</tr>
<tr>
<td>70</td>
<td>20FF D034 D056 D078 D09A D11C</td>
</tr>
<tr>
<td>80</td>
<td>9D61 6263 6465 6667 6869 AEA8</td>
</tr>
<tr>
<td>90</td>
<td>F86A 686C 686C 6F70 7172 6A7F</td>
</tr>
<tr>
<td>A0</td>
<td>E67E 7373 7576 7778 797A ADB8</td>
</tr>
<tr>
<td>B0</td>
<td>5E9C BEFA B8F5 F4AC A8F3 5B5D</td>
</tr>
<tr>
<td>C0</td>
<td>7841 4243 4445 4647 4849 F093</td>
</tr>
<tr>
<td>D0</td>
<td>7F4A 484C 404E 4F50 5152 F996</td>
</tr>
<tr>
<td>E0</td>
<td>5CF6 5354 5556 5758 595A FDE2</td>
</tr>
<tr>
<td>F0</td>
<td>3031 3233 3435 3637 3839 FCEA</td>
</tr>
</tbody>
</table>

You can modify this code page using EBCDIC_xx keywords. Note that the EBCDIC_PASSTHRU? line precedes any EBCDIC_xx lines in your PDF file because Personal Communications reinitializes the EBCDIC-to-ASCII translation table when it finds that EBCDIC_PASSTHRU? is set.

Even if EBCDIC_PASSTHRU? is set, control codes defined START_JOB and END_JOB are sent to the printer at the start and the end of a print job respectively. To remove those commands, you need to rebuild the PDT file after removing PDF keyword definitions for START_JOB and END_JOB.
**EBCDIC_xx Keyword Support**

EBCDIC_xx keywords are used to remap entries of EBCDIC-to-ASCII translation table for printer sessions that receive SNA character string (SCS) data streams. For example, if you want to print host space characters using ASCII X'1B', add the following line to your PDF file and recompile to update the PDT file:

```
EBCDIC_40 = 1B
```

You can specify two or more characters for one EBCDIC character. The following definition:

```
EBCDIC_F1 = 1 2 3
```

translates EBCDIC X'F1' into "123" in ASCII.

You can also remap EBCDIC code points (X'00'-X'3F') which are normally assigned to SCS control characters. The following line:

```
EBCDIC_15 = 0C
```

overrides the SCS new line function with X'0C', which normally works as a form feed function. If you remap a code point that is not used for a SCS command (for example, X'27') Personal Communications sends the defined code to the printer and does not send SNA sense data to the host. The following example

```
EBCDIC_27 = 1B
```

defines EBCDIC code point X'27' as ASCII X'1B', which is used as an escape character on most personal computer printers.

If you do not need to use any SCS command processing but still need EBCDIC-to-ASCII translation, the EBCDIC_PASSTHRU? is a better solution. If you do not need any SCS command processing or EBCDIC-to-ASCII translation, ASCII_PASSTHRU? is an easier solution.

---

**Printer Definition Tables**

Standard printer definition table file names are of the form `IBMnnnnn.PDT`, and PDT’s ASCII-to-ASCII character definitions are of the form `PRNnnnnn.PDT`, where nnnnn is a machine type. See character definition descriptions for more details.

See the help panel or the specific 5250, 3270, or VT emulator user's reference for a list of the PDT files provided by Personal Communications.

The PDT files contained in the PC400 installation diskette can be used as is. However, you might want to do special formatting by changing the definitions of some fields. To do so, copy an existing PDF file, modify it, and then convert it to a new PDT file.

Example PDF files are shown in "Example Printer Definition Files". Do not attempt to change the statements in a field for which modification is specifically prohibited. If you use a PDT file created from a changed PDF file, the results of printing cannot be guaranteed.

---

**Example Printer Definition Files**

The following examples are annotated versions of printer definition files for the IBM LaserPrinter 4019 (for SBCS sessions) and for the IBM 5577 Printer (for DBCS sessions). These are examples only; the actual files may differ.
Macro Definitions

Define values here that will be used commonly throughout your definitions. Then use the left hand side of the equate as you define your characters and control strings. The printer compiler will substitute the right hand side of the equate for each occurrence of the left hand side throughout the file.

Macro names must be at least three characters long and may not begin with a number.

Format

A Macro Name is associated with a value or string of values by the EQU statement. The right hand side of an EQU statement must be a string of zero or more two digit hexadecimal numbers. If a macro definition is more than one line long, you may extend it to the next line by ending the first line with a comma. In this manner you may define a macro which is many lines long by terminating each line except the last with a comma. No macro names are allowed on right hand side.

BEGIN_MACROS

The following values are standard for most printers. Check your printer manual to verify that these are correct for your printer.

NUL EQU 00 /* Nul character */
BEL EQU 07 /* Beeper */
BAK EQU 08 /* Back Space */
TAB EQU 09 /* Tab */
LFF EQU 0A /* Line Feed */
VTB EQU 0B /* Vertical Tab */
FFF EQU 0C /* Form Feed */
CRR EQU 0D /* Carriage Return */
P05 EQU 1B 57 01 /* 5 Pitch-Characters/inch */
P10 EQU 12 /* 10 Pitch-Characters/inch */
CDW EQU 1B 57 00 /* Cancel Double Wide contin. */
CDL EQU 14 /* Cancel Double Wide line */
ESC EQU 1B /* Escape */
CAN EQU 18 /* Cancel Data */
SPA EQU 20 /* Space */
P17 EQU 12 0F /* 17.1 Pitch-Characters/inch */
CS2 EQU 1B 36 /* Select Character Set 2 */
CSI EQU 1B 37 /* Select Character Set 1 */
P12 EQU 1B 3A /* 12 Pitch-characters/inch */
SVT EQU 1B 42 /* Set Vertical Tabs */
SFL EQU 1B 43 00 /* Set Form Length */
SHT EQU 1B 44 /* Set Horizontal Tabs */
SDS EQU 1B 47 /* Start Double Strike */
COD EQU 1B 48 /* Cancel Double Strike */
SSP EQU 1B 4E /* Set skip perforation */
CSP EQU 1B 4F /* Cancel skip perforation */
CAT EQU 1B 52 /* Cancel all tabs Clears VT */
CSS EQU 1B 54 /* Cancel Subscript or Superscript */
SSO EQU 1B 53 00 /* Set Superscript over */
SSU EQU 1B 53 01 /* Set Subscript under */
SUL EQU 1B 2D /* Start Underline */
CUL EQU 1B 2D 00 /* Cancel Underline */
SCP EQU 1B 58 54 04 00 00 00 /* ESC T - select code page */
CP8 EQU 1B 5B 54 04 00 00 00 03 52  /* select code page 850 */
CP4 EQU 1B 5B 54 04 00 00 00 01 B5  /* select code page 437 */
LL2 EQU 1B 41 24 1B 32  /* Set line length 2 lines/inch */
LL3 EQU 1B 41 18 1B 32  /* Set line length 3 lines/inch */
LL4 EQU 1B 41 12 1B 32  /* Set line length 4 lines/inch */
LL6 EQU 1B 41 0C 1B 32  /* Set line length 6 lines/inch */
LL8 EQU 1B 41 09 1B 32  /* Set line length 8 lines/inch */
LL0 EQU 1B 41 07 1B 32  /* Set line length 10 lines/inch */
  /* actually 7/72 inch */
SD1 EQU 1B 5B 46 05 00 00 01 01 00 00  /* Select Drawer 1 */
SD2 EQU 1B 5B 46 05 00 00 01 02 00 00  /* Select Drawer 2 */
ENV EQU 1B 5B 46 05 00 00 02 00 00 00  /* Select Envelope */
FRM EQU 1B 64  /* Forward Relative Movement */
VLF EQU 1B 4A  /* Vertical Line Feed 1/216 inch units */
SPO EQU 1B 6B  /* Set Portrait Orientation */
SLO EQU 1B 6C  /* Set Landscape Orientation */
SFG EQU 1B 5B 49 08 00  /* Set Font Global */
END_MACROS

/* Session Parameters */
/* These parameters determine the way in which output will be */
/* formatted for your printer. */
/* Numeric Parameters */
/* These parameters should be defined with a two digit hex number */
/* or a three digit decimal number. The range of the number is zero */
/* to 255 (decimal). */
MAXIMUM_PAGE_LENGTH=066  /* Printed lines per page */
MAXIMUM_PRINT_POSITION=080  /* Printed characters per line */
INTERV_REQ_TIMER=001
RESELECT_TIME_EXPT.5204=001
INTERV_TIMER_ON_PE_ONLY?=NO
HORIZONTAL_PEL=120
VERTICAL_PEL=216
LINE_SPACING_RATIO=072
PAGE_LENGTH_TYPE?=INCH  /* SET_PAGE_LENGTH "value" is */
  /* values */
/* YES/NO Parameters */
/* These parameters should be defined with either "YES" or "NO" on the */
/* right hand side of the '=' */
COMPRESS_LINE_SPACING?=NO  /* Should blank or null lines */
  /* be printed? */
FORM_FEED_ANY_POSITION?=YES  /* Should the form feed be */
  /* valid in any position? */
 OVERRIDE_FORMATTED_PRINT?=YES  /* Should nulls be printed as */
  /* blanks? */
AUTO_NEWLINE_AT_MAX_POS?=NO
/* Control Codes */
/* These definitions tell the emulator what control strings to send to */
/* your printer to issue control commands. */
/* /* Format */
/* The name of the control command should always be at the beginning */
/* of a line followed by a '=' and then a definition string. */
/* A Definition String is any combination of macro names, hexadecimal */
/* numbers, and characters separated by blanks. A macro must have */
/* previously defined in the macro definitions section above. A */
/* hexadecimal number must be two digits (0,...,F) long and a */
/* character must be preceded and followed by a blank. If a */
/* definition string will not fit on a line, it may be continued */
/* as many lines as you wish by ending each line except the last with */
/* a comma; '. '. You made add any comments you wish to by including */
/* them between a slash* and a *slash where slash is the symbol / */

/* START_JOB is the control string which will be sent to your printer */
/* at the beginning of each print job. */
START_JOB=SEL CDW CDL CUL CDS CP8 CS2
/* END_JOB is the string which will be sent to your printer at the end */
/* of each print job. */
The following commands specify control codes for which most PC printers require command strings which contain a variable value or values somewhere in the middle of the string.

Place the word "values" in the position of your definition string where the Personal Communications 5250 should fill in the hexadecimal value(s) indicated. For example, on the IBM Proprinter, the SET_HORIZONTAL_TABS definition is:

```
SET_HORIZONTAL_TABS=ESC D values NUL
```

SET_VERTICAL_TABS=SVT values NUL /* "values" are the tab stops in line numbers */

SET_HORIZONTAL_MARGINS=

SET_PAGE_LENGTH=SFL value /* "value"=inch of the page */

SET_AUTO_PERFORATION_SKIP=SSP value /* "value"=number of lines to skip over the perforation between pages. Used to set top and bottom margins. */

SET_VARIABLE_LINE_DENSITY=ESC A value ESC 2 /* "value"=number of points. */

SET_CHARACTER_SET=

```
/*SET_CHARACTER_SET=ESC I NULL selects the normal font*/
/*SET_CHARACTER_SET=ESC I 02 selects the NLQ (near letter quality)*/
/*SET_CHARACTER_SET=ESC I 04 selects the normal downloaded font*/
/*SET_CHARACTER_SET=ESC I 06 selects the NLQ downloaded font*/
/*SET_CHARACTER_SET=CS1 selects the Character set 1*/
/*SET_CHARACTER_SET=CS2 selects the Character set 2*/
```

These control codes set the printer lines per inch and characters per inch to fixed amounts. If your printer does not support setting the line density in points then you can enter control strings for the following commands. When Personal Communications 5250 gets a command from the host to set the lines per inch, it will round it to the closest line per inch setting that you provide. Note that if you provide a command for the SET_VARIABLE_LINE_DENSITY command above that it will be used and any control strings you provide for the set lines per inch commands below will not be used.

```
SET_2_LINES_PER_INCH=LL2
SET_3_LINES_PER_INCH=LL3
SET_4_LINES_PER_INCH=LL4
SET_6_LINES_PER_INCH=LL6
SET_8_LINES_PER_INCH=LL8
SET_10_LINES_PER_INCH=LL0 /* 7/72 inch or 9/96 inch */
SET_10_CHARACTERS_PER_INCH=P10
SET_12_CHARACTERS_PER_INCH=P12
SET_13_CHARACTERS_PER_INCH= /* */
```
SET_15_CHARACTERS_PER_INCH= /* The proprinter does not */
       /* support 15 pitch except in */
       /* graphic mode */ *
SET_17_CHARACTERS_PER_INCH=P17 /* Condensed mode */ *
SET_20_CHARACTERS_PER_INCH=*
START_DOUBLE_WIDTH_CHARACTERS=P05
END_DOUBLE_WIDTH_CHARACTERS=CDW

/* These control codes are used to select the source drawer number */
/* when your printer has the dual drawer sheetfeed option. */
SELECT_DRAWER1=SD1
SELECT_DRAWER2=SD2
SELECT_DRAWER3=
SELECT_ENVELOPE=ENV /* Envelope */

/* These control codes select the print mode (quality of print). */
SELECT_DRAFT_QUALITY=
SELECT_LETTER_QUALITY=
SELECT_ENHANCED_QUALITY=
SELECT_SETUP_QUALITY=

/* These control codes */
SET_DUPLEX=
SET_DUPLEX_TUMBLE=
RESET_DUPLEX=

/* These control codes set page orientation */
SET_PORTORATE_ORIENT=SPO
SET_LANDSCAPELEFT_ORIENT=SLO
SET_PORTORATUPOWN_ORIENT=SPO
SET_LANDSCAPERIGHT_ORIENT=SLO

/* These control codes move the print position (Horizontal/Vertical) */
FORWARD_HORIZNTAL_SKIP=FRM word-value(LH)
FORWARD_HORIZONTAL_STEP_FEED=VLF byte-value

/* These control codes select the printer font via global font ID */
SET_FONT_GLOBAL=
SET_GFID_0003=SFG 00 03 00 90 01 01 03 52 CDW /* OCR-B.10 */
SET_GFID_0005=SFG 00 05 00 90 01 01 03 52 CDW /* Orator.10 */
SET_GFID_0011=SFG 00 0B 00 90 01 01 03 52 CDW /* Courier.10 */
SET_GFID_0012=SFG 00 0C 00 90 01 01 03 52 CDW /* Prestige.10 */
SET_GFID_0013=SFG 00 0B 00 90 01 01 03 52 CDW /* Artisan.10 */
SET_GFID_0019=SFG 00 13 00 90 01 01 03 52 CDW /* OCR-A.10 */
SET_GFID_0020=SFG 00 14 00 90 01 01 03 52 CDW /* Pica.10 */
SET_GFID_0030=SFG 00 1E 00 90 01 01 03 52 CDW /* Math-Symbol.10 */
SET_GFID_0038=SFG 00 26 00 90 01 01 03 52 CDW /* Orator.Bold.10 */
SET_GFID_0039=SFG 00 27 00 90 01 01 03 52 CDW /* Gothic-Bold.10 */
SET_GFID_0040=SFG 00 28 00 90 01 01 03 52 CDW /* Gothic-Text.10 */
SET_GFID_0041=SFG 00 29 00 90 01 01 03 52 CDW /* Roman-text.10 */
SET_GFID_0042=SFG 00 2A 00 90 01 01 03 52 CDW /* Serif-text.10 */
SET_GFID_0043=SFG 00 2B 00 90 01 01 03 52 CDW /* Serif-text.Italic.10 */
SET_GFID_0044=SFG 00 2C 00 90 01 01 03 52 CDW /* Katakana-gothic.10 */
SET_GFID_0045=SFG 00 2D 00 90 01 01 03 52 CDW /* APL.10 */
SET_GFID_0046=SFG 00 2E 00 90 01 01 03 52 CDW /* Courier.10 */
SET_GFID_0050=SFG 00 2F 00 90 01 01 03 52 CDW /* Shalom.10 */
SET_GFID_0066=SFG 00 42 00 78 01 01 03 52 CDW /* Gothic-text.12 */
SET_GFID_0068=SFG 00 44 00 78 01 01 03 52 CDW /* Gothic-text.Italic.12 */
SET_GFID_0069=SFG 00 45 00 78 01 01 03 52 CDW /* Gothic.12 */
SET_GFID_0070=SFG 00 46 00 78 01 01 03 52 CDW /* Serif-text.12 */
SET_GFID_0071=SFG 00 47 00 78 01 01 03 52 CDW /* Serif-text.Italic.12 */
SET_GFID_0072=SFG 00 48 00 78 01 01 03 52 CDW /* Serif.12 */
SET_GFID_0080=SFG 00 73 00 78 01 01 03 52 CDW /* Math-Symbol.12 */
SET_GFID_0084=SFG 00 54 00 78 01 01 03 52 CDW /* Script.12 */
SET_GFID_0085=SFG 00 55 00 78 01 01 03 52 CDW /* Courier.12 */
SET_GFID_0086=SFG 00 56 00 78 01 01 03 52 CDW /* Prestige.12 */
START_HIGHLIGHT_INTENSE=SDS /* This is double strike */
END_HIGHLIGHT_INTENSE=CDS

Color Specifications
START_COLOR_BLUE=
END_COLOR_BLUE=
START_COLOR_GREEN=
END_COLOR_GREEN=
START_COLOR_CYAN=
END_COLOR_CYAN=
START_COLOR_RED=
END_COLOR_RED=
START_COLOR_MAGENTA=
END_COLOR_MAGENTA=
START_COLOR_YELLOW=
END_COLOR_YELLOW=
START_COLOR_BLACK=
END_COLOR_BLACK=
START_COLOR_WHITE=
END_COLOR_WHITE=

Highlight Specifications
START_HIGHLIGHT_INTENSE=SDS /* This is double strike */
END_HIGHLIGHT_INTENSE=CDS
Chapter 20. Building a Printer Definition Table (PDT) for PC400
LEFT_BRACKET=5B
BACKSLASH=5C
RIGHT_BRACKET=5D
CIRCUMFLEX_ACCENT=5E
UNDERLINE=5F
GRAVE_ACCENT=60
A_SMALL=a
B_SMALL=b
C_SMALL=c
D_SMALL=d
E_SMALL=e
F_SMALL=f
G_SMALL=g
H_SMALL=h
I_SMALL=i
J_SMALL=j
K_SMALL=k
L_SMALL=l
M_SMALL=m
N_SMALL=n
O_SMALL=o
P_SMALL=p
Q_SMALL=q
R_SMALL=r
S_SMALL=s
T_SMALL=t
U_SMALL=u
V_SMALL=v
W_SMALL=w
X_SMALL=x
Y_SMALL=y
Z_SMALL=z
LEFT_BRACE=7B
VERTICAL_BAR=7C
RIGHT_BRACE=7D
TILDE_ACCENT=7E
C_CEDILLA_CAPITAL=80
U_DIAERESIS_SMALL=81
E_ACUTE_SMALL=82
A_CIRCUMFLEX_SMALL=83
A_DIAERESIS_SMALL=84
A_OVERCIRCLE_SMALL=85
A_GRAVE_SMALL=86
A_CEDILLA_SMALL=87
E_CIRCUMFLEX_SMALL=88
E_DIAERESIS_SMALL=89
E_GRAVE_SMALL=8A
I_DIAERESIS_SMALL=8B
I_CIRCUMFLEX_SMALL=8C
I_GRAVE_SMALL=8D
A_DIAERESIS_CAPITAL=8E
A_OVERCIRCLE_CAPITAL=8F
E_ACUTE_CAPITAL=90
AE_DIPHTHONG_SMALL=91
AE_DIPHTHONG_CAPITAL=92
O_CIRCUMFLEX_SMALL=93
O_DIAERESIS_SMALL=94
O_GRAVE_SMALL=95
U_CIRCUMFLEX_SMALL=96
U_GRAVE_SMALL=97
Y_DIAERESIS_SMALL=98
U_DIAERESIS_CAPITAL=99
U_DIAERESIS_CAPITAL=9A
O_SLASH_SMALL=9B
POUND_SIGN=9C
O_SLASH_CAPITAL=9D
MULTIPLY_SIGN=9E
Chapter 20. Building a Printer Definition Table (PDT) for PC400
/* Do not change these statements. */

TOP_MARGIN=
LEFT_MARGIN=
DYNAMIC_START_JOB=00 00 00 00 00 00 00 00 00 00 00
DYNAMIC_END_JOB=00 00
DYNAMIC_SET_PAGE_LENGTH=00 00
PRINTER_ID=40 19

/* End of Definition File */

IBM5577.PDF File Contents

BEGIN_MACROS
NUL EQU 00
BEL EQU 07
BAK EQU 08
TAB EQU 09
LFF EQU 0A
VTB EQU 0B
FFF EQU 0C
CRR EQU 0D
SEL EQU 11
DC3 EQU 13
ESC EQU 1B
CAN EQU 18
SPA EQU 20
P10 EQU 1B 7E 02 00 01 32
P12 EQU 1B 7E 02 00 01 3C
P13 EQU 1B 7E 02 00 01 43
P15 EQU 1B 7E 02 00 01 4B
SDW EQU 1B 7E 0E 00 01 09
EDW EQU 1B 7E 0E 00 01 0A
SVT EQU 1B 7E 19
SHT EQU 1B 7E 18
CSS EQU 1B 7E 0E 00 01 0F
SSO EQU 1B 7E 0E 00 01 0D
SSU EQU 1B 7E 0E 00 01 1E
SUL EQU 1B 7E 11 00 01 01
CUL EQU 1B 7E 11 00 01 00
LL2 EQU 1B 7E 03 00 01 14
LL3 EQU 1B 7E 03 00 01 1E
LL4 EQU 1B 7E 03 00 01 28
LL6 EQU 1B 7E 03 00 01 3C
LL7 EQU 1B 7E 03 00 01 4B
LL8 EQU 1B 7E 03 00 01 50
SPL EQU 1B 7E 04 00 03 00
INZ EQU 1B 7E 01 00 00
EJC EQU 1B 7E 0E 00 01 06
END_MACROS

MAXIMUM_PAGE_LENGTH=066
MAXIMUM_PRINT_POSITION=132
DEFAULT_CPI?=010
DEFAULT_LPI?=006
COMPRESSION_LINE_SPACING?=NO
FORM_FEED_ANY_POSITION?=YES
OVERRIDE_FORMATTED_PRINT?=YES
HORIZONTAL_PEL=180
VERTICAL_PEL=120
UNITS_OF_DRAW_LINE=
KANJI_CODE?=SHIFT_JIS
ZENKAKU_SPACE=
PAGE_LENGTH_TYPE?=6INCH
/***************************************************************************/
/* Control Codes */
/***************************************************************************/
START_JOB=INZ SEL LL6 P10
END_JOB=INZ
BACKSPACE=BAK
BEL=BEL
CARRIAGE_RETURN=CRR
NEW_LINE=CRR LFF
LINE_FEED=LFF
FORM_FEED=EJC
HORIZONTAL_TAB=TAB
VERTICAL_TAB=VTB
DESELECT=DC3
START_SUBSCRIPT=SSU
END_SUBSCRIPT=CSS
START_SUPERSCRIPT=SSO
END_SUPERSCRIPT=CSS
DUP=+
FIELD_MARK=:
SET_HORIZONTAL_TABS=SHT length(HL)-values
SET_VERTICAL_TABS=SVT length(HL)-values
SET_HORIZONTAL_MARGINS=
SET_PAGE_LENGTH=SPL word-value(HL)
SET_2_LINES_PER_INCH=LL2
SET_3_LINES_PER_INCH=LL3
SET_4_LINES_PER_INCH=LL4
SET_6_LINES_PER_INCH=LL6
SET_7.5_LINES_PER_INCH=LL7
SET_8_LINES_PER_INCH=LL8
SET_10_CHARACTERS_PER_INCH=P10
SET_12_CHARACTERS_PER_INCH=P12
SET_13.4_CHARACTERS_PER_INCH=P13
SET_15_CHARACTERS_PER_INCH=P15
START_DOUBLE_WIDTH_CHARACTERS=SDW
END_DOUBLE_WIDTH_CHARACTERS=EDW
IMAGE_TRANSMISSION=1B 25 31 length(HL)-images
FORWARD_HORIZONTAL_SKIP=1B 25 33 word-value(HL)
FORWARD_VERTICAL_STEP_FEED=1B 25 35 word-value(HL)
SET_FONT_SIZE=1B 7E 20 00 03 word-value(HL) 02
SET_TATEGAKI_MODE=1B 7E 0E 00 01 0B
RESET_TATEGAKI_MODE=1B 7E 0E 00 01 0C
SBCS_FONT_LOAD=1B 7E 81 00 28 F0 40 00 18 byte-values F0 40
DBCS_FONT_LOAD=1B 7E 81 00 28 F0 40 00 18 word-value(HL) F0 40
SELECT_DRAWER=
SET_LOCAL_FONT=
RESET_LOCAL_FONT=
ABS_HORIZONTAL_COLUMN_SKIP=1B 7E 1C 00 02 00 byte-value
REL_HOR_COLUMN_SKIP_TO_RIGHT=1B 7E 1C 00 02 01 byte-value
SET_SOLID_LINE_TYPE=
SET_DOTTED_LINE_TYPE=
SET_LINE_WIDTH_THIN=
SET_LINE_WIDTH_BOLD=
DRAW_LINE=
KANJI_ON=
KANJI_OFF=
ATTRIBUTE_GRID_LINE=1B 7E 16 length(HL)-values
/******************************************************************************/
/* Highlight Specifications */
/******************************************************************************/
START_HIGHLIGHT_INTENSE=ESC 7E 0E 00 01 17
END_HIGHLIGHT_INTENSE=ESC 7E 0E 00 01 18
START_HIGHLIGHT_UNDERLINE=1B 7E 11 00 01 01
END_HIGHLIGHT_UNDERLINE=1B 7E 11 00 01 00
/******************************************************************************/
Chapter 20. Building a Printer Definition Table (PDT) for PC400  185
Field Names of Printer Definition Files

Table 22 lists the field names of the printer definition files (PDF files) and their meanings:

<table>
<thead>
<tr>
<th>Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAXIMUM_PAGE_LENGTH</td>
</tr>
<tr>
<td>MAXIMUM_PRINT_POSITION</td>
</tr>
<tr>
<td>DEFAULT_CPI?</td>
</tr>
<tr>
<td>DEFAULT_LPI?</td>
</tr>
<tr>
<td>COMPRESS_LINE_SPACING?</td>
</tr>
<tr>
<td>FORM_FEED_ANY_POSITION?</td>
</tr>
<tr>
<td>OVERRIDE_FORMATTED_PRINT?</td>
</tr>
<tr>
<td>HORIZONTAL_PEL</td>
</tr>
<tr>
<td>VERTICAL_PEL</td>
</tr>
<tr>
<td>IMAGE_HORIZONTAL_PEL</td>
</tr>
<tr>
<td>IMAGE_VERTICAL_PEL</td>
</tr>
<tr>
<td>LINE_SPACING_RATIO</td>
</tr>
<tr>
<td>PAGE_LENGTH_TYPE?</td>
</tr>
<tr>
<td>FIRST_LEFT_POSITION</td>
</tr>
<tr>
<td>FIRST_TOP_POSITION</td>
</tr>
<tr>
<td>DRAWER1_ORIENTATION</td>
</tr>
<tr>
<td>DRAWER2_ORIENTATION</td>
</tr>
<tr>
<td>AUTOMATIC_ORIENTATION</td>
</tr>
<tr>
<td>START_JOB</td>
</tr>
<tr>
<td>END_JOB</td>
</tr>
<tr>
<td>BACKSPACE</td>
</tr>
<tr>
<td>BEL</td>
</tr>
<tr>
<td>CARRIAGE_RETURN</td>
</tr>
<tr>
<td>NEW_LINE</td>
</tr>
<tr>
<td>LINE_FEED</td>
</tr>
<tr>
<td>FORM_FEED</td>
</tr>
<tr>
<td>HORIZONTAL_TAB</td>
</tr>
<tr>
<td>VERTICAL_TAB</td>
</tr>
<tr>
<td>DESELECT</td>
</tr>
</tbody>
</table>

Administrator's Guide and Reference
<table>
<thead>
<tr>
<th>Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>START_SUBSCRIPT</td>
</tr>
<tr>
<td>END_SUBSCRIPT</td>
</tr>
<tr>
<td>START_SUPERSCRIPT</td>
</tr>
<tr>
<td>END_SUPERSCRIPT</td>
</tr>
<tr>
<td>DUP</td>
</tr>
<tr>
<td>FIELD_MARK</td>
</tr>
<tr>
<td>SET_HORIZONTAL_TABS</td>
</tr>
<tr>
<td>SET_VERTICAL_TABS</td>
</tr>
<tr>
<td>SET_HORIZONTAL_MARGINS</td>
</tr>
<tr>
<td>SET_PAGE_LENGTH</td>
</tr>
<tr>
<td>SET_VARIABLE_LINE_DENSITY</td>
</tr>
<tr>
<td>SET_2_LINES_PER_INCH</td>
</tr>
<tr>
<td>SET_3_LINES_PER_INCH</td>
</tr>
<tr>
<td>SET_4_LINES_PER_INCH</td>
</tr>
<tr>
<td>SET_6_LINES_PER_INCH</td>
</tr>
<tr>
<td>SET_8_LINES_PER_INCH</td>
</tr>
<tr>
<td>SET_10_LINES_PER_INCH</td>
</tr>
<tr>
<td>SET_10_CHARACTERS_PER_INCH</td>
</tr>
<tr>
<td>SET_12_CHARACTERS_PER_INCH</td>
</tr>
<tr>
<td>SET_13_CHARACTERS_PER_INCH</td>
</tr>
<tr>
<td>SET_15_CHARACTERS_PER_INCH</td>
</tr>
<tr>
<td>SET_17_CHARACTERS_PER_INCH</td>
</tr>
<tr>
<td>SET_20_CHARACTERS_PER_INCH</td>
</tr>
<tr>
<td>IMAGE_TRANSMISSION</td>
</tr>
<tr>
<td>SELECT_DRAWER1</td>
</tr>
<tr>
<td>SELECT_DRAWER2</td>
</tr>
<tr>
<td>SELECT_ENVELOPE</td>
</tr>
<tr>
<td>SELECT_DRAFT_QUALITY</td>
</tr>
<tr>
<td>SELECT_LETTER_QUALITY</td>
</tr>
<tr>
<td>SELECT_ENHANCED_QUALITY</td>
</tr>
<tr>
<td>SET_DUPLEX</td>
</tr>
<tr>
<td>SET_DUPLEX_TUMBLE</td>
</tr>
<tr>
<td>RESET_DUPLEX</td>
</tr>
<tr>
<td>SET_PORTRAIT_ORIENT</td>
</tr>
<tr>
<td>SET_LANDSCAPELEFT_ORIENT</td>
</tr>
<tr>
<td>SET_PORTRAITUPDOWN_ORIENT</td>
</tr>
<tr>
<td>SET_LANDSCAPERIGHT_ORIENT</td>
</tr>
<tr>
<td>FORWARD_HORIZONTAL_SKIP</td>
</tr>
<tr>
<td>FORWARD_VERTICAL_STEP_FEED</td>
</tr>
</tbody>
</table>
Table 22. Field Names of PDF Files (continued)

<table>
<thead>
<tr>
<th>Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>SET_FONT_GLOBAL</td>
</tr>
<tr>
<td>SET_GFID_0003</td>
</tr>
<tr>
<td>SET_GFID_0005</td>
</tr>
<tr>
<td>SET_GFID_0011</td>
</tr>
<tr>
<td>SET_GFID_0012</td>
</tr>
<tr>
<td>SET_GFID_0013</td>
</tr>
<tr>
<td>SET_GFID_0018</td>
</tr>
<tr>
<td>SET_GFID_0019</td>
</tr>
<tr>
<td>SET_GFID_0020</td>
</tr>
<tr>
<td>SET_GFID_0030</td>
</tr>
<tr>
<td>SET_GFID_0038</td>
</tr>
<tr>
<td>SET_GFID_0039</td>
</tr>
<tr>
<td>SET_GFID_0040</td>
</tr>
<tr>
<td>SET_GFID_0041</td>
</tr>
<tr>
<td>SET_GFID_0042</td>
</tr>
<tr>
<td>SET_GFID_0043</td>
</tr>
<tr>
<td>SET_GFID_0044</td>
</tr>
<tr>
<td>SET_GFID_0045</td>
</tr>
<tr>
<td>SET_GFID_0046</td>
</tr>
<tr>
<td>SET_GFID_0050</td>
</tr>
<tr>
<td>SET_GFID_0066</td>
</tr>
<tr>
<td>SET_GFID_0068</td>
</tr>
<tr>
<td>SET_GFID_0069</td>
</tr>
<tr>
<td>SET_GFID_0070</td>
</tr>
<tr>
<td>SET_GFID_0071</td>
</tr>
<tr>
<td>SET_GFID_0072</td>
</tr>
<tr>
<td>SET_GFID_0080</td>
</tr>
<tr>
<td>SET_GFID_0084</td>
</tr>
<tr>
<td>SET_GFID_0085</td>
</tr>
<tr>
<td>SET_GFID_0086</td>
</tr>
<tr>
<td>SET_GFID_0087</td>
</tr>
<tr>
<td>SET_GFID_0091</td>
</tr>
<tr>
<td>SET_GFID_0110</td>
</tr>
<tr>
<td>SET_GFID_0111</td>
</tr>
<tr>
<td>SET_GFID_0112</td>
</tr>
<tr>
<td>SET_GFID_0115</td>
</tr>
<tr>
<td>SET_GFID_0155</td>
</tr>
<tr>
<td>SET_GFID_0158</td>
</tr>
<tr>
<td>SET_GFID_0159</td>
</tr>
<tr>
<td>SET_GFID_0160</td>
</tr>
<tr>
<td>Field Name</td>
</tr>
<tr>
<td>--------------------------------</td>
</tr>
<tr>
<td>SET_GFID_0162</td>
</tr>
<tr>
<td>SET_GFID_0163</td>
</tr>
<tr>
<td>SET_GFID_0168</td>
</tr>
<tr>
<td>SET_GFID_0173</td>
</tr>
<tr>
<td>SET_GFID_0175</td>
</tr>
<tr>
<td>SET_GFID_0176</td>
</tr>
<tr>
<td>SET_GFID_0177</td>
</tr>
<tr>
<td>SET_GFID_0193</td>
</tr>
<tr>
<td>SET_GFID_0198</td>
</tr>
<tr>
<td>SET_GFID_0204</td>
</tr>
<tr>
<td>SET_GFID_0221</td>
</tr>
<tr>
<td>SET_GFID_0222</td>
</tr>
<tr>
<td>SET_GFID_0223</td>
</tr>
<tr>
<td>SET_GFID_0225</td>
</tr>
<tr>
<td>SET_GFID_0229</td>
</tr>
<tr>
<td>SET_GFID_0230</td>
</tr>
<tr>
<td>SET_GFID_0245</td>
</tr>
<tr>
<td>SET_GFID_0252</td>
</tr>
<tr>
<td>SET_GFID_0253</td>
</tr>
<tr>
<td>SET_GFID_0254</td>
</tr>
<tr>
<td>SET_GFID_0280</td>
</tr>
<tr>
<td>SET_GFID_0281</td>
</tr>
<tr>
<td>SET_GFID_0290</td>
</tr>
<tr>
<td>SET_GFID_0751</td>
</tr>
<tr>
<td>SET_GFID_1051</td>
</tr>
<tr>
<td>SET_GFID_1053</td>
</tr>
<tr>
<td>SET_GFID_1056</td>
</tr>
<tr>
<td>SET_GFID_1351</td>
</tr>
<tr>
<td>SET_GFID_1653</td>
</tr>
<tr>
<td>SET_GFID_2103</td>
</tr>
<tr>
<td>START_HIGHLIGHT_INTENSE</td>
</tr>
<tr>
<td>END_HIGHLIGHT_INTENSE</td>
</tr>
<tr>
<td>START_HIGHLIGHT_UNDERLINE</td>
</tr>
<tr>
<td>END_HIGHLIGHT_UNDERLINE</td>
</tr>
<tr>
<td>TOP_MARGIN</td>
</tr>
<tr>
<td>LEFT_MARGIN</td>
</tr>
<tr>
<td>DYNAMIC_START_JOB</td>
</tr>
<tr>
<td>DYNAMIC_END_JOB</td>
</tr>
<tr>
<td>DYNAMIC_SET_PAGE_LENGTH</td>
</tr>
<tr>
<td>PRINTER_ID</td>
</tr>
</tbody>
</table>
### Table 22. Field Names of PDF Files (continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>KANJI_CODE?</td>
<td></td>
</tr>
<tr>
<td>ZENKAKU_SPACE</td>
<td></td>
</tr>
<tr>
<td>SBCS_FONT_LOAD</td>
<td></td>
</tr>
<tr>
<td>DBCS_FONT_LOAD</td>
<td></td>
</tr>
<tr>
<td>SET_LOCAL_FONT</td>
<td></td>
</tr>
<tr>
<td>RESET_LOCAL_FONT</td>
<td></td>
</tr>
<tr>
<td>KANJI_ON</td>
<td></td>
</tr>
<tr>
<td>KANJI_OFF</td>
<td></td>
</tr>
<tr>
<td>ATTRIBUTE_GRID_LINE</td>
<td></td>
</tr>
<tr>
<td>START_DOUBLE_WIDTH_CHARACTER</td>
<td></td>
</tr>
<tr>
<td>END_DOUBLE_WIDTH_CHARACTER</td>
<td></td>
</tr>
</tbody>
</table>

**Notes:**

1. When using IBM5577.PDF, change FORM_FEED=EJC to FORM_FEED in the file when a continuous form job does not feed correctly.

2. When using ESC_P.PDF, DBCS (2-byte) characters are placed to the left of the character box, not in the center. To place DBCS characters in the center of the character box, change the IBM-supplied values in ESC_P.PDF:

   ```
P10 EQU 18 50 1B 20 00 1C 53 00 0C 1C 54 00 00
P12 EQU 18 40 1B 20 00 1C 53 00 06 1C 54 00 00
P13 EQU 18 67 1B 20 01 1C 53 00 03 1C 54 00 01
P15 EQU 18 67 1B 20 00 1C 53 00 00 1C 54 00 00
```

   to the following:

   ```
P10 EQU 18 50 1B 20 00 1C 53 06 06 1C 54 00 00
P12 EQU 18 40 1B 20 00 1C 53 03 03 1C 54 00 00
P13 EQU 18 67 1B 20 01 1C 53 02 01 1C 54 00 01
P15 EQU 18 67 1B 20 00 1C 53 00 00 1C 54 00 00
```

The following table lists the session parameter field names and their effective values:

### Table 23. Effective Values for PDF File Field Names

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Effective Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAXIMUM_PAGE_LENGTH</td>
<td>001 to 255</td>
</tr>
<tr>
<td>MAXIMUM_PRINT_POSITION</td>
<td>001 to 255</td>
</tr>
<tr>
<td>DEFAULT_CPI?</td>
<td>010/012/015</td>
</tr>
<tr>
<td>DEFAULT_LPI?</td>
<td>004/006/008</td>
</tr>
<tr>
<td>COMPRESS_LINE_SPACING?</td>
<td>YES/NO</td>
</tr>
<tr>
<td>FORM_FEED_ANY_POSITION?</td>
<td>YES/NO</td>
</tr>
<tr>
<td>OVERRIDE_FORMATTED_PRINT?</td>
<td>YES/NO</td>
</tr>
<tr>
<td>HORIZONTAL_PEL</td>
<td>FORWARD_HORIZONTAL_SKIP length unit</td>
</tr>
<tr>
<td>VERTICAL_PEL</td>
<td>FORWARD_VERTICAL_STEP_FEED length unit</td>
</tr>
<tr>
<td>IMAGE_HORIZONTAL_PEL</td>
<td>IMAGE_TRANSMISSION horizontal unit</td>
</tr>
<tr>
<td>IMAGE_VERTICAL_PEL</td>
<td>IMAGE_TRANSMISSION vertical unit</td>
</tr>
</tbody>
</table>
Table 23. Effective Values for PDF File Field Names (continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Effective Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LINE_SPACING_RATIO</td>
<td>SET_VARIABLE_LINE_DENSITY length unit</td>
</tr>
<tr>
<td>PAGE_LENGTH_TYPE?</td>
<td>LINE/INCH/6INCH*</td>
</tr>
<tr>
<td>FIRST_LEFT_POSITION</td>
<td>000 to 1440 in units of 1/1440 inch</td>
</tr>
<tr>
<td>FIRST_TOP_POSITION</td>
<td>000 to 1440 in units of 1/1440 inch</td>
</tr>
<tr>
<td>DRAWER1_ORIENTATION</td>
<td>LANDSCAPE/PORTRAIT/COR</td>
</tr>
<tr>
<td>DRAWER2_ORIENTATION</td>
<td>LANDSCAPE/PORTRAIT/COR</td>
</tr>
<tr>
<td>AUTOMATIC_ORIENTATION</td>
<td>YES/NO</td>
</tr>
</tbody>
</table>

* 6/INCH indicates that page length should be specified in units of 1/6 inch.

Notes:
1. If one of the desired CPI/LPI settings is not exactly supported by the printer, set the nearest value. The results of printing might not be as desired.
2. If the units used to specify the control code length defined in FORWARD_HORIZONTAL_SKIP and FORWARD_VERTICAL_STEP_FEED are not the same as the units used to specify the HORIZONTAL_PEL and VERTICAL_PEL, the desired output will not be obtained.
3. If the units used to specify the control code length defined in SET_VARIABLE_LINE_DENSITY are not the same as the units used to specify the LINE_SPACING_RATIO, the desired output will not be obtained.
4. When FIRST_LEFT_POSITION and FIRST_TOP_POSITION are specified, their values are regarded as specifying the unprintable area in the page of the printer. These values are included in the top margin and the left margin specified by the iSeries, eServer i5, or System i5 printer control code.

Symbols of Printer Definition Files

The following table lists the symbols that are defined for printer definition files.

Table 24. Printer Symbol Definitions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPACE</td>
<td></td>
</tr>
<tr>
<td>EXCLAMATION_POINT</td>
<td>!</td>
</tr>
<tr>
<td>QUOTATION_MARKS</td>
<td>&quot;</td>
</tr>
<tr>
<td>NUMBER_SIGN</td>
<td>#</td>
</tr>
<tr>
<td>DOLLAR_SIGN</td>
<td>$</td>
</tr>
<tr>
<td>PERCENT_SIGN</td>
<td>%</td>
</tr>
<tr>
<td>AMPERSAND</td>
<td>&amp;</td>
</tr>
<tr>
<td>APOSTROPHE</td>
<td>'</td>
</tr>
<tr>
<td>LEFT_PARENTHESIS</td>
<td>(</td>
</tr>
<tr>
<td>RIGHT_PARENTHESIS</td>
<td>)</td>
</tr>
<tr>
<td>ASTERISK</td>
<td>*</td>
</tr>
<tr>
<td>PLUS_SIGN</td>
<td>+</td>
</tr>
<tr>
<td>COMMA</td>
<td>,</td>
</tr>
<tr>
<td>HYPHEN</td>
<td>-</td>
</tr>
</tbody>
</table>
### Table 24. Printer Symbol Definitions (continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERIOD</td>
<td>.</td>
</tr>
<tr>
<td>SLASH</td>
<td>/</td>
</tr>
<tr>
<td>ZERO</td>
<td>0</td>
</tr>
<tr>
<td>ONE</td>
<td>1</td>
</tr>
<tr>
<td>TWO</td>
<td>2</td>
</tr>
<tr>
<td>THREE</td>
<td>3</td>
</tr>
<tr>
<td>FOUR</td>
<td>4</td>
</tr>
<tr>
<td>FIVE</td>
<td>5</td>
</tr>
<tr>
<td>SIX</td>
<td>6</td>
</tr>
<tr>
<td>SEVEN</td>
<td>7</td>
</tr>
<tr>
<td>EIGHT</td>
<td>8</td>
</tr>
<tr>
<td>NINE</td>
<td>9</td>
</tr>
<tr>
<td>COLON</td>
<td>:</td>
</tr>
<tr>
<td>SEMICOLON</td>
<td>;</td>
</tr>
<tr>
<td>LESS_THAN_SIGN</td>
<td>&lt;</td>
</tr>
<tr>
<td>EQUAL_SIGN</td>
<td>=</td>
</tr>
<tr>
<td>GREATER_THAN_SIGN</td>
<td>&gt;</td>
</tr>
<tr>
<td>QUESTION_MARK</td>
<td>?</td>
</tr>
<tr>
<td>AT_SIGN</td>
<td>@</td>
</tr>
<tr>
<td>A_CAPITAL</td>
<td>A</td>
</tr>
<tr>
<td>B_CAPITAL</td>
<td>B</td>
</tr>
<tr>
<td>C_CAPITAL</td>
<td>C</td>
</tr>
<tr>
<td>D_CAPITAL</td>
<td>D</td>
</tr>
<tr>
<td>E_CAPITAL</td>
<td>E</td>
</tr>
<tr>
<td>F_CAPITAL</td>
<td>F</td>
</tr>
<tr>
<td>G_CAPITAL</td>
<td>G</td>
</tr>
<tr>
<td>H_CAPITAL</td>
<td>H</td>
</tr>
<tr>
<td>I_CAPITAL</td>
<td>I</td>
</tr>
<tr>
<td>J_CAPITAL</td>
<td>J</td>
</tr>
<tr>
<td>K_CAPITAL</td>
<td>K</td>
</tr>
<tr>
<td>L_CAPITAL</td>
<td>L</td>
</tr>
<tr>
<td>M_CAPITAL</td>
<td>M</td>
</tr>
<tr>
<td>N_CAPITAL</td>
<td>N</td>
</tr>
<tr>
<td>O_CAPITAL</td>
<td>O</td>
</tr>
<tr>
<td>P_CAPITAL</td>
<td>P</td>
</tr>
<tr>
<td>Q_CAPITAL</td>
<td>Q</td>
</tr>
<tr>
<td>R_CAPITAL</td>
<td>R</td>
</tr>
<tr>
<td>S_CAPITAL</td>
<td>S</td>
</tr>
<tr>
<td>T_CAPITAL</td>
<td>T</td>
</tr>
<tr>
<td>U_CAPITAL</td>
<td>U</td>
</tr>
<tr>
<td>Field Name</td>
<td>Symbol</td>
</tr>
<tr>
<td>------------------</td>
<td>----------</td>
</tr>
<tr>
<td>V_CAPITAL</td>
<td>V</td>
</tr>
<tr>
<td>W_CAPITAL</td>
<td>W</td>
</tr>
<tr>
<td>X_CAPITAL</td>
<td>X</td>
</tr>
<tr>
<td>Y_CAPITAL</td>
<td>Y</td>
</tr>
<tr>
<td>Z_CAPITAL</td>
<td>Z</td>
</tr>
<tr>
<td>LEFT_BRACKET</td>
<td>[</td>
</tr>
<tr>
<td>BACKSLASH</td>
<td>\</td>
</tr>
<tr>
<td>RIGHT_BRACKET</td>
<td>]</td>
</tr>
<tr>
<td>CIRCUMFLEX_ACCENT</td>
<td>^</td>
</tr>
<tr>
<td>UNDERLINE</td>
<td>_</td>
</tr>
<tr>
<td>GRAVE_ACCENT</td>
<td>`</td>
</tr>
<tr>
<td>A_SMALL</td>
<td>a</td>
</tr>
<tr>
<td>B_SMALL</td>
<td>b</td>
</tr>
<tr>
<td>C_SMALL</td>
<td>c</td>
</tr>
<tr>
<td>D_SMALL</td>
<td>d</td>
</tr>
<tr>
<td>E_SMALL</td>
<td>e</td>
</tr>
<tr>
<td>F_SMALL</td>
<td>f</td>
</tr>
<tr>
<td>G_SMALL</td>
<td>g</td>
</tr>
<tr>
<td>H_SMALL</td>
<td>h</td>
</tr>
<tr>
<td>I_SMALL</td>
<td>i</td>
</tr>
<tr>
<td>J_SMALL</td>
<td>j</td>
</tr>
<tr>
<td>K_SMALL</td>
<td>k</td>
</tr>
<tr>
<td>L_SMALL</td>
<td>l</td>
</tr>
<tr>
<td>M_SMALL</td>
<td>m</td>
</tr>
<tr>
<td>N_SMALL</td>
<td>n</td>
</tr>
<tr>
<td>O_SMALL</td>
<td>o</td>
</tr>
<tr>
<td>P_SMALL</td>
<td>p</td>
</tr>
<tr>
<td>Q_SMALL</td>
<td>q</td>
</tr>
<tr>
<td>R_SMALL</td>
<td>r</td>
</tr>
<tr>
<td>S_SMALL</td>
<td>s</td>
</tr>
<tr>
<td>T_SMALL</td>
<td>t</td>
</tr>
<tr>
<td>U_SMALL</td>
<td>u</td>
</tr>
<tr>
<td>V_SMALL</td>
<td>v</td>
</tr>
<tr>
<td>W_SMALL</td>
<td>w</td>
</tr>
<tr>
<td>X_SMALL</td>
<td>x</td>
</tr>
<tr>
<td>Y_SMALL</td>
<td>y</td>
</tr>
<tr>
<td>Z_SMALL</td>
<td>z</td>
</tr>
<tr>
<td>LEFT_BRACE</td>
<td></td>
</tr>
<tr>
<td>VERTICAL_BAR</td>
<td></td>
</tr>
<tr>
<td>Field Name</td>
<td>Symbol</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>RIGHT_BRACE</td>
<td>}</td>
</tr>
<tr>
<td>TILDE_ACCENT</td>
<td>~</td>
</tr>
<tr>
<td>C_CEDILLA_CAPITAL</td>
<td>Ç</td>
</tr>
<tr>
<td>U_DIAERESIS_SMALL</td>
<td>ü</td>
</tr>
<tr>
<td>E_ACUTE_SMALL</td>
<td>é</td>
</tr>
<tr>
<td>A_CIRCUMFLEX_SMALL</td>
<td>â</td>
</tr>
<tr>
<td>A_DIAERESIS_SMALL</td>
<td>å</td>
</tr>
<tr>
<td>A_GRAVE_SMALL</td>
<td>à</td>
</tr>
<tr>
<td>A_OVERCIRCLE_SMALL</td>
<td>å</td>
</tr>
<tr>
<td>C_CEDILLA_SMALL</td>
<td>ç</td>
</tr>
<tr>
<td>E_CIRCUMFLEX_SMALL</td>
<td>ê</td>
</tr>
<tr>
<td>E_DIAERESIS_SMALL</td>
<td>ê</td>
</tr>
<tr>
<td>E_GRAVE_SMALL</td>
<td>è</td>
</tr>
<tr>
<td>I_DIAERESIS_SMALL</td>
<td>ì</td>
</tr>
<tr>
<td>I_CIRCUMFLEX_SMALL</td>
<td>ì</td>
</tr>
<tr>
<td>I_GRAVE_SMALL</td>
<td>ì</td>
</tr>
<tr>
<td>A_DIAERESIS_CAPITAL</td>
<td>Ä</td>
</tr>
<tr>
<td>A_OVERCIRCLE_CAPITAL</td>
<td>Å</td>
</tr>
<tr>
<td>E_ACUTE_CAPITAL</td>
<td>É</td>
</tr>
<tr>
<td>AE_DIPHTONG_SMALL</td>
<td>æ</td>
</tr>
<tr>
<td>AE_DIPHTONG_CAPITAL</td>
<td>Æ</td>
</tr>
<tr>
<td>O_CIRCUMFLEX_SMALL</td>
<td>ô</td>
</tr>
<tr>
<td>O_DIAERESIS_SMALL</td>
<td>õ</td>
</tr>
<tr>
<td>O_GRAVE_SMALL</td>
<td>ó</td>
</tr>
<tr>
<td>U_CIRCUMFLEX_SMALL</td>
<td>û</td>
</tr>
<tr>
<td>U_GRAVE_SMALL</td>
<td>ú</td>
</tr>
<tr>
<td>Y_DIAERESIS_SMALL</td>
<td>ÿ</td>
</tr>
<tr>
<td>O_DIAERESIS_CAPITAL</td>
<td>Ö</td>
</tr>
<tr>
<td>U_DIAERESIS_CAPITAL</td>
<td>Ü</td>
</tr>
<tr>
<td>O_SLASH_SMALL</td>
<td>ø</td>
</tr>
<tr>
<td>POUND_SIGN</td>
<td>£</td>
</tr>
<tr>
<td>O_SLASH_CAPITAL</td>
<td>Ø</td>
</tr>
<tr>
<td>MULTIPLY_SIGN</td>
<td>×</td>
</tr>
<tr>
<td>A_ACUTE_SMALL</td>
<td>á</td>
</tr>
<tr>
<td>I_ACUTE_SMALL</td>
<td>í</td>
</tr>
<tr>
<td>O_ACUTE_SMALL</td>
<td>ó</td>
</tr>
<tr>
<td>U_ACUTE_SMALL</td>
<td>ú</td>
</tr>
<tr>
<td>N_TILDE_SMALL</td>
<td>ñ</td>
</tr>
<tr>
<td>N_TILDE_CAPITAL</td>
<td>Ñ</td>
</tr>
<tr>
<td>ORDINAL_INDICATOR_FEMININE</td>
<td>2</td>
</tr>
<tr>
<td>Field Name</td>
<td>Symbol</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>ORDINAL_INDICATOR_MASCULINE</td>
<td>©</td>
</tr>
<tr>
<td>QUESTION_MARK_INVERTED</td>
<td>.</td>
</tr>
<tr>
<td>REGISTERED_TRADEMARK_SYMBOL</td>
<td>®</td>
</tr>
<tr>
<td>LOGICAL_NOT</td>
<td>¬</td>
</tr>
<tr>
<td>ONE_HALF</td>
<td>½</td>
</tr>
<tr>
<td>ONE_QUARTER</td>
<td>¼</td>
</tr>
<tr>
<td>EXCLAMATION_POINT_INVERTED</td>
<td>¡</td>
</tr>
<tr>
<td>LEFT_ANGLE_QUOTES</td>
<td>«</td>
</tr>
<tr>
<td>RIGHT_ANGLE_QUOTES</td>
<td>»</td>
</tr>
<tr>
<td>A_ACUTE_CAPITAL</td>
<td>Á</td>
</tr>
<tr>
<td>A_CIRCUMFLEX_CAPITAL</td>
<td>Â</td>
</tr>
<tr>
<td>A_GRAVE_CAPITAL</td>
<td>À</td>
</tr>
<tr>
<td>COPYRIGHT_SYMBOL</td>
<td>©</td>
</tr>
<tr>
<td>CENT_SIGN</td>
<td>¢</td>
</tr>
<tr>
<td>YEN_SIGN</td>
<td>¥</td>
</tr>
<tr>
<td>A_TILDE_SMALL</td>
<td>ã</td>
</tr>
<tr>
<td>A_TILDE_CAPITAL</td>
<td>À</td>
</tr>
<tr>
<td>E_CIRCUMFLEX_CAPITAL</td>
<td>È</td>
</tr>
<tr>
<td>E_DIAERESIS_CAPITAL</td>
<td>Ê</td>
</tr>
<tr>
<td>I_ACUTE_CAPITAL</td>
<td>Í</td>
</tr>
<tr>
<td>I_CIRCUMFLEX_CAPITAL</td>
<td>Ï</td>
</tr>
<tr>
<td>I_DIAERESIS_CAPITAL</td>
<td>Ë</td>
</tr>
<tr>
<td>VERTICAL_LINE_BROKEN</td>
<td>-</td>
</tr>
<tr>
<td>I_GRAVE_CAPITAL</td>
<td>Í</td>
</tr>
<tr>
<td>O_ACUTE_CAPITAL</td>
<td>Ö</td>
</tr>
<tr>
<td>O_CIRCUMFLEX_CAPITAL</td>
<td>ô</td>
</tr>
<tr>
<td>O_GRAVE_CAPITAL</td>
<td>Õ</td>
</tr>
<tr>
<td>O_TILDE_SMALL</td>
<td>õ</td>
</tr>
<tr>
<td>O_TILDE_CAPITAL</td>
<td>Õ</td>
</tr>
<tr>
<td>MICRO_SYMBOL</td>
<td>-</td>
</tr>
<tr>
<td>U_ACUTE_CAPITAL</td>
<td>Ú</td>
</tr>
<tr>
<td>U_CIRCUMFLEX_CAPITAL</td>
<td>Ù</td>
</tr>
<tr>
<td>U_GRAVE_CAPITAL</td>
<td>Û</td>
</tr>
<tr>
<td>ACUTE_ACCENT</td>
<td>'</td>
</tr>
<tr>
<td>SYLLABLE_HYPHEN</td>
<td>-</td>
</tr>
<tr>
<td>PLUS_OR_MINUS_SIGN</td>
<td>±</td>
</tr>
<tr>
<td>THREE_QUARTERS</td>
<td>¾</td>
</tr>
<tr>
<td>PARAGRAPH_SYMBOL</td>
<td>¶</td>
</tr>
</tbody>
</table>
Table 24. Printer Symbol Definitions (continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>SECTION_SYMBOL</td>
<td>§</td>
</tr>
<tr>
<td>DIVIDE_SIGN</td>
<td>÷</td>
</tr>
<tr>
<td>DEGREE_SYMBOL</td>
<td>°</td>
</tr>
<tr>
<td>ONE_SUPERSCRIPT</td>
<td>¹</td>
</tr>
<tr>
<td>THREE_SUPERSCRIPT</td>
<td>³</td>
</tr>
<tr>
<td>TWO_SUPERSCRIPT</td>
<td>²</td>
</tr>
<tr>
<td>REQUIRED_SPACE</td>
<td></td>
</tr>
<tr>
<td>INTERNATIONAL_CURRENCY_SYMBOL</td>
<td>ø</td>
</tr>
<tr>
<td>ETH_ICELANDIC_SMALL</td>
<td>ð</td>
</tr>
<tr>
<td>ETH_ICELANDIC_CAPITAL</td>
<td>Ð</td>
</tr>
<tr>
<td>SHARP_S_SMALL</td>
<td>§</td>
</tr>
<tr>
<td>THORN_ICELANDIC_SMALL</td>
<td>þ</td>
</tr>
<tr>
<td>THORN_ICELANDIC_CAPITAL</td>
<td>þ</td>
</tr>
<tr>
<td>Y_ACUTE_SMALL</td>
<td>ý</td>
</tr>
<tr>
<td>Y_ACUTE_CAPITAL</td>
<td>Ý</td>
</tr>
<tr>
<td>OVERLINE</td>
<td>.</td>
</tr>
<tr>
<td>CEDILLA</td>
<td></td>
</tr>
<tr>
<td>DIAERESIS</td>
<td>..</td>
</tr>
<tr>
<td>MIDDLE_DOT_ACCENT</td>
<td></td>
</tr>
</tbody>
</table>

Using Printer Control Codes

This section explains the SNA Character String (SCS) control codes, or Final Form Text: Document Content Architecture (FFT DCA).

For details of iSeries, eServer i5, or System i5 printer control codes, refer to AS/400 Guide to Programming for Printing.

Printer Control Code Format

Some printer control codes perform single, specific functions by themselves, while others perform multiple functions according to the parameters specified after the control code.

A printer control code with parameters has the following format:

<table>
<thead>
<tr>
<th>Control Code</th>
<th>Count</th>
<th>Parameter 1</th>
<th>Parameter 2...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 or 2 bytes</td>
<td>1 byte</td>
<td>1 or 2 bytes</td>
<td>1 or 2 bytes</td>
</tr>
</tbody>
</table>

A count consists of 1 byte, and indicates the length of the parameters (including the count) after the control code, in bytes. For example, a count and two 1-byte parameters is shown as X'03', because the count itself is included. Some control codes, such as the Printing Position (PP) control code, do not have counts.
A parameter can be 1 or 2 bytes in length. The number of bytes depends on the control codes. Not all control codes have parameters.

**Note:** In this manual, counts and parameters that are actually processed in binary are all expressed in hexadecimal (0–F) to improve readability.

**Parameter Definition of Printer Control Codes**

Some printer control codes require that parameters be specified. Pay particular attention when defining a parameter because how this is done depends on the parameter type. If the definition method for another type is used, the desired output will not be obtained.

The following table lists printer control code parameter types and their meanings:

*Table 25. Printer Control Code Parameter Types*

<table>
<thead>
<tr>
<th>Parameter Type</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>byte-value</td>
<td>One-byte parameter.</td>
</tr>
<tr>
<td>byte-values</td>
<td>Multibyte parameter. Used if operands are fixed.</td>
</tr>
<tr>
<td>word-value(HL)</td>
<td>One-word parameter (higher and lower bytes).</td>
</tr>
<tr>
<td>word-value(LH)</td>
<td>One-word parameter (lower and higher bytes).</td>
</tr>
<tr>
<td>length(HL)-values</td>
<td>Multibyte parameter requiring operands. Used if operands are variable.</td>
</tr>
<tr>
<td>length(LH)-values</td>
<td>Multibyte parameter requiring operands. Used if operands are variable.</td>
</tr>
<tr>
<td>length(HL)-images</td>
<td>Image data requiring operands. An operand consists of a higher and lower byte.</td>
</tr>
<tr>
<td>length(LH)-images</td>
<td>Image data requiring operands. An operand consists of a higher and lower byte.</td>
</tr>
<tr>
<td>decimal-characters</td>
<td>Decimal characters parameter.</td>
</tr>
</tbody>
</table>

**Supported Control Codes**

Personal Communications supports all control codes for the 3812 printer.

**Supported SCS Commands**

*Table 26. Supported SCS Commands*

<table>
<thead>
<tr>
<th>SCS Command</th>
<th>Abbreviation</th>
<th>Hexadecimal Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character Attribute</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Font Size Scaling</td>
<td>SFSS</td>
<td>2BFDnn02xxyy</td>
<td>Specifies the font-size scaling for expansion.</td>
</tr>
<tr>
<td>Character Set Control</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Alternate Character (DBCS only)</td>
<td>LAC</td>
<td>2BFEmmmeee</td>
<td>Loads the alternate character font.</td>
</tr>
<tr>
<td>Set CGCS(^1) Through Local ID</td>
<td>SCL</td>
<td>2BD1nn810B</td>
<td>Specifies the character set for each language.</td>
</tr>
<tr>
<td>Set Character Distance</td>
<td>SCD</td>
<td>2BD2nn29xxxxx</td>
<td>Selects the pitch and font.</td>
</tr>
</tbody>
</table>
### Table 26. Supported SCS Commands (continued)

<table>
<thead>
<tr>
<th>SCS Command</th>
<th>Abbreviation</th>
<th>Hexadecimal Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Font ID Through GFID²</td>
<td>SFG</td>
<td>2BD1nn05xxxyyyyyzzz</td>
<td>Selects the font.</td>
</tr>
<tr>
<td>Set GCSGID³ Through GCID⁴</td>
<td>SCG</td>
<td>2BD1nn01xxxyyyyyy</td>
<td>Specifies the code page.</td>
</tr>
<tr>
<td>Set Presentation of Control Character</td>
<td>SPCC</td>
<td>2BFDnn03xxxx</td>
<td>Specifies the treatment of SO and SI.</td>
</tr>
<tr>
<td>Shift Out (DBCS only)</td>
<td>SO</td>
<td>0E</td>
<td>Start of DBCS field.</td>
</tr>
<tr>
<td>Shift In (DBCS only)</td>
<td>SI</td>
<td>0F</td>
<td>End of DBCS field.</td>
</tr>
</tbody>
</table>

#### Device Control

<table>
<thead>
<tr>
<th>Command</th>
<th>Abbreviation</th>
<th>Hexadecimal Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bell</td>
<td>BEL</td>
<td>2F</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Null</td>
<td>NUL</td>
<td>00</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Repeat</td>
<td>RPT</td>
<td>0A</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Set Exception Action</td>
<td>SEA</td>
<td>2BD2nn85p1–pn</td>
<td>Specifies the explicit action.</td>
</tr>
<tr>
<td>Set Initial Conditions</td>
<td>SIC</td>
<td>2BD2nn45xx</td>
<td>Sets the environment of the EBCDIC transform.</td>
</tr>
<tr>
<td>Set Print Setup</td>
<td>SPSU</td>
<td>2BD2nn4Cp1–pn</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Switch</td>
<td>SW</td>
<td>2A</td>
<td>Ignored.</td>
</tr>
</tbody>
</table>

#### Generation Control

<table>
<thead>
<tr>
<th>Command</th>
<th>Abbreviation</th>
<th>Hexadecimal Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Emphasis</td>
<td>BES</td>
<td>2BD1nn8Axx</td>
<td>Begins emphasis.</td>
</tr>
<tr>
<td>Begin Overstrike</td>
<td>BOS</td>
<td>2BD4nn72wwxxxxyyzzzz</td>
<td>Begins overstriking.</td>
</tr>
<tr>
<td>Begin Underscore</td>
<td>BUS</td>
<td>2BD4nn0Axyy</td>
<td>Begins underscoring.</td>
</tr>
<tr>
<td>Enable Presentation</td>
<td>ENP</td>
<td>14</td>
<td>Ignored.</td>
</tr>
<tr>
<td>End Emphasis</td>
<td>EES</td>
<td>2BD1nn8Exx</td>
<td>Ends emphasis.</td>
</tr>
<tr>
<td>End Overstrike</td>
<td>EOS</td>
<td>2BD4nn76</td>
<td>Ends overstriking.</td>
</tr>
<tr>
<td>End Underscore</td>
<td>EUS</td>
<td>2BD4nn0E</td>
<td>Ends underscoring.</td>
</tr>
<tr>
<td>Inhibit Presentation</td>
<td>INP</td>
<td>24</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Justify Text Field</td>
<td>JTF</td>
<td>2BD2nn03xxxxyy</td>
<td>Justifies the following text.</td>
</tr>
<tr>
<td>Set Graphic Error Action</td>
<td>SGEA</td>
<td>2BC8nnxxyy</td>
<td>Specifies how to process a received unprintable character font.</td>
</tr>
<tr>
<td>Set Justify Mode</td>
<td>SJM</td>
<td>2BD2nn0Dxyy</td>
<td>Justifies each line of text between the left and right margins.</td>
</tr>
<tr>
<td>Subscript</td>
<td>SBS</td>
<td>38</td>
<td>Subscript.</td>
</tr>
<tr>
<td>Substitute</td>
<td>SUB</td>
<td>3F</td>
<td>Synonym for the graphic exception character.</td>
</tr>
<tr>
<td>Superscript</td>
<td>SPS</td>
<td>09</td>
<td>Superscript.</td>
</tr>
<tr>
<td>Word Underscore</td>
<td>WUS</td>
<td>23</td>
<td>Underscore the entire word immediately preceding the control.</td>
</tr>
</tbody>
</table>

#### Grid Control

<table>
<thead>
<tr>
<th>Command</th>
<th>Abbreviation</th>
<th>Hexadecimal Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Grid Line</td>
<td>DGL</td>
<td>2BFDnn00 xxyyG1–Gn</td>
<td>Specifies and prints the grid line.</td>
</tr>
</tbody>
</table>

#### Print Format Control
### Table 26. Supported SCS Commands (continued)

<table>
<thead>
<tr>
<th>SCS Command</th>
<th>Abbreviation</th>
<th>Hexadecimal Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form Feed</td>
<td>FF</td>
<td>0C</td>
<td>Moves the printing position to the next page.</td>
</tr>
<tr>
<td>Page Presentation Media</td>
<td>PPM</td>
<td>2BD2nn48sssuuvvv wwxxyyyyy</td>
<td>Specifies the forms setting, the source drawer, the quality, and the duplex function.</td>
</tr>
<tr>
<td>Required Form Feed</td>
<td>RFF</td>
<td>3A</td>
<td>Moves the printing position to the next page and restores the indent level to the left margin.</td>
</tr>
<tr>
<td>Set Horizontal Format</td>
<td>SHF</td>
<td>2BC1nnxxxztt1–tn</td>
<td>Specifies the maximum print position, the left and right margins, and the horizontal tab stops in units of 1 character.</td>
</tr>
<tr>
<td>Set Horizontal Margins</td>
<td>SHM</td>
<td>2BD2nn11xxxxyyyy</td>
<td>Sets the left and right margins in units of 1/1440 inch.</td>
</tr>
<tr>
<td>Set IGC Type</td>
<td>SIT</td>
<td>2BF0nn010000</td>
<td>Specifies the pitch of DBCS characters</td>
</tr>
<tr>
<td>Set Presentation Page Size</td>
<td>SPPS</td>
<td>2BD2nn40xxxxyyyy</td>
<td>Specifies the presentation surface width and depth.</td>
</tr>
<tr>
<td>Set Text Orientation</td>
<td>STO</td>
<td>2BD3nnF6xxxxyyyy</td>
<td>Specifies the page rotation.</td>
</tr>
<tr>
<td>Set Vertical Format</td>
<td>SVF</td>
<td>2BC2nnxxxztt1–tn</td>
<td>Specifies the maximum print line, the top and bottom margins, and the vertical tab stops in units of 1 character.</td>
</tr>
<tr>
<td>Set Vertical Margins</td>
<td>SVM</td>
<td>2BD2nn49xxxxyyyy</td>
<td>Sets the top and bottom margins in units of 1/1440 inch.</td>
</tr>
</tbody>
</table>

### Printing Position Control

<table>
<thead>
<tr>
<th>Command</th>
<th>Abbreviation</th>
<th>Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backspace</td>
<td>BS</td>
<td>16</td>
<td>Moves the printing position to the left one font width.</td>
</tr>
<tr>
<td>Carriage Return</td>
<td>CR</td>
<td>0D</td>
<td>Moves the printing position to the left margin.</td>
</tr>
<tr>
<td>Horizontal Tab</td>
<td>HT</td>
<td>05</td>
<td>Moves the printing position right to the next tab stop.</td>
</tr>
<tr>
<td>Indent Tab</td>
<td>IT</td>
<td>39</td>
<td>Moves the printing position right to the next tab stops and sets the indent level one tab stop further to the right.</td>
</tr>
<tr>
<td>Index Return</td>
<td>IRT</td>
<td>33</td>
<td>Synonym for “Required New Line.”</td>
</tr>
<tr>
<td>Interchange Record Separator</td>
<td>IRS</td>
<td>1E</td>
<td>Synonym for “New Line.”</td>
</tr>
<tr>
<td>Line Feed</td>
<td>LF</td>
<td>25</td>
<td>Moves the printing position one line vertically.</td>
</tr>
<tr>
<td>New Line</td>
<td>NL</td>
<td>15</td>
<td>Moves the printing position to the left margin of the next line.</td>
</tr>
<tr>
<td>Numeric Backspace</td>
<td>NBS</td>
<td>36</td>
<td>Synonym for “Backspace.”</td>
</tr>
<tr>
<td>Presentation Position</td>
<td>PP</td>
<td>34fpxx</td>
<td>Moves the printing position.</td>
</tr>
<tr>
<td>Release Left Margin</td>
<td>RLM</td>
<td>2BD2nn0B</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Required New Line</td>
<td>RNL</td>
<td>06</td>
<td>Moves the printing position to the left margin of the next line and resets any pending indent level.</td>
</tr>
</tbody>
</table>
## Table 26. Supported SCS Commands (continued)

<table>
<thead>
<tr>
<th>SCS Command</th>
<th>Abbreviation</th>
<th>Hexadecimal Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Horizontal Tab Stops</td>
<td>STAB</td>
<td>2BD2nn01xxt1–tn</td>
<td>Specifies the tab stops.</td>
</tr>
<tr>
<td>Set Indent Level</td>
<td>SIL</td>
<td>2BD2nn07xx</td>
<td>Sets the indent level to the specific tab stop.</td>
</tr>
<tr>
<td>Set Line Density</td>
<td>SLD</td>
<td>2BC6nnxx</td>
<td>Specifies the line pitch in units of 1/72 inch.</td>
</tr>
<tr>
<td>Set Line Spacing</td>
<td>SLS</td>
<td>2BD2nn09xx</td>
<td>Specifies the number of lines spaced by a new line control.</td>
</tr>
<tr>
<td>Set Single Line Distance</td>
<td>SSLD</td>
<td>2BD2nn15xxxx</td>
<td>Specifies the line pitch in units of 1/1440 inch.</td>
</tr>
<tr>
<td>Unit Backspace</td>
<td>UBS</td>
<td>1A</td>
<td>Moves the printing position 1/60 inch to the left.</td>
</tr>
<tr>
<td>Vertical Tab</td>
<td>VT</td>
<td>0B</td>
<td>Moves the printing position down to the next tab stop.</td>
</tr>
</tbody>
</table>

### Transparent Control

<table>
<thead>
<tr>
<th>Transparent Control</th>
<th>ATRN</th>
<th>03</th>
<th>Allows printer commands and ASCII data to be passed to the printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transparent</td>
<td>TRN</td>
<td>35nn</td>
<td>Allows printer commands and ASCII data to be passed to the printer.</td>
</tr>
</tbody>
</table>

### Note:

1. Coded Graphic Character Set
2. Global Font ID
3. Graphic Character Set Global Identifier
4. Graphic Character set ID

### Legend:

nn: Count
fp: Function parameter
ee, gg, hh, il–ix, mm, nn, p1–pn, ss, t1–tn, uu, vv, ww, xx, yy, zz: Numeric parameter

### Programming Notes

This section briefly explains how a printer reacts if a partial control code is received, or if an incomplete control code is sent.

If the transmission of a control code is interrupted, the printer waits for the remaining part of the code. If the data stream (the series of data units and control codes) sent after the interruption is consistent with the data stream sent before the interruption, (that is, if one complete printer control code is restored by chaining), the control code is processed as is.

If the two parts of the data stream are inconsistent, an error occurs. A negative response to an “Invalid Printer Parameter” is sent to the host system, or treated as a no-op (no operation; ignored because of a meaningless code). Detailed information is not sent to the host system if an error occurs in a control code. After programming, the data stream must be checked thoroughly by repeating the printing test.

### Restrictions and Notes for iSeries, eServer i5, or System i5

#### Commands and Printer Setup

This section provides supplementary notes and explains restrictions for printing.
### Printer Control Codes

**Table 27. Printer Control Codes**

<table>
<thead>
<tr>
<th>Printer Control Code</th>
<th>If <em>Use PDT file</em> is Selected:</th>
<th>If a Windows Printer Driver is Used:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ting the Character Density</td>
<td>Select the GFID for the valid character distance (CD) as shown in Table 28. See &quot;Field Names of Printer Definition Files&quot; on page 186.</td>
<td>If the specified font is not supported, a substitution is provided. For example, when 15 CPI font is specified but the font is not supported, the supported 17 CPI font is substituted.</td>
</tr>
<tr>
<td><strong>SFG — Set Font ID through GFID</strong></td>
<td>Recognizable GFIDs are restricted. (See &quot;Field Names of Printer Definition Files&quot; on page 186.) If the specified GFID is not supported and it is out of the range from 154 through 200, the closest font width from the fonts shown in Table 29 on page 202 is substituted.</td>
<td>If the specified GFID is not supported and it is between 154 and 200, the following font is substituted: <strong>Font name:</strong> Document; <strong>GFID value:</strong> 175.</td>
</tr>
<tr>
<td><strong>BUS — Begin Underscore</strong></td>
<td>The selected font might not support the underscore.</td>
<td></td>
</tr>
<tr>
<td><strong>BES — Begin Emphasis</strong></td>
<td>The selected font might not support the emphasis.</td>
<td></td>
</tr>
<tr>
<td><strong>STO — Set Text Orientation</strong></td>
<td>The page orientation can be changed to portrait or landscape. The direction, which is up, down, left, or right on the paper, depends on the Microsoft Windows printer driver. If the page orientation is changed, the current paper is ejected.</td>
<td></td>
</tr>
<tr>
<td><strong>PPM — Page Presentation Media</strong></td>
<td>The following parameters are supported for PDTs in DBCS mode: - Forms Control (FC) - Source Drawer (SD) - Duplex (DX) Other parameters are ignored.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 28. SCD Parameter Values**

<table>
<thead>
<tr>
<th>CD Parameter</th>
<th>Character Pitch (normal)</th>
<th>GFID Value (COR)</th>
</tr>
</thead>
<tbody>
<tr>
<td>000A</td>
<td>10 CPI</td>
<td>13 CPI 204</td>
</tr>
<tr>
<td>000B</td>
<td>Proportional</td>
<td>13 CPI 175</td>
</tr>
<tr>
<td>000C</td>
<td>12 CPI</td>
<td>15 CPI 86</td>
</tr>
<tr>
<td>000F</td>
<td>15 CPI</td>
<td>20 CPI 230</td>
</tr>
<tr>
<td>00FF</td>
<td>10 CPI</td>
<td>13 CPI 204</td>
</tr>
</tbody>
</table>
The following table lists only the most commonly used GFIDs. See Table 30 for the complete list.

Table 29. Commonly Used SFG GFID Values

<table>
<thead>
<tr>
<th>Font Name</th>
<th>GFID value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Courier Bold 5</td>
<td>245</td>
</tr>
<tr>
<td>Courier 10</td>
<td>11</td>
</tr>
<tr>
<td>Prestige Elite 12</td>
<td>86</td>
</tr>
<tr>
<td>Gothic-text 13</td>
<td>204</td>
</tr>
<tr>
<td>Gothic-text 15</td>
<td>230</td>
</tr>
<tr>
<td>Courier 17</td>
<td>252</td>
</tr>
<tr>
<td>Gothic-text 20</td>
<td>281</td>
</tr>
<tr>
<td>Gothic-text 27</td>
<td>290</td>
</tr>
</tbody>
</table>

When you use the Windows printer driver, the spooler must be on.

**How to Determine PC400 Font**

When a print job is created on iSeries, eServer i5, or System i5, a certain font, identified by font ID (GFID), is associated with it. Such a font can be specified by the following parameters:

- Font family
- Pitch and family
- Character set
- Width
- Height
- Weight
- Style

System fonts are available with all print drivers, and more flexible device fonts are unique to each printer and printer driver. These fonts are also more fixed as to CPI, weight, code pages, and other criteria that can preclude use of it when matching to the host specified needs.

There are problems associated with mapping an iSeries, eServer i5, or System i5 font to a PC font. When your PC has all of the fonts that you need, use the following table to determine the best font to use.

Table 30. iSeries, eServer i5, or System i5 Font Parameters

<table>
<thead>
<tr>
<th>Entry ID</th>
<th>Font Family</th>
<th>GFID</th>
<th>Pitch &amp; Family</th>
<th>Character Set</th>
<th>Width</th>
<th>Height</th>
<th>Weight</th>
<th>Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFID0003</td>
<td>OCR-B</td>
<td>3</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0005</td>
<td>Orator</td>
<td>5</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0011</td>
<td>Courier</td>
<td>11</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0012</td>
<td>Prestige</td>
<td>12</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0013</td>
<td>Artisan</td>
<td>13</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0018</td>
<td>Courier Italic</td>
<td>18</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>255</td>
</tr>
<tr>
<td>GFID0019</td>
<td>OCR-A</td>
<td>19</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0020</td>
<td>Pica</td>
<td>20</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
</tbody>
</table>
Table 30. iSeries, eServer i5, or System i5 Font Parameters (continued)

<table>
<thead>
<tr>
<th>Entry ID</th>
<th>Font Family</th>
<th>GFID</th>
<th>Pitch &amp; Family</th>
<th>Character Set</th>
<th>Width</th>
<th>Height</th>
<th>Weight</th>
<th>Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFID0030</td>
<td>Symbol</td>
<td>30</td>
<td>49</td>
<td>2</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0038</td>
<td>Orator</td>
<td>38</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0039</td>
<td>Gothic</td>
<td>39</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0040</td>
<td>Gothic</td>
<td>40</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0041</td>
<td>Roman</td>
<td>41</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0042</td>
<td>Serif</td>
<td>42</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0043</td>
<td>Serif</td>
<td>43</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>255</td>
</tr>
<tr>
<td>GFID0044</td>
<td>Katakana</td>
<td>44</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0045</td>
<td>APL</td>
<td>45</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0046</td>
<td>Courier</td>
<td>46</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0050</td>
<td>Shalom</td>
<td>50</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0066</td>
<td>Gothic</td>
<td>66</td>
<td>49</td>
<td>0</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0068</td>
<td>Gothic</td>
<td>68</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>255</td>
</tr>
<tr>
<td>GFID0069</td>
<td>Gothic</td>
<td>69</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0070</td>
<td>Serif</td>
<td>70</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0071</td>
<td>Serif</td>
<td>71</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>255</td>
</tr>
<tr>
<td>GFID0072</td>
<td>Serif</td>
<td>72</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0080</td>
<td>Symbol</td>
<td>80</td>
<td>49</td>
<td>2</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0084</td>
<td>Script</td>
<td>84</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0085</td>
<td>Courier</td>
<td>85</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0086</td>
<td>Prestige</td>
<td>86</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0087</td>
<td>Letter-Gothic</td>
<td>87</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0091</td>
<td>Light</td>
<td>91</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>255</td>
</tr>
<tr>
<td>GFID0107</td>
<td>Courier</td>
<td>107</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0110</td>
<td>Letter-Gothic</td>
<td>110</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0111</td>
<td>Prestige</td>
<td>111</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0112</td>
<td>Prestige</td>
<td>112</td>
<td>49</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>255</td>
</tr>
<tr>
<td>GFID0115</td>
<td>Symbol</td>
<td>115</td>
<td>49</td>
<td>2</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0155</td>
<td>Boldface</td>
<td>155</td>
<td>18</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0158</td>
<td>Document</td>
<td>158</td>
<td>18</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0159</td>
<td>Boldface</td>
<td>159</td>
<td>18</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0160</td>
<td>Essay</td>
<td>160</td>
<td>34</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0162</td>
<td>Essay</td>
<td>162</td>
<td>34</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>800</td>
<td>255</td>
</tr>
<tr>
<td>GFID0163</td>
<td>Essay</td>
<td>163</td>
<td>34</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0168</td>
<td>Barak</td>
<td>168</td>
<td>18</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0173</td>
<td>Essay</td>
<td>173</td>
<td>34</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0175</td>
<td>Document</td>
<td>175</td>
<td>18</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
</tbody>
</table>
Table 30. iSeries, eServer i5, or System i5 Font Parameters (continued)

<table>
<thead>
<tr>
<th>Entry ID</th>
<th>Font Family</th>
<th>GFID</th>
<th>Pitch &amp; Family</th>
<th>Character Set</th>
<th>Width</th>
<th>Height</th>
<th>Weight</th>
<th>Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFID0176</td>
<td>Boldface</td>
<td>176</td>
<td>18</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0177</td>
<td>Boldface</td>
<td>177</td>
<td>18</td>
<td>0</td>
<td>120</td>
<td>240</td>
<td>800</td>
<td>255</td>
</tr>
<tr>
<td>GFID0193</td>
<td>Symbol</td>
<td>193</td>
<td>49</td>
<td>2</td>
<td>120</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0198</td>
<td>Symbol</td>
<td>198</td>
<td>49</td>
<td>2</td>
<td>144</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0204</td>
<td>Gothic</td>
<td>204</td>
<td>49</td>
<td>0</td>
<td>108</td>
<td>210</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0221</td>
<td>Prestige</td>
<td>221</td>
<td>49</td>
<td>0</td>
<td>96</td>
<td>210</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0222</td>
<td>Gothic</td>
<td>222</td>
<td>49</td>
<td>0</td>
<td>96</td>
<td>210</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0223</td>
<td>Courier</td>
<td>223</td>
<td>49</td>
<td>0</td>
<td>96</td>
<td>210</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0225</td>
<td>Symbol</td>
<td>225</td>
<td>49</td>
<td>2</td>
<td>96</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0229</td>
<td>Serif</td>
<td>229</td>
<td>49</td>
<td>0</td>
<td>96</td>
<td>210</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0230</td>
<td>Gothic</td>
<td>230</td>
<td>49</td>
<td>0</td>
<td>96</td>
<td>210</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0245</td>
<td>Courier Bold</td>
<td>245</td>
<td>49</td>
<td>0</td>
<td>288</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0252</td>
<td>Courier</td>
<td>252</td>
<td>49</td>
<td>0</td>
<td>84</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0253</td>
<td>Courier Bold</td>
<td>253</td>
<td>49</td>
<td>0</td>
<td>84</td>
<td>240</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID0254</td>
<td>Courier</td>
<td>254</td>
<td>49</td>
<td>0</td>
<td>84</td>
<td>120</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0280</td>
<td>APL</td>
<td>280</td>
<td>49</td>
<td>0</td>
<td>72</td>
<td>120</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0281</td>
<td>Gothic</td>
<td>281</td>
<td>49</td>
<td>0</td>
<td>72</td>
<td>120</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0290</td>
<td>Gothic</td>
<td>290</td>
<td>49</td>
<td>0</td>
<td>54</td>
<td>120</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID0751</td>
<td>Sonoran-serif</td>
<td>751</td>
<td>18</td>
<td>0</td>
<td>54</td>
<td>162</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID1051</td>
<td>Sonoran-serif</td>
<td>1051</td>
<td>18</td>
<td>0</td>
<td>66</td>
<td>198</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID1053</td>
<td>Sonoran-serif</td>
<td>1053</td>
<td>18</td>
<td>0</td>
<td>66</td>
<td>198</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID1056</td>
<td>Sonoran-serif</td>
<td>1056</td>
<td>18</td>
<td>0</td>
<td>66</td>
<td>198</td>
<td>400</td>
<td>255</td>
</tr>
<tr>
<td>GFID1351</td>
<td>Sonoran-serif</td>
<td>1351</td>
<td>18</td>
<td>0</td>
<td>84</td>
<td>240</td>
<td>400</td>
<td>0</td>
</tr>
<tr>
<td>GFID1653</td>
<td>Sonoran-serif</td>
<td>1653</td>
<td>18</td>
<td>0</td>
<td>108</td>
<td>312</td>
<td>800</td>
<td>0</td>
</tr>
<tr>
<td>GFID2103</td>
<td>Sonoran-serif</td>
<td>2103</td>
<td>18</td>
<td>0</td>
<td>162</td>
<td>480</td>
<td>800</td>
<td>0</td>
</tr>
</tbody>
</table>

Notes:
1. Default GFID from host is 011, we use Courier 10 CPI.
2. A print driver will change the font to its default if you ask for a font name that it does not recognize. Some drivers recognize Gothic, but the DeskJet drivers do not.
3. Most print drivers default to Courier New, instead of Courier. So Courier switched to Courier New works, but Gothic switched to Courier New changes the font family. Preferably, you should explicitly select Courier New.
4. Special fonts like CourHEB and GRCOUR869 (for Greek) has required them to be added to PCSPD.DAT to work. Note if the operating system properly or fully supports a language, that font could be the default font instead of Courier New.
Avoiding iSeries System Dump

If you are running OS/400 Version 3 Release 1, and you attempt to perform a Telnet 5250 mode host print operation, you may experience an iSeries system dump under certain conditions. To prevent this from occurring you should apply PTF SF35327 on OS/400.

This table matches the iSeries, eServer i5, or System i5 table of fonts. PC400 builds a PC spool file with the selected font in it. The printer driver picks up the spool file and the font and sends it to the printer where the expected font is used. Refer to Printer Device Programming for additional information on other useful tables.

The following factors can produce unexpected results:

• Not all fonts are available on a PC or printer device.
  
  If the font that was selected from the table and incorporated into the spool file cannot be found on a PC or on a printer, the printer driver determines how to present the data on a printer. For example, HP printer drivers have the following order of considerations:
  
  – HP Font Priority Considerations:
    1. Symbol Set
    2. Spacing
    3. Pitch
    4. Height
    5. Style
    6. Stroke Weight
    7. Typeface Family
    8. Resolution
    9. Orientation
  
  – Location: printer ROM, SIMM module ROM, cartridge ROM, printer RAM
    
    Priority of locations:
    1. Soft font (lowest ID first)
    2. Cartridge Font
    3. SIMM Font
    4. Internal Font
    
    600 dpi has priority over 300 dpi
  
  To avoid this uncertainty, it is recommended that you update the table so that only the fonts that are available in the given environment are used.

• NLS
  
  The iSeries, eServer i5, or System i5 font has NLS characters in it, which are not part of a corresponding PC font. The IBM-supplied table does not support character sets other than ANSI, although it provides a field for them. In this case, PC400 builds a PC spool file with a font that doesn’t recognize NLS.
  
  To fix the problem, it is recommended that you either change the font names in the table to the NLS enabled on a PC/printer, or if the font has the same name as the one in the table, update a Character Set value.

• After you decide to scale a printout which may be a result of CORig or BesFitting, you usually decrease the distance horizontally as well as vertically between characters. This can result in overlapping. PC400 attempts to adjust the given character size to a new one. A problem may occur when a font defined in the table is not a scalable font. Like GFID011, the most heavily used iSeries, eServer i5, or System i5 font is mapped to Courier. Courier is a non-scalable font.
which has only a limited number of character box sizes. To avoid possible problems it is recommended that you use Courier New instead, which is a scalable TTF font.

**PFT Migration Utility**

The PFT migration utility converts the printer function table (PFT) for the PC Support/400 workstation feature to a printer definition file (PDF) for PC400.

This section describes the operator interface of the PFT migration utility.

For details about PFT, refer to *AS/400 PC Support: DOS and OS/2 Technical Reference*.

**Using the PFT Migration Utility**

The file name of the PFT Migration Utility program is PCSPFC.EXE. It is a Windows application, and you can execute it by doing the following:

1. Double-click the program name using the Windows Explorer utility.
2. Specify the program name (and parameters) in the Windows Run utility as follows:

   ```
   PCSPFC [ [drive:] [path] PFT-file-name[,extension] ]
   ```

   If no parameter is specified, PCSPFC.EXE displays the Convert PFT to PDF dialog box.
   If you omit a drive name and a directory name, PCSPFC.EXE uses the current drive and the current directory. If you omit an extension, PCSPFC.EXE adds .PFT to the PFT file name.

3. When you execute the PFT Migration Utility, the Convert PFT to PDF dialog box appears. On the Convert PFT to PDF dialog box, select a PFT file from the list box or type a specific PFT file name, and click **OK**. The PFT Migration Utility starts the conversion and displays the PFT File Converter dialog box to show the conversion status.

   After the conversion, if you click **Save List** on the PFT File Converter dialog box, conversion messages in the dialog box are saved into a list file. The list file is created in the same directory and with the same name as the PFT file, except the extension. The extension of the list file is .LS2.

   If the conversion was completed successfully, you can click **Convert PDF to PDT** from the PFT File Converter dialog box to convert the PDF file to a PDT file. You can also create a PDT file by selecting **Printer Setup** from the File pull-down menu as explained in "Using the Printer Definition Table (PDT) File" on page 169.

**Migration Considerations**

When the base PDF file already exists, the converted PDF fields are appended to the end of the base PDF file. The name of the base PDF file is decided as follows:

<table>
<thead>
<tr>
<th>PFT File Name</th>
<th>PDF File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>xxxxxxxx.PFT</td>
<td>xxxxxxxx.PDF</td>
</tr>
<tr>
<td>xxxx.MNL</td>
<td>xxxx.MNL</td>
</tr>
<tr>
<td>zzzzzzzz.MNL*</td>
<td>zzzzzzzz.PDF</td>
</tr>
</tbody>
</table>

* "zzz" is not "IBM".
Even if the same fields are already defined in the PDF file, the appended fields are effective because the last definition is always effective in a PDF file.

If the base PDF file does not exist in the directory, the PFT Migration Utility creates a new PDF file that has only the converted fields from the PFT file. In this case, you should append this file to an appropriate base file manually, because the fields converted from the PFT file do not cover all of the necessary PDF fields.

Therefore, it is recommended that you prepare both the PFT file and its base PDF file in the same directory before the conversion.

**Details of Migration**

This section describes how the PFT Migration Utility migrates the printer function table (PFT) to the printer definition file (PDF).

**Migration from the Printer Function Table**

The following table shows the target fields of the PDF for the data in the PFT.

*Table 32. Migration from the Printer Function Table to the Printer Definition File*

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>INITIALIZATION AND RESET</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initialization</td>
<td>START_JOB=</td>
<td>When the data is defined in the Initialization field of PFT, the data is appended to the string START_JOB=.</td>
</tr>
<tr>
<td>Filename</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Reset</td>
<td>END_JOB=</td>
<td>When the data is defined in the Reset field of PFT, the data is appended to the string END_JOB=.</td>
</tr>
<tr>
<td><strong>VERTICAL LINE SPACING</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 lines per inch</td>
<td>SET_6_LINES_PER_INCH=</td>
<td>When the data is defined in the 6 lines per inch field of PFT, the data is appended to the string SET_6_LINES_PER_INCH=.</td>
</tr>
<tr>
<td>8 lines per inch</td>
<td>SET_8_LINES_PER_INCH=</td>
<td>When the data is defined in the 8 lines per inch field of PFT, the data is appended to the string SET_8_LINES_PER_INCH=.</td>
</tr>
<tr>
<td>Variable line spacing</td>
<td>SET_VARIABLE_DENSITY=</td>
<td>When the data is defined in the control sequence field of the PFT for the variable line spacing, the data is appended to the string SET_VARIABLE_DENSITY=. The parameter n in the control sequence is replaced with the PDF parameter type.</td>
</tr>
<tr>
<td>PFT Field Name</td>
<td>PDF Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Maximum</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Offset</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>X/Y</td>
<td>LINE_SPACING_RATIO=</td>
<td>When the data is defined in the X/Y field of the PFT for the variable line spacing, the value Y/X is appended to the string LINE_SPACING_RATIO= as three-digit or four-digit numbers to indicate the decimal number. For example, when Y/X is 72, the \textbf{072} is appended to the string LINE_SPACING_RATIO= and LINE_SPACING_RATIO=072 is written to the output file. When the value is greater than 255, the four-digit number is migrated. When the value is less than 255, the three-digit number is migrated.</td>
</tr>
</tbody>
</table>

**Indexing Functions**

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Superscript</td>
<td>START_SUPERSCRIPT=</td>
<td>When the data is defined in the Begin Superscript field and End Superscript field of the PFT for the indexing functions, the data is appended to the string START_SUPERSCRIPT=. If the data for the End Superscript is not defined, the data for the Begin Superscript is ignored.</td>
</tr>
<tr>
<td>End Superscript</td>
<td>END_SUPERSCRIPT=</td>
<td>When the data is defined in the End Superscript field and Begin Superscript field of the PFT for the indexing functions, the data is appended to the string END_SUPERSCRIPT=. If the data for the Begin Superscript is not defined, the data for the End Superscript is ignored.</td>
</tr>
<tr>
<td>Begin Subscript</td>
<td>START_SUBSCRIPT=</td>
<td>When the data is defined in the Begin Subscript field and End Subscript field of the PFT for the indexing functions, the data is appended to the string START_SUBSCRIPT=. If the data for the End Subscript is not defined, the data for the Begin Subscript is ignored.</td>
</tr>
<tr>
<td>End Subscript</td>
<td>END_SUBSCRIPT=</td>
<td>When the data is defined in the End Subscript field and Begin Subscript field of the PFT for the indexing functions, the data is appended to the string END_SUBSCRIPT=. If the data for the Begin Subscript is not defined, the data for the End Subscript is ignored.</td>
</tr>
</tbody>
</table>
### Table 32. Migration from the Printer Function Table to the Printer Definition File (continued)

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Reverse 1/2 Index    | START_SUPERSCRIPT= END_SUBSCRIPT=        | The data is appended to the START_SUPERSCRIPT= for all of the following conditions:  
|                      |                                          | • When the data is not defined in the Begin Superscript field in the PFT or when the data is not defined in the End Superscript field in the PFT.  
|                      |                                          | • When the data is defined in the Reverse 1/2 index and Forward 1/2 index field in the PFT.  
|                      |                                          | The data is appended to END_SUBSCRIPT= for all of the following conditions:  
|                      |                                          | • When the data is not defined in the Begin Subscript field in the PFT or when the data is not defined in the End Subscript field in the PFT.  
|                      |                                          | • When the data is defined in the Reverse 1/2 index and Forward 1/2 index field in the PFT.  
| Forward 1/2 Index    | END_SUPERSCRIPT= START_SUBSCRIPT=        | The data is appended to END_SUPERSCRIPT= for all of the following conditions:  
|                      |                                          | • When the data is not defined in the Begin Superscript field in the PFT or when the data is not defined in the End Superscript field in the PFT.  
|                      |                                          | • When the data is defined in the Reverse 1/2 index and Forward 1/2 index field in the PFT.  
|                      |                                          | The data is appended to START_SUBSCRIPT= for all of the following conditions:  
|                      |                                          | • When the data is not defined in the Begin Subscript field in the PFT or when the data is not defined in the End Subscript field in the PFT.  
|                      |                                          | • When the data is defined in the Reverse 1/2 index and Forward 1/2 index field in the PFT.  
| Reverse Index        | None                                     | This field is ignored. |
|                      |                                          | **HORIZONTAL LINE SPACING** |
|                      | 5 pitch                                  | 5 pitch None  
|                      |                                          | This field is ignored.  
|                      | 8.55 pitch                               | 8.55 pitch None  
|                      |                                          | This field is ignored.  
|                      | 10 pitch                                 | 10 pitch SET_10_CHARACTERS_PER_INCH=  
|                      |                                          | When the data is defined in the 10 pitch field of the PFT for the horizontal character spacing, the data is appended to the string SET_10_CHARACTERS_PER_INCH=.  
|                      | 12 pitch                                 | 12 pitch |
Table 32. Migration from the Printer Function Table to the Printer Definition File (continued)

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 pitch</td>
<td>SET_12_CHARACTERS_PER_INCH=</td>
<td>When the data is defined in the 12 pitch field of the PFT for the horizontal character spacing, the data is appended to the string SET_12_CHARACTERS_PER_INCH=.</td>
</tr>
<tr>
<td>15 pitch</td>
<td>SET_15_CHARACTERS_PER_INCH=</td>
<td>When the data is defined in the 15 pitch field of the PFT for the horizontal character spacing, the data is appended to the string SET_15_CHARACTERS_PER_INCH=.</td>
</tr>
<tr>
<td>17.1 pitch</td>
<td>SET_17_CHARACTERS_PER_INCH=</td>
<td>When the data is defined in the 17.1 pitch field of the PFT for the horizontal character spacing, the data is appended to the string SET_17_CHARACTERS_PER_INCH=.</td>
</tr>
</tbody>
</table>

Horizontal Motion Index

- Control Sequence: None
  - This field is ignored.
- Maximum: None
  - This field is ignored.
- Offset: None
  - This field is ignored.
- X/Y: None
  - This field is ignored.

**HORIZONTAL RELATIVE MOVEMENT**

Forward Relative Movement

- Control Sequence: FORWARD_HORIZONTAL_SKIP=
  - When the data is defined in the Forward Relative Movement field of PFT, the data is appended to the string FORWARD_HORIZONTAL_SKIP=.
  - The parameter n in the control sequence is replaced with the PDF parameter type.
- Maximum: None
  - This field is ignored.
- Offset: None
  - This field is ignored.
- X/Y: HORIZONTAL_PEL=
  - When the data is defined in the X/Y field of the PFT for the forward relative movement, the value Y/X is appended to the string HORIZONTAL_PEL= as three-digit or four-digit number to indicate the decimal number. For example, when Y/X is 120, HORIZONTAL_PEL=120 is written to the output file. When the value is greater than 255, the four-digit number is migrated. When the value is less than 255, the three-digit number is migrated.

Backward Relative Movement
<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Maximum</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Offset</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>X/Y</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

**HIGHLIGHTING**

Begin Emphasis

Begin Emphasis START_HIGHLIGHT_INTENSE=

When the data is defined in the Begin Emphasis of PFT, the data is appended to the string START_HIGHLIGHT_INTENSE=.

End Emphasis

End Emphasis END_HIGHLIGHT_INTENSE=

When the data is defined in the End Emphasis of PFT, the data is appended to the string END_HIGHLIGHT_INTENSE=.

Begin Underline

Begin Underline START_HIGHLIGHT_UNDERLINE=

When the data is defined in the Begin Underline of PFT, the data is appended to the string START_HIGHLIGHT_UNDERLINE=.

End Underline

End Underline END_HIGHLIGHT_UNDERLINE=

When the data is defined in the End Underline of PFT, the data is appended to the string END_HIGHLIGHT_UNDERLINE=.

Begin Quality Print

Begin Quality Print None

This field is ignored.

End Quality Print

End Quality Print None

This field is ignored.

**PAPER HANDLING**

Bottom Tray Feed
Table 32. Migration from the Printer Function Table to the Printer Definition File (continued)

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom Tray Feed</td>
<td>SELECT_DRAWER2=</td>
<td>If the data is defined in some fields for LANDSCAPE PAPER HANDLING, the PFT Migration Utility assumes that this control sequence includes the control of the portrait orientation. For this, the PFT Migration Utility divides this control sequence into two parts and migrates the control sequence for the drawer select and paper feed. The control sequence of the portrait orientation is migrated to SET_PORTRAIT_ORIENT=. If no data is defined in any fields for LANDSCAPE PAPER HANDLING, the PFT Migration Utility migrates this control sequence to SELECT_DRAWER2=. (See “Definition of PAPER HANDLING Migration” on page 227.)</td>
</tr>
<tr>
<td>Top Tray Feed</td>
<td>SELECT_DRAWER1=</td>
<td>If the data is defined in some fields for LANDSCAPE PAPER HANDLING, the PFT Migration Utility assumes that this control sequence includes the control of the portrait orientation. For this, the PFT Migration Utility divides this control sequence into two parts and migrates the control sequence for the drawer select and paper feed. The control sequence of the portrait orientation is migrated to SET_PORTRAIT_ORIENT=. If no data is defined in any fields for LANDSCAPE PAPER HANDLING, the PFT Migration Utility migrates this control sequence to SELECT_DRAWER1=. (See “Definition of PAPER HANDLING Migration” on page 227.)</td>
</tr>
<tr>
<td>Envelope Feed</td>
<td>SELECT_ENVELOPE=</td>
<td>If the data is defined in some fields for LANDSCAPE PAPER HANDLING, the PFT Migration Utility assumes that this control sequence includes the control of the portrait orientation. For this, the PFT Migration Utility divides this control sequence into two parts and migrates the control sequence for the drawer select and paper feed. The control sequence of the portrait orientation is migrated to SET_PORTRAIT_ORIENT=. If no data is defined in any fields for LANDSCAPE PAPER HANDLING, the PFT Migration Utility migrates this control sequence to SELECT_ENVELOPE=. (See “Definition of PAPER HANDLING Migration” on page 227.)</td>
</tr>
<tr>
<td>Manual Feed</td>
<td>SELECT_DRAWER3=</td>
<td>If the data is defined in some fields for LANDSCAPE PAPER HANDLING, the PFT Migration Utility assumes that this control sequence includes the control of the portrait orientation. For this, the PFT Migration Utility divides this control sequence into two parts and migrates the control sequence for the drawer select and paper feed. The control sequence of the portrait orientation is migrated to SET_PORTRAIT_ORIENT=. If no data is defined in any fields for LANDSCAPE PAPER HANDLING, the PFT Migration Utility migrates this control sequence to SELECT_DRAWER3=. (See “Definition of PAPER HANDLING Migration” on page 227.)</td>
</tr>
</tbody>
</table>
Table 32. Migration from the Printer Function Table to the Printer Definition File (continued)

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous Feed</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Ignore Paper End Sensor</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Enable Paper End Sensor</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Eject Automatic Cut Sheet</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Eject Manual Cut Sheet</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Collate</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

**PAPER POSITIONING**

**Continuous Forms**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dist. from Top Paper Edge</td>
<td>None</td>
</tr>
<tr>
<td>Dist. from Left Paper Edge</td>
<td>None</td>
</tr>
<tr>
<td>Location of First Print Column</td>
<td>None</td>
</tr>
</tbody>
</table>

**Manual Feed**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dist. from Top Paper Edge</td>
<td>None</td>
</tr>
<tr>
<td>Dist. from Left Paper Edge</td>
<td>None</td>
</tr>
<tr>
<td>Location of First Print Column</td>
<td>None</td>
</tr>
</tbody>
</table>

**Automatic Feed**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dist. from Top Paper Edge</td>
<td>None</td>
</tr>
<tr>
<td>Dist. from Left Paper Edge</td>
<td>None</td>
</tr>
<tr>
<td>PFT Field Name</td>
<td>PDF Field Name</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Location of First Print Column</td>
<td>None</td>
</tr>
</tbody>
</table>

### SET PAGE LENGTH (INCHES)

<table>
<thead>
<tr>
<th>Control Sequence</th>
<th>PAGE_LENGTH_TYPE?=INCH SET_PAGE_LENGTH=</th>
<th>When the data is defined in the control sequence for SET PAGE LENGTH (INCHES) and if any of the data is not defined in the control sequence for SET PAGE LENGTH (LINES), this field is migrated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Offset</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>X/Y</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Top Margin Size</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Bottom Margin Size</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

### SET PAGE LENGTH (LINES)

<table>
<thead>
<tr>
<th>Control Sequence</th>
<th>PAGE_LENGTH_TYPE?=LINE SET_PAGE_LENGTH=</th>
<th>When the length is defined in the control sequence for SET PAGE LENGTH (LINES), this field is migrated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Offset</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>X/Y</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Top Margin Size</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Bottom Margin Size</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

### SET LEFT MARGIN (INCHES)

<table>
<thead>
<tr>
<th>Control Sequence</th>
<th>None</th>
<th>This field is ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Offset</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>PFT Field Name</td>
<td>PDF Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>X/Y</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>SET LEFT MARGIN (COLUMN)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Sequence</td>
<td>SET_HORIZONTAL_MARGIN=</td>
<td>When the data is defined in the control sequence field for SET LEFT MARGIN (COLUMN), this field is migrated.</td>
</tr>
<tr>
<td>Maximum</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Offset</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>CARRIER RETURN/LINE FEED</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Continuous Forms</td>
<td>CARRIAGE_RETURN=</td>
<td>This field is migrated for the following cases:</td>
</tr>
<tr>
<td>Carrier Return (Continuous Forms)</td>
<td></td>
<td>• Case 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Carrier Return field for the Continuous Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any of the data in the Carrier Return field is not defined for the Manual Feed and Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Carrier Return field for the Continuous Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Carrier Return field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any of the data in the Carrier Return field is not defined for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Carrier Return field for the Continuous Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Carrier Return field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any of the data in the Carrier Return field is not defined for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Carrier Return field for the Continuous Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Carrier Return field for the Automatic Feed and Manual Feed.</td>
</tr>
<tr>
<td>PFT Field Name</td>
<td>PDF Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Line Feed (Continuous Forms) | LINE_FEED= | This field is migrated for the following cases:  
    - Case 1  
      - The data is defined in the Line Feed field for the Continuous Forms.  
      - Any of the data in the Line Feed Line field is not defined for the Manual Feed and Automatic Feed.  
    - Case 2  
      - The data is defined in the Line Feed field for the Continuous Forms.  
      - The same data is defined in the Line Feed field for the Manual Feed.  
      - Any data is not defined in the Line Feed field for the Automatic Feed.  
    - Case 3  
      - The data is defined in the Line Feed field for the Continuous Forms.  
      - The same data is defined in the Line Feed field for the Automatic Feed.  
      - Any data is not defined in the Line Feed field for the Manual Feed.  
    - Case 4  
      - The data is defined in the Line Feed field for the Continuous Forms.  
      - The same data is defined in the Line Feed field for the Automatic Feed and Manual Feed.  |

Manual Feed
### Table 32. Migration from the Printer Function Table to the Printer Definition File (continued)

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carrier Return (Manual Feed)</td>
<td>CARRIAGE_RETURN=</td>
<td>This field is migrated for the following cases:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any of the data in the Line Feed Line field is not defined for the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continuous Forms and Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Line Feed field for the Continuous</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any data is not defined in the Line Feed field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Line Feed field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any data is not defined in the Line Feed field for the Continuous Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Line Feed field for the Automatic Feed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and Continuous Forms.</td>
</tr>
<tr>
<td>Line Feed (Manual Feed)</td>
<td>LINE_FEED=</td>
<td>This field is migrated for the following cases:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any of the data in the Line Feed Line field is not defined for the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continuous Forms and Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Line Feed field for the Continuous</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any data is not defined in the Line Feed field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Line Feed field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any data is not defined in the Line Feed field for the Continuous Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Line Feed field for the Automatic Feed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and Continuous Forms.</td>
</tr>
<tr>
<td>PFT Field Name</td>
<td>PDF Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Carrier Return</td>
<td>CARRIAGE_RETURN=</td>
<td>This field is migrated for the following cases:</td>
</tr>
<tr>
<td>(Automatic Feed)</td>
<td></td>
<td>• Case 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The data is defined in the Carrier Return field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Any of the data in the Carrier Return field is not defined for the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continuous Feed and Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The data is defined in the Carrier Return field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The same data is defined in the Carrier Return field for the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continuous Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Any of the data in the Carrier Return field is not defined for the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The data is defined in the Carrier Return field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The same data is defined in the Carrier Return field for the Manual</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Any of the data in the Carrier Return field is not defined for the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continuous Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The data is defined in the Carrier Return field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The same data is defined in the Carrier Return field for the Manual</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Feed and Continuous Forms.</td>
</tr>
</tbody>
</table>
Table 32. Migration from the Printer Function Table to the Printer Definition File (continued)

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Feed (Automatic Feed)</td>
<td>LINE_FEED=</td>
<td>This field is migrated for the following cases:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any of the data in the Line Feed Line field is not defined for the Continuous Forms and Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Line Feed field for the Continuous Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any data is not defined in the Line Feed field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The data is defined in the Line Feed field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Line Feed field for the Manual Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Any data is not defined in the Line Feed field for the Continuous Forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– When the data is defined in the Line Feed field for the Automatic Feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– The same data is defined in the Line Feed field for the Manual Feed and Continuous Forms.</td>
</tr>
</tbody>
</table>

MULTIPLE COPIES

Print without Clearing Page from

| Top Tray   | None | This field is ignored. |
| Bottom Tray| None | This field is ignored. |
| Envelope Tray| None | This field is ignored. |
| Manual Tray| None | This field is ignored. |
| Clear Page Buffer| None | This field is ignored. |

Multiple Copies Variable Control

<p>| Control Sequence | None | This field is ignored. |
| Maximum          | None | This field is ignored. |
| Offset           | None | This field is ignored. |</p>
<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LANDSCAPE PAPER HANDLING</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bottom Tray Feed</td>
<td>SET_LANDSCAPELEFT_ORIENT=</td>
<td></td>
</tr>
<tr>
<td>Top Tray Feed</td>
<td>SET_LANDSCAPELEFT_ORIENT=</td>
<td></td>
</tr>
<tr>
<td>Envelope Feed</td>
<td>SET_LANDSCAPELEFT_ORIENT=</td>
<td></td>
</tr>
<tr>
<td>Manual Feed</td>
<td>SET_LANDSCAPELEFT_ORIENT=</td>
<td></td>
</tr>
</tbody>
</table>

**TYPESTYLE DEFINITION**
Table 32. Migration from the Printer Function Table to the Printer Definition File (continued)

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Typestyle Definition</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>PC Character Set</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Initial Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Ending Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Individual Typestyle Definition</td>
<td>SET_GFID_</td>
<td>This number is appended as a four-digit number after the string SET_GFID_. For example, when the typestyle number 9 is defined, 0009 is appended after the string SET_GFID_ and SET_GFID_0009= is migrated. And the numbers supported by PC400 are migrated. The numbers not supported by PC400 are ignored.</td>
</tr>
<tr>
<td>PC Character Set</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Initial Control Sequence</td>
<td>SET_GFID_xxxx=</td>
<td>This control sequence is appended after the string SET_GFID_xxxx=, where xxxx is the four-digit number defined in the typestyle number field.</td>
</tr>
<tr>
<td>Ending Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Characters</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Initial Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Ending Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Symbols</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Initial Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Ending Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Group Typestyle Definition</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Group Identifier</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Group Identifier Comment</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>PFT Field Name</td>
<td>PDF Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Typestyle number</td>
<td>SET_GFID_</td>
<td>This number is appended as a four-digit number after the string SET_GFID_. For example, when the typestyle numbers 1, 2, 3, and 4 are defined, 0001, 0002, 0003, and 0004 are appended after the string SET_GFID_ and SET_GFID_0001=, SET_GFID_0002=, SET_GFID_0003=, and SET_GFID_0004= are migrated because the PC400 does not have the group typestyle definition. The typestyle numbers that are not supported by the PC400 are not migrated.</td>
</tr>
<tr>
<td>PC Character Set</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Initial Control</td>
<td>SET_GFID xxxx=</td>
<td>This control sequence is appended after the string SET_GFID xxxx=, where xxxx is the four-digit number defined in the typestyle number field.</td>
</tr>
<tr>
<td>Ending Control</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Characters</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Initial Control</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Ending Control</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Symbols</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Initial Control</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Ending Control</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Character Set Number</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>SLOT SELECTION</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot 1 Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Slot 2 Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Slot 3 Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>
Table 32. Migration from the Printer Function Table to the Printer Definition File (continued)

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

**USER DEFINED CONTROL**

Parameters of SET ENVELOP SIZE Command

<table>
<thead>
<tr>
<th>Control Number: 984</th>
<th>None</th>
<th>This field is ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

Parameters of SET PAGE SIZE Command

<table>
<thead>
<tr>
<th>Control Number: 986</th>
<th>None</th>
<th>This field is ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

ESC Sequence of SET PAGE SIZE Command

<table>
<thead>
<tr>
<th>Control Number: 987</th>
<th>None</th>
<th>This field is ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

ESC Sequence of SET PAGE SIZE Command

<table>
<thead>
<tr>
<th>Control Number: 988</th>
<th>None</th>
<th>This field is ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

Printer Data Stream
### Table 32. Migration from the Printer Function Table to the Printer Definition File (continued)

<table>
<thead>
<tr>
<th>PFT Field Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Sequence</td>
<td>SET_FONT_GLOBAL=1B 5B 49 word-value(LH) word-value(HL) word-value(HL) byte-value word-value(HL)</td>
<td>When 04 is defined in this field, SET_FONT_GLOBAL=1B 5B 49 ... word-value(HL) is migrated. When the other value is defined, this field is ignored. 04 means IBM Personal Printer Data Stream Level 2 or higher. When the migration is done for PAPER HANDLING, use this information. (See “Definition of PAPER HANDLING Migration” on page 227.)</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

**Duplex long edge**

<table>
<thead>
<tr>
<th>Control Number: 989</th>
<th>None</th>
<th>This field is ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Sequence</td>
<td>SET_DUPLEX=</td>
<td>When the data is defined in the control sequence for the duplex long edge, the data is appended to the string SET_DUPLEX=.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

**Duplex short edge**

<table>
<thead>
<tr>
<th>Control Number: 990</th>
<th>None</th>
<th>This field is ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Sequence</td>
<td>SET_DUPLEX_TUMBLE=</td>
<td>When the data is defined in the control sequence for the duplex short edge, the data is appended to the string SET_DUPLEX_TUMBLE=.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

**Simplex**

<table>
<thead>
<tr>
<th>Control Number: 991</th>
<th>None</th>
<th>This field is ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Sequence</td>
<td>RESET_DUPLEX=</td>
<td>When the data is defined in the control sequence for the simplex, the data is appended to the string RESET_DUPLEX=.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

**Jog the output tray**

<table>
<thead>
<tr>
<th>Control Number: 992</th>
<th>None</th>
<th>This field is ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>PFT Field Name</td>
<td>PDF Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Normal portrait orientation</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Number: 993</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Sequence</td>
<td>SET_PORTRAIT_ORIENT=</td>
<td>When the data is defined in the control field for the normal portrait orientation, the data is appended to the string SET_PORTRAIT_ORIENT=.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Landscape left</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Number: 994</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Sequence</td>
<td>SET_LANDSCAPELEFT_ORIENT=</td>
<td>When the data is defined in the control field for the landscape left, the data is appended to the string SET_LANDSCAPELEFT_ORIENT=.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Portrait upside down orientation</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Number: 995</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Sequence</td>
<td>SET_PORTRAITUPDWN_ORIENT=</td>
<td>When the data is defined in the control field for the portrait upside down orientation, the data is appended to the string SET_PORTRAITUPDWN_ORIENT=.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Landscape right</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Number: 996</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Sequence</td>
<td>SET_LANDSCAPERIGHT_ORIENT=</td>
<td>When the data is defined in the control field for the landscape right, the data is appended to the string SET_LANDSCAPERIGHT_ORIENT=.</td>
</tr>
<tr>
<td>Control Sequence File Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>COR in 10 pitch</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>PFT Field Name</td>
<td>PDF Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Control Sequence File</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>COR in 12 pitch</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Number: 998</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Sequence File</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>COR in 15 pitch</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Number: 999</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Sequence</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Control Sequence File</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
<tr>
<td>Name</td>
<td>None</td>
<td>This field is ignored.</td>
</tr>
</tbody>
</table>

**FUNCTION SELECTION TEST RESPONSES**

<table>
<thead>
<tr>
<th>Function Name</th>
<th>PDF Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Superscript/Subscript</td>
<td>None</td>
<td>This data is ignored.</td>
</tr>
<tr>
<td>Underline</td>
<td>None</td>
<td>This data is ignored.</td>
</tr>
<tr>
<td>Emphasis (Bold)</td>
<td>None</td>
<td>This data is ignored.</td>
</tr>
<tr>
<td>Form Feed</td>
<td>None</td>
<td>This data is ignored.</td>
</tr>
<tr>
<td>Back Space</td>
<td>BACKSPACE=</td>
<td>This field is migrated when you type YES or NO in response to the prompt during the Backspace Function Selection Test.</td>
</tr>
<tr>
<td>Mid-line pitch change</td>
<td>None</td>
<td>This data is ignored.</td>
</tr>
<tr>
<td>Horizontal Character</td>
<td>None</td>
<td>This data is ignored.</td>
</tr>
<tr>
<td>spacing</td>
<td>None</td>
<td>This data is ignored.</td>
</tr>
<tr>
<td>First character position</td>
<td>None</td>
<td>This data is ignored.</td>
</tr>
<tr>
<td>PSM</td>
<td>None</td>
<td>This data is ignored.</td>
</tr>
<tr>
<td>Cursor Draw</td>
<td>None</td>
<td>This data is ignored.</td>
</tr>
</tbody>
</table>
Note: When you migrate IBM3812.PFT and IBM3812.MNL, the following fields are added to IBM3812.PDF:
   • FORWARD_VERTICAL_STEP_FEED=1B 5B 43 03 00 E3 word-value(LH)
   • VERTICAL_PEL=240

Definition of PAPER HANDLING Migration
The PFT Migration Utility migrates the data for PAPER HANDLING and LANDSCAPE PAPER HANDLING as follows:
1. The PFT Migration Utility checks whether the LANDSCAPE PAPER HANDLING controls are defined.
2. If the LANDSCAPE PAPER HANDLING controls are defined, the PFT Migration Utility assumes that the PAPER HANDLING control sequences include controls to set the page orientation to portrait. Each LANDSCAPE PAPER HANDLING control sequence has the controls to set the page orientation to landscape in addition to the tray select and feed controls.
3. If the LANDSCAPE PAPER HANDLING controls are not defined, the PAPER HANDLING controls do not have the controls to set the page orientation to portrait. If a personal printer supports normal portrait, landscape left, portrait upside down, and landscape right orientation, the page orientation controls are defined in the appropriate user-defined controls.

If the LANDSCAPE PAPER HANDLING controls are not defined: When the PAPER HANDLING controls are not defined, the controls are migrated as follows:

<table>
<thead>
<tr>
<th>PFT Fields</th>
<th>PDF Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom Tray</td>
<td>SELECT_DRAWER2=</td>
</tr>
<tr>
<td>Top Tray</td>
<td>SELECT_DRAWER1=</td>
</tr>
<tr>
<td>Envelope Tray</td>
<td>SELECT_ENVELOPE=</td>
</tr>
<tr>
<td>Manual Tray</td>
<td>SELECT_DRAWER3=</td>
</tr>
</tbody>
</table>

If the LANDSCAPE PAPER HANDLING controls are defined: When the PAPER HANDLING controls are defined, these controls have the controls to set the page orientation to portrait. The LANDSCAPE PAPER HANDLING controls have the controls to set the page orientation to landscape. The PFT Migration Utility migrates the controls as follows:
<table>
<thead>
<tr>
<th></th>
<th>(Length1) == 0</th>
<th>(Length1) &gt; 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length of the</td>
<td></td>
<td></td>
</tr>
<tr>
<td>control in the</td>
<td></td>
<td></td>
</tr>
<tr>
<td>corresponding</td>
<td></td>
<td></td>
</tr>
<tr>
<td>field of</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LANDSCAPE PAPER</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HANDLING with</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PAPER HANDLING</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **CASE 1**
  
  Since both of the fields are not defined, no data is migrated.
  
  **Example:** No data is migrated to SELECT_DRAWER2= under the following conditions. For this example, SELECT_DRAWER2= is not written in the output file.
  - No data is defined in the bottom tray select and feed for PAPER HANDLING.
  - No data is defined in the bottom tray select and feed for LANDSCAPE PAPER HANDLING.

- **CASE 2**
  
  Since no data is defined in the field for PAPER HANDLING, the PFT Migration Utility cannot compare the data in the corresponding field with the data for LANDSCAPE PAPER HANDLING. The data for LANDSCAPE PAPER HANDLING is migrated to the drawer selection field of PDF regardless, including control of the landscape orientation.
  
  **Example:** The control of the top tray select and feed for LANDSCAPE PAPER HANDLING is migrated to SELECT_DRAWER1= under the following conditions.
  - No data is defined in the top tray select and feed for PAPER HANDLING.
  - The control is defined in the top tray select and feed for LANDSCAPE PAPER HANDLING.

- **CASE 3**
  
  Since no data is defined in the field for LANDSCAPE PAPER HANDLING, the PFT Migration Utility cannot compare the data in the corresponding field with
the data for PAPER HANDLING. The data for PAPER HANDLING is migrated to the drawer selection field of PDF regardless, including the control of the portrait orientation.

**Example:** The control of the manual select and feed for PAPER HANDLING is migrated to SELECT_DRAWER3= under the following conditions.

- The control is defined in the manual select and feed for PAPER HANDLING.
- No data is defined in the top tray select and feed for LANDSCAPE PAPER HANDLING.

**CASE 4**
Since the length is different, no data is migrated.

**Example:** No data is migrated to SELECT_DRAWER2= under the following conditions. For this example, SELECT_DRAWER2= is not written in the output file.

- The data is defined in the bottom tray select and feed for PAPER HANDLING and the length is 8.
- The data is defined in the bottom tray select and feed for LANDSCAPE PAPER HANDLING and the length is 10.

**CASE 5**
The PFT Migration Utility compares the data for PAPER HANDLING with the data for LANDSCAPE PAPER HANDLING as follows:

- If a different value is found in the data, search the control backward for the escape character X'1B'.
- If the escape character is found in the middle of the control, divide the control into two parts. The PFT Migration Utility assumes that the first part is the control for the tray select and feed, and the second part is the control for the page orientation. The PFT Migration Utility migrates the first part of the PAPER HANDLING control into the tray select and feed, the second part of the PAPER HANDLING control into the SET_PORTRAIT_ORIENT=, and the second part of the LANDSCAPE PAPER HANDLING control into SET_LANDSCAPELEFT_ORIENT=.
- If the escape character is found at the top of the control and 03 (= HP PCL) is defined in the user-defined control 988, the PFT Migration Utility assumes that the controls are combined. For this, the control begins with the escape character and the two shared characters. For this, the PFT Migration Utility assumes that the last character of the first part is a lowercase letter and converts it to an uppercase letter to indicate that it is a terminating character. The PFT Migration Utility divides the controls into the two parts as follows:
> < Control for the PAPER HANDLING >

- Migrated into SET_PORTRAIT_ORIENT=

  ESC shared character oo oo oo oo XX . . .

  Different value

  Converted uppercase

  Migrated into the tray select and feed

< Control for LANDSCAPE PAPER HANDLING >

- Migrated into SET_LANDSCAPELEFT_ORIENT=

  ESC shared character oo oo oo oo XX : : :

  Different value

- If the escape character is found, but the data stream is not HP PCL, the PFT Migration Utility displays the error message to indicate that the PFT Migration Utility cannot migrate the data.
- If the escape character is not found, the PFT Migration Utility displays the error message to indicate that the PFT Migration Utility cannot migrate the data.
- If a different value is not found, the same control is defined for PAPER HANDLING and LANDSCAPE PAPER HANDLING.

The PFT Migration Utility migrates the data in the following order:
1. Top Tray Select and Feed
2. Bottom Tray Select and Feed
3. Manual Select and Feed
4. Envelope Tray Select and Feed

The migration stops for the page orientation, SET_PORTRAIT_ORIENT= and SET_LANDSCAPELEFT_ORIENT=, when the controls for the page orientation are found. For example, the controls for the page orientation are found when the data is migrated for the Bottom Tray Select and Feed. The PFT Migration Utility does not care about the page orientation when migrating the data Manual Select and Feed, and Envelop Tray Select and Feed.
Chapter 21. Troubleshooting

There are a number of self-help information resources and tools to help you troubleshoot problems. When you have any problem when using the product, you can perform the following tasks:

- Refer to the release information for your product for known issues, workarounds, and troubleshooting information.
- Check if a download or fix is available to resolve your problem.
- Search the available knowledge bases to see if the resolution to your problem is already documented.
- If you still need help, contact IBM® Software Support and report your problem.

1. Personal Communications Database Access error when starting Microsoft Excel

   Problem (Abstract)

   Microsoft Excel startup via the Database Access utility might return PCSDB002 error. Modify system environment variable to correct the error.

   Symptom

   Error message PCSDB002. An error occurred when connecting with the application.

   Environment

   Microsoft Office 2007. Prior versions might also be affected.

   Resolving the problem

   Add the installation path of the Excel application (excel.exe) to the Windows Path environment variable.

2. Personal Communications Database Access utility limitations with Microsoft Office 2007

   Problem (Abstract)

   The .xlsx file format is not supported.

   Resolving the problem

   The following limitation applies when using Microsoft Office 2007 with Database Access:
   - The Database Access utility does not support the .xlsx file format introduced in Microsoft Office 2007.
   - A query result can be saved in a .xls file, which can then be edited with Microsoft Office Excel 2007.
3. Windows Firewall, provided as part of Windows XP Service Pack 2, blocks EEDLC packets

Problem (Abstract)

Windows® Firewall blocks EEDLC packets. You must add UDP ports to the firewall configuration.

Resolving the problem

Both IPv4 and IPv6 EEDLC packets are blocked by the Windows Firewall feature introduced in Microsoft® Windows XP SP2. This feature differs from the Internet Connection Firewall (ICF) in Windows XP releases prior to SP2. To enable the EEDLC connection, the EEDLC standard UDP ports (that is, 12000–12004) must be added to the Windows Firewall exception list. You can use any of the following methods to add the ports.

Windows Firewall configuration window:
1. Open Windows Firewall from the Windows Control Panel.
2. Click the Exceptions tab.
3. Click Add to add UDP ports 12000 to 12004.

Network Connections window:
1. Open the Network Connections dialog and click Properties > Advanced > Settings.
2. Click the Exceptions tab.
3. Click Add Port to add UDP ports 12000 to 12004.
4. Command line:
1. Use the following commands to add each port:
   • netsh firewall set portopening UDP 12000 Udp_12000_EEDLC
   • netsh firewall set portopening UDP 12001 Udp_12001_EEDLC
   • netsh firewall set portopening UDP 12002 Udp_12002_EEDLC
   • netsh firewall set portopening UDP 12003 Udp_12003_EEDLC
   • netsh firewall set portopening UDP 12004 Udp_12004_EEDLC
2. After you add the ports, the Windows Firewall window exception dropdown list shows the new UDP port numbers.

For additional details about the Windows Firewall, refer to the Microsoft Developer Network database.

4. Disable firewall/filtering when using Personal Communications IPv6 functionality on Windows

Problem(Abstract)

The Windows® XP Internet Connection Firewall (filtering) blocks IPv6 packets by default. You must disable IPv6 filtering for all adapters for Personal Communications to operate properly. The behavior is different from Windows Firewall (introduced in Windows XP SP2).
Resolving the problem

If the Windows Internet Connection Firewall (ICF) is enabled, Personal Communications IPv6 features might not function properly. You must explicitly disable the ICF IPv6 firewall/filtering.

ICF is available on Windows XP releases prior to Service Pack 2; Microsoft introduced Windows Firewall with XP SP2.

To configure ICF, type netsh firewall show adapter at a command prompt to see a list of all network adapters with IPv6 configured. Each item indicates whether filtering is enabled for that adapter, as follows:

<table>
<thead>
<tr>
<th>AdapterFriendlyName</th>
<th>IPV6FilteringEnabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Area Connection</td>
<td>Yes</td>
</tr>
<tr>
<td>6to4 Tunneling Pseudo-Interface</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatic Tunneling Pseudo-Interface</td>
<td>Yes</td>
</tr>
</tbody>
</table>

You could use the following commands to disable IPv6 filtering for the adapter interfaces shown in the previous example:

- netsh firewall set adapter "Local Area Connection" filtering=disable
- netsh firewall set adapter "6to4 Tunneling Pseudo-Interface" filtering=disable
- netsh firewall set adapter "Automatic Tunneling Pseudo-Interface" filtering=disable

After you disable filtering, type netsh firewall show adapter to show the firewall status. The display should be similar to the following:

<table>
<thead>
<tr>
<th>AdapterFriendlyName</th>
<th>IPV6FilteringEnabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Area Connection</td>
<td>No</td>
</tr>
<tr>
<td>6to4 Tunneling Pseudo-Interface</td>
<td>No</td>
</tr>
<tr>
<td>Automatic Tunneling Pseudo-Interface</td>
<td>No</td>
</tr>
</tbody>
</table>

For additional details about configuring the IPv6 Internet Connection Firewall, refer to the Microsoft® TechNet database.
Part 6. Appendixes
Appendix A. iSeries, eServer i5, or System i5 Configuration Examples

To connect to an iSeries, eServer i5, or System i5, you need to specify configuration information in the workstation profile that accurately corresponds to the information specified in the iSeries, eServer i5, or System i5 (referred to as the device description).

For example, the LAN attachment via IEEE 802.2 in the following figure shows how the configuration information specified in the workstation profile corresponds to the configuration information in the iSeries, eServer i5, or System i5.

![Figure 26. LAN Attachment via IEEE 802.2](image)

### iSeries Device Description

To configure 5250 display or printer sessions, the following values must be set in the iSeries device description:

<table>
<thead>
<tr>
<th>iSeries Device Description</th>
<th>Display Session</th>
<th>Printer Session</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>24 x 80</td>
<td>27 x 132</td>
</tr>
<tr>
<td>Device category</td>
<td>*DSP</td>
<td>*DSP</td>
</tr>
<tr>
<td>Device class</td>
<td>*VRT</td>
<td>*VRT</td>
</tr>
<tr>
<td>Device type</td>
<td>3197</td>
<td>3477</td>
</tr>
<tr>
<td>Device model</td>
<td>C1</td>
<td>FC</td>
</tr>
<tr>
<td>Keyboard language type</td>
<td>USB+</td>
<td>USB+</td>
</tr>
<tr>
<td>Character identify code</td>
<td>697 037+</td>
<td>697 037+</td>
</tr>
</tbody>
</table>

* For SBCS, depends on the host code page selection.

The following table applies to DBCS only.

<table>
<thead>
<tr>
<th>iSeries Device Description</th>
<th>Display Session</th>
<th>Printer Session</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Host Code Page</td>
<td>Host Code Page</td>
</tr>
<tr>
<td></td>
<td>931</td>
<td>939</td>
</tr>
<tr>
<td>Device category</td>
<td>*DSP</td>
<td>*PRT</td>
</tr>
<tr>
<td>Device class</td>
<td>*VRT</td>
<td>*VRT</td>
</tr>
<tr>
<td>Device type</td>
<td>5555</td>
<td>5555</td>
</tr>
<tr>
<td>C01</td>
<td>C01</td>
<td></td>
</tr>
<tr>
<td>JUB</td>
<td>JPB</td>
<td>-</td>
</tr>
<tr>
<td>Character identify code</td>
<td>101 037</td>
<td>-</td>
</tr>
<tr>
<td>DBCS device feature</td>
<td>2424J0</td>
<td>2424J0</td>
</tr>
</tbody>
</table>
**5250 Sessions through One Link**

If you want all your 5250 sessions to connect through one link to an iSeries, eServer i5, or System i5, use the same **PC Location Name** and the same **Link Parameters** for all the sessions.

For example, you can configure two display sessions and one printer session connected to an iSeries, eServer i5, or System i5 using APPN.PC5250 as the **Location Name**.

```plaintext
Session A : Session Type : Display
            (Display) System Location Name : APPN.S7801234
            PC Location Name : APPN.PC5250
            Workstation ID : (not specified)

Session B : Session Type : Display
            (Display) System Location Name : APPN.S7801234
            PC Location Name : APPN.PC5250
            Workstation ID : (not specified)

Session C : Session Type : Printer
            (Printer) System Location Name : APPN.S7801234
            PC Location Name : APPN.PC5250
            Workstation ID : PCLOCALP1
```

In this example, the iSeries network attributes are:

- **Local network ID**: APPN
- **Local location**: S7801234

---

**Tip**

Enter **DSPNETA** from a 5250 session to display iSeries, eServer i5, or System i5 network attributes.

---

**System i5, iSeries, eServer i5, or System Mode Description**

PC400 initially uses mode description **QPCSUPP** on the iSeries, eServer i5, or System i5. If the PC Support/400 program or iSeries Access is installed on the iSeries, eServer i5, or System i5, QPCSUPP need not be created. If mode description QPCSUPP does not exist on the iSeries, eServer i5, or System i5, create the mode description:

1. Enter the following command on the command line of the main menu of the iSeries, eServer i5, or System i5:
   ```
   CRTM00D
   ```
   The Creating Mode Description panel appears.
Creating Mode Description (CRTMODD)

Type the selected items, and push the Enter key.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode Description.................</td>
<td>QPCSUPP</td>
</tr>
<tr>
<td>Maximum Session..................</td>
<td>8</td>
</tr>
<tr>
<td>Maximum number of Interaction...</td>
<td>8</td>
</tr>
<tr>
<td>Number of Local Control Sessions.</td>
<td>0</td>
</tr>
<tr>
<td>Number of Pre-joined Sessions...</td>
<td>0</td>
</tr>
<tr>
<td>Inbound Pacing Value.............</td>
<td>7</td>
</tr>
<tr>
<td>Outbound Pacing Value............</td>
<td>7</td>
</tr>
<tr>
<td>Maximum Length of Request Unit...</td>
<td>*CALC</td>
</tr>
<tr>
<td>Text Description ................</td>
<td>*BLANK</td>
</tr>
</tbody>
</table>

End

F3=Exit    F4=Prompt    F5=Rehash    F10=Add parameter    F12= Cancel
F13=How to use this panel    F24=More key

2. Type the necessary values in each field, according to the following table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode description</td>
<td>QPCSUPP</td>
</tr>
<tr>
<td>Maximum session</td>
<td>64</td>
</tr>
<tr>
<td>Maximum number of interactions</td>
<td>64</td>
</tr>
<tr>
<td>Number of local control sessions</td>
<td>0</td>
</tr>
<tr>
<td>Number of pre-joined sessions</td>
<td>0</td>
</tr>
<tr>
<td>Inbound pacing value</td>
<td>7</td>
</tr>
<tr>
<td>Outbound pacing value</td>
<td>7</td>
</tr>
<tr>
<td>Maximum length of request unit</td>
<td>*CALC</td>
</tr>
<tr>
<td>Text description</td>
<td>This field is optional</td>
</tr>
</tbody>
</table>

3. After you type all the values, press the Enter key.
   This completes the creation of the mode description QPCSUPP.

### iSeries, eServer i5, or System i5 Device Description for Twinaxial Attachments (APPC) Example

If you want to use a twinaxial (TDLC) attachment, the iSeries, eServer i5, or System i5 requires that you specify a device description. When the automatic device configuration indicator (QAUTOCFG) is set to ON in the iSeries, eServer i5, or System i5, the device description is created automatically. When the indicator is set to OFF, create the device description, as follows:

1. Enter the following command on the command line of the iSeries, eServer i5, or System i5 main menu:
   ```
   CRTDEVDSP
   ```
   The Creating Device Description (Display) panel appears.
2. Type the values in each field, according to the following table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device description</td>
<td>This is an optional field</td>
</tr>
<tr>
<td>Device class</td>
<td>*LCL</td>
</tr>
<tr>
<td>Device type</td>
<td>5150</td>
</tr>
<tr>
<td>Device format</td>
<td>2</td>
</tr>
</tbody>
</table>

3. After you type all values, press the Enter key.

The following screen appears:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port number</td>
<td>Number of the port to be attached</td>
</tr>
<tr>
<td>Switch setting</td>
<td>Device address</td>
</tr>
<tr>
<td>Controller to be attached</td>
<td>Descriptive name of the controller to be attached</td>
</tr>
</tbody>
</table>
5. After you enter all the values, press the Enter key.
   This completes the creation of the device description for the twinaxial attachment.

### iSeries, eServer i5, or System i5 Device Description for Asynchronous Attachment Example

If you want to use an asynchronous dial attachment, the iSeries, eServer i5, or System i5 requires that you specify configuration parameters for the controller/line/devices to be used.

The following sample is a typical configuration on the iSeries, eServer i5, or System i5 for an asynchronous dialed connection through an ASCII Workstation Controller.

1. Enter the following command on the command line of the iSeries, eServer i5, or System i5 main menu:
   ```
   WRKCFGSTS +CTL CTL03
   ```
   where `CTL03` is the name of your controller.

   The Work with Configuration Status panel appears.

   2. Enter 8 in the **Opt** field to work with the controller description for CTL03.
      The Work with Controller Descriptions panel appears.
3. Enter 2 in the Opt field to change the controller description for CTL03.

The Change Controller Description panel appears.

4. Type the values in each field, according to the following table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller description</td>
<td>CTL03</td>
</tr>
<tr>
<td>Resource name</td>
<td>CTL03</td>
</tr>
<tr>
<td>Online at IPL</td>
<td>*YES</td>
</tr>
<tr>
<td>Device wait timer</td>
<td>10</td>
</tr>
<tr>
<td>Auto-configuration controller</td>
<td>*YES</td>
</tr>
<tr>
<td>Text description</td>
<td>This field is optional</td>
</tr>
</tbody>
</table>

The Work with Controller Descriptions panel appears.
5. Enter 8 in the **Opt** field to work with the configuration status. The Work with Configuration Status panel appears.

6. Enter 8 in the **Opt** field next to **ASYNRTR** to work with the display device description. The Work with Device Descriptions panel appears.
7. Enter 2 in the Opt field to change the device description.

The Change Device Description panel appears.

This completes the creation of the controller and display device descriptions for an asynchronous dial attachment.

**iSeries, eServer i5, or System i5 VT Asynchronous Attachment Example**

The following sample is a typical configuration on the iSeries, eServer i5, or System i5 for a VT asynchronous dial connection through an ASCII Workstation Controller. For more details on iSeries, eServer i5, or System i5 for VT asynchronous attachments, refer to AS/400 ASCII Workstation Reference.

1. Enter the following command on the command line of the iSeries, eServer i5, or System i5 main menu:
   
   CRTDEVDSP
The Create Device Description panel appears, in a first and second screen, as shown for the configuration of a VT100 device in the following screens. When filling in the panel, make sure that the name of the attached controller (arbitrarily shown as CTL05 here) matches the name of the twinaxial controller configured on your iSeries, eServer i5, or System i5.

<table>
<thead>
<tr>
<th>Create Device Desc (Display) (CRTDEVDSP)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type choices, press Enter.</td>
</tr>
<tr>
<td>Device description...............&gt; VT100 Name</td>
</tr>
<tr>
<td>Device class...............&gt; *LCL *LCL, *RMT, *VRT, *SNPT</td>
</tr>
<tr>
<td>Device type...............&gt; V100 3101, 3151, 3161, 3162...</td>
</tr>
<tr>
<td>Device model...............&gt; *ASCII 0, 1, 2, 4, 5, 12, 23...</td>
</tr>
<tr>
<td>Emulated twinaxial device...............&gt; *TYPE 3196A2, 319702, *TYPE</td>
</tr>
<tr>
<td>Port number...............&gt; 1 0-17</td>
</tr>
<tr>
<td>Emulating ASCII device...............&gt; *NO *YES</td>
</tr>
<tr>
<td>Online at IPL...............&gt; *YES *NO</td>
</tr>
<tr>
<td>Attached controller...............&gt; CTL05 Name</td>
</tr>
<tr>
<td>Keyboard language type...............&gt; USB *SYSVAL, AGB, AGI, ALI...</td>
</tr>
<tr>
<td>Inactivity timer...............&gt; *NOMAX 1-30, *ATTACH, *NOMAX...</td>
</tr>
<tr>
<td>Line speed...............&gt; 19200 *TYPE, *CALC, 150, 300...</td>
</tr>
<tr>
<td>Word length...............&gt; 8 *TYPE, *CALC, 7, 8</td>
</tr>
<tr>
<td>Type of parity...............&gt; *NONE *TYPE, *CALC, *EVEN, *ODD...</td>
</tr>
<tr>
<td>Stop bits...............&gt; 2 *TYPE, 1, 2</td>
</tr>
</tbody>
</table>

F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

<table>
<thead>
<tr>
<th>Create Device Desc (Display) (CRTDEVDSP)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type choices, press Enter.</td>
</tr>
<tr>
<td>Text 'description'...............&gt; 'dec vt100 device description test'</td>
</tr>
</tbody>
</table>

Additional Parameters

<table>
<thead>
<tr>
<th>Character identifier:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic character set...............&gt; *KBDTYPE 1-32767, *SYSVAL, *KBDTYPE</td>
</tr>
<tr>
<td>Code page...............&gt; 1-32767</td>
</tr>
<tr>
<td>Print device...............&gt; *SYSVAL Name, *SYSVAL</td>
</tr>
<tr>
<td>Output queue...............&gt; *DEV Name, *DEV</td>
</tr>
<tr>
<td>Library...............&gt; *LIBL Name, *LIBL, *CURLIB</td>
</tr>
<tr>
<td>Library...............&gt; QSYSPRTR Name</td>
</tr>
</tbody>
</table>

F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

2. For a similar configuration for a VT220:
Use the same command, CRTDEVDSP, on the command line of the iSeries, eServer i5, or System i5 main menu. Again, the same kind of panels appear. You must make sure that the name of the attached controller matches the name of the twinaxial controller configured on your iSeries, eServer i5, or System i5.
### iSeries, eServer i5, or System i5 Configuration for SDLC Example

The following examples refer to SDLC and Hayes AutoSync.

#### Network Attributes

To display the network attributes for the iSeries, eServer i5, or System i5 to which you are connecting, enter the command `dspneta` on the iSeries, eServer i5, or System i5 main menu.
Press **Enter**.

The Display Network Attributes screen is displayed.

<table>
<thead>
<tr>
<th>Display Network Attributes</th>
<th>System: RALYAS4B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current system name ..........: RALYAS4B</td>
<td></td>
</tr>
<tr>
<td>Pending system name ..........:</td>
<td></td>
</tr>
<tr>
<td>Local network ID ..............: USIBMRA</td>
<td></td>
</tr>
<tr>
<td>Local control point name ......: RALYAS4B</td>
<td></td>
</tr>
<tr>
<td>Default local location .......: RALYAS4B</td>
<td></td>
</tr>
<tr>
<td>Default mode ..................: BLANK</td>
<td></td>
</tr>
<tr>
<td>APPN node type ...............: *NETNODE</td>
<td></td>
</tr>
<tr>
<td>Data compression .............: *NONE</td>
<td></td>
</tr>
<tr>
<td>Intermediate data compression : *NONE</td>
<td></td>
</tr>
<tr>
<td>Maximum number of intermediate sessions : 200</td>
<td></td>
</tr>
<tr>
<td>Route addition resistance ....: 128</td>
<td></td>
</tr>
<tr>
<td>Server network ID/control point name : +LCLNETID *ANY</td>
<td></td>
</tr>
</tbody>
</table>

Press Enter to continue.

**SDLC Leased Configuration**

Several descriptions must be created on the iSeries, eServer i5, or System i5; examples are given in this section.

**Creating an SDLC Line Description**

To create an SDLC leased line description, enter the command `crtlinsdlc` on the iSeries, eServer i5, or System i5 main menu.
Press **F4** (Prompt).

The Create Line Description panel is displayed. Enter the values for each parameter on the panel.

<table>
<thead>
<tr>
<th>Create Line Desc (SDLC) (CRTLNSDLC)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type choices, press Enter.</strong></td>
</tr>
<tr>
<td>Line description ........&gt; PCOMSSLCL Name</td>
</tr>
<tr>
<td>Resource names ........&gt; LIN021 Name</td>
</tr>
<tr>
<td>+ for more values</td>
</tr>
<tr>
<td>Online at IPL ........&gt; +YES +YES, +NO</td>
</tr>
<tr>
<td>Data link role ........&gt; +NEG +NEG, +PRI, +SEC</td>
</tr>
<tr>
<td>Physical interface ................&gt; +RS232V24 +RS232V24, +V35, +X21, ...</td>
</tr>
<tr>
<td>Connection type ................&gt; +NONSTTPP +NONSTTPP, +STTPP, +MP, +SHM</td>
</tr>
<tr>
<td>Switched network backup ........&gt; +NO +NO, +YES</td>
</tr>
<tr>
<td>Exchange identifier ........&gt; +SYSSGN 05600000-056FFFFFF, +SYSSGN</td>
</tr>
<tr>
<td>NRZI data encoding ........&gt; +YES +YES, +NO</td>
</tr>
<tr>
<td>Line speed ................&gt; 9600 600, 1200, 2400, 4800...</td>
</tr>
<tr>
<td>Modem type supported ........&gt; +NORMAL +NORMAL, +V54, +IBMWRAP...</td>
</tr>
<tr>
<td>Maximum frame size ........&gt; 521 265, 521, 1033, 2057</td>
</tr>
<tr>
<td>Duplex ................&gt; +HALF +HALF, +FULL</td>
</tr>
<tr>
<td>Inactivity timer ........&gt; 300 NOMAX, 150-4200 (0.1 sec)</td>
</tr>
<tr>
<td>Poll response delay ........&gt; 0 0-2048 (0.0001 seconds)</td>
</tr>
</tbody>
</table>

F3=Exit  F4=Prompt  F5=Refresh  F12=Cancel  F13=How to use this display  F24=More keys
Create Line Desc (SDLC) (CRTLNSDLCL)

Type choices, press Enter.

Nonproductive receive timer . . 320  160-4200 (0.1 seconds)
Idle timer . . . . . . . . . . . 30  5-300 (0.1 seconds)
Connect poll timer . . . . . . . 30  2-300 (0.1 seconds)
Poll cycle pause . . . . . . . 0  0-2048 (0.0001 seconds)
Frame retry . . . . . . . . . . 7  0-64
Text 'description' . . . . . . . PCOMM SDLC leased line

Additional Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attached nonswitched ctls</td>
<td></td>
<td>Name</td>
</tr>
<tr>
<td>Modem data rate select</td>
<td></td>
<td>*FULL, *HALF</td>
</tr>
<tr>
<td>Error threshold level</td>
<td></td>
<td>*OFF, *MIN, *MED, *MAX</td>
</tr>
<tr>
<td>Modulus</td>
<td>8</td>
<td>8, 128</td>
</tr>
<tr>
<td>Maximum outstanding frames</td>
<td>7</td>
<td>1-28</td>
</tr>
</tbody>
</table>

More...  
F3=Exit  F4=Prompt  F5=Refresh  F12=Cancel  F13=How to use this display  
F24=More keys

Press Enter to save the line description pcommsdlcl.

**SDLC Controller Description**

To create the SDLC controller description for the line PCOMMSDLCL, enter **crtctlappc** on the iSeries, eServer i5, or System i5 main menu.

Press F4 (Prompt). The Create Controller Description panel is displayed. Enter values for each parameter on the following two panels.
The APPC Device Description will create itself automatically.

**SDLC Switched Configuration**

The following examples contain information about the SDLC switched configuration on the iSeries, eServer i5, or System i5.

**SDLC Line Description**

To create an SDLC switched line definition on the iSeries, eServer i5, or System i5, enter the command `crtlinsdlc` on the iSeries, eServer i5, or System i5 main menu.
Press **F4** (Prompt).

The Create Line Description panel is displayed. Enter values for each parameter on the panel.

### Create Line Desc (SDLC) (CRTLNSDLC)

**Type choices, press Enter.**

- **Line description**........> PCOMSDLCSW
- **Resource names**.........> LIN051
- **Online at IPL**...........> *YES
t+ for more values
- **Data link role**.........> *PRI
- **Physical interface**.....> *RS232V24
- **Connection type**........> *SWTPP
- **Vary on wait**............> *NOWAIT
- **Autocall unit**..........> *NO
- **Exchange identifier**....> *SYSGEN
- **NRZI data encoding**.....> *YES
- **Line speed**..............> 9600, 600, 1200, 2400, 4800...
- **Modem type supported**...> *NORMAL
- **Switched connection type**........> *BOTH
- **Autoanswer**.............> *YES
- **Autodial**..............> *NO

**More...**

**F3=Exit  F4=Prompt  F5=Refresh  F12=Cancel  F13=How to use this display**

**F24=More keys**
Create Line Desc (SDLC) (CRTLINS DLC)

<table>
<thead>
<tr>
<th>Type choices, press Enter.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calling number ............ *NONE</td>
</tr>
<tr>
<td>Connect poll retry ........ 7 0-64</td>
</tr>
<tr>
<td>Maximum frame size ...... 521 265, 521, 1033, 2057</td>
</tr>
<tr>
<td>Duplex ................. +HALF +HALF, +FULL</td>
</tr>
<tr>
<td>Nonproductive receive timer 320 160-4200 (0.1 seconds)</td>
</tr>
<tr>
<td>Idle timer ............. 30 5-300 (0.1 seconds)</td>
</tr>
<tr>
<td>Connect poll timer ....... 30 2-300 (0.1 seconds)</td>
</tr>
<tr>
<td>Poll cycle pause ........ 0 0-2048 (0.0001 seconds)</td>
</tr>
<tr>
<td>Frame retry ............ 7 0-64</td>
</tr>
<tr>
<td>Data Set Ready drop timer 6 3-60 (seconds)</td>
</tr>
<tr>
<td>Autoanswer type .......... +DTR +DTR, +CDSTL</td>
</tr>
<tr>
<td>Remote answer timer ...... 60 30, 35, 40, 45 (seconds)</td>
</tr>
<tr>
<td>Text 'description' ...... PCOMM SDLC switched line</td>
</tr>
</tbody>
</table>

F3=Exit  F4=Prompt  F5=Refresh  F12=Cancel  F13=How to use this display  
F24=More keys

Press **Enter** to save the description pcomsd1csw.

**SDLC Controller Description**

To create the controller description for the switched SDLC line, enter **crtctlappc** on the iSeries, eServer i5, or System i5 main menu.

**MAIN iSeries Main Menu**

Select one of the following:

1. User tasks  
2. Office tasks  
3. General system tasks  
4. Files, libraries, and folders  
5. Programming  
6. Communications  
7. Define or change the system  
8. Problem handling  
9. Display a menu  
10. Information Assistant options  
11. iSeries Access tasks

90. Sign off

Selection or command  
***crtctlappc***

F3=Exit  F4=Prompt  F9=Retrieve  F12=Cancel  F13=Information Assistant  
F23=Set initial menu

Press **F4** (Prompt).

The Create Controller Description panel is displayed. Enter values for each parameter on the panel.
### LAN Configuration Example

This example assumes that a line description (token-ring or Ethernet) is already in place. This is a shared configuration object— all connections on that adapter will use the same line description. In the configuration example shown, the line description name is `TRN2619`.

---

**Press Enter to save the controller description `pcomsdlcsw`.

The APPC Device Description will create itself automatically once Personal Communications attaches to the iSeries, eServer i5, or System i5 using the line and controller descriptions that were just created.**
LAN Controller Description

The normal method would be to let the APPC controller create itself automatically. However, if preferred, the following command can be used to manually create the APPC controller.

To create a LAN controller description, enter `crtctlappc` on the iSeries, eServer i5, or System i5 main menu.

```
MAIN iSeries Main Menu
System: RALYAS4B

Select one of the following:
1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. iSeries Access tasks
90. Sign off

Selection or command
===> crtctlappc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu
```

Press F4 (Prompt). The Create Controller Description panel will be displayed.

Enter values for each parameter on the panel.

```
Create Ctl Desc (APPC) (CRTCTLAPPC)

Controller description . . . . > PCOMMLAN Name
Online at IPL . . . . . . > *YES *YES, *NO
APPN-capable . . . . . . > *YES *YES, *NO
Switched line list . . . . . > TRN2619 Name
    + for more values
Maximum frame size . . . . . > *LINKTYPE 265-16393, 256, 265, 512...
Remote control point . . . . > PEPE Name, *ANY
Exchange identifier . . . . . . > 00000000-FFFFFFFF
Initial connection . . . . . . > *DIAL *DIAL, *ANS
Dial initiation . . . . . . . . > *LINKTYPE *LINKTYPE, *IMMED, *DELAY
LAN remote adapter address . . . > 400052005109 000000000001-FFFFFFFFFFFF
APPN CP session support . . . . . > *LENMODE *ENDNODE, *LENMODE...
APPN/HPR capable . . . . . . > *YES *YES, *NO

More...
```

F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

- APPN transmission group number:  1  1-20, *CALC
- APPN minimum switched status:  *VRYONPND  *VRYONPND, *VRYON
- Autocreate device:  *ALL  *ALL, *NONE
- Autodelete device:  1440  1-10000, *NO
- User-defined 1:  *LIND  0-255, *LIND
- User-defined 2:  *LIND  0-255, *LIND
- User-defined 3:  *LIND  0-255, *LIND
- Model controller description:  *NO  *NO, *YES
- Text 'description':  PCOMM token-ring

Press **Enter** to save the controller description pcommlan.

The APPC Device Description will create itself automatically. Personal Communications attaches to the iSeries, eServer i5, or System i5 using the controller description that was just created.
Appendix B. Alerts

Alerts are generated by components of Personal Communications; corresponding messages are logged in the message log and can be viewed with the Personal Communications log viewer utility. Refer to the information about log viewer functions in the User’s Reference for the specific emulator type for more information.

Note that some alerts can be caused by different situations. Each situation may generate a different message. Other alerts are informational and do not generate specific messages in the log, although messages about problems relating to the situation that generated the alert may be logged.

<table>
<thead>
<tr>
<th>Alert ID number</th>
<th>Messages logged</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPN</td>
<td></td>
</tr>
<tr>
<td>X'034A6F0B'</td>
<td>PCS4066E</td>
</tr>
<tr>
<td></td>
<td>PCS4068E</td>
</tr>
<tr>
<td></td>
<td>PCS4093E</td>
</tr>
<tr>
<td>X'0DF28A14'</td>
<td>PCS4065E</td>
</tr>
<tr>
<td></td>
<td>PCS4066E</td>
</tr>
<tr>
<td></td>
<td>PCS4068E</td>
</tr>
<tr>
<td></td>
<td>PCS4069E</td>
</tr>
<tr>
<td></td>
<td>PCS4070E</td>
</tr>
<tr>
<td>X'170F7710'</td>
<td>No specific message</td>
</tr>
<tr>
<td>X'21745F2B'</td>
<td>No specific message</td>
</tr>
<tr>
<td>X'2313A399'</td>
<td>PCS4364A</td>
</tr>
<tr>
<td></td>
<td>PCS4365A</td>
</tr>
<tr>
<td></td>
<td>PCS4379A</td>
</tr>
<tr>
<td>X'32CDF4E2'</td>
<td>PCS4073E</td>
</tr>
<tr>
<td>X'47302521'</td>
<td>No specific message</td>
</tr>
<tr>
<td>X'6D27D125'</td>
<td>PCS4066E</td>
</tr>
<tr>
<td></td>
<td>PCS4068E</td>
</tr>
<tr>
<td>X'7599A70B'</td>
<td>No specific message</td>
</tr>
<tr>
<td>X'769022F0'</td>
<td>PCS4504E</td>
</tr>
<tr>
<td>X'90CD7CCA'</td>
<td>PCS4275E</td>
</tr>
<tr>
<td></td>
<td>PCS4280E</td>
</tr>
<tr>
<td></td>
<td>PCS4282E</td>
</tr>
<tr>
<td></td>
<td>PCS4283A</td>
</tr>
<tr>
<td></td>
<td>PCS4284E</td>
</tr>
<tr>
<td></td>
<td>PCS4304E</td>
</tr>
<tr>
<td></td>
<td>PCS4305E</td>
</tr>
<tr>
<td></td>
<td>PCS4310A</td>
</tr>
<tr>
<td></td>
<td>PCS4311E</td>
</tr>
<tr>
<td></td>
<td>PCS4312E</td>
</tr>
<tr>
<td>X'9E452D9C'</td>
<td>PCS4593A</td>
</tr>
<tr>
<td>X'89646AA'</td>
<td>PCS4275E</td>
</tr>
<tr>
<td></td>
<td>PCS4280E</td>
</tr>
<tr>
<td></td>
<td>PCS4282E</td>
</tr>
<tr>
<td></td>
<td>PCS4283A</td>
</tr>
<tr>
<td></td>
<td>PCS4284E</td>
</tr>
<tr>
<td></td>
<td>PCS4304E</td>
</tr>
<tr>
<td></td>
<td>PCS4305E</td>
</tr>
<tr>
<td></td>
<td>PCS4310A</td>
</tr>
<tr>
<td></td>
<td>PCS4311E</td>
</tr>
<tr>
<td></td>
<td>PCS4312E</td>
</tr>
<tr>
<td>X'B558D310'</td>
<td>PCS4324E</td>
</tr>
<tr>
<td></td>
<td>PCS4342E</td>
</tr>
<tr>
<td></td>
<td>PCS4347E</td>
</tr>
<tr>
<td>X'C781E91E'</td>
<td>No specific message</td>
</tr>
</tbody>
</table>
### PCS 4593A
- X'EBAA3C4F'

### PCS 4063E
- X'EBEE390E'
  - PCS4064E
  - PCS4066E
  - PCS4067E
  - PCS4068E
  - PCS4071A
  - PCS4091E
  - PCS4092E
  - PCS4094E
  - PCS4123E
  - PCS4124E
  - PCS4125E

### LLC2 SAP
- X'F52A0C01'
  - PCS4061E
  - PCS4062E

### LLC2 Link Station
- X'016E5F4E'
  - PCS1066A
  - PCS1054A
- X'3BA03B6D'
  - PCS1066A
  - PCS1005E
- X'55BF3E1C'
  - PCS1066A
  - PCS1054A
- X'A676B230'
  - PCS1066A
  - PCS1005E
- X'CAE3C58A'
  - PCS1066A
  - PCS1054A
- X'D2E2497B'
  - PCS1066A
  - PCS1005E
- X'D615A61E'
  - PCS1066A
  - PCS1054A
- X'EB1D6ADB'
  - PCS1066A
  - PCS1005E
- X'EB61E14F'
  - PCS1066A
  - PCS1005E

### pDLC

<table>
<thead>
<tr>
<th>Alert ID number</th>
<th>Messages logged</th>
<th>Alert type</th>
<th>Alert description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X'0E499026'</td>
<td>PCS8607</td>
<td>01</td>
<td>3300</td>
</tr>
<tr>
<td>X'0F935B3E'</td>
<td>PCS8603</td>
<td>01</td>
<td>3300</td>
</tr>
<tr>
<td>X'21C346F0'</td>
<td>PCS8619</td>
<td>01</td>
<td>3300</td>
</tr>
<tr>
<td>X'25025847'</td>
<td>PCS8620</td>
<td>01</td>
<td>3300</td>
</tr>
</tbody>
</table>
Appendix C. Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
500 Columbus Avenue
Thornwood, NY 10594
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM documentation or non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those documents or Web sites. The materials for those documents or Web sites are not part of the materials for this IBM product and use of those documents or Web sites is at your own risk.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
Department T01
Building 062
P.O. Box 12195
RTP, NC 27709-2195
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this information and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

# Trademarks

The following terms are trademarks of the IBM Corporation in the United States or other countries, or both:

| Advanced Peer-to-Peer Networking          | Netfinity          |
| AIX                                   | OfficeVision/400   |
| AnyNet                               | OfficeVision/MVS   |
| Client Access                        | Open Blueprint     |
| CUA                                  | OS/2               |
| DB2                                  | OS/390             |
| DB2 Connect                          | OS/400             |
| eServer                              | RACF               |
| GDDM                                 | SecureWay          |
| i5/OS                                | System i5          |
| IBM                                  | VTAM               |
| IBM Global Network                   | World Registry     |
| InfoWindow                           | z/OS               |
| iSeries                              | zSeries            |
| Micro Channel                        |                    |

Lotus, Notes, SmartSuite, and 1–2–3 are trademarks of Lotus Development Corporation in the United States, other countries, or both.

Tivoli® is a trademark of Tivoli Systems, Inc. in the United States and/or other countries.

Microsoft, Windows, and the Windows logo are registered trademarks of Microsoft Corporation in the United States, other countries, or both.
Java, JavaBeans, and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks of others.
Index

Numerics

3270
  configuring a second link 17
  configuring emulation to multiple hosts 19
3270 data stream (printing) 161
3270 passthru 32
5250
  automatic device name generation 22
  configuring a second link 18
  configuring emulation to multiple hosts 19

A
  adapters
    3270 via iSeries 32
    Home3270 31
    IBM Global Network Connection 31
    IBM PCI Multiprotocol 34
    IBM SDLC PCMCIA 34
    OEM 35
    SDLC MPA 29
  alerts xiii
  AnyNet
    AnyNet examples 106
    AnyNet SNA over TCP/IP
      configuration examples 106
      defining names 102, 103
      hints 105
      mapping 102
      overview 97
      routing preference protocol 104
  APARs 10
  Arabic support 141, 143
  asynchronous attachment
    eServer i5 device description 241
    iSeries device description 241
    System i5 device description 241
  asynchronous console 33

B
  bidirectional language support
    Arabic
      character shape selection functions 145
      installation 143
      keyboard functions for 3270 143
      limitations 143
    Hebrew
      configuration 149
      functions for 5250 150
      general 147
      printing considerations, Arabic and Hebrew 141
      VT, Arabic and Hebrew 151

C
  Certificate Express Logon
    configuring 83
    preparing to configure 82
  Certificate Express Logon (continued)
    problem determination 84
    using 82
  Certificate Management 52, 54
  character sequences, unsupported 31
  Chinese character set 137
  Citrix 71
  communication check 50x 32
  compiler, printer table
    description of 159
    explanation 169
  printer color mixing 161
  printer definition file format 166
  configuration
    3270 17
    5250 18
    advanced configuration 13
    eServer i5 examples 237
    iSeries examples 237
    System i5 examples 237
  conflicts, preventing 33

D
  data stream support, printer
    3270 161
    SCS 163
  Database Access 77
    data source, accessing 77
    overview 75
    size limit 79
  delimiting print jobs 164

E
  eServer i5
    5250 sessions through one link 238
    configuration examples 237
    device description 239, 241
    error messages 32
    system mode description 238
    system setup 32

F
  files
    configuration 13
    template 14
    update 14

H
  Hebrew support 141, 147
  Home3270 31
  host-directed print 161